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Where do | start?

Introduction

Where do | start?

Start by reading this introduction in its entirety. It contains useful general information
about the Modeller user interface and details of how the examples are formatted.

Software requirements

The examples are written for use with version 14.6 of LUSAS software products.

The LUSAS software product (and version of that product) and any product options
that are required in order to run an example will be stated in a usage box like this:

For software product(s): | All (except LT versions)
With product option(s): Nonlinear

Note that Composite examples can be run in any software product if a Composite
product option has been purchased. Similarly, LUSAS Analyst or LUSAS Composite
products can run bridge or civil examples if a Bridge or Civil product option was
purchased. The LUSAS Academic software product will run any example.

What software do | have installed?

To find out which software product(s), which version of that product, and which
software options are installed and licensed for your use run LUSAS and select Help >
About LUSAS Modeller and press the Key Information button to display a dialog
that lists the facilities and options supported by your software license.

About the examples

The examples are of varying complexity and cover different modelling and analysis
procedures using LUSAS. The first example in this manual contains detailed
information to guide you through the procedures involved in building a LUSAS model,
running an analysis and viewing the results. This fully worked example details the
contents of each dialog used and the necessary text entry and mouse clicks involved.




Introduction

The remaining examples assume that you have completed the fully worked example and
may not necessarily contain the same level of information. It will benefit you to work
through as many examples as possible, even if they have no direct bearing on your
immediate analysis interests.

Except where mentioned, all examples are written to allow modelling and analysis to be
carried out with the Teaching and Training version of LUSAS which has restrictions on
problem size. The teaching and training version limits are currently set as follows:

500 100 250 1500 10
Nodes Points Elements Degrees of Freedom Loadcases

Because of the modelling and analysis limits imposed by the Teaching and Training
Versions some examples may contain coarse mesh arrangements that do not necessarily
constitute good modelling practice. In these situations these examples should only be
used to illustrate the LUSAS modelling methods and analysis procedures involved and
should not necessarily be used as examples of how to analyse a particular type of
structure in detail.

Other worked examples

A separate worked examples manual Application Examples Manual (Bridge, Civil &
Structural) contains application-specific examples for civil, structural and bridge
enegineering.

User Manuals for optional software products and options, such as IMD Plus, or Rail
Track Analysis contain worked examples to illustrate the use of each.

Format of the examples

Headings

Each example contains some or all of the following main headings:

U Description contains a summary of the example, defining geometry, material
properties, analysis requirements and results processing requirements.

e Objectives states the aims of the analysis.
e Keywords contains a list of keywords as an aid to selecting the correct
examples to run.

e Associated Files contains a list of files held in the \<Lusas
Installation Folder>\Examples\Modeller directory that are associated with
the example. These files are used to re-build models if you have problems, or




| Geometry
| Point >
Coordinates...
| Geometry

Point >
Coordinates...

Format of the examples

can be used to quickly build a model to skip to a certain part of an example,
for instance, if you are only interested in the results processing stage.

O Modelling contains procedures for defining the features and attribute datasets
to prepare the LUSAS model file. Multiple model files are created in some of
the more complex examples and these therefore contain more than one
‘Modelling’ section.

O Running the Analysis contains details for running the analysis and
assistance should the analysis fails for any reason.

0 Viewing the Results contains procedures for results processing using
various methods.

Menu commands

Menu entries to be selected are shown as follows:

This implies that the Geometry menu should be selected from the menu bar, followed
by Point, followed by the Coordinates... option.

Sometimes when a menu entry is referred to in the body text of an example it is written
using a bold text style. For example the menu entry shown above would be written as
Geometry > Point > Coordinates...

Toolbar buttons

For certain commands a toolbar button will also be shown to show the ‘short-cut’
option to the same command that could be used instead:

.::}l The toolbar button for the Geometry > Point > Coordinates... command is
shown here.

User actions

Actions that you need to carry out are generally bulleted (the exception is when they are
immediately to the right of a menu command or a toolbar button) and any text that has
to be entered is written in a bold text style as follows:

e Enter coordinates of (10, 20).

So the selection of a typical menu command (or the equivalent toolbar button) and the
subsequent action to be carried out would appear as follows:

El Enter coordinates of (10, 20).




| File
[New...
| File
| Script >
| Run Script...

Introduction

Selecting the menu commands, or the toolbar button shown will cause a dialog box to
be displayed in which the coordinates 10, 20 should be entered.

Filling-in dialogs

For filling-in dialogs a bold text style is used to indicate the text that must be entered.
Items to be selected from drop-down lists or radio buttons that need to be picked also
use a bold text style. For example:

e In the New Model dialog enter the filename as frame_2d and click the OK
button to finish.

Grey-boxed text

Grey-boxed text indicates a procedure that only needs to be performed if problems
occur with the modelling or analysis of the example. An example follows:

Rebuilding a model

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as example

To recreate the model, select the file example_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Visual Basic Scripts

Each example has an associated set of LUSAS-created VBS files that are supplied on
the release Kkit. These are installed into the \<Lusas Installation
Folder>\Examples\Modeller directory. If results processing and not the actual
modelling of an example is only of interest to you the VVBS files provided will allow
you to quickly build a model for analysis. These scripts are also for use when it proves
impossible for you to correct any errors made prior to running an analysis of an
example. They allow you to re-create a model from scratch and run an analysis
successfully. For more details refer to Creating a Model From The Supplied VBS files.




Running LUSAS Modeller

Modelling Units

At the beginning of each example the modelling units used will be stated something like
this:

“Units used are N, m, kg, s, C throughout”

Model units are specified as part of the creation of a new model and are reported at all
times in the status bar at the bottom of the Modeller window. Once set, for all dialogs
with grid cells permitting dimensional input, the units expected are displayed as a
tooltip when the cursor is hovered over the input cell.

Timescale Units

Timescale units are specified as part of the creation of a new model and can be changed
on the Model Properties dialog. Choosing a timescale unit dictates how time-based
values are displayed on dialogs during modelling, and how they are output when
processing results

Ilcons Used

Throughout the examples, files, notes, tips and warnings icons may be found. They can
be seen in the left margin.

Files. The diskette icon is used to indicate files used or created in an example.

Note. A note is information relevant to the current topic that should be drawn to your
attention. Notes may cover useful additional information or bring out points requiring
additional care in their execution.

N [E

Tip. A tip is a useful point or technique that will help to make the software easier to
use.

Caution. A caution is used to alert you to something that could cause an inadvertent
error to be made, or a potential corruption of data, or perhaps give you results that you
would not otherwise expect. Cautions are rare, so take heed if they appear in the
example.

ed K

Running LUSAS Modeller

e Start LUSAS Modeller from the start programs menu. This differs according to the
operating system in use, but typically is done by selecting:

Start > All Programs > LUSAS 15.x for Windows > LUSAS Modeller

5
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e The on-line help system will be displayed showing the latest changes to the

software.

e Close the on-line Help system window.

(LUSAS Academic version only)

e Select your chosen LUSAS product and click

the OK button.

Academic Yersion
Mot for Commercial Use

Select Product

£+ LUSAS Analyst
" LUS4S Composite
 LUSAS Civil & Structural

" LUSAS Eridge

oK |

Creating a new model / Opening an existing model
Lushs Modellerstortp |

When running LUSAS for
the first time the LUSAS
Modeller Startup dialog will
be displayed.

This dialog allows either a
new model to be created, or
an existing model to be
opened.

Note. When an existing
model is loaded a check is
made by LUSAS to see if a
results file of the same name
exists. If so, you have the
option to load the results file
on top of the opened model.

]

&% Create new model

=

" Dpen existing file

tdare Files...

1 DeALUSAST44% . Sseamental_bridoe Bdive.mdl  Fesults
2 DeALUSAST44%, | Sseamental_bridae_correct. mdl

3 DoALUSAST 445 Projectsh. . heegmental_bridge.mdl

4 multiple_tapering_zections_full_assignment.md|

QK I Cancel

Note. When an existing model is loaded, that in a previous session caused a carsh to
occur in LUSAS Modeller, options are provided to help recover your model data.

6



Creating a Model from the Supplied VBS Files

If creating a new model the
NEW Model dlalog Wi” be ~File details

File: namne: I

displayed.
working Folder @ Default ¢ Current ¢ User-defined
e Enter information and s [ <sasisaipropcts ]
make selections for " Modsl detals
the new model and Tile I
click the OK button. Modelurits  [umiasc 7]

. ) Timescale units lm Job na. I
Product specific menu entries -
for the selected software | ‘e Pmewd Sl wemelem xS €
product in use e.g. Bridge or | e tenaee Iene ]

ClVlI W|“ be added tO the ’TI Cancel Help
LUSAS Modeller menu bar.

Creating a Model from the Supplied VBS Files

| File

New...

| File
Script >
Run Script...

If results processing and not the actual modelling of an example is only of interest, the
VBS files provided will allow you to quickly build a model for analysis.

Proceed as follows to create the model from the relevant VVBS file supplied:

Ql Start a new model file.
o Enter the file name as example name and click OK

o In general, ensure that the User interface selected is of the same type as the analysis
to be carried out.

&l Select the file example_name_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Note. VBS scripts that create models automatically perform a File > Save menu
command as the end.

Some additional modelling may need to be carried out prior to an analysis being run.
See individual examples for details.
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The LUSAS Modeller Interface

The principal regions and components of theModeller user interface are shown on the
following image and are described below.

- e - [R]-EE- b ka N

I8 %1

Text Output YWindow

I o [

[[cad—azs T remulex fals b7
dony

-

hrsannling rsmules

[Losdoase & resulis file |
e

|

Far ek, pemss P

Main Menu and Toolbars

The main menu and associated toolbars which contain toolbar buttons provide the
means to define model related geometry and other data. On initial start-up of

LUSAS Modeller the Main, Define and View Toolbars are displayed. All toolbars can
be shown, hidden, or customised, using the View> Toolbar menu item.

View window

A View Window is where each model is developed and manipulated. Any number of
view windows can be created with each displaying a unique view of a model. Pre-
defined view layers inside each window hold model information that can be generally
manipulated in the current view window as required.




The LUSAS Modeller Interface

Modelling in LUSAS

A LUSAS model is graphically represented by geometry features (points, lines,
surfaces, volumes) which are assigned attributes (mesh, geometric, material, support,
loading etc.). Geometry is defined using a whole range of tools under the Geometry
menu, or the buttons on the Toolbars. Attributes are defined from the Attributes menu.
Once defined attributes are listed in the Treeview.

Treeviews

Treeviews are used to organise various aspects of the model in graphical frames. There
are a number of Treeviews showing Groups , Attributes e-ob, Analyses @, Utilities

JB, and Reports .

O The Layers = Treeview controls the display of selective model data and
results data to a view window.

O The Groups L=l Treeview is used to store selected user-defined collections of
objects (geometry, nodes or elements) under a collective name.

O The Attributes &Treeview is where defined contains information relating to
the model; the element type and discretisation on the geometry; section
properties and thicknesses; the materials used; how the model is supported or
restrained; and how the model is loaded.

O The Analyses (X Treeview shows all analyses defined; loadcases defined
including analysis control loadcases defined during the modelling stage;
results loadcases containing solutions for results processing; loadcase
combinations and envelopes; and IMD and Fatigue calculations.

O The Utilities & Treeview contains utility items used in the definition of
model geometry or attributes, or to control an analysis, or to provide a
particular functionality, such as to define a load combination or produce a
report for example.

O The Reports = Treeview contains a user-defined folder structure of reports,
chapter and image entries to allow a report to be generated in a variety of
formats.

Treeviews use drag and drop functionality. For example, an attribute in the Attributes
& Treeview can be assigned to model geometry by dragging the attribute onto an
object (or objects) currently selected in the graphics window, or by copying and pasting
an attribute onto another valid Treeview item as for instance, a group name, as held in
the Groups L] Treeview.
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Text Output Window

The Text Output Window displays messages and warnings during a modelling session.
When an error message or warning relating to a particular object is written to the text
output window, extra information is usually available by double-clicking on that line of
text.

Browse Selection

This window is not displayed by default but can be viewed using the View> Browse
Selection menu item. Once visible it will contain a list of all currently selected items
which may then be individually deselected.

Browse Cyclable Items

This window is not displayed by default but can be viewed using the View> Browse
Cyclable Items menu item. Once visible it will contain a list of all cyclable items.
These may then be individually selected or deselected.

Browse Selection Memory

This window is not displayed by default but can be viewed using the View> Selection
Memory> Browse Memory Selection menu item. Once visible it will contain a list of
all items currently in Selection Memory which may then be individually deselected.

Status Bar

The Status Bar displays progress messages and help text during a modelling session, the
model units, the current cursor position in model units (if the model is displayed in an
orthogonal plane) and the item or number of items in the current selection. The View>
Status Bar menu item may be used to hide or show the Status Bar.

Data Tips and Tooltips

Data tips and tool tips provide basic information about whatever is under the cursor.
Datatips generally report information relating to the model geometry, attributes and
assignments etc. Tool tips report on uses of toolbar buttons or expected input for grid
cells etc.

Context Menus

Although commands can be accessed from the main menu, pressing the right-hand
mouse button with an object selected usually displays a context menu which provides
access to relevant operations. Treeview panels also have a context menu which provides
access to additional functionality such as editing of data, control of visibility,
visualisation of assignments, and selective control of results plotting on selected
attributes.

10



The LUSAS Modeller Interface

Properties

General information relating to a model is presented in property dialogs. Properties may
relate to the whole model or the current window, or a single geometric feature - in fact
most objects have properties. To view an object’s properties, select it, press the right
mouse button, then choose Properties from the context menu

Getting Help

LUSAS contains a comprehensive Help system. The Help consists of the following:

e The Help button El on the Main toolbar is used to get context-sensitive help on
the LUSAS interface. Click on the Help button, then click on any toolbar button or
menu entry (even when greyed out).

e Most dialogs include a Help button which provides information on that dialog.

e Selecting Help > Help Topics from the main menu provides access to all the Help
files.

Sho% | 1f the Help Contents, the Help Index and the Search facility are not shown

when a help page is first displayed pressing the Show button will show these tabs in the
HTML Help Window.

11
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Description

Linear Analysis of a
2D Frame

For software product(s):

LUSAS Civil & Structural LT and above, or
LUSAS Bridge LT and above

With product option(s):

None.

Description

A simple 2D frame is
to be analysed. The
geometry of the frame
is as shown.

All members are made
of mild steel with a
Young's modulus of
210E9 Pa, a Poisson's
Ratio of 0.3 and a mass
density of 7860 kg/m3.

The structure is

«—2.0—>

%Z'OHPZ'OAFZ'OH

*
1.0

1

-

777

subjected to two loadcases; the self-weight of the structure, and a sway load at the top

of the left-hand column.

The units of the analysis are N, m, kg, s, C throughout.

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading.
O An axial force diagram showing stresses in the members.

13
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Modelling

Linear Analysis of a 2D Frame

Keywords

2D, Frame, Beam, Standard Sections, Fleshing, Copy, Mirror, Deformed Mesh,
Axial Force Diagram, Shear Force Diagram, Bending Moment Diagram, Fibre
Results, Report, Printing Results.

Associated Files

0 frame_2d_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a New Model

e Enter the file name as

Frame 2D i~ File details
- File name I Frame_20

L] Use the Default working Folder ' Defaulk ¢ Current ' User-defined

working folder. Savein [[ctusasisoiprojacts ]
e Enter the title as | "™

. Title: I Simple 2D Frame
Simple 2D Frame
Model units IN,m,kg,ch - I

L] Set the mOdel Units to Timescale units ISacnnds vl Job na. I

be N'm'kg’s’c Analysis type IStructuraI VI wertical axis ~ © % (] &z
e Ensure the timescale | #atptenebts [een |

units are Seconds | e e

Ensure the analysis
type is Structural

Select the startup template 2D Beam. This populates the Attributes &b treeview
with useful basic line mesh and support entries.

14



| Geometry

Point >

| Coordinates...

| Geometry
Line >
Points...

| Geometry
Line
Points...

\Y

| Geometry
Line
Points...

\

Modelling

e Select the Vertical Y axis option.

e Click the OK button.

Note. Save the model regularly as the 2.Dragabox -7
example progresses. This allows a around these2 1'% 1
previously saved model to be re-loaded if a Points to create : :
mistake is made that cannot be corrected 2 avertical lineon | _
easily. I the centre line L _ _J
: of the Frame k
[

The Undo button g may also be used to
correct a mistake. The undo button allows
any number of actions since the last save to
be undone.

| 1. Drag a box
I around these 2
I'Points to create

i

|

|

|

|

|

|

|

|

| | the left hand
I I column
|

L

El Enter coordinates of (0, 0), (0, 3), (4,

3) and (4, 4) to define the main setting-out points for one-half of the portal frame. Use
the Tab key to move to the next entry field on the dialog. With all the coordinates
entered click the OK button.

Feature Geometry

Note. Sets of coordinates must be separated by commas or spaces unless the ‘Grid
Style” method is chosen. The Tab key is used to create new entry fields. The Arrow
keys are used to move between entries.

e Select the Points on the left-hand side of the model.

il Connect the selected Points with a Line representing the left-hand column of the
portal frame.

e  Select the pairs of Points on the right hand side of the model.

il Connect the selected Points with a Line representing the right-hand vertical
member on the frame centreline.

e Create the horizontal member by selecting the appropriate Points and define a Line
in a similar manner.

e  Select the Points at the top of the left hand column and the apex of the roof. (Hold
down the Shift key to add the second Point to the initial selection).

il Connect the selected Points with a Line representing the sloping member of the
frame.

15



| Geometry
Line >
| By Splitting >
In Equal
Divisions...
| Geometry
[ Line >
Points...

Linear Analysis of a 2D Frame

To create the vertical roof member at quarter span the 2 Lines shown are split into equal
divisions to create the points required and the new line is then defined.

Select the lower line (first) and the
upper line (second) of those shown
(Hold down the Shift key to add the
second Line to the initial selection).

Enter the number of divisions for
both Lines as 2

Ensure that Delete original lines
after splitting is set so that the
original Lines are deleted and click
the OK button.

Drag a box around the 2 Points just
created.

il Create the Line representing the
internal member.

This completes the geometry definition for the half-frame.

Select these 2

Lines to be split ™~

Drag a box
around these 2
Points

Model attributes now need to be defined and assigned to the model.

16



| Attributes

Mesh
Line...

Modelling

Note. LUSAS Modeller works on a define and
assign basis where attributes are first defined,
then assigned to features of the model. This can
be done either in a step-by-step fashion for each
attribute or by defining all attributes first and
then assigning all in turn to the model.

O Attributes, once defined, are displayed in
the &b Treeview. Unassigned attributes
appear ‘greyed-out’.

O Attributes are then assigned to features by
dragging an attribute dataset from the &

Treeview onto previously selected
features.

Tip. Useful commands relating to the
manipulation of attributes can be accessed by
selecting an attribute in the & Treeview, then
clicking the right-hand mouse button to display a
shortcut menu.

Meshing

F IE & |® & |

=3 frame_2d.mdl

B3 Attributes [22]
B2 Mesh [9]
B3 Line [9]
----- 1:Divisionz=1
----- 2:Divisionz=2
----- FDivisionz=2
----- 4:Divizionz=4
----- B:Divizionz=H
----- E:Divizionz=6
----- T:Divizionz=7
----- A:Divizionz=8
----- & 9:Thick Beam
=23 Geometric (1]
=23 Surface [1]

- 1:Unit Thickne
B3 Material [1]
=23 lsotropic (1]

LB 1Ml Steel Ur
23 Suppartz [11)

- 1:Pinned

- 2:Fully Fixed

s

The Line features are to be meshed using two-dimensional beam elements. A 2D thick
beam element is automatically provided in the &b Treeview but to show the process

involved another will be defined:

e Select Thick beam, 2 dimensional, Linear elements.

e Set the number of divisions to be 1

e Enter the attribute name as Thick Beam then click OK

e  Select the whole model. (Ctrl and A keys together).

e Drag and drop the mesh attribute Thick Beam from the & Treeview onto the

selected model Lines.

Note. When an assignment is made confirmation of the assignment is written to the

Text Output Window.
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Linear Analysis of a 2D Frame

Material Properties

| Attributes e Select material Mild Steel from
% the drop-down list, leave the | atsil [iigsis =
[ Material Library... grade set as Ungraded and click o
OK to add the material attribute f2de | Ungraded I
to the & Treeview.
. —Propertties
e With the whole model selected
(Ctrl and A keys together) drag [ oMo [ 20000e3
and drop the material attribute Poissan's ratio (EED
Isol (Mild Steel Ungraded) Dent
) y w
from the & Treeview onto the
Selected features. Coefficent of thermal expansion I 0.011E-3
0K Cancel Apply | Help |

Geometric Properties
| Attributes

Geometric > The standard sections dialog will appear.
| Section Library ...

e Inthe Usage section select 2D Thick Beam

e Select the library of UK Sections
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Modelling

o Select section type Geometric Line
Universal Beams
(BS4)

. {l— ksectons =]
e Select section name — |[ovesasemsesy =

127x76x13kg UB. m

e Enter the Attribute S
name as stanchion.

e Click the Apply
button to add the
Universal Beam
attribute to the &
Treeview.

e Change the library to
EU Sections

e Change the section
type to Equal Angles
and select  the
70x70x6 EA section
name.

e Enter the Attribute
name as roof
member

e Click the OK button
to add the Equal

Angle attribute to the & Treeview.

Note. The orientation of the section is appended to the section name which is un-
editable. Attribute names (used for identification purposes) can be appended to the
section name to make selection of similarly sized members easier.
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Linear Analysis of a 2D Frame

Assigning Geometric Properties

e Drag a box around the Lines
representing the roof members.

e Drag and drop the geometry
attribute 70x70x6 EA major y @ s

- - - - - - _____
roof member from the & ‘k
Treeview onto the selected Lines.

Drag a box around these members

e Select the Line representing the
left-hand vertical member.

e Drag and drop the geometry <:| Select this Line
attribute 127x76x13kg UB major &

y stanchion from the &b Treeview
onto the selected Line.

—foefe

Geometric assignments are visualised by default.

e Click in a blank part of the Graphics Window to
deselect the members.

@l Select the isometric button to see the geometric
visualisation on the members.

El The Zoom in button can be used to check the
orientations.

@l Select the Home button to return the model to the
default view.

ﬂ Select the fleshing on/off button to turn-off the -
geometric visualisation.

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. The structure will be supported at the end of the stanchion which is in
contact with the ground with a fully fixed support condition.

Assigning the Supports

e Select the Point at the bottom of the left-hand vertical member.
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Line
Copy...

Modelling

e Drag and drop the support attribute Fully Fixed from the & Treeview onto the
selected feature.

e  Ensure the Assign to points and All loadcases options are selected and click OK

Mirroring the Model

One half of the 2D frame has now been generated. This half can now be copied about a
mirror plane to create the complete frame.

e  Select the whole model (Ctrl and A keys together).
M Select Mirror, select Parallel to Y axis and enter 4 in X, and O in Z in the top
cellsand 4 in X, and 3 in Z in the lower cells to define the mirror plane.

e Click the OK
button to create
the full model.

Note. Features that o . *
are copied retain
their attributes. This
means that there is
no need to define the
mesh, material or 4
geometric properties 1. i
for the newly created
Lines as they will
already have the
attributes from the
original half of the model assigned.

Note. In mirroring the features the Line directions will have been reversed. The
orientation of Lines is important as it controls the local beam axes directions which will
define the sign convention used to present the results.

e In the Layers Treeview double-click on Geometry to display the geometry
layer properties. Select the Line directions option and click OK

The Lines orientations are shown.
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| Geometry
|Line >
| Reverse

| Attributes
| Loading...

| Attributes
| Loading...

Linear Analysis of a 2D Frame

Select the 4 Lines to
be reversed. (Hold
down the Shift key to
add lines to the initial
selection).

The selected Line ]
directions will be 4 These Line
reversed. directions need

reversing

Once the Line &

directions are

corrected, de-select the Line directions option in the geometry layer properties and
click the OK button.

Loading

Two loadcases will be considered; self weight, and a concentrated sway load acting at
the top of the left-hand vertical member.

Loadcase 1 - Self Weight

Loadcase 1 will represent the self-weight of the structure. This is modelled using a
constant body force which is an acceleration loading simulating the force of gravity
acting upon the structure.

Select the Body Force option and click Next
Enter a linear acceleration in the Y direction of -9.81

Enter the attribute name as Self Weight and click Finish to add the attribute to the
& Treeview.

Select the whole model (Ctrl and A keys together) and drag and drop the loading
attribute Self Weight from the & Treeview onto the selected features.

Ensure that the Assign to lines and Single loadcase options are selected and the
loading is applied to Analysis 1 and Loadcase 1. Click the OK button and the
loading on the frame will be displayed.

Loadcase 2 - Sway Load

Loadcase 2 is a sway load acting at the top of the left-hand vertical member.

Ensure the Concentrated option is selected and click Next

Enter a concentrated load in the X direction of 500
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| File

Save

Running the Analysis

e Enter the attribute name as Sway Load and click Finish

e Select the Point at the
top of the left-hand

column. _/I’//T\T\

e Drag and drop the
loading attribute Sway [s
Load from the & Select this Point to assign
Treeview onto  the the concentrated load
selected Point.

e Ensure the Assign to
points and  Single
loadcase options are
selected, and that the selected analysis is Analysis 1. Change the loadcase name to
Loadcase 2.

e Click the OK button to assign the loading as the active loadcase with a factor of 1

Saving the Model.
El Save the model file.

Running the Analysis

&

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and click the OK
button to perform the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (& Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

0 frame_2d.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Linear Analysis of a 2D Frame

O frame_2d.mys this is the LUSAS results file which is loaded automatically
into the = Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O frame_2d_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as frame_2D

e To recreate the model, select the file frame_2d_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Selecting the Results to be Viewed

Analysis loadcase results are present in the () Treeview. The loadcase results for the
first results loadcase (Loadcase 1) is set active by default. This is signified by the active

results bitmap & in the {2 Treeview.

Deformed Mesh Plot

A deformed mesh plot is normally displayed initially to highlight any obvious errors
with an analysis before progressing to more detailed results processing. The deformed
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Viewing the Results

shape will usually show up errors in loading or supports and may also indicate incorrect
material property assignments (e.g. where the results show excessive displacements).

For clarity, the geometry will be removed from the display to leave only the
undeformed mesh displayed.

e Inthe [=" Treeview turn off the display of the Geometry and Attributes layers by
right-clicking on each layer name and selecting the On/Off menu item.

e With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Deformed mesh option. This will add the
deformed mesh layer to the Treeview. Accept the default properties by
selecting OK

Note. By default the maximum displacement is scaled to the magnitude defined on the
deformed mesh dialog so the deformed shape can be easily visualised. The exaggeration
factor used to multiply the displacements is displayed on the deformed mesh properties
dialog and can be defined if required.

The deformed mesh plot
for loadcase 1 (the default
active loadcase) will be
displayed on top of the
mesh layer.

e Turn off the Mesh
layer from the
Treeview to leave
only the deformed
mesh displayed as
shown.
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| Analyses

Basic Combination

N S

Linear Analysis of a 2D Frame

Defining a Combination

Combinations can be created to view the combined effects of multiple loadcases on the
structure.

The combination properties dialog will appear.

Basic Combination
Available Induded Load factor I 1.0 Grid... |
File Imodel j I File 1: 1: Loadcase 1

L7 File 1: 2: Loadcase 2
MName Type | Res file |
Q IiLoadcase 1 0
Q 2iloadcase 2 0

dl | 0

Mame I Combination 1

TyEeE INone j

Close ance] | gl Help

e Ensure Analysis 1 is selected from the drop down list.

Both results loadcases should be included in the combination panel.

e Select Loadcase 1, hold the shift key down and select Loadcase 2. Click the LI
button to add the loadcases to the load combination.

e Click the OK button to finish.

Note. The load factor may be modified by selecting the included loadcase in the right
hand list and updating the factor or by updating the factor in the grid, which is
displayed by selecting the Grid button.

Note. To obtain the correct effect from the combined loads in this example, the
Combination should only include one occurrence of each loadcase.
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Viewing the Results

Viewing a Combination

o Inthe = Treeview right-click on Post Processing > Combination 1 and select the
Set Active option.

The deformed mesh plot will show the effect of the combined loading on the structure.

Marking Peak Values

e With no features selected click the right-hand mouse button in a blank part of the

Graphics window and select the Values option to add the values layer to the
Treeview.

The values layer properties will be displayed.

e Select Displacement results from the Entity drop down list and select the resultant
displacement RSLT from the Component drop down list.

e From the Values Display tab set 100% of Maxima values to be displayed.

e Set the number of
significant figures to
4

e Click the OK button
to display the
deformed mesh plot

showing the
displacement at each o X 0.0
node.

Note. Because this example is written for LUSAS LT versions that only allow one
model or results viewing window to be used the Values layer is best turned off prior to
adding further layers. In Standard and Plus versions of LUSAS multiple windows each
having different layers can be defined.

e Turn off the Values layer in the = Treeview.

Axial Force Diagram

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select Diagrams to add the diagrams layer to the
Treeview.

The diagram properties will be displayed.

e Select Force/Moment — Thick 2D Beam results of axial force Fx in the members
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Linear Analysis of a 2D Frame

e Select the Diagram Display tab and select the Label values button.
e Select the Label only if selected option.

e  Change the number of significant figures to 4

e Click the OK button to finish.

The order of the layers in the Treeview governs the order that the layers are
displayed. To see the deformed mesh on top of the diagram plot the deformed mesh
layer needs to be moved down the Treeview to a position after the diagram layer.

e Inthe Treeview select the Deformed Mesh layer, click the right-hand mouse
button and select the Move Down option.

e Now add labels

to the columns

(vertical
members). Select f
the left hand
column, hold the
Shift key and
select the right

hand column.

An axial force diagram for each member will be displayed with values of Fx displayed
on the selected columns.

Shear Force Diagram

e In the Treeview
double-click on the
Diagrams layer. The
diagram properties will
be displayed.

e Select Force/Moment —
Thick 2D Beam results
of shear force Fy in the
members.

e Click the OK button to display a shear force diagram of stresses in each member
with labels on the selected vertical members.
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Viewing the Results

Bending Moment Diagram

e Inthe Treeview double-click on the Diagrams layer. The diagram properties
will be displayed.

e Select
Force/Moment —
Thick 2D Beam
results of bending
moments in  the
members Mz

e Click the OK button
to display a bending
moment diagram for
each member with labels on the selected vertical members.

Viewing Results on Fleshed Members

As an alternative to plotting diagram results stresses in beams can be plotted on fleshed
members.

e Turn off the Diagrams layer in the [’=¥ Treeview.

e Click in a blank part of the Graphics Window to deselect the members.

El Select the isometric button.

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select Contours to add the contours layer to the it
Treeview.

The contour properties will be displayed.

e Select Stress — Thick 2D Beam results of axial and moment results in the members
Sx(Fx Mz)

Initially contours will be drawn at the current active fibre location on both stanchions as
seen on the left-hand image below. Fibre locations will be explained shortly.
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Linear Analysis of a 2D Frame

r<x

I

ll Select the fleshing on/off button to visualise the stress results on the fleshed cross-
section as seen on the right-hand image above.

Viewing Force/Moment Results at Fibre Locations

As an alternative to plotting force and moment diagrams along nodal lines they can be
also plotted at pre-defined fibre locations on members and be superimposed on other
results plots. Standard steel sections have various extreme fibre locations pre-defined.
These fibre locations can be seen by expanding the Geometric Line entry in the in the

& Treeview and can be visualised by double-clicking the Geometric Line attribute
name and selecting the Visualise button.

Diagram Stress Results at Fibre Locations

e With no features selected right-click in a blank part of the graphics window and
select Diagrams to add the diagrams layer to the =" Treeview.

The diagram properties will be displayed.
e  Select Stress - Thick 2D Beam results of stress Sx(Fx, Mz) in the beam.

e Select the Diagram Display tab and select the Label values button. Change the
angle of the text to -45 and set the number of significant figures to 4.

e Select the Scale tab and set a local scale of magnitude 12mm.

e Click OK to display the stress diagram at Fibre location I1.
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| File

Save

| utilities

Report...

Viewing the Results

vf» X ¥ “‘J

Save the Model
El Save the model file.

Note. When the model file is saved after viewing results, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

Creating a Report

Selective model and results details can be printed to a variety of output formats by
using the LUSAS report facility. Reports can include screen captures and imported
images or additional text. A report template is used to specify items to be included in a

report. This template is saved in the 2= Treeview when a model is saved. A model can
have any number of report templates.

e On the Report dialog enter a report title of 2D Frame

e Leave the modelling units and the number of significant figures set to default
values.

e Enter a report name of Report 1 and click OK.
A report entry will be created in the =l Treeview.

e Inthe = Treeview right-click on Report 1 and select Add Chapter
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Linear Analysis of a 2D Frame

e With the Model properties tab selected select the All checkbox.
e Select the Loadcase/Basic combination results tab and click the Add button

e On the Results Entity dialog select Displacement from the entity pull-down menu
and click OK

e Select the Add button again, select Force/Moment — Thick 2D Beam from the
pull-down menu and click OK

e  Select the User content tab and select the Capture button, and save the current
screen image as a JPG file of the name frame_2d.jpg

e Click OK to finish

Note. The default order of the report items in the Treeview (and hence the order of
any items on any exported report) can be changed by dragging and dropping the report
sections as required. Right-clicking on an item gives access to additional options, such
as modifying existing data or adding more chapters.

Viewing and Exporting a Report

e Inthe & Treeview right-click on Report 1 and select View Report

After a short pause whilst the report is created, the first page of the report will be
displayed. The contents of the report may be browsed using the ‘page forward’ and
‘page backward’ buttons at the top of the dialog.

ﬁl Select the Export Report button.

e  On the Export dialog and from the Format: drop-down menu select Adobe
Acrobat (PDF)

e From the Destination: drop-down menu select Application to open the file with
Adobe Acrobat and click OK

e On the Export Options dialog select a page range of All and click OK

This completes the example.
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Description

Importing DXF Data

For software product(s): | All (except LT versions)
With product option(s): None.
Note: This example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example shows the steps involved in importing DXF drawing data for use in
LUSAS.

SR
B NN
——i

T T O T Features imported

[ l from DXF file

The initial geometry shown is equivalent to that imported from a typical CAD general
arrangement drawing.

Modelling Objectives

The operations in the creation of the model are as follows:

O Import initial Point and Line feature information from CAD drawing.
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Modelling

Importing DXF Data

U Rationalise drawing to delete unwanted information.
O Re-scale imported features to establish analysis units of length (m).

Associated Files

O slab.dxf contains the drawing information available in DXF format.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as dxf_slab

e Use the default working folder.

e Enter the title as Imported DXF file of slab
e Set model units of kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Set the Startup template as None

e Ensure a vertical Z axis is set and click OK.

Note. It is useful to save the model regularly as the example progresses. This allows a
previously saved model to be re-loaded if a mistake is made that cannot be corrected
easily by a new user.
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| Import...

Modelling

Importing DXF Model Data

With DXF data there may be situations where the DXF drawing units need to be
converted from scaled ‘paper’ dimensions into full size model dimensions as with this
example where modelling units of metres are required. This conversion of units can be
done in two ways:

1. By setting a pre-translation scale before importing the data
2. By transforming the data using a scale factor after importing the data

In both cases unless the paper dimensions are already known some measurement of data
will be involved in LUSAS prior to either re-importing or scaling the data. By using the
Advanced import options entities can be selected for inclusion/exclusion from import
and LUSAS modelling-related features can be automatically tidied or merged together.
This example covers the use of scaling the data after import. Notes describing the use of
a pre-translation scale are at the end of the example.

Importing the DXF Data for Scaling

Select the DXF file slab.dxf from the \<Lusas Installation
Folder>\Examples\Modeller directory and click the Import button.

Feature Geometry

=\
RRINANY
St

ENNAY
PRGN NN

\ |
| |
: : Delete these Features
N .Y
ool A

The DXF features are imported in scaled units defined by the drawing scale. These
features will need to be scaled to suit the units of the analysis. Only the features
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Importing DXF Data

| Edit
Delete
| Geometry
| Paint >
Distance between
points

defining the plan view are to be used in creating the analysis model. All other features
can be deleted.

e Drag a box around the Point and Line features on the other views of the bridge. Use
the Shift key to add additional features to the initial selection.

E Delete the selected features, confirming that the Lines and Points are to be deleted.

The remaining features will form the basis of the slab definition, but some further
manipulation is required before a finite element model can be created.

Converting Units

The imported DXF drawing units are millimetres plotted at 1:100 scale, so these will
need to be scaled by 100 to get the actual full-size dimensions of the slab in millimetres.
These dimensions in millimetres will then need to be scaled by 0.001 to convert them
into metres. To save scaling the data twice, one scale factor of (100x0.001)=0.1 can be
used to convert the feature data into metres. Before scaling the model data it is worth
checking the dimensions of the slab.

To check the existing model dimensions, 2 sample Points on the centre line of the mid-
span support can be selected in turn and their coordinates obtained. If necessary zoom
in on the model to make Point selection easier.

El Use the Zoom in button to " _,$<<<\ f—'

enlarge the view to include both
. Select this Point
ends of the centreline. \\

h . %% - .
_| Return to normal cursor \
selection mode. "

Select this Point \_\. \\\
e Select the Point on the left-hand & ™ e
edge of the slab deck as shown ’ I
in the diagram W

e With the Shift key held down,
select the Point shown on the right-hand edge of the deck.

A value between the Points selected of 202.075 will be displayed in the message
window.

o
il Resize the model to fit the graphics window.
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Point >
Move...
| Geometry
|Point >
Distance between
points
| File
Save

Modelling

Scaling the model units

e Drag a box around the slab to select all the features. (Or press the Ctrl and A keys

together).

ﬂ Select the Scale option and enter a Scale factor of 0.1 in the X, Y and Z fields.
Leave the origin set as 0,0,0 and click OK

The slab dimensions will be scaled accordingly.

To check the new model dimensions, The same sample Points on the centre line of the
mid-span support are to be selected and their new coordinates obtained.

El Use the Zoom in

button to enlarge the
view to include both
ends of the centreline
as before.

il Return to normal

cursor selection mode.

e Select the Point on
the left-hand edge
of the slab deck as
shown in the
diagram

Select this Point

Select this Point
— =

e With the Shift key held down, select the Point shown on the right-hand edge of the

deck.

A value between the Points selected of 20.2075 will be displayed in the message

window.

>
il Resize the model to fit the graphics window.

Save the model

El Save the model.
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Importing DXF Data

[Import...

This completes the conversion and preparation of the DXF data model for use in
LUSAS. From the imported data, Surfaces would be defined, a mesh assigned to the
model, and geometric properties, supports and loading added.

This completes the example.

Notes on importing the DXF data using a pre-translation
scale

As an alternative to scaling data a pre-translation scale could be used. After importing
the DXF data and checking the model dimensions in LUSAS as previously described (if
required) the DXF file can be re-imported using a pre-translation scale to convert it into
the correct dimensions for use.

Select the DXF file slab.dxf from the \<Lusas Installation
Folder>\Examples\Modeller directory and click the Import button.

e Click the Advanced button
e On the Import Parameters dialog enter a pre-translation scale of 0.1
e Click the OK button

e Select Import
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Description

A

Description

Arbitrary Section
Property
Calculation and Use

For software product(s): | All (except LT versions)

With product option(s): | None.

The section properties of an
arbitrary shaped box section are | |
to be computed and saved in a
user library. Section geometry is
supplied as a DXF file.

Units of N, mm, t, s, C are used.

Objectives
The required output from the
analysis consists of:
U Section Properties of a
box section
Keywords

Section Properties, Arbitrary Section, Holes, Local Library, Server Library

Associated Files

U box_section.dxf DXEF file containing geometry of section.
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Modelling

Arbitrary Section Property Calculation and Use

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File>
New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

o Enter the file name as box_section

e Use the Default working folder.

e Enter the title as Box Section

e Set model units of N,mm,t,s,C

e Leave the Timescale units as Seconds

e Ensure an Analysis type of Structural is set.
e Set the Startup template as None

e Ensure the vertical axis is setto Z

e Click the OK button.

Discussion

The arbitrary section property calculator within LUSAS Modeller computes the section
properties of any open or closed section. Cross-sections are created either as a single
regular or irregular surface, or as a group of surfaces (including holes). Fibre definitions
(positions on the cross-section at which stresses or values can be plotted when viewing
results) are also created for each drawn section at the time of section property
calculation.

Note. 2D cross-sections for section property calculation must be defined in the XY
plane.
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| File
[Import...

| Geometry

Surface >

[Lines...

| Geometry
Surface >
Lines...

Modelling

Feature Geometry

Set the Files of type drop-down menu to DXF Files (*.dxf)

Locate the  box_ section.dxf file in the \<Lusas Installation
Folder>\Examples\Modeller directory and click the Import button to read in the
DXF file and create the cross section geometry as shown below.

Defining holes within a section

This is done by first defining a
surface that represents the total
extent of the box-section, then
defining a surface that represents
the void or hole, and then selecting
both the surrounding and inner
surface to create the hole in the
bounding surface.

e Drag a box around the
whole model

J Create an outer Surface from the selected Lines.

J Create an inner Surface from the
selected Lines.

e Now, drag a box around the . — . .
only the lines defining the void. l [

X

Box select the lines defining the void
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| Geometry

Arbitrary Section Property Calculation and Use

| Surface
|Holes
|Create

| File

|Save...

e Select the outer Surface of the box-

section followed by the inner I 1
Surface representing the void. (Use
the Shift key to pick the inner 1
Surface to add it to the initial k
selection) 2
Select these two surfaces
e On the Create Holes dialog, select the [efiEitiEs

option Delete geometry defining holes. [ Delete geometry defining holes

A new singular Surface will be created, ’—|
QK

. - Cancel Hel
containing a void ance | =p |

El Save the cross-section model for any future modifications or for use with the
definition of any additional fibre locations.

The section properties can now be calculated as follows:
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| utilities

Calculator

Section Property

>

Arbitrary

Section...

Modelling

Calculating Section Properties

Select the Add to local library option.

Click the Apply button, and after a short wait the calculated section properties will
be displayed in the grid at the top of the dialog.

Arbitrary Section Property Calculator E3

—Calculated Properties
Area A 1.05398E6
Second moment of area about x ads box 327 937E9
Second moment of area about v ads hyy 389.956E9
Product moment of area bey -151.781E6
Torsional constant J 274 636E9
Effective shear area in x direction Asx 469.548E3
Effective shear area in y direction Asy 4595.225E3
Radius of gyration about x axis n 47 508
Radius of gyration about y axis y h57.04
Shear centre, distance from centroid along x axis X0 0.906498
Shear centre, distance from centroid along y axis ¥y -399.084
Warping torsional constant Cw 45.0883E15
Plastic neutral &ds, distance from centroid along x ds xp -0.0618874
Plastic neutral axs, distance from centroid along y ds ¥p 21172
Plastic section modulus about x axis Zp 523.264E6
Plastic section modulus about v axis Zpy 577 TT8EG
Plastic torsional section modulus Zpt 382 37E6
Angle to principal axds (anticlockwise +ve) Theta 00

¥ Annotate properties W Automatic meshing
¥ Recompute section properties W Add to local library

Maximum elements/line 15 ﬂ

[~ Add to server library

Mame box_section

Cancel [[ Apply | Help

Click Cancel to close the dialog.

Note. There is no need to compute the section properties in the units they are to be
used in the analysis model because units conversion is carried out when the section
properties are extracted from the section library if it is found to be required.

Note. Section properties may be added to local (user) or server (all users) section
property libraries by selecting the appropriate option(s) prior to selecting the Apply
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| File
New...
| Attributes
| Geometric >
| Section library...

Arbitrary Section Property Calculation and Use

button. Alternatively you can deselect the ‘Recompute section properties’ option after
selecting the ‘Add local library’ or ‘Add server library’ options. By default the model
name is entered as the Section Name. This can be modified if required.

Notes on the automatic meshing used

The mesh used to compute the
properties of each of the surfaces
(and the holes) is displayed in the
graphics window.

By default an element size is selected
which will assign 15 elements to the
longest side and a minimum of 2
elements is applied to the shorter
sides. This mesh may be adjusted by
deselecting the automatic mesh
check box and changing the mesh
size in the &b Treeview. Alternatively, the maximum element on the longest side may
be adjusted by changing the ‘Max elements/line’ option as required prior to selecting
the Apply button. As with all finite element models the more elements used the more
accurate the results but the slower the calculation. A good compromise of 2 elements
across all thin sections has been found to provide reasonable results without using
excessive computation time.

A
EOOOTEN)

Viewing and using sections in the user library

Ql Create a new model called Test and select units of N,mm,t,s,C from the drop
down list provided. Click OK.

e Select User Sections from the top-right drop-down on the dialog
¢ Browse for, and select the box_section name. The basic section will be visualised.

e Select the Visualise button and the fibre definitions will be seen. Click Close
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Modelling

Visualise Cross Section

Usag :
(| 30 Thick Beam =] | |[user Sections =l ]
Definitian Local d o
B
% From Library ~
Rotation about centaid [0 = ]
" Enter Properties ]
o
<
K Fibre AZ = Fibre A%
B
y 1
o
Value UD!
Cross sectional area (4) 1.09395E6 -
Second momert of area about ¥ axs (yy) 327 937E8 : Fibre A1 Fibre &4
Second momert of area shoul z s (122) 389 956E9 ]
Froduct momert of area tyz) -151.781E5 ]
Torsion constant (k) 306.737E8 ﬂ
Effective shear areain y direction (Asy) 6692853 o
Effective shear area i z direction (Asz) 563 507E3 ]
[Oifsetin y direction (Ry) 00 ]
[Oifsetin z direction (Rz) 00 ]
o
Viuglse.. | Tapeing > Fisssenion, | Plastc propsities i
o
Z 2.0EZ 1.0ES . 1] . -1.0E3. . -2.0E3.
Attribut -]
e I =l =] = Create anhotation
0K | Cancel | Apok | Hep |

Visualisation of local library item

Visualisation of fibre locations

Fibre locations can be used to calculate beam stress results for plotting force and
moment diagrams. LUSAS automatically creates one for every extreme point on a

section.

e On the Geometric Line dialog, select
the Enter Properties option then
press the Section Details button.

e Select the Fibre locations tab.

e Additional fibre locations can be
added manually to the library item by
clicking in the Fibre locations area
and pressing the TAB key until a new
line is created, and then entering the
coordinate of the fibre location
required.

e Press OK to save changes and return
to the Geometric Line dialog.

Beam Cross Section

Fibre locations for post-processing

Fibre name Local zy coordinates
1 A1 (-BE0.795, 454.75)
2 A2 (¥09.202, 1 180338E3)
3 AT (709.202, -1.17962E3)
4 Ad (-960.795, -485.255)

= umben of intearation peifts fon the curent sectier;

% Defaul
U ppenand|awer sides |2 33

=) Bpecify
LLeft ard gkt sites |2 E

Quadrilateral cross section properties
Lowver Left Corner
Upper Left Corner
pper Right Corner
Lowet Right Corner

= ofE

Local zy coordinates

(281615, 453 354)
(-3.76358, 620.755)

Hew | Inselll De\elel Yisualise. I

[ ox |

Cancel | Help |
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Arbitrary Section Property Calculation and Use

Tip. If additional fibre locations are required on the section use Modeller to obtain the

properties of any additional points on the saved model and enter the point coordinates
in the manner described above.

Finally, to add the local library section to the Attributes Treeview (for subsequent
assignment to beams in the model) press the OK button.

This completes the example.
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Description

Simple Building Slab
Design

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | None.

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a T
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m

. 2
displacement checks need to be | gomee o Nmm

carried out separately. The geometry Columns
of the slab is as shown. e
I
The slab is subjected to self-weight Panel C Panel D
and a live load.
i i 2 < \ Line 6m
The units of the analysis are N, m, Supports

kg, s, C throughout.

e

6m

Objective L]
\
\

U To produce areas of
reinforcement under ultimate
loads and check crack widths under service loads

[ ] [] —
|
\

Keywords

Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel Area, Load
Combinations, Smart Combinations, Cracking
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Simple Building Slab Design

Associated Files

- U slab_design_modelling.vbs carries out the modelling of this example.
&

Modelling

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Note. This example is written assuming a new LUSAS Modeller session has been

Creating a new model

o Enter the file name as Slab_Design

e Use the Default working folder.

o Enter the title as Slab Design Example

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Startup template Standard from those available in the drop-down list.

e Ensure the Z vertical axis is selected and click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
/ correct any mistakes made since the last save was done.
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Modelling

Feature Geometry

G .
| fs"u”;ZCZ > _I Enter coordinates of (0, 0), (6, 0), (6, 6) and (0, 6)
Coordinates... to define the lower left-hand area of slab. Use the Tab
key to move to the next entry field. With all the
coordinates entered click the OK button to create a
surface.
Fiiy
e  Select the newly created Surface.
|G§’$fi’e’ S M Copy the selected surface with an X translation
[Copy... of 6. Click the OK button to create the new Surface.
e Use Ctrl + A keys together to select the whole
model.
|G|eso$fztcz 3 M Copy the selected surfaces with a Y translation of
Copy... 6. Click the OK button to define two new Surfaces.
o
Defining a Hole in a Slab i
Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.
G .
[Geomety ~ 5] Enter coordinates of 2, 2), (4, 2), (4, 4) and (2,
Coordinates... 4) and click OK to define the extent of the hole.
e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)
| Geometry e Ensure Delete geometry defining holes is
SUI:falce > selected A new singular Surface will be created. A
oles >
(Ceate  This new surface containing the hole can be seen / =

checked by clicking in a blank part of the Graphics Window and then re-selecting the
lower-left hand surface.
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| File

Model Properties...

| Attributes

Mesh >
Surface...

| Attributes

Geometric >
Surface...

Simple Building Slab Design

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. If you are using the Teaching
and Training version this default value should be left unaltered to create a surface
element mesh within the limit available. This will give a coarser mesh and
correspondingly less accurate results will be obtained. Otherwise, for this example, and
to give greater accuracy, 8 divisions per line will be used.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions
to be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drop

the mesh attribute Thick Plate from the &
Treeview onto the selected Surfaces =

In the vicinity of the lift core less elements are
required.

e Select the 4 lines defining the lift core and drag
and drop the line mesh attribute Divisions=4

from the & Treeview onto the selected Lines. 1

In this manner the mesh density on slabs can be o
varied according to the levels of detail required.

Geometric Properties

e Enter a thickness of 0.2. Enter the attribute name as Thickness 200mm and click
the OK button.

e With the whole model selected drag and drop the geometric attribute Thickness
200mm from the & Treeview onto the selected Surfaces.

Geometric properties are visualised by default.
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Modelling

e Inthe = Treeview drag and re-order the layers so that the Attributes layer is at the
top, the Mesh layer is in the middle, and the Geometry layer is at the bottom.

!l Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

| Attributes e Select material Concrete EU from the from drop-down list, select grade EN1992-

|% 1-1 Table 3.1 fck=40MPa and click OK to add the material attribute to the &%
e Y- Treeview.

e Select the whole model and drag and drop the material attribute 1sol (EN1992-1-1
Table 3.1 fck=40MPa) from the &b Treeview onto the selected Surfaces.

Supports

For clarity the mesh layer is not shown on these

diagrams. Select these
Points and

i ign Fixed in Z
o Select the 6 points where the columns are |*9" "

located. // N\ W

e Assign the supports by dragging and dropping

the support attribute Fixed in Z from the
Treeview and assign to All analysis loadcases g %
1

by clicking the OK button.

e Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in H
Z from the &b Treeview and assign to All Select these 2
analysis loadcases by clicking the OK button. Lines andassign

e Select only the top, bottom, and left-hand lines
defining the lift shaft and drag and drop the . Select these 3
support attribute Fixed in Z from the & %} Lines and assign
Treeview and assign to All loadcases by clicking : Fedinz
the OK button.

¥
kil
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| Attributes

Loading...

| Attributes

Loading...

Simple Building Slab Design

@l Select the isometric view i
button to check that all supports '
have been assigned correctly.

£ Wi Click this part of the

status bar to view the model from
the Z direction again.

Loading

Now the dead and live loading needs to be "
assigned to each slab panel of the building. This
is done using separate load cases so that the
loadcases can be combined to determine the
most adverse effects.

Select Body Force and click Next.

Enter an acceleration of -9.81 in the Z direction.

Enter an attribute name of Self Weight and click the Finish button.
Select the Global Distributed radio button.

Select the per unit Area option.

Enter -5000 in the Z Direction.

Enter the attribute name as Imposed Load 5kN/m2 and click the Finish button.

Firstly, right click on Analysis 1 > %
Loadcase 1 in the (X! Treeview, select the
Rename option and change the first
loadcase name to Panel A Permanent

Select the surface representing the top left-
hand panel (Panel A). =

Assign the dead loading by dragging and dropping the attribute Self Weight from
the &b Treeview onto the selection. The loading assignment dialog will be
displayed. Select the Single Loadcase option, the analysis Analysis 1 and loadcase
Panel A Permanent, then click the OK button.
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Modelling

Note. The loading assigned to each panel will be visualised as each loadcase is
assigned to the model

The (& Treeview should now contain 8 !
loadcases consisting of a Permanent and
Variable loadcase for each panel.

Drag and drop the dataset Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel A Variable and click the OK
button.

Select the top right-hand panel (Panel B).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel B
Permanent Leave the load factor as 1 and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel B Variable and click the OK
button.

Select the bottom-left panel (Panel C).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the & Treeview onto the selection. Change the loadcase name to Panel C
Permanent and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection. Change the loadcase name to Panel C Variable and click the OK
button.

Select the bottom right-hand panel (Panel D).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel D
Permanent and click the OK button.

Drag and drop the attribute Imposed Load
5kN/m2 from the &% Treeview onto the
selection. Change the loadcase name to F
Panel D Variable and click the OK
button.

= =
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| File

Simple Building Slab Design

| Save

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the @ Treeview
Addition files will be created in the directory where the model file resides, including:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U slab_design.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O slab_design_modelling.vbs carries out the modelling of the example.
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| File

New...

| File
Script >
Run Script...

Viewing the Results

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as slab_design
e To recreate the model, select the file slab_design_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

=
;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the @ Treeview, and load case results for Panel
A Permanent are set to be active by default.

° Tum Off the Analysis: Analysis 1
Attributes layer in o i iao s o

Entity: Force/Moment - Thick Plate

the Treeview_ Component: MX(B) (Units: N.m/m}

. -13 5665E3
e With no features s
-9.04436E3

selected, click the 7 53897E3

-6.02858E3

right-hand mouse acontses
- -3.01479E3
button in a blank part g -7
of the active window i 35S e o
and select  the
Contours option to
add the contours
layer to the &

Treeview.

e Select entity Force/Moment - Thick Plate and results component MX(B) to see
the results for Permanent effects in Panel A.

Defining a Load Combination

The loadcases will be combined to provide the most adverse loading effects. This is
achieved using the smart load combination facility within LUSAS Modeller. For
Ultimate Limit State (ULS) design EN1990:2002 requires permanent actions to be
factored by 1.35 where unfavourable and 1.0 where favourable. Unfavourable variable
actions are factored by 1.5 and omitted where favourable. (These factors may be subject
to national variation)
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| Analyses

Smart

Combination...

Simple Building Slab Design

For permanent actions this is equivalent to a Permanent load factor of 1.0 and a
Variable load factor of 0.35 since 1.0 will always be applied and 0.35 will only be
applied if it creates an unfavourable effect.

For variable actions this is equivalent to a Permanent load factor of 0.0 and a
Variable load factor of 1.5 since the loading will only be applied if it creates an

unfavourable effect.

Note. Permanent load factor and Variable load factor refer to the LUSAS Smart
Combination definitions rather than the EN1990 definitions.

Creates a smart combination in the @ Treeview.

¢ Include all loadcases in the smart combination. To do this select the first load case
in the loadcase selector at the bottom-left of the then hold the Shift key down and

scroll down the list and select the last loadcase.

e Click the LI button to add these loadcases to the included list.

e Select the Grid button and set the permanent and variable factors as shown in bold

in the table that follows:

Name Permanent Variable
Factor Factor
Panel A Permanent 1.0 0.35
Panel A Variable 0 15
Panel B Permanent 1.0 0.35
Panel B Variable 0 1.5
Panel C Permanent 1.0 0.35
Panel C Variable 0 1.5
Panel D Permanent 1.0 0.35
Panel D Variable 0 1.5

e Click the OK button to return to the combination properties

e Change the smart combination name to ULS

e Click the OK button to complete the definition of the smart combination
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Viewing the Results

The maximum combination will produce the most adverse hogging moments whilst the
minimum combination will produce the most adverse sagging moments.

Note. When the properties of the max combination are modified the corresponding
min combination is updated automatically.

e Select ULS (Min)  commmen e

ULS (Min)

from the @ Treeview Entity: Force/Moment - Thick Plate

. . Component: MX(B) (Units: N.m/m)
with the right-hand i
mouse button and S1arees

ple the Set Active | “ense

-38.3361E3

-69.005E3

option. oo
-15.3344E3 "
. . -7.86722E3
e Select entity o moosnee s
FOrCe/MOment _ Minimum -69.005E3 at node 45

Thick Plate and
results component
MX(B) to combine,
applying the variable
factors based on the
bottom Wood Armer moments in the X direction and click the OK button.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided.

Note. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations ,if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results may will need to be transformed to a
consistent direction. This can be achieved by either setting a local coordinate set or
choosing an appropriate results transformation option on a results layer property dialog
prior to opening the RC Slab Designer.
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| Bridge

RC Slab Design...

Simple Building Slab Design

e Ensure that United Kingdom
and BS EN  1992-1-
1:2000/NA:2005 are selected
from the dropdown list of
countries and design codes

e Ensure slab depth is from
model geometry

e  Ensure that the option for ULS
reinforcement  design s
selected.

e Ensure that the characteristic

RC Slab Design: Design Code Settings

Design code
Country [united Kingdom =l
Design code [BS EN 1952-1-1:2004/NA2005 =l
Slzb depth
’7 & From model geometry € Constantdepth  [2500 mm

Design
’7 & ULS reinforcement design ~ SLSerack checking

Design parameters
Characteristic yield sirength of reinforcement (fyk)
Material factor for reinforcing steel (vs)

Medulus of elasticity of reinforcing steel (Es)
Characteristic eylinder strength of concrete (fck)
Material factor for concrete (yc)

Cocficient for long term and unfaverable effects (Aec)

Defaults <Back |

Finsh |

Cancel |

teip |

concrete cylinder strength is 40 and the characteristic yield strength of the

reinforcement to 460.

e  Click Next to proceed to the Slab Properties.

RC slab Design: Reinforcement Details

—Slab details —Reinforcement layout
—Top reinforcement _&%0%
Bar size Spacing (mm) I é N Top layer 1
Barsinx |[Layer1 v [12om > [1500 E N G NS
R AR
Barsiny [Layer2 [12em =] [1500 R A
S :
— Battom reinfo | Tclnp layer 2
Bar size Spacing (mm) ¥ | I
Barsinx |Layer1 x| [12om x| [1500 i :
0 |
Barsiny |Layer2 J1zom =] [1500 ! |
! i
—Cover lIBr;ar\s( e Bottom layer 2
Top IZD.D mm  Bottom IZD.D mm ! 9
Skew angle of bars in y from x IB'D.{I deg L::‘
Bars - .-~ "Bottom layer 1
in X Tt
Defaults | < Back Iext = Cancel Help
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Viewing the Results

o Enter the slab E‘E;‘w::)ﬂm MX(B)
properties as Eny: R Slab Design
Component: Steel Area (Units: mm?/m)
shown v
114.541
e Click Finish to nas
calculate the fnn e
reinforcement sar2as
requirements. 918325

Maximum 1.03087E3 at node 43 of element 7
Minimum 0.0 at node 18 of element 6

This will close the RC
Slab Designer dialog and
plot contours of required
bottom steel area in the X

RC Slab Design to BS EN 1992-1-1:2004/NA: 2005

direction based On the Calculation based on MX(B), rebar skew angle=20"°
Slab depth from geometry
1 Charactenstic concrete cylinder strength =40.0N/mm?*
aCtI Ve Load Case (O r Charactenstic steel strength =460.0N/mm*
- - Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm
comblnatlon/envelope). Bottom: cover=20.0mm, bar diameler in x =12.0mm, bar diameteriny =12.0mm

A floating toolbox is provided to enable results for all four layers of reinforcement to be
viewed without having to return to the slab designer dialog.

Plotting the contours of Utilisation displays the ratio of the applied moment to the
calculated moment capacity and provides a rapid check on the proposed reinforcement
arrangement.

To calculate results for the bottom steel in the Y direction:

e Select ULS (Min) from the (&) Treeview with the right- [ |LScaleulations
hand mouse button and pick the Set Active option. Companent IMx[B} -
e Select Force/Moment — Thick Plate and MY (B) from Bar sizes

factors based on the Wood-Armer moments in the Y
direction and click the OK button.

Tension control

the drop-down lists to combine applying the variable e |

Utilization

e The Slab Designer will automatically recalculate for
the new results however the calculations will be based |
on MX(B) as shown in the toolbox.

RC Slab Design |

Close
e A message may be issued by the Slab Designer to warn
that the current loadcase is optimised for different o |
results than those currently being calculated by the Slab
Designer. Change the toolbox dropdown item to be MY(B) and the Slab Designer
will recalculate the appropriate steel areas in the Y direction.

e The reinforcement design can be viewed in terms of required area, bar size and
utilisation by selecting the appropriate button in the toolbox.
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| Analyses

N1/

Smart
Combination...

Simple Building Slab Design

Caution. The ULS design of reinforcement assumes that the slab is “under-reinforced”
and therefore the calculations are only valid when this holds true. The contour plot
“Tension Control” indicates whether the slab will undergo ductile failure and is hence
“under-reinforced.” Plots of Tension Control must therefore be checked to ensure a
valid design. For more information see the help entry.

‘Combining on: MY (B)
ULS {Min)
Entity: RC Slab Design

Component: Steel Area (Units: mm?/im)
0.0
12074
241.4

382.221
482 882
603.702
724447
B845.183
965.923

Maximum 1.08666E3 at node 90 of element 28
Minimum 0.0 at node 18 of element &

RC Slab Design to BS EN 1892-1-1:2004/NA 2005
Calculation based on MY(B), rebar skew angle=80°
Slab depth from geometry

‘Characteristic concrete cylinder strength =40 0N/mm?
Characteristic steel strength =480 0N/mm*

Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameter in y =12.0mm
Bottom: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm

e The previous processes can also be repeated to plot contours of required top steel
reinforcement using the ULS (Max) combination for most adverse hogging
moments MX(T) and MY(T)

Concrete crack checking

The calculation of crack widths in the RC Slab Design facility is based on principal
moments rather than Wood-Armer moments used in reinforcement design. Effective
steel areas are interpolated based on the orientation of the principal moments with
respect to the steel directions. Extensive coverage of the crack calculation procedure is
provided in the help manual.

Crack widths will be calculated based on service loads and hence a new combination is
required. Click the Close button on the Slab Designer toolbox to clear the current
reinforcement results.

Creates a smart combination in the @ Treeview.

e Include all loadcases (but not the two ULS combinations) in the basic combination.
To do this select the first load case in the loadcase selector at the bottom-left of the
then hold the Shift key down and scroll down the list and select the last loadcase.

e Click the il button to add these loadcases to the included list.
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| Bridge

Viewing the Results

|RC Slab Design...

e The load factors can be entered as follows

Name Permanent Variable
Factor Factor
Panel A Permanent 1.0 0
Panel A Variable 0 1.0
Panel B Permanent 1.0 0
Panel B Variable 0 1.0
Panel C Permanent 1.0 0
Panel C Variable 0 1.0
Panel D Permanent 1.0 0
Panel D Variable 0 1.0

e Click the OK button to return to the combination properties

e  Change the smart combination name to SLS

e Click the OK button to complete the definition of the smart combination

e Select SLS (Min) from the (5 Treeview with the right-hand mouse button pick the
Set Active option and set the combination for MMin.

Restart the Slab Designer

e On the main page change the design calculation option to SLS crack checking

e Select the Next button to navigate to the reinforcement details (which remain as set
for the ULS design) and again to access the crack width settings.

e Enter the crack width settings as shown on the dialog.
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Simple Building Slab Design

RC Slab Design: Crack Width Settings x|
—Cs tion properties r— Elastic moduli
Top (mm)  Botiom (mm) % Use code defined values

Cover for crack spacing  [20.0 200 Creep cosfficient (Phi) 22
Allowable crack width (mm) 0.3 Aggregate type: IOuartzitE v

[ EE IR 4~ User defined values
€ Include € lgners & Interpelate Short term moedulus of concrete GPa |35.D
Bt e e s ————————— Long term modulus of concrete GPa 11.0
¥ Quasi-permanent
" Interpolated, based on proportion I R
Coefficient for load duration (Kt) 0.4

Variable effects : Total effects (%) IBD.D
Fermanent effects: Total effects (%) [20.0 Cosfficient for bond properties (K1) 0.8
Coefficient for strain distribution (K2) 0.5
Coefficient for cover influence (K3)

" Interpolated. based on calculated proportion

Permanent effects from loadease or combination
[ | (a) [34 (&) 0.0 (e 00

The variable moments are taken from the curently Coefficient for bar diameter (K4) 0.425
active loadcase. Crack widths are based on the
summed moments from the designated {permanent)
and active (variable) loadcases

Defaults | <Back | nei- | Fimish | [7Canedl Help |

e Click the Finish button to plot contours of crack widths throughout the slab.
Crack widths to the top and bottom faces can be viewed by selecting either
Top of Bottom in the toolbox.

‘Combining on: MMin

SLS (Min)

Entity: RC Slab Design

Component: Max bottom face crack widths (Units: mm)

0.0
0.0508365
0.101673
0.15251
0.203346
0.254183
0.305019
0.355856
0.406692

Mazximum 0.457 529 at node 78 of element 7
Minimum 0.0 at node 18 of element &

RC Slab Design to BS EN 1982-1-1:2004/NA 2005
Calculation based on principal mements, rebar skew angle=20°

Slab depth from geometry

Charactenstic concrete cylinder strength =40.0N/mm*

Characteristic steel strength =460.0N/mm*

Effective concrete modulus=11.3789Nimm?*

Top: cover=20.0mm, bar diameter in x =12.0mm bar diameter iny =12 0mm
Bottom: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm

Note. The crack checking calculations are based on strains calculated from an
interpolated effective area of steel. However the actual crack width is calculated taking
the bar spacing and bar diameter of the layer orientated closest to the principal moment
in question. Contour plots for crack widths “controlled” by each reinforcement layer are
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| File

Save

Viewing the Results

provided to identify exactly which bars are controlling the cracks. By default the
maximum crack width is displayed.

To determine the extent of any excessive cracking press the Pass/Fail button on the RC
Slab Design Control to show a two-tone contour plot of crack width below and above
the acceptable limit.

Combining on: MMin

SLS (Min)

Enity: RG Siab Design

Component: Max bottom face crack widths (Units: mm)
Gontours indicate passfail for allowable crack width

03

Maximum 0.457 529 at node 78 of element 7
Minimum 0.0 at node 18 of element &

RC Slab Design to BS EN 1992-1-1:2004/NA:2005
Calculation based on principal moments, rebar skew angle=80°
Slab depth from geometry

Cl cylinder strength
Characterisic stesl strength =460.0N/mm?
Effective concrete modulus=11.378Nimm?*
Top: cover=20.0mm, bar diameter in x =12.0mm, bar diameterin y =12.0mm

Bottom: cover=20.0mm, bar diameter in x=12.0mm, bar diameter in y =12.0mm

In this instance excessive cracking is localised and local increases in reinforcement
maybe sufficient to prevent the cracks. The reinforcement density will be increased to
prevent any excessive cracking. Return to the Slab Design dialog by selecting RC Slab
Design from the floating toolbox. Click next to display the crack definition page and
increase the bottom reinforcement to be 16mm in both X and Y directions. Click next
and then click finish to view the updated results. The extent of the cracking is reduced
to a small concentration. Cracking to the top face would be investigated in a similar
manner with the combination set for MMax to maximise hogging moments.

Note. The crack checks are based on an interpolated concrete modulus allowing for
time-dependant effects. The interpolated value is displayed in the on screen output. For
complicated models featuring multiple materials, it may therefore be necessary to
reanalyse the model with the interpolated concrete stiffness to more precisely calculate
the loading effects.

Click Close in the Slab Designer toolbox to remove all Slab Designer results and return
to modeller. All the Slab Designer inputs are saved to the model and will be saved to
disk when the model is saved. Should the Slab Designer need to be run again the saved
values will be recovered.

Save the model

El Save the model file.
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Simple Building Slab Design

Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.

Element types and orientation of results

This example demonstrates the use of the RC Slab designer for a model that uses an
irregular mesh of thick plate elements. Within the slab the reinforcement will generally
be orthogonal for the layout demonstrated and for thick plate elements the results are
output in global directions, so there is no conflict. If, in a real-life example, shell
elements were inadvertently used for a model such as this, the use of an irregular mesh
would mean that the results used for the Wood-Armer / slab calculations would have
different orientations over the whole slab and hence be incorrect. In this circumstance a
local coordinate set would need to be used to orientate the shell element results to be
consistent with the global axes in order to obtain sensible components for use in the
calculations.

The following result contours shows the difference between results from global (left)
and local (right) axes for the ULS(Max) MX(B) plot.

Global Axes Local Axes
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Discussion

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply

changes.

e Results transformations can be applied using the Transformed... button on a results
layer’s Properties dialog. Selecting Global axes will transform local element results
into the global axes system. Other options are available..

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase X, y and z (when seen) are used to denote local results or

transformed results.

Element density and results obtained

If the Evaluation Version of LUSAS was used to carry out this example with a reduced
default mesh density of 4 divisions per line a reduced accuracy of results will have been
obtained. The following graph for ULS(Min) shows how Bending Moment (MX) along
a horizontal 2D slice section through the central three columns typically varies with the

number of line mesh divisions used.
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In general, more accurate results are obtained when using more line mesh divisions and

hence more elements when modelling slabs of this type.

Care should always be taken

to use an appropriate number of elements together with a possible refinement of the
mesh in areas of interest in order to obtain the best results.
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Description

Linear Analysis of a
Post Tensioned
Bridge

For software product(s):

LUSAS Civil & Structural or LUSAS Bridge

With product option(s): | None.

Description
A 3 span concrete y y=0.2 - 0.163(x-19) + 0.0136(x-19) 2
post _ tensioned T y=0.2+0.1630¢13) - 0.02717(x-13) 2 ‘
bridge is to be
analysed. The

bridge is idealised
as a 1 metre deep
beam with a tendon
profile as shown in
the half model of the
bridge.

The initial  post
tensioning force of
5000 kN is to be

T
y=-0.1322x + 0.01135x 2 f\\D \
A \ b\ /' X

¥ v
W tangent points \E_

A

6.5 2 4 6

15 10

6.5

4

Column

Half-model of bridge

Abutment (Not to scale)

applied from both ends. Tendons with a cross section area of 3.5e3mm? are located
every 2 metres across the section allowing the analysis to model a 2 metres effective

width.

Three loadcases are to be considered; self-weight, short term losses, and long term

losses.

Units of kN, m, t, s, C are used throughout the analysis. Note that tendon cross-sectional

area is specified in mm?.
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A

Modelling

Linear Analysis of a Post Tensioned Bridge

Objectives

The required output from the analysis consists of:

O The maximum and minimum long and short term stress in the concrete due to
post tensioning.

Keywords

2D, Beam, Prestress, Post tensioning, Beam Stress recovery.

Associated Files

U post_ten_modelling.vbs carries out the modelling of the example.
U post_ten_profile.csv carries out the definition of the tendon.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

Enter the file name as post_ten

Use the Default working folder.

Enter the title as Post-tensioning of a bridge
Select model units of kN,m,t,s,C

Ensure the timescale units are Seconds
Ensure the analysis type is Structural

Select the startup template Standard

Select the Vertical Y axis option.

Click the OK button.
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| Geometry
Line >
| Coordinates...

| Geometry
| Group >

New Group...

Model Properties. ..

Modelling

Note. Save the model regularly as the example progresses. This allows a previously
saved model to be re-loaded if a mistake is made that cannot be corrected easily.

llt] .
Note also that the Undo button ﬂ may also be used to correct a mistake. The undo
button allows any number of actions since the last save to be undone

Feature Geometry

il Enter coordinates of (0, 0), (15, 0) and (25, 0) to define two Lines representing
half the bridge. Use the Tab key to move to the next entry field on the dialog.

i

e With all the coordinates entered click the OK button.

-

Fal=s >
= = L

e Select all the visible Points and Lines using the Ctrl and A keys together.

To make the manipulation of the model easier create a group of the bridge
e Enter the group name as Bridge

e Inthe Treeview select the group Bridge with the right-hand mouse button and
select the Invisible option to hide these features from the display.

Defining the tendon profile

When using the Prestress utility the tendon geometry is determined from a Line
definition which, in practice, is usually a spline curve. The geometry of the tendon may
be input into the model directly by manually entering the coordinates, or, as in this
example, by copying values from a comma separated file (.csv) which has been opened
in a spreadsheet application and pasting these values into the Point coordinates dialog
in Modeller. This is done using standard Ctrl + C and Ctrl + V keys.

Note. To prevent the point representing the left-hand end of the bridge and the end
point of the tendon profile from becoming stored as just a single point in the model the
geometry should be made unmergable.

e On the Geometry tab select the New geometry unmergable option and click OK
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Linear Analysis of a Post Tensioned Bridge

e Read the file
\<LUSAS Installation Folder>\Examples\Modeller\post_ten_profile.csv into a

spreadsheet.
|Geometry > e Select the top left-hand corner of the
Pont > spreadsheet grid to select all the cells and il sile
[Coordinates... use Ctrl + C to copy the data. { ¥ ‘
e Select the 3 Columns option to show X, Y L X Al z
and Z columns. '
o Select the top left-hand corner of the Enter
Coordinates dialog and use Ctrl + V to el e iy e s
paste the coordinates defining the tendon ICKEre {0 SEIect e fable
profile into the table. Note that the use of % .
‘Paste’ using a mouse button is not enabled.
Clle OK. IGIobaI coordinate set j
= Keen 2 referenceises
ak. I Cancel | Help |
The points defining the tendon profile should appear as shown.
v
I_D'E;'x‘--iilii'-"- -I..'-"
| File On the Geometry tab de-select the New geometry unmergable option and click OK

[Model Properties...

Use Ctrl and A keys together to select all the visible Points.

| Geometry
[Line >

| Spline >
By Points... A

Do

Use Ctrl and A keys together to select the spline line and points.

Click OK to define a spline that is defined in point selection order.
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Modelling

Geomet —_— . . .
| fé’{‘;jp'y ~ Make the model definition easier by placing the prestress tendon into a group.
|New Group .
e Enterthe group name as Tendon and click OK
Note. As well as defining the tendon manually using coordinates the Prestress Wizard
/ allows you to define the profile of the tendon in 2D or 3D space as a series of straight
lines, arcs, splines and parabolas, using Bridge (or Civil) > Prestress Wizard >
Tendon Profile. The Tendon Profile dialog is used in the Segmental Construction of a
Post Tensioned Bridge example.
Defining the Mesh
The concrete bridge is represented by 2D beam elements.
e Inthe Treeview select Bridge and pick the Set As Only Visible option. This
turns off the display of the tendon to make bridge assignments easier.
| Attributes e Select Thick Beam, 2 dimensional, Linear elements, enter the dataset name as 2D
|% Beam and click OK to add the mesh dataset to the &b Treeview.
e Use Ctrl + A to select all the features.
e Drag and drop the mesh dataset 2D Beam onto the selection.
Defining the Geometric Properties
The beam idealisation represents a two metre width of the bridge which is one metre
deep. A section of this size will be created and added to the local library for subsequent
assigning to the model.
| Utilities ° Select the Rectangular Rectangular Solid Section Property Calculator
Section Property 50|Id Sectlon (RSS) -~ Dimensional data -~ Calculated propertiss ——
Calculator > b |17 It a lzu—
Rectangul i
S:gtgzgu:rsoud Enter a depth (D) of 1 gnd N | T -
- a breadth (B) of 2 and click . —
OK to add the section to ' l w |
the local library. w0
—B— . R
L) W
Name [RSS D=1B-2 i I1 S
ii::::f;il:::gw Load sections... | Clealageumelry..l “izualige... |
ak. I Cancel | Apply | Help |
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| Attributes

Linear Analysis of a Post Tensioned Bridge

Geometric >
Section Library..
| Attributes
Material >

Material Library...

To add this section to the & Treeview:

From the Usage section select 3D Thick Beam (Any beam)

Select User Sections from the top-most drop-down list, select Local library, then
select RSS D=1 B=2. Since the initial section was defined simply in an xy plane, a
rotation about the centroid will be required. As a result:

Select a Rotation about centroid of 90
Enter the attribute name as Beam Properties and click OK

With the whole model selected drag and drop the geometric dataset RSS D=1 B=2
Beam Properties (RSS D=1 B=2 major y) from the & Treeview onto the selected
features.

@l Select the Isometric button to view the visualised beam.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation.

@l Select the Home button to return the model to the default view.

Defining the Material

Select material Concrete of grade Ungraded from the drop down list and click OK
to add the material dataset to the &b Treeview.
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Modelling

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Concrete Ungraded) from the & Treeview onto the selected
features and assign to the selected Lines by clicking the OK button.

Defining the Supports

LUSAS provides the more common types of support by default. These can be seen in
the & Treeview.

The bridge is supported with rollers at each of the abutments.

e Select the point at the left-hand abutment and the point at the column. (Hold the
Shift key to add to the initial selection)

e Drag the support dataset Fixed in Y from the 63; Treeview and drop it onto the
selected Points in the graphics window. Choose options to Assign to points for All
analysis loadcases and click OK

o Select the right-hand point on the centre line of the bridge.

e Drag the support dataset Symmetry YZ from the & Treeview and drop it onto the
selected Point in the graphics window. Choose options to Assign to points for All
analysis loadcases and click OK

—

T

3

o
—

Loading

Three loadcases are to be applied. The first represents self-weight of the structure. The
second represents the prestress with short term losses only. The third represents the
prestress with short and long term losses.

Defining the Self-weight

e Gravity can be applied to any loadcase from the (& Treeview.

o Select Loadcase 1 from the '=! Treeview with the right-hand mouse button and
select Gravity. Note that, when applied to a loadcase as an option load arrows
representing self-weight are not shown
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| Analyses

| Loadcase. ..

Linear Analysis of a Post Tensioned Bridge

e Select Loadcase 1 from the = Treeview with the right-hand mouse button and pick
the Rename option and change the loadcase name to Self Weight

Turn-on the display of the tendon

Now that the bridge assignments have been made the tendon can be re-displayed.

e In the L=l Treeview select Tendon with the right-hand mouse button and select the
Visible option.

Rebuilding a model after a previous failed analysis

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

Defining Prestress with Short Term Losses

e Change the loadcase name to Short Term Loss and click OK

e Select Short Term Loss from the ‘= Treeview with the right-hand mouse button
and pick the Set Active option. Ensure that the Automatically add gravity to this
loadcase option is not selected.

e Select the spline Line representing the tendon in the Treeview with the right-
hand mouse button and click the Select Members option. Then select the 2 beams
representing the concrete bridge. (Hold the Shift key to add the other 2 lines to the
initial selection)

1. Select this tendon line first

2. Select this bridge line 3. Select this bridge line

Caution. Prior to running the Prestress Wizard to calculate short term and long term
tendon losses the correct Short Term or Long Term loadcase must be set active to
ensure that the values are written into the correct Tendon Load assignment attributes as
held in the &% Treeview. With the Short Term Loss loadcase active:
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Modelling

|Bridge e Select the Defaults button.
Prestress Wizard > ~Short term losses —————————————————
SingleTendon > e Ensure the Analysis type is  |*="* Bean ] Pl
BS5400... set to Beam Wobble factor 3.%-3 jm
~Tendon detsls —————— 1 longtermlosses —————————————————
L4 In the Tendon detal'S Prestress force IW kN Relaxation loss |25— o
section enter the Prestress S —— s P S S =
force as 5000 Modulus of elasticity 200.0E6 kMfm2 Creep coefficent
e Enter the Tendon area as | Terensmimeant [ 3 Siress at ransfer

H 1 Jacking details
35E3 (n0te that thls IS Jacking end End 1 slip IU-EIIJE m Jacking angle

entered in mm2 [erd torty =]
) Fnd torly End 2 slip | m Jacking angle
e Leave the Modulus of the & amereor

elasticity of the tendon as ¥ Geesiaass vefauts | [ o€ | cond | b |
200E6

e Set the number of Tendon sampling points to 25

¢ In the Short term losses section set the duct friction coefficient to 0.3

e Ensure the Long term losses option is deselected.

¢ In the Jacking details section enter an End 1 (anchorage) slippage of 0.005

e Click the Generate report option. This will generate a report in HTML format in
the \<Lusas Installation Folder>/Projects directory summarising the prestress
tendon forces.

e Click the Generate graphs option. This generates graph datasets in the v
Treeview for subsequent graphing to be carried out.

e Click OK

Equivalent nodal loading is then calculated from the values entered on the Prestress
Definition dialog.

On completion, an HTML report will be opened automatically in the default web
browser. This report is also saved into the specified folder. The report is a complete
summary of the tendon profile, properties and loading assignments made. On closing
the report the tendon loading assignments on the model can be seen for the active
loadcase.

V2 Caution. Subsequent modification of the current tendon profile or beam lines will not
‘7 4 update the calculated loading until the prestress wizard is run again.

AN

e Click OK to dismiss the warning message displayed
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| Analysis
| Loadcase. ..

| Bridge
| Prestress Wizard >
|Single Tendon >
|BS5400...

Linear Analysis of a Post Tensioned Bridge

Modeller will assign the datasets to the selected Lines representing the concrete beams
for the current loadcase and will also add two load datasets to the &b Treeview.

e Inthe Treeview double-click the Utilities entry and on the Tendon profile tab
click the None button to stop the display of the tendon profile setting-out details.

Note. Tendon sampling points determine the number of points used when graphing
and creating reports on short and long term losses.

Defining Prestress with Short and Long Term Losses

e Change the loadcase name to Long Term Loss and click OK

e Select Long Term Loss from the @ Treeview with the right-hand mouse button
and pick the Set Active option.

e Re-select the tendon profile and the two lines representing the bridge, taking care to
ensure the tendon profile is selected first.

With the Long Term Loss loadcase active:

The values previously entered on the dialog will be retained. Select the Long term
losses option. Leave all other values as they were set for the short term loss loadcase.

e Click the Generate report and the Generate graphs options. This generates a

report in HTML format and graph datasets in the & Treeview for subsequent
graphing to be carried out.

e Click OK to apply the prestress force to the current loadcase.

Equivalent nodal loading is calculated from the values entered on the Prestress
Definition dialog.

e Click OK to dismiss the warning message about subsequent modification of the
current tendon profile or beam lines not updating the calculated loading until the
prestress wizard is run again.
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| utilities

Graph Wizard...

| Utilities

Graph Wizard...

Modelling

Graphing of Prestress Force in the Tendon

When the Generate graphs option is selected on the Prestress dialog two graph datasets
are created. One contains the distance along the beam and the other contains the force
in the tendon at each point. To graph these:

e Select the Specified datasets option and click Next

e From the first drop down list select Tendon Assignment Line 3 Distance and from
the second select Tendon Assignment Line 3 - Short Term Losses and click Next

e Click Finish to display the graph
Now add a graph of the Force after long term losses:
o Select the Specified datasets option and click Next

e From the first drop down list select Tendon Assignment Line 3 Distance and from
the second select Tendon Assignment Line 3 - Long Term Losses and click Next

e Select the Add to existing graph option and click Finish to update the graph.

FPost-tensioning of @ bridge
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EI Close the graph window.
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| File

Linear Analysis of a Post Tensioned Bridge

| Save

Saving the Model
El Save the model file.

Running the Analysis

| File

=

[New...

El Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
LUSAS loadcase results will be added to @ Treeview.

In addition, 2 files will be created in the Additional Model Data folder, where the
model file resides:

U post_ten.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U post_ten.mys this is the LUSAS results file which is loaded automatically
into the = Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U post ten_modelling.vbs carries out the modelling of the example up to
the point of defining the prestress.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.
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| File

Viewing the Results

|Script

| Run Script...

e Enter the file name as post_ten

e To recreate the model up until the point of defining the prestress, select the file
post_ten_modelling.vbs located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Defining Prestess With Short Term Losses earlier
in this example and re-define the tendon properties.

Viewing the Results

Selecting the Results to be Viewed

The results will be loaded on top of the current model and the loadcase results for the
first loadcase (the self weight loadcase) will be set to be active by default.

Deformed Mesh Plots

A deformed mesh plot helps highlight any obvious errors with an analysis before
progressing to detailed results processing. The deformed shape will usually show up
errors in loading or supports and may also indicate incorrect material property
assignments (e.g. where the results show excessive displacements).

Deformed Mesh Plot for Self Weight

o |f present, turn off the display of the Geometry, Attributes and Mesh layers from
the = Treeview.

The Deformed mesh layer should be already present in the Treeview, and the View
window will be showing the deformed mesh for the self-weight alone.

e With no model features selected, click the right-hand mouse button in the graphics
window and select Values

e Select entity Displacement and component DY

e Select the Values Display tab.

e Select the Show values of selection option.

e Change the number of significant figures to 4 and click OK

e Select the node on the centre line to add the value of vertical displacement at mid-
span to the display.
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| Analyses

Linear Analysis of a Post Tensioned Bridge

Basic

Combination. ..

-4 87E-3

Deformed Mesh Plot for Short Term Loss

e In the {2 Treeview right-click on Short Term Loss and select the Set Active
option.

i
. —— —~3856E3

Defining a Basic Combination

Combinations can be created to view the combined effects of the self weight and short
term loss loadcases on the structure.

The combination properties dialog will appear.
e Ensure post_ten.mys is selected from the drop down list.

e Select the Self Weight and Short Term Loss loadcases from those available and

click the LI button to add them to the load combination. Change the combination
name to Self Weight and Short Term and click the OK button to finish.

Deformed Mesh Plot for Combination

o In the ‘X Treeview right-click on Self Weight and Short Term and select the Set
Active option.

The deformed mesh plot will show the effect of the combined loading on the structure.

i

b T T 1.014E-3

Fibre Locations

Force/moment and stress diagrams can be plotted for pre-defined fibre locations on
members. All sections created by the Section Property Calculator will have extreme
fibre locations pre-defined. These fibre locations can be seen by expanding the
Geometric Line entry Beam properties (RSS D=1 B=2 major y) in the &b Treeview,
and they can be visualised by double-clicking the Geometric Line attribute name and
then selecting the Visualise button on the dialog. In doing so, it can be seen that, by
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Viewing the Results

default, Fibre S1 is the active fibre and Fibre S1 and Fibre S4 are the upper and lower
extreme fibres for which diagram and stress results plots should be created.
Diagram Stress Results at Fibre Locations

e Turn off the display of the Values layer from the [=- Treeview.

o In the & Treeview right-click on Short Term Loss and select the Set Active
option.

e With no features selected right-click in a blank part of the graphics window and
select Diagrams to add the diagrams layer to the =¥ Treeview.

The diagram properties will be displayed.
e  Select Stress - Thick 2D Beam results of stress Sx(Fx, Mz) in the beam.
e Select the Diagram Display tab and deselect the Peeks only option.

e Change the angle of the text to 45, set the number of significant figures to 4 and
click OK to display the stress diagram at Fibre location S1 for the Short Term Loss
loadcase

Diagram Results for Short Term Loss

&
;-_.:rx’/—/—\ —_—— & e

Diagram Results for Combination

e In the ‘X! Treeview right-click on the combination Self Weight and Short Term
and select the Set Active option to display the stress diagram at Fibre location S1
for the Self Weight and Short Term combination

Diagram Results for Combination at Fibre 4

Once a loadcase has been set results can be plotted for any defined fibre location. In
this example, because of their location and because of the applied loading, Fibre S1 and
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Linear Analysis of a Post Tensioned Bridge

Fibre S2 will give the same results at the top of the beam. Fibre S3 and Fibre S4 will
both also give the same results at the bottom of the beam — so only a diagram for Fibre
S4 needs to be plotted.

With the combination Self Weight and Short Term still set active in the () Treeview:

o Inthe &b Treeview expand Geometric Line entry RSS D=1 B=2 major y beam and
right-click on Fibre S4 and select Set Fibre Active.

The diagram display will update to show the stresses at Fibre S4:

Viewing Results on Fleshed Members

e Asan alternative to plotting diagram results, stresses in beams can also be plotted
on fleshed members.

e Turn off the display of the Diagrams layer from the = Treeview.

Contour Results for Short Term Loss

e In the ‘2 Treeview right-click on Short Term Loss and select the Set Active
option.

e Clickin a blank part of the Graphics Window to deselect the members.

e With no features selected right-click in a blank part of the graphics window and
select Contours to add the contours layer to the = Treeview.

e Select Stress — Thick 2D Beam results of axial and moment results in the members
Sx(Fx, Mz) and click OK

e Initially the contour properties will be displayed for the fibre location (Fibre S4)
that is currently set active.

E

82



Viewing the Results

To see the stresses on the fleshed beam member:
B | . .
Select the isometric button.

ﬂ Select the fleshing on/off button to visualise the stress results for the fully fleshed
cross-section.

Analysis: Analysis 1

Loadcase: 2:Short Term loss

Results file: post_ten~Analysis 1.mys
Entity: Stress - Thick 2D Beam
Component: Sx(Fx, Mz) (Units: kN/im?)

-7.2314E3
-6 02617E3
-4 B2094E3
-3 6157E3
|| -2.41047E3

-1.20523E3
0.0

1.20523E3
. 2.41047E3

Contour Results for Combination

o In the & Treeview right-click on the combination Self Weight And Short Term
and select the Set Active option.

Combination 1
Entity: Stress - Thick 2D Beam
Component: Sx(Fx, Mz) (Units: kN/m*)

-5.25472E3
-4.37893E3
-3.50315E3
-2 62736E3
- -1.75157E3

-B75.786
0.0

875.786
. 1.75157E3
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Linear Analysis of a Post Tensioned Bridge

Note. Diagrams and contours may be displayed at the same time to show results for
selected fibre locations.

This completes the example.

Discussion

This example illustrates the use of the single tendon prestress wizard, which does not
take into account any stressing or unstressing of any other tendons, should they also be
present in the model, which in this example they are not.

The Multiple tendon prestress wizard should generally be used instead of the single
tendon wizard since it takes into account elastic shortening due to stressing of other
tendons according to the selected design code or user-defined percentage losses, and is
more suited to staged construction analysis. If the option to ignore effects due to elastic
shortening is chosen the loading computed will be the same as that calculated by the
single tendon wizard
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Description

Simple Grillage

For software product(s): | LUSAS Bridge.
With product option(s): None.

Description

A bridge deck is to be analysed using the grillage method. The geometry is as shown
below. All members are made of C50 concrete to BS5400. Section properties of the

longitudinal beams and diaphragms are to be calculated using the Section Property
Calculator facility.

Footway 0.25m Concrete Surfacing 0.1m Tarmac
Density 2.4t/m3 Density 2.0/m3

L—Z.Sm—»ld—:‘s.Sm Lane—>l<—3.5m Lane Jf 2.5m—>1
L |

Y6 beam with insitu

12m > concrete top slab
| : . Voo5m | Span = 20m
04 24 ¢ XL ¢ (Ot Width = 12m
Skew = Q°
o 6@2m——————
Cross-section through deck
l 20m |
‘ ] A&
u u 0.75m
_v
Longitudinal section along deck Nig

0.5m
The structure is subjected to four loadcases: Dead load, Superimposed dead load, Lane
loads in both lanes (UDL and KEL), and an abnormal load (HB) in the lower notional

lane with a lane load (UDL and KEL) in the upper lane.
Units of kN, m, t, s, C are used throughout when modelling the grillage.

Units of N, mm, t, s, C are used in calculating the section properties of selected
components.
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Modelling

Simple Grillage

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading

O A diagram showing bending moments in the longitudinal members for the design
load combination

Keywords

2D, Y6 Precast Section, Section Property Calculation, Local Library, Grillage,
Basic Load Combination, Smart Load Combination, Enveloping, Deformed Mesh,
Bending Moment Diagram, Print Results Wizard

Associated Files

U grillage_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Before creating the grillage model the section properties of the longitudinal beams and
end diaphragms are to be computed using the section property calculator and stored for
future use. Calculation of section properties requires section geometry to be
drawn/defined in the XY plane.

Creating the Longitudinal Beam Model

e Enter the file name as Y6

e Use the Default working folder.

e Enter the title as Y6 Precast Beam

e Select model units of N,mm,t,s,C from the drop down list provided.

e Ensure the timescale units are Seconds
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| utilities

Section Property
Calculator

>

| Precast Section...

| utilities

Section Property
Calculator

>

Arbitrary
Section...

Modelling

e Ensure the analysis type is Structural

e Ensure the startup template is set as None

e Ensure the Vertical Z Axis option is selected

e Click the OK button.

Defining Longitudinal Beam Geometry

e From the Y Beams section
series select a Y6 section.

e Specify a slab depth of 250
e Enter a slab width of 2000
e Click the OK button.

The section will now be drawn.

Precast Beam Section Generator

—Precast beam

Precast section | vy geamg vl

Section no. 6 -

—Conerete slab

¥ Symmetric about beam centre line

Depth (D)[ 259 Left hand width (BI)
Width (B8) [ 2pog Right hand width {Br)

OK |

Cancel Help

Calculating Longitudinal Beam Section Properties

e Press Ctrl and A to select the
two surfaces defining the Y6
section

e Select the option Add to local
library so the calculated
properties will be available
from the local library when
required.

e Name the section Y6 Precast
Beam.

e Click the Apply button to
compute the section
properties. These will be
displayed in the greyed text
boxes on the right hand side

Arbitrary Section Property Calculator [ x]
—Calculated Properties
Area A 00
Second moment of area about x ads bee 0o
Second moment of area about y axds by 0.0
Product moment of area bey 0.0
Torsional constart J 0.0
Effective shear area in x direction Asx 00
Effective shear area in y direction Asy 00
Fadius of gyration about x axs e 0.0
Radius of gyration about y axis y 0.0
Shear centre, distance from centroid along x ads X0 0.0
Shear centre, distance from centroid along y axis Yo 0.0
Warping tersional constant Cw 0.0
Plastic neutral axis, distance from centroid along x axis xp 00
Plastic neutral axis, distance from centroid along y axis b 00
Plastic section modulus about x axis Zpx. 00
Plastic section modulus about y ds Zoy 0.0
Plastic torsional section modulus Znt 0.0
Angle to principal axis (ar ise +ve) Theta 0.0
[ Annctate properties ¥ Automatic meshing Maximum elements/line [ 15 3:
I¥ Recomput= sestion properties ¥ | Add to local library I™ Add to server library
Cancel Apply Help

of the dialog and written to the local library.
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Simple Grillage

e Click the Cancel button to close the dialog.

Creating the End Diaphragm Model

| File
[New...

Ql Create a new model and discard the changes to the previous model.
e Enter the file name as diaphragm

e Use the default working folder.

o Enter the title as End diaphragm

e Ensure units of N,m,kg, s,C are selected.

e Ensure the Structural user interface is selected

e Ensure the startup template is set as None

e Ensure the Vertical Z Axis option is selected

e Click the OK button.

Defining Diaphragm Geometry

| Geometry

[Surface S _I Enter coordinates of (0,0), (0.5,0),
~ [Coordinates... (0.5,0.5), (1,0.5), (1,0.75), (0,0.75) to define
a surface representing the end diaphragm

and slab (which is to be represented by the
end beam on the grillage model) and click
OK

W
W
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| utilities

Calculator

Section Property

>

Arbitrary
Section...

| File

New...

Modelling

Calculation of End Diaphragm Section Properties

Select the option Add local
library and name the section
End Diaphragm.

Click the Apply button to
compute the section
properties. These will be
displayed in the greyed text
boxes on the right hand side
of the dialog and written to
the local library file for future
use.

Click the Cancel
close the dialog.

button to

Creating the Grillage
Model

Now that the beam and diaphragm properties have been calculated the grillage model
can be created.

Arbitrary Section Property Calculator [ x]

[ Calculated Properties

Area

Second moment of area about x axs

Second moment of area about y axds

Product moment of area

Torsional constant

Effective shear area in x direction

Effsctive shear area iny direction

Radius of gyration about x axis

Radius of gyration about y axis

Shear centre, distance from centroid along x axdis

Shear centre. distance from centroid along y ads

Warping torsional constart

Plastic neutral axis, distance from centroid along x ads

Plastic neutral axis, distance from centroid along y axis

Plastic section modulus about x axis

Plastic section modulus about y axis

Plastic torsional section modulus

EEyEE2EER R g |T=E >

Angle to principal axs (ar ise +ve)

Theta |0.0

¥ Annctate properties
[#| Recompute

¥ Automatic meshing
section properties | Add to local library

Maximum elementsfine [15 =]

™ Add to server library

Name [ang diaphragm

Cancel

Apply Help

Ql Create a new model and discard the changes to the previous model.

Enter the file name as grillage

Enter the title as Simple grillage analysis

Set the units as kN,m,t,s,C

Ensure the Structural user interface is selected

Ensure the startup template is set as None

Ensure the Vertical Z Axis option is selected.

Click the OK button.

Note. Save the model regularly as the example progresses. Use the undo button to
correct any mistakes made since the last save.
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Simple Grillage

Using the Grillage Wizard

In this example the grillage wizard is used to generate a model of the bridge deck. The
grillage wizard defines the grillage geometry, assigns grillage elements to each of the
lines, and assigns supports to the end beams. It also creates Groups to ease member
identification and the application of section properties.

Note. It is difficult to make absolute recommendations as to how individual structures
/ should be modelled using a grillage. A few basic recommendations are however valid
for most models:

a) Longitudinal beams within the grillage should be coincident with the actual
beams within the structure.

b) Transverse beams should have a spacing which is similar or greater than that of
the longitudinal beams and the total number of transverse beams should be odd
to ensure a line of nodes occur at mid span.

| Bridge e Select the Set defaults button

Grillage Wizard...

e Ensure Slab deck is selected and click Next
e The grillage is Straight with 0 degrees skew so click Next again

e Enter the grillage width as 10 and the number of internal longitudinal beams as 6 .
Select evenly spaced longitudinal beams and click Next

e Leave the number of spans set as 1
e Enter the length of span as 20 and the number of internal transverse beams as 9

e Click Finish to generate the grillage model.
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| Utilities

Section Property
Calculator

>

Rectangular

Sections > Solid

Modelling

Calculation of Transverse Beam Section Properties

The internal transverse beams each represent 2m of slab so the section properties are
computed for an equivalent solid rectangular section.

End Diaphragm ‘ ‘ Slab ‘ ‘ Transverse Grillage beams ‘
° | o | ° | =+
r—lm—PZmAiZmA
Longitudinal Section
Enter a depth Of D = 0.25 Rectangular Solid Section Property Calculator
i~ Dimensional data i~ Calculated properties
Enter a width of B =2 b [0 iy s [is
B 2 : bi -
The section properties will : T e PO
be displayed in the greyed R W [T
text boxes on the right hand i by [0
side of the dialog. h—B— [
Note the torsion constant B |
) is calcula@ed_ as Mane [FES D0 ho [THERET
(0.0096). This is based on
beam th?Ol’y and iS nOt i ::: :: T:i!::::w Load sections.. | Create geometry... | Wisualize... |
appropriate to represent a o | cect | s | [ ]
slab in a grillage analysis. It

will be adjusted later in the example.

A section name of RSS D=0.25 B=2 is automatically created from the entered
dimensions.

Ensure the Add to local library option is selected and click OK to add the
properties to the local section library.

Modifying Section Properties for Grillage Analysis

When representing an isotropic slab using a grillage model, the effective torsion
constant (per unit width) can be shown to be ¢ = d*/6 (per unit width). It is
therefore common practice to assume 50% of the value calculated using beam
theory for a wide slab-like beam.
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| Attributes
| Geometric >
| Section Library...

| Attributes
| Geometric >

| Section Library...

Simple Grillage

In this example the transverse members represent only the slab and therefore their
torsion constant can be entered as ¢ = bd®/6 (i.e. 50% of the section library value).
The longitudinal members represent the precast beam and associated width of slab,
however, and therefore this reduction is only applied to the proportion of the
torsion constant exhibited by the slab.

When the transverse 0.25m deep 2m wide slab and the Y6 precast (longitudinal)
beams are selected from the local section library their section properties will be
adjusted to reflect this.

Adding Section Library Items to the Treeview

First, add the transverse slab section geometric attribute:

Select Grillage as the usage.

Select the User Sections library from the upper-right drop-down list.
Select the Local library type.

Select the RSS D=0.25 B=2 entry from the drop down list.

Select the Enter Properties option and reduce the torsion constant to 0.005 (as
discussed: ¢ = bd*/6).

Enter an Attribute name of Transverse Slab major z and click OK to add the
section properties to the 63; Treeview.

Next, add the Y6 beam geometric attribute:

Select Grillage as the usage.

Select the User Sections library from the upper drop-down list.
Select the Local library type.

Select Y6 Precast Beam from the name in the drop-down list.

Select the Enter Properties option and modify the torsion constant to be 0.020
(The computed value of the precast beam alone, 0.0143, plus the reduced
contribution from the slab; ¢ = bd3/12 = 0.005).

Enter an Attribute name of Y6 Precast Beam major z and click OK to add the
section properties to the & Treeview.

Note. Even though the Y6 beam was defined in millimetres the units can be extracted
from the library in metres. The units will be set to metres automatically as these were
the units selected on the New Model dialog.
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| Attributes
| Geometric >
| Section Library...

Modelling

e Lastly, define the end diaphragm geometric attribute:

e Select Grillage as the usage.

e Select the User Sections library from the upper drop-down list.
e Select the Local library type.

e Select End diaphragm from the drop down list.

e Click OK to add the section properties to the &b Treeview.

Note. When a section is used from a library without amending section properties or
the section’s orientation (as just done for the End diaphragm) the library name is
appended automatically to the automatic identifying name given in the dialog.

Assigning Geometric Properties to the Grillage Members

El Use the Isometric View button to rotate the model so that the following assignment
of the geometric properties can be seen.

I? Ensure the fleshing button is depressed in the toolbar menu.

Longitudinal members

The Y6 beam section properties are to be assigned to all the longitudinal members.

o In the ¢ Treeview select the Y6 Precast Beam major z entry and click on the

copy button.

e Inthe L=l Treeview select the Edge Beams group and click the El paste button to
assign the Y6 beam section properties to the edge beams.

Confirmation of the assignment will appear in the text window.

e Select the Longitudinal Beams group and click the El paste button again to
assign the Y6 beam section properties.

Transverse slab members

The slab section properties are assigned to the transverse members in a similar fashion.

o Inthe &b Treeview select the Slab D=0.25 B=2 (m) major z entry and click on the
copy button.
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| Geometry
Line >
Reverse...

Simple Grillage

e Inthe Treeview select the Transverse Beams group and click the EI paste
button to assign the slab section properties.

To clarify the display prior to assigning the diaphragm members the extent of the
fleshing of each grillage member can be modified as follows:

e Inthe [= Treeview, double click on the Attributes name, click the Geometry tab
and press the Settings button. Select Automatic cross-section end shrinkage and
click OK to update the display

Diaphragm members

The diaphragm section properties are assigned to the end diaphragms in a similar
fashion.

e Inthe & Treeview select the End diaphragm (m) major z entry and click on the

copy button.

e In the Treeview select the End Diaphragms group and click the El paste
button to assign the slab section properties.

From the fleshed image it can be seen that the end diaphragm members for the far end
are incorrectly displayed, and as a result the line directions of the lines to which they
have been assigned need to be reversed.

e Select the 5 lines at the far end of the grillage

This reverses the line directions of the selected lines to give the following image.
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| Attributes
Material >

| Material Library. ..

| Bridge
Bridge Loading >
Gravity

Modelling

Note. You can also check assignments by right-clicking on a group name in the
Treeview and selecting Select Members.

Defining the Material

Note. In this example a single material property will be used. If deflections and
rotations are of interest then separate analysis runs with short and long term properties
may be appropriate.

e Select material Concrete BS5400 from the drop down list, and Short Term C50
from the grade drop down list.

e Click OK to add the material dataset to the & Treeview.

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset 1sol (Concrete BS5400 Short Term C50) from the &b Treeview
onto the selected features and assign to the selected Lines by clicking the OK
button.

Loading

In this example seven loadcases will be applied to the grillage. These will be enveloped
and combined together to form the design combination.

Renaming the Loadcases

o Inthe = Treeview expand Analysis 1 and right click on Loadcase 1 and select the
Rename option.

e Rename the loadcase to Dead Load by over-typing the previous name.

Dead Load

Dead load is made up of the self-weight of the structure, which is defined as an
acceleration due to gravity.

Note. When a bridge deck is modelled by a grillage the slab area is included by both
the longitudinal and transverse members. This means that self-weight should only be
applied to the longitudinal members.

ﬂ Turn off the display of the fleshed members

e Aload dataset named BFP1 (Gravity -ve Z) will be added to the & Treeview.
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| Bridge

Simple Grillage

| Bridge Loading

|Surfacing....

>

e In the &b Treeview select the BFP1 Gravity -ve Z entry and click on the
copy button.
e Inthe L2l Treeview select the Edge Beams group and click the El paste button.

e With the Assign to lines and Single Loadcase options selected click the OK
button to assign the gravity loading to the Dead Load loadcase.

The self-weight dead load will be displayed on the edge beams.
e Inthe L=l Treeview select the Longitudinal Beams group and click the El paste
button to gravity loading.

e With the Assign to lines and Single Loadcase options selected click the OK
button to assign the gravity loading to the Dead Load loadcase.

The self-weight dead load on the internal longitudinal beams will be added to the
display.

Superimposed Dead Load

Superimposed dead load consists of the surfacing loads. These represent the self-
weight of the footways and the surfacing on the road.

Specify the surfacing loading for the footway:

e Leave the density as 2.4

Change the thickness to 0.25

Set the length to 20 and set the width to 2.5

Leave the skew angle as 0 and the origin as Centre

Click the Apply button to add the loading to the &b Treeview.
Now specify the tarmac highway surfacing load:

e Change the density to 2.0

e  Change the thickness to 0.1

e Leave the length as 20 but change the width to 3.5

e Click the OK button to add the loading to the & Treeview.

Discrete point and patch loads are positioned by assigning them to points which do not
have to form part of the model.
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| Geometry

| Paint

| Coordinates. ..

Modelling

El Enter the coordinates of the mid point of each footway and each notional lane
(10,0.25), (10,3.25), (10,6.75), (10,9.75) and click OK

<. N/ On the status bar at the bottom of the display, click the Z axis button to
return to a global Z direction view.

e Select the points at the centre

of each footway by holding the J/)
Shift key down to select points Select these
after the initial selection. points to assign

e Drag and drop the discrete -footway surface
loading dataset Pch2 Surfacing  l0ading

20mx2.5m Skew=0.0 |
Thickness=0.25m Density=2.4 \I\

tm~3 onto the selected points.

° Select Include Full Load [MEEEsEyGEnEEEr T =]
frO m the d I’Op dOWﬂ I |St ~Patch transformation
ThIS W| I I ensure the IND Attribute Selected j
portlon Of the pavemer_]t "~ Load transformation
Ioad A WhICh IS IND Attribute Selected j
or:/erhan.?lmg the eéjgle c_>f L
the grillage model is e =
applied to the edge
beamS. " Project onto line (2D line beam and frame models)

r Ignore projection direction moments

e Enter Superimposed

& Project over area (grilages, slabs and 30 space frames)

Dead Load as the € Project inko volume {solid madels)
Loadcase and Cl |Ck O K Options for loads outside search area IIncIude Full Load j
to assign the loading. Analysis [analysis 1 =l

Loadcase

The loading will be visualised.

¥ et as active loadcase

Load Fackor I 1.0

a4 I Cancel Help

Patch load divisions

The Patch divisions object seen in the & Treeview controls the number of discrete
point loads used to represent a patch load. By default a specified number of 10
divisions is used. However, for this example, and for most real life uses a greater
number of divisions is required to accurately reflect the surfacing loading.

o Inthe &b Treeview double-click the Patch divisions object
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| Bridge

| Bridge Loading

United

>

Kingdom. ..

Simple Grillage

e Select the Distance between loads option and specify 0.5. Click OK to update the
patch divisions.

Now the road surfacing is to be assigned:

e Select the two points at the

centre of each notional lane. ees
. lect th
e Drag and drop the discrete <,i1] ?iic Mese
load dataset Pch3 Surfacing %;J;:L mll‘;ne
20x3.5 Thickness=0.1 >S9
: surface
Density=2 from the loadi
Treeview onto the selected —,:o:ecccicceiineiizlriios

points.

e Leave the loading option for loads outside the search area set as Exclude All Load
because for this load type it is irrelevant whether include or exclude is used since
the load length, which is positioned centrally, is the same length as the span length

e Select Superimposed Dead Load from the Loadcase drop down list.

e Click OK to assign the road surfacing load.

Vehicle Load Definition

HA loading is to be applied to each notional lane in loadcases 3 and 4. These loads are
defined using the UK vehicle loading definitions supplied with LUSAS Bridge.

e Select the Lane load (HA load) button.

e Select loading code BD 37/88, change the length to 20 and select the OK button to
add the load dataset to the &b Treeview.

e Select the Knife edge load (KEL load) button.

e Leave the notional width as 3.5 and the intensity as 120 and click the OK button to
add the load dataset to the &b Treeview.

e Select the Abnormal load (HB vehicle) button.

e  With the axle spacing set to 6 and 45 units of HB load select the OK button to add
the load dataset to the &b Treeview.

e Click the Close button to close the UK bridge loading dialog.
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Modelling

Assigning HA Loading

e Select the point defined at the
centre of the upper notional lane.

R
R

I
e
e
DR
ey

e
+ s

e Drag and drop the dataset Pch4
HA BD37/88 20m x 3.5m

Skew=0 (Centre) from the &
Treeview.

R

e Enter HA upper as the
Loadcase, leave other values as
their defaults, and click OK

e Select the point defined at the centre of the lower notional lane.

e Drag and drop the dataset Pch4 HA BD37/88 20m x 3.5m Skew=0 (Centre) from
the &% Treeview.

e Enter HA lower as the Loadcase, leave other values as their defaults, and click OK

Assigning KEL Loading

e Select the point defined at the
centre of the upper notional lane.

e L

e Drag and drop the dataset Pch5
KEL 120kN  Width=3.5m
Offset=0 Skew=0 (Centre) |

from the & Treeview.

e Enter KEL upper as the Loadcase and click OK
e Select the point defined at the centre of the lower notional lane.

e Drag and drop the dataset Pch5 KEL 120kN Width=3.5m Offset=0 Skew=0
(Centre) from the & Treeview.

e Enter KEL lower as the Loadcase, leave other values as their defaults, and click
OK

99



| File

Save

Simple Grillage

Assigning Abnormal HB Loading

e Select the point defined at the
centre of the lower notional lane.

e Drag and drop the dataset Pnt6
HB 6m spacing 45 units from .
the &b Treeview onto the ’
selected point.

o o+ | e
-

i

e Enter HB lower as the
Loadcase, leave other values as their defaults, and click OK

Save the model

El Save the model file.

Running the Analysis

&

With the model loaded:

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to solve.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, 2 files will be created in the directory where the model file resides:

U grillage.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

O grillage.mys this is the LUSAS results file which is loaded automatically
into the ‘X! Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.
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Viewing the Results

[New...

| File

| Script

| Run Script...

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O grillage_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as grillage and click OK
To recreate the model, select the file grillage_modelling.vbs located in the \<LUSAS

Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the () Treeview, and results for the first load
case will be set to be active by default.

Deformed Mesh and Summary Plot

A deformed mesh plot helps highlight any obvious errors with an analysis before
progressing to detailed results processing. The deformed shape will usually show up
errors in loading or supports and may also indicate incorrect material property
assignments (e.g. where the results show excessive displacements).

e If present, turn off the display of the Geometry, Attributes and Mesh layers in the
Treeview.
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e The Deformed mesh
layer should be turned on

by default in the
Treeview.. Double click
its name and select the
Specify factor option
and enter 300 Click the
OK button to display the
deformed mesh  for
loadcase 1.

El If necessary use the

Isometric View button to rotate the model.

e  Step through each of the loadcases in the (X Treeview using the Set Active option
and check each deformed shape looks correct for the supposed loading.

£ Wi Return to the view from the global Z direction.

Defining Envelopes and Combinations

The design combination will consist of all dead loads and an envelope of all live loads
factored by the appropriate adverse or relieving factor.

Adverse Factor
Loadcase name Relieving Factor
b 83
Dead Load 1.15 1.10 1.0
Super Dead Load 1.75 1.10 1.0
HA alone 1.5(*) 1.10 0
HA with HB 1.3 (% 1.10 0
Table 1

Note. According to BS5400 part 1 two safety factors should be applied to adverse

loading. Yriaccounts for the uncertainty in the applied loading and 7ss is a safety factor
to allow for modelling inconsistencies / inaccuracies.
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Viewing the Results

Note. (*) When designing to BD 37/88 the HA lane loading factors also include
additional lane factors. For a two lane structure these are noted in the tables which
follow.

Defining a Basic Load Combination 1

A basic load combination to investigate HA and Knife Edge loads will be defined.

On the Basic Combination dialog:

LI Add loadcases (3) HA upper, (4) HA lower, (5) KEL upper, (6) KEL lower

Note. To add a number of loadcases all together select the first loadcase in the list,
hold down the Shift key and select the last loadcase in the list (scrolling down the list if

necessary) and click the LI button.
Each loadcase selected then needs a corresponding lane factor to be specified.

e Select the Grid button and update the factors as shown in Factor column of the
following loadcase combination table.

Load Factor
Lane Lane Factor to
Loadcase name
Factor be used
Y1 Y3
HA upper 15 1.10 0.956 1.6
HA lower 1.5 1.10 0.956 1.6
KEL upper 1.5 1.10 0.956 16
KEL lower 15 1.10 0.956 1.6
Table 2

e Click OK to return to the combination properties dialog.
e Change the combination name to HA + KEL both lanes

e Click OK to save the combination definition.

Defining a Basic Load Combination 2

A basic load combination to investigate HA, HB and Knife Edge loads will also be
defined.
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| Analyses On the Basic Combination dialog:
Basicl .
Combination... LI Add result loadcases (3) HA upper, (5) KEL upper, (7) HB lower

Each loadcase selected needs the factor to be specified.

e Select the Grid button and update the factors as shown in Factor column of the
following loadcase combination table.

Load Factor L Fact
Loadcase name Lane Factor ane ractor
to be used

Yeu | V83

HA upper 1.3 1.10 0.956 1.4

KEL upper 1.3 1.10 0.956 14

HB lower 1.3 1.10 0.956 1.4
Table 3

e Click OK to return to the combination properties dialog.
e Change the combination name to HB lower, HA + KEL upper

e Click OK to save the combination definition.

Enveloping the Basic Live Load Combinations

| Analyses On the Properties dialog:
| Envelope

il Add combinations (8)HA+KEL both lanes and (9)HB lower, HA+KEL upper
e Change the envelope name to Live Load Envelope

e Click OK to save the envelope definition.

Note. When either a Max or Min smart combination or envelope is modified the
/ corresponding Max and Min dataset will be updated automatically.

Defining a Smart Combination

Smart load combinations take account of adverse and relieving effects for the loadcase
being considered. The Self-weight, Superimposed Dead Load, and the Live Load
Envelope will all be combined using the Smart Load Combination facility to give the
design combination.

104



Viewing the Results

| Analyses On the Smart Combination dialog:
| Smart Combination. ..

LI Add loadcase (1)Dead load and (2)Superimposed DL to the Included panel.

LI Add (10)Live Load Envelope (Max) and (11)Live Load Envelope (Min) to the
Included panel.

Each loadcase/envelope selected needs the permanent and variable factors to be
specified.

e Select the Grid button and update the Permanent Factor for the Live Load
Envelopes to 0 and ensure the Variable Factor for all loadcases are as shown in

the table.
Permanent Variable
Loadcase name Variable Factor (relieving) Factor to be
Factor used
Y1 V3
(1)Dead Load 0.15 0.10 1.0 0.265
(2)Superimposed DL 0.75 0.10 1.0 0.925
(10)Live Load _ _
Envelope (Max) 0 10
(11)Live Load _ _
Envelope (Min) 0 10
Table 4

Note. In this table the permanent factor is based upon the relieving factor from Table

1. The variable factor for Dead Load and for Superimposed Dead Load is based upon
the product of the adverse factors for both from Table 1 minus the permanent
(relieving) factor. The live load envelopes have already been factored in previous load
combinations (Tables 2 and 3) and, as a result, only a unity factor is applied as a
variable factor.

e Click OK to return to the combination properties dialog.
e Change the envelope title to Design Combination

¢ Click OK to save the smart combination.
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Selecting Loadcase results

o In the "= Treeview right-click on Design Combination (Max) and select the Set
Active option.

e Select entity Force/Moment — Thick Grillage results of component My from the
drop down lists to combine and apply the variable factors based on the moments
about the Y axis and click the OK button.

Note. When activating a smart combination the selected component is used to decide
if the variable factor should be applied. (The variable component is only applied if the
resulting effect is more adverse) Viewing results for a component other than the
selected component will result in display of the associated values (coincident effects).
When the results of an envelope or smart combination are printed the column used to
compute the combination or envelope is denoted with an asterisk in the column header.

Selecting Members for Results Processing

Results are to be plotted for selected longitudinal members of the grillage only. The
grillage wizard automatically creates groups which are useful in the results processing.

e In the Treeview select the Longitudinal Beams with the right hand mouse
button and pick Set as Only Visible

e Inthe L=l Treeview select Edge Beams with the right hand mouse button and pick
Visible

e Turn off the display of the Deformed mesh layer in the (= Treeview.

e Add the Mesh layer to the Treeview and click OK to accept the default
properties.

Bending Moment Diagram

A plot showing the bending moment from the design combination is to be displayed for
the selected members of the grillage.

e With no features selected, click the right-hand mouse button in a blank part of the
graphics window and select the Diagrams option to add the diagram layer to the
Treeview.

The diagram properties will be displayed.

e Select entity Force/Moment — Thick Grillage results of component bending
moment My

e Select the Diagram Display tab
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e  Select the Label values option.

e Select the Orientate flat to screen/page option.
e  Set the Label font to size 12

e Enter an Angle of 45 degrees

e  Set the Number of significant figuresto 4

e  Set % of element length to 60

e Click the OK button to display the bending moment diagram.

Note. Results plots which are to be printed are best created in the page layout view.

This provides a view that will appear similar to the printed output. Labels however may
however be difficult to read in the page layout view since they reflect the size of the
labels on the final printout. When this situation arises the zoom facility may be used to
examine labels of interest more closely.

| View e  Switch to page layout view.
Page Layout Mode
| utilities e Add a border to the page which contains the title, date and version of the LUSAS
Annotation > software in use.
Window border
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| Annotation
Window
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Print Results
Wizard...

Summary

Simple Grillage

e Ensure the orientation is set to Landscape. Change the page margins to enable the
annotation to be added without obscuring the display. Set the left margin to 50, the
right margin to 15 and the top and bottom margins to 10. Click OK

A summary of results will be added to the graphics window showing the loadcase name,
diagram component, maximum and minimum diagram values, and element numbers in
which the maximum and minimum moments occurs.

e Select the annotation by clicking over any piece of text and then drag it the
summary text to an appropriate location on the plot.

Note. The location of any model feature, element or node can be found by using the
Advanced Selection facility. This can be used to find the location of the maximum and
minimum results values as the element number is output in the window summary text.

As well as creating a results plot, results can be printed for saving or copying to a
spreadsheet using standard Windows copy and paste.

Printing results for the active loadcase

Results values may be output to the screen in a tabular listing format for the active
loadcase or for any selected loadcase. With Design Combination (Max) currently set
active:

e On the Results Wizard dialog ensure Loadcases Active is selected and click Next.

e On the Results Entity dialog, select entity Force/Moment — Thick Grillage, type
Component and location Gauss Point. Ensure Primary component My is selected.

e Set the number of decimal places to 1 and click the Finish button to display the

results.
"LUSAS Yiew: Forces and Moments in Element Local Axes Loadcase = 12 Results File = ... [ljj=]
Element & Gauss point Fz M My(*) =
1 Element Gauss point Fz M My(*)
2 1 1 -3814 ¢ -20.8 T
3 1 2 3055 108 | -508 Properties. ..
4 1 3 3042 105 1123 2] Sort Ascending
5 1 4 2996 108 | 1725z | (EE—
8 { g BB <0G A Save as Microsoft Excel...
7 1 G -2905: 108 ¢ 2907
B i 7 258 -ina  asea oY Qe
] 1 g 2813 05 | 4050 BBk Crl+P
10 1 9 -2767: 108 | -4605
11 1 10 =272 108 ¢ 5157
12 1 11 -2675: 108 @ -5697
13 2 1 -2470: 104 -567 1
14 2 2 -242.4: 104 -E16.1
13 2 3 -2375: 104 -664.1 LI
A 2 [#F, Medelinfo }, 12:Design Combination (Mazx) (My)
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Viewing the Results

Note. When the active loadcase is an envelope or smart combination the results
printed will show the primary component (My in this case) marked with an asterisk.

Note. Hovering over the contents of a cell will display a datatip showing location
information and an associated value.

Saving printed results to a spreadsheet

When the Printed Results window is shown a context menu can be displayed allowing
the printed results to have their number of significant figures or decimal places
changed, be sorted in ascending or descending order, be saved to a spreadsheet or
copied for pasting elsewhere.

e Right-click inside the Printed Results window and select Save as Microsoft
Excel...

e Enter a file name of grillage_results
e Ensure the save option All tabs is selected and click Save.

Note that Microsoft Excel may impose limitations on the length of tab name permitted.

Printing results for selected loadcases

Results values may be printed for selected loadcases. To illustrate usage:

e On the Results Wizard dialog ReEs=s
ensure Loadcases Selected is I Hlloadcases
chosen and click Next. Fiter
’VStart IU_ Step ll_ Filter
e On the Loadcases dialog select ialrtln Incuded
results files or load combinations = ™ ™= [~

from the model and results panels o I

%B:HA +KEL both lanes
9:HE lavwer, HA + KEL upper
and press the Add to button Bilio | |t

0
o
& 13:Design Combination (Min) 0
0
0

=)

add them into the Included panel B 10:Live Losd Erwelope (M)
and CIiCk NeXt. @llzLiveLnad Ervelope (Min)
|51 ——) |

e On the Results Entity dialog, select
entity Force/Moment - Thick
Grillage, type Component and
location Gauss Point. Ensure Primary component My is selected.

< Back I Mext = | FEiriish | Cancel | Apnl Help

e Set the number of decimal places to 1 and click the Finish button to display the
results.
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Save the model

|Fi|k;ave— & e the modet fite.

Note. If the model file is saved after results processing, all load combinations,
/ envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Description

Simple Slab Deck

For software product(s): | LUSAS Bridge.
With product option(s): | None.

Description

A simply supported bridge structure consisting of an in-situ slab deck is to be analysed.
The geometry of the deck is as shown. The slab has 0.5m thick carriageways and 0.4m

thick footways.

> <

1.5m—

Fl.SmH?mgﬁl.qu N
| T 1

0.5m Am

o

The structure is subjected to loading defined in the Departmental Standard BD 37/88
Loads for Highway Bridges.

The units of the analysis are kN, m, t, s, C throughout.
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A

Modelling

Simple Slab Deck

Objectives

The required output from the analysis consists of:

O A deformed shape plot showing displacements caused by the imposed loading
O A diagram showing the bending moments in the slab

Keywords

2D, Shell, Bridge Loading, Moving Load, Eccentricity, Basic Load Combination,
Load Envelope, Peak Values, Deformed Mesh, Contours, Graphing, Wood Armer

Associated Files

U bridge_slab_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

e Enter the file name as bridge_slab

e Use the Default working folder.

e Enter the title as Simple Bridge Slab Analysis
e Change the model units to kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Startup template Standard.

e Select the Vertical Z axis option and click OK

112
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| Material >
| Material Library. ..

| Geometry
| Line >
Coordinates...
| Geometry
| Surface >
By Sweeping...
| Geometry
| Surface >
By Sweeping...
| Geometry
| Surface >
By Sweeping...

Modelling

Note. It is useful to save the model regularly as the example progresses. Use the undo
button to correct a mistake. The undo button allows any number of actions since the last
save to be undone.

Defining the Material

e Select material Concrete grade Ungraded from the drop down list and click OK to
add the material attribute to the &% Treeview.

e Select the Isol (Concrete Ungraded) attribute from the & Treeview with the
right-hand mouse button and select Set Default to make concrete the default
material for all newly created features.

Feature Geometry

il Enter coordinates of (0, 0), (10.5, 0) to define the lower Line. Use the Tab key to
move to the next entry field on the dialog. With all the coordinates entered click the
OK button.

e Select the line.

él Sweep the line through a translation of X=-1.5, Y= 1.5, Z = 0 and click OK to
create a Surface which defines the lower footway.

e Select the Line at the top of the footway.

él Sweep the Line through a translation of X= -7, Y= 7, Z= 0 and click OK to create
a Surface which defines the carriageway.

e Select the Line at the top of the carriageway.

él Sweep the Line through a translation of X= -1.5, Y= 1.5, Z= 0 and click OK to
create a Surface which defines the upper footway.

Meshing

The slab deck will be meshed using a Surface mesh. The number of elements in the
mesh can be controlled, by defining Line meshes, on the Lines defining the Surface
boundary. Other methods of controlling mesh density are also available.
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| Attributes

Mesh >
Surface...

| Edit

Select All

Simple Slab Deck

Defining a Surface Mesh

e Select a Thick shell element type which is Quadrilateral in shape with a Linear
interpolation order.

e Ensure a Regular Mesh that will allow Transition, Irregular and Automatic
meshing if possible.

e Enter the mesh attribute name as Thick Shell

e Click the OK button to add the mesh attribute name to the &b Treeview.
To assign the mesh to the model all features must be selected:

o Select all the features of the model, (the shortcut is to press the Ctrl and A keys at
the same time).

e Drag and drop the Surface mesh attribute Thick Shell from the & Treeview onto
the selected features.

The mesh will be displayed with each Line being split according to a default number of
divisions.

Note. One way of controlling the mesh density is by specifying the number of mesh
divisions along each Line. Since Modeller is fully associative, this will control Surface
mesh density.

Using Line Mesh Divisions

In this example 8 divisions per Line are required for the longitudinal Lines and
transverse Line representing the carriageway. A number of Line mesh divisions are

defined by default. These can be seen in the &b Treeview.

e Select the 4 Select these 6
longitudinal Lines as Lines for

shown. Hold the Shift 'Divisions=8'
key down after y //\4

selecting the first Line
to add the other Lines I .

to the selection. \&\ \y

e Still holding the Shift
key select the 2
transverse Lines of the ! >)\A\
surface representing the l )
carriageways.

¥
oy
v
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| Attributes

| Geometric
| Surface...

>

Modelling

e Drag and drop the Line mesh attribute Divisions=8 from the & Treeview onto the
selected features.

The mesh will be re-displayed to show 8 mesh divisions along each selected line.

Note. Holding down the L key while selecting ensures that only lines will be
selected. Similarly the P key limits the selection to Points, the S key; Surfaces, the V
key; Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes,
etc., which can be found in Modeller Manual.

Defining the Thickness and Eccentricity

The slab is 0.5 m thick in the carriageway region and 0.4 m thick beneath the footways.
e Enter a thickness of 0.5 and leave the eccentricity field empty.
e Enter the attribute name as Thickness 0.5

e Click the Apply button to define the first geometry attribute and allow another
dataset to be defined.

e Change the thickness to 0.4

Eccentricity measured Elementlocal zaxs
from mid surface of
0.4m thick slab to nodal
line in elementlocal z
direction.

Nodal line at
Mid surface of slab centre of 0.5m
in footway region thick slab

Note. The direction of the eccentricity is measured from the mid-surface of the slab to
the nodal line in the local element direction which follows the local surface direction.
Since in this example the mid-surface of the slab representing the footway is above the
nodal line, and the element local Z axis direction is vertically up, the eccentricity is
input as negative.

e Enter the eccentricity as -0.05
e Change the attribute name to Thickness 0.4

e Click the OK button to finish.
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Simple Slab Deck

| Local Coordinate. ..

The thickness is now assigned to each Surface.

e Select the Surface representing the carriageway.

e Drag and drop the geometry attribute Thickness 0.5 from the &b Treeview onto the
selected surface.

Geometric assignments are visualised by default.

e Select the two footway Surfaces, (hold down the Shift key to add the second
Surface to the selection).

e Drag and drop the geometry attribute Thickness 0.4 from the &b Treeview onto the
selected surfaces.

El Select the isometric

button to see the geometric
visualisation on the
members.

El The Zoom in button

can be used to check the eccentricity has been assigned correctly.

@l Select the Home button to return the model to the default view.

ll Select the fleshing on/off button to turn-off the geometric visualisation

Supports

The more common types of support are provided in the &b Treeview by default. In this
example the slab deck is to be restrained in the vertical and lateral direction at the
abutment edges, Additionally, a single pinned support will be assigned to one point on
the deck to prevent rigid body motion.

Before the supports can be assigned a local coordinate system needs to be defined so
the lateral displacement can be restrained in the skew direction along the length of the
abutment edges.

e Enter an angle of 45 for the rotation about the Z-axis.

e Enter the dataset name as Skew and click OK to add the Local coordinate attribute
to the c&: Treeview.

e By default the new Skew local coordinate system, is visualised within the view
global axes.
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To assign the abutment supports:

e Select the Six Select these 6 Lines
transverse Lines .
representing the end ‘@é =
diaphragms  (ensure ., ™,
the Shift key is used N ™
L ~, ™
to add to the initial \&
selection) ™.
™, : ™,
e Drag and drop the AN \\
local coordinate % i)
attribute  Skew onto T >

the selected Lines.
e Drag and drop the support attribute Fixed in YZ onto the selected Lines.
The Assign Support dialog will be displayed.
o  Ensure that the attribute is assigned to All analysis loadcases
e  Click the OK button to finish.

To assign the pinned

support: N =
. _ . N

e Select the single Point \\ ‘\\

at the origin
J AN \

e Drag and drop the \\\ \\\
support attribute . ! ™,
Pinned onto  the b Sy
selected Point. Select this Point [ ) ¥ ™

The Assign Support dialog
will be displayed.

e Ensure that the attribute is assigned to All analysis loadcases

e Click the OK button to finish.

Note. Since the slab is flat the in-plane rotation degrees of freedom for the thick shell
elements can be eliminated from the element formulation by deselecting the following
element option. This will remove ill-conditioning of the equations and reduce the
problem size. It should however be noted that if moment supports are to be applied with
this option deselected, rotation about the Z axis must be restrained to eliminate
mechanisms in the solution.
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| Model Properties...

| Bridge
|Bridge Loading >
| Gravity

| Bridge

|Bridge Loading >
United
Kingdom. ..

Simple Slab Deck

e Select the Solution tab and select the Element Options button. Deselect the option
to Assign 6 DOF to all thick shell element nodes and click the OK button to
return to the Model Properties, Click OK to return to the display.

Defining the Loads

Four loadcases will be defined:

U The self-weight of the slab (ignoring any surfacing loads).

O A patch load equivalent to a traffic load over the full length and width of the
upper traffic lane.

U A knife edge load acting at mid-span of the upper lane.
O An HB vehicle in the lower lane.

Self-weight

The self-weight is defined as a gravity acceleration in the negative Z direction. The
correct units are automatically calculated when the gravity loading is selected from the
bridge menu.

Lane Load

The second load will represent a lane load along the upper traffic lane.
e From the Vehicle Loading dialog select the Lane load (HA Load) button.
e Select loading code BD37/88 from the pull-down list.

e Enter the loaded length as 10.5, leave the notional width set as 3.5, set the skew
angle as -45 and the origin as Centre, then click OK to add the lane load patch

loading to the &b Treeview.

Note. Setting a skew angle on this patch load does not skew the whole load — it only
skews the ends of the patch load to match the angle of the skewed deck.

Knife Edge Load
e From the Vehicle Loading dialog select the Knife edge load (KEL load) button.

e Leave the skew angle as 0 and click OK to add the lane load patch loading to the
& Treeview.
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Abnormal Loading

e From the
Vehicle Loading | ehicle details

dialog select the D L
Abnormal _ P B
Load (HB Inner axle spacing [m) Iﬁ o -BIE—-—EE _____ E};-._EI;_
Vehicle) button. Nurber of HE Lrite (25 - A — B
(25 - 45) |45— Tm 'Eia"'aﬁ'___'%' 'Eia'
e Leave the Axle 18m|£11,16,21.26 m18m
spacing as 6

and the Number

of HB units as ok | cancel sooh | Heb |

45 and click OK
to add the HB

vehicle point load to the FoTreeview.

e Select Close to close the Vehicle Loading dialog.

Assigning the Self-weight Load

e To assign the gravity loading select all active features using the Ctrl + A keys
together and drag and drop the loading attribute BFP1 (Gravity -ve Z) from the
& Treeview onto the selected features.

The Loading  Assignment [EEXTrl e i
dialog will be displayed.
[ Assign to points [V Assign to surfaces
° EnSUre that the Assign to [ Assign to lines [T &ssign bo valumes
Surfaces button is selected :
. " allloadcases Analysis | Analysis 1 j
and click the OK button to I
aSSign the |Oad to AnalySiS ¥ single loadcase  Loadcase I 1:loadcase 1 j
1 Loadcase 1. More =3 | ¥ | 5et a5 active [nadcase
The load visualisation for ok | cancel | b |
Loadcase 1 will be displayed.

o To rename Loadcase 1 in the ‘= Treeview expand Analysis 1 and select Loadcase
1 with the right-hand mouse button, then choose the Rename option. Overtype the
loadcase name with the name Self Weight

Assigning the Lane Load and Knife Edge Loads

Vehicle and lane loads are represented by patch loads that are assigned to Points which
may form part of the model, or may be defined specifically to locate the bridge loads as
in this case:
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| Geometry
Point >
Coordinates...

Simple Slab Deck

El Enter coordinates as (-1.5, 6.75) and click the OK button to create a new Point in
the middle of the upper lane.

e In the Treeview move the Geometry layer name down to sit beneath the
Attributes layer so that the point defined can be seen.

The patch and knife edge loads can now be assigned to the Point that has just been
defined.

e Select the Point defined at the centre of the upper traffic lane.

e Drag and drop the loading attribute Pch2 (HA BD37/88 10.5m x 3.5m Skew=-45
(Centre) Patch 1) from the &b Treeview onto the selected Point.

The Loading Assignment dialog will
Patch transformation
appear' Mo Attribute Selected = |

The loading option to Project over area LINd:mh“’ES‘:Ed 5
will have been automatically selected.

Search area

IWhu\e model j

e Overtype the name of the loadcase to
be HA & KEL upper  Project onto line (2D line beam and frame madels)

™ Ignere projection direction moments

& Project over area (grilages, slabs and 3D space frames)

e Click on the OK to complete the W T )

H Options for loads outside search area | Excude All Load -
assignment. 5
The patch load will be visualised on the C -
model. Lomd Facter [10

l—
oK I Cancel | Help |

Note. The number of patch load

divisions in the patch is set in the ¥ Patch divisions object. By default ten patch
divisions are used in the long direction of the patch. For more detailed information on
discrete point and patch loads refer to the on-line help.

e Drag and drop the loading = .
attribute Pch3 (KEL 120kN “N S _\g,\\,“‘:\
Width=3.5m Offset=0 Skew=0 N T RS NTS,
(Centre))  from  the \\\\?\ \2"\\\'\?' ~ \\\
Treeview onto the selected o “
Point. ANy o
\\ 'y \"\.
e  Select the loadcase name HA & s s,
KEL upper from the loadcase N A

drop down list and click the
OK button to assign the load.

The assigned patch loading for the upper lane should be as shown.
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Line >

| Coordinates...

| Bridge

Moving Load...

Modelling

Note. In this example the patch loading has been shaped to match the skew of the
deck but it could have alternatively been defined oversize in length and when assigned
to the model any loading outside of the model could have been excluded as necessary.

Rebuilding a model after a previous failed analysis

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.

Assigning the Moving HB Vehicle Load

The HB vehicle will be assigned to the points using the moving load generator. To use
this facility a line defining the path of the vehicle must be created.

e Click on a blank area of the model window to clear the current selection.

il Enter coordinates of (-3.25, 3.25) and (7.25, 3.25) to define a Line describing the
path of the HB vehicle and click OK

e  Select the Line just defined.
e Ensure the Moving vehicle load is set to Pnt4: (HB 6m spacing 45 units)

e Set the option Move the vehicle along path in equal number of divisions to 10
and click OK to generate loadcases 3 to 13 representing the HB load moving
forward across the bridge.

ElThe isometric view button can be used to rotate the model so the load directions
can be visualised.

Checking loading ~ &N

Loads on the model may be visually \\ \\

checked at any time by changing the ™ AN

. N N
active loadcase. N TR
LY DAL

o From the ‘5 Treeview select \,‘\: \\;\ :\\
Load ID=4 Line=17 Pos=6, s s,
click the right-hand mouse AN
button and select the Set Active option to see the mid-span position of the moving
load.

This process may be repeated for any loadcase.
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|Save

Saving the Model

The model is now complete and the model data should be saved before running
analysis.

El Save the model file.

Running the Analysis

=

With the model loaded:

;l Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful
Analysis loadcase results are added to the () Treeview.

In addition, 2 files will be created in the Associated Model Data directory:
U bridge_slab.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U bridge_slab.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O bridge_slab_modelling.vbs carries out the modelling of the example.
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[New...

| File

| Script

|Run Script...

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as bridge_slab and click OK

To recreate the model up to the point of defining the moving load, select the file
bridge_slab_modelling.vbs located in the \LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Assigning the Moving HB Vehicle Load earlier in
this example and continue from this point.

Viewing the Results

[ View

| Page Layout Mode

| File

| Page Setup...

In this section the results produced by the analysis of the slab will be examined. There
are a number of ways to do this in LUSAS, allowing users to choose the most
appropriate way to present their results. For this problem the following are required:

U A plot of the deformed mesh.

O A colour-filled contour plot of bending moments in the X direction due to a load
combination.

U A graph showing the variation of bending moment along a section of the slab.
O A contour plot of Wood-Armer reinforcement moments in the slab.

Selecting the results to be viewed

Loadcase results can be seen in the @ Treeview, and the loadcase results for the first
loadcase (self weight) are set active by default.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Results could be viewed using this mode of operation, but in order to
allow additional information to be added without obscuring the model, Page Layout
Mode can be used instead.

The graphics window will resize to show the model on an A4 size piece of paper in
landscape orientation.

e Ensure that left, right top and bottom margins are set to 60, 10, 10 and 10
respectively and click OK

To plot a deformed mesh the Attributes and Mesh layers will be hidden.
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e Click the right-hand mouse button on the Attributes entry in the [= Treeview and
select the On/Off option. The geometry will be hidden from the display.

e Repeat to turn off the Mesh layer.

8

If necessary, use the Isometric view button to rotate the model to the view shown.

Note. When required, the local coordinate system axes can be turned off by
deselecting the Show Definition option for the Skew entry in the &b Treeview.

This page layout view can be saved for subsequent re-use with other models.

Enter the view name as Landscape Page Layout and click OK

Displaying the deformed shape
e Inthe =" Treeview turn-off the display of the Geometry layer.

e With no features selected
click the right-hand mouse
button in a blank part of the
Graphics Window and select
the Deformed mesh option

to add the deformed mesh layer to the [=¥ Treeview.

e Click the OK button to accept the default deformed mesh properties values.

The deformed mesh plot for the first loadcase will be displayed.

Contour Plots
Results can be plotted as colour line or filled contour plots. Here, longitudinal bending
moments will be plotted as colour filled contours.

£ 1 Return the model to the default starting view by pressing the Z axis field
on the status bar at the bottom of the graphics window.
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e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select the Contours option to add the contours layer to the

Treeview.
The contours properties dialog will be displayed.

e Select Entity Force/Moment -
Thick Shell Component
moments in the X direction Mx

e Click the OK button to display
contours of moments in the X
direction.

Re-ordering the display
of the layers
Note. The order of the layers in the Treeview governs the order in which the

layers are displayed in the graphics window with layer names at the top of the list drawn
to the screen first. To see the mesh layer on top of the contours layer the mesh layer

needs to be moved down the [ Treeview to a position after the contours layer.

=

e

e Inthe Treeview select the
Deformed mesh layer, click
the right-hand mouse button
and select the Move Down
option. (This can also be
done by dragging and
dropping a layer name on top
of another layer name).

Note. Contours of results may be displayed which are either averaged at the nodes, to
give a smoothed contour display, or unaveraged to contour on an element by element
basis. Unaveraged nodal results are useful for checking for sufficient mesh refinement
(since they will display inter-element discontinuities in the solution). They are also used
to prevent the averaging of stresses across elements with dissimilar material or
geometric properties. By default contours are smoothed.

Moving information on the annotation layer

Text and other objects such as the contour key may be moved after their initial
placement.
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e Click on one of the items of text on the contour key. (This will select the key and
enable it to be moved).

e Click and drag the object to a new position on the left-hand margin of the page.

Marking Peak Values

e  With nothing selected click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties dialog will be displayed.
e Select Force/Moment - Thick Shell contour results of bending moment Mx

e On the same dialog, select the Values Display tab and ensure the Maxima and
Minima check boxes are selected to display the top 1% of results.

e  Set the number of significant figures to 4
e Change the angle to 45 degrees
e Select the Choose Font button and set the text size to 16 and click OK

e Click the OK hbutton to
redisplay the contours with
peak values marked. Note
that on the diagram shown
above the mid-span values
have been artificially
coloured white in order to be
visible when printed.

Defining an Envelope

Envelopes are used to automatically assemble the worst effect from a selection of
loadcases, combinations, or other envelopes. In this example an envelope is to be
assembled to show the worst effect from the moving HB vehicle.

To include just the moving load loadcases in the envelope:

e With Analysis 1 selected from the drop-down list select (3) Load ID=4 Line 17
Pos=1 Dir=Fwd from the loadcase panel. To select all HB moving loadcases hold
down the Shift key, scroll down the list and select (13) Load ID=4 Line 17
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Basic Combination

Viewing the Results

Pos=11 Dir=Fwd and click on the il button to add all the selected datasets to
the Included panel.

e Change the name to Moving load lower and click OK

e Two envelope attributes representing the maximum and minimum results will be
created in the ©= Treeview.

Note. Changing the properties of the max or min envelope will change the definition
of both envelopes.

Defining a Combination
Combinations can be used to view the combined effects of several results loadcases,
combinations or envelopes.

The combination properties dialog will appear. Loadcases Self Weight, HA & KEL
upper and the moving load envelope are to be included in the combination.

e With the model file selected from the drop-down list select both Self Weight and

HA & KEL upper and click the il button to add the loadcases to the
combination dataset with a factor of 1

e Select the envelope Moving load lower (Max) and click the LI button to add
the loadcase to the combination dataset

Note. By default loadcases are added to the combination with a factor of 1. This
factor may be changed by selecting the loadcase in the Included panel and changing the
load factor in the text box provided. Alternatively the factors may be changed in a grid
by selecting the Grid button.

e Change the combination name to Max Design Combination and click the OK
button to finish.

Note. To obtain the correct effect from the combined loads the combination should
only include one occurrence of each loadcase. Envelope and Combination definitions
are held within the model file.

Selecting and Viewing the Combination Results

e In the ‘& Treeview right-click on Max Design Combination and select the Set
Active option.

e  Select Force/Moment - Thick Shell results of component Mx and click OK
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The contour plot for Mx from the
load combination will be
displayed.

Note. The values layer is still

listed in the Treeview so the
maximum and minimum values of
Mx for the load combination will
also be shown.

Graphing the Results of a Slice

A graph is to be plotted showing the variation in bending moment through a specified
section of the slab.

If the model is in the XY plane the By Cursor dialog will appear.
e Ensure that Snap to grid is selected with a grid size of 1
e Click the OK button.

e Click and drag the cursor along the centre of the lower lane (Y=3) to define the
location of a section slice through the slab.

Note. The Y ordinate of the slice can be seen in the status bar I'1:3 . The X
and Y scales on the sides of the window will also help this selection.

The graph X axis values of distance through the deck are defined by the slice section.
The graph Y axis results now need to be specified on the slice data dialog.

e Select Force/Moment - Thick Shell results for Bending Moment in the X
direction Mx and click the Next button.

The graph Y axis results have now been defined and title information for the graph can
be added.

128



Viewing the Results

° Enter the graph title as 10 Eending morment My along lower lane
Bending Moment Mx L) SR LN A O 0 0 0
along lower lane e ;g
E -30 -
e Leavethe graph Xand Y &
axis names blank. S 80
-2 &0
e Click the Finish button to < 7
display the graph. = a
:-100
Note. If the graph axes labels = Bg
are left unspecified default 430 i
A O — W 0 WD WD ST WD WD WD WD WD e LD 0D W) WD O e gy
names will be used. e A R e e - A e

Coordinates (-6,3,0) to (8,3.09(1)
Note. The graph properties —8— My - 16:Max Design Combination() / Coordinates (-6,3 0) to (3,3,0)(1)
can be modified by clicking the right hand mouse button in the graph window and
selecting the Edit Graph Properties option.

E Close the graph window.

il Click on the selection mode button to return to normal cursor mode.

Wood Armer Reinforcement Plots
e Inthe = Treeview double-click on the Contours layer.
The contour properties dialog will be displayed.

e With the Force/Moment - Thick Shell entity selected, select Component My(B)
to display results of Wood Armer moments in the Y direction in the bottom of the
slab.

e Click the Wood Armer button.

e On the Wood Armer Options dialog Transverse
enter a Reinforcement skew angle of Reinforcement
135 degrees. Direction

e Click the OK button to return to the 135° Longitudinal
contour properties dialog. Reinforcement
Direction

e Click the OK button to display a plot of
Wood Armer contours of My(B) for the +ve
active combination.
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Note. Specifying the distance from top or bottom surface to centre of top or bottom
reinforcement is only used when plotting contours of M[UtilB] or M[ULilT]

Caution. The selected results component (My(B)) is different to that being used to
compute smart combinations and/or envelopes (Mx) and therefore the results displayed
will be coincident effects.

e Click the OK button to accept this.

Caution. The contour plot will show bending moment contours My(B) but the

Values layer will currently show values of bending moments in the X direction. i.e. Mx

since these were specified previously.

e Click Yes to change the g v
values layer to show >

maxima and minima

values of My(B).

Save the model

El Save the model file.

Note. When the model file

is saved after results processing, all load combinations, envelopes, and graph datasets, if
defined, are also saved and therefore do not have to be re-created if the model is
amended and a re-analysis is done at a later date.

This completes the example.

Note. A separate example covers Wood Armer slab assessment in more detail.

Note

e In this example the geometry and mesh attributes result in a regular mesh aligned to
the global axis. The use of an irregular mesh would mean that the results used for
the Wood-Armer plots will have different orientations over the whole slab and
hence be incorrect. In this circumstance a local coordinate set would need to be
used to orientate the shell element results to be consistent with the global axes in
order to obtain sensible components for use in the calculations.
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Viewing the Results

The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

Results transformations can be applied from the Treeview. Press
Transformed... and select Global axes to transform local element results into the
global axes.

131



Simple Slab Deck

132



Description

Wood-Armer Bridge
Slab Assessment

For software product(s):

LUSAS Bridge.

With product option(s):

None.

Description

A Wood Armer slab
assessment is to be
carried out on a 15m
long, 9.8m wide single
span, reinforced
concrete bridge deck.
The deck has a skew
angle of 11.3 degrees
and is 0.9m deep.

A load combination
comprising self
weight, upper and
lower lane loads, and
upper and lower knife
edge is to be created
from  the  results

11.3 degree skew angle

v

1.25
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, P —
4 I Upper lane

<« Boundaries of Pa}tch loads —— | 3.65

Sy |
I Positions of Knife 3.65

Lower lane ‘/ edge loads i
1.25

B

15.0 {

All dimensions in metres

obtained. Slab reinforcement is to be arranged orthogonally and has capacities of 1700
and 300 kNm in the chosen Mx and My directions.

Units of kN, m, t, s, C are used throughout.

Note. In order to create a generic example, no reference is made to any particular
design code or loadcase type.
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Modelling

Wood-Armer Bridge Slab Assessment

Keywords

2D, Simple Slab, Skew Angle, Wood-Armer Reinforcement, Wood-Armer
Assessment, Safety Factors, Self Weight, General Loading, Knife Edge Loading,
General Patch Loading, Combination, Contour Plotting, Display Peak Values.

Associated Files

O wood_armer_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as wood_armer

e Use the Default working folder.

e Enter the title as Wood Armer Slab Example

e Select model units of kN,m,t,s,C from the drop-down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Ensure the Standard startup template is selected

e Select the Vertical Z axis option

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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| Geometry
[Surface >
Coordinates...
| Geometry
Line >
Copy...
| Geometry
Line >
Copy...

Modelling

Feature Geometry

_I Enter coordinates of (0, 0), (15, 0), (16.96, 9.8) and (1.96, 9.8) and click OK to
define the slab as a single Surface.

Next, the edge of carriageway and - .
lane widths will be defined by

copying the lower Line of the main

span.

e Select the lower horizontal Line Select this Line

of the model.
M Enter the X translation as 0.25 ﬁ

[derived from 1.25*tan(11.3°] L

e Enter the Y translation as 1.25 metres, and click the OK button.
The edge of the lower carriageway will be drawn.
To define 2 notional lane widths of 3.65 metres.

e Select the Line just drawn.

&

[Tl Enter the X translation as 0.73
[derived from 3.65*tan{11.3°}]

e Enter the Y translation as 3.65

metres. @ Select this Line
e Enter the number of copies as 2

=g l=s.
L ="

J

e Click the OK button to finish.
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| Attributes
Mesh >
Surface...
| Attributes
Geometric >
Surface...

Wood-Armer Bridge Slab Assessment

Meshing

e Select Thick plate, *
Quadrilateral, elements with JF
Linear interpolation. ;’ }( }[ ,{ ){ ,'[ f ,{ ){ }( [r
/

e Deselect the automatic
divisions option and enter 10 A R R i

divisions in the local X jf ,/ ,r' )‘r f f f )‘fj ,‘rf f }"r
[ ] /

direction and 7 divisions in the sf J{ }( jlr
local Y direction. S .

. IR EED,
e Enter the attribute name as i
Thick Plate and click the OK button to finish.

LUSAS will add the Surface mesh attribute to the & Treeview.

e Select the whole model using the Ctrl and A keys together.

e Drag and drop the Surface mesh attribute Thick Plate from the & Treeview onto
the selected features.

Note. At any time the mesh (and other features) displayed in the Graphics area may

be turned on or off by right-clicking on the layer name in the l=* Treeview and selecting
the On/Off option.

e Turn off the display of the Mesh as just described.

Geometric Properties

e M Open the Units Convertor and Variation
Utility from the Thickness textbox.  [uit convertor

Convert from

e Convert from 900, selecting mm to convert [rm |
900mm to model units. Press OK to return.

To model units
|n.9 |m

e Enter the attribute name as Thickness 0.9.
Click OK to add surface geometry attribute to ~~ _+f ="t
the &b Treeview. ok | concdl | hep

e Select the whole model.

e Drag and drop the geometry attribute Thickness 0.9 from the & Treeview onto the
selected features.
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Modelling

| Material >
| Material Library. ..

!l Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

Material Properties

e Select material Concrete from the drop down list, leave grade as Ungraded and
click OK to add the material attribute to the &% Treeview.

e With the whole model selected, drag and drop the material attribute 1sol (Concrete

Ungraded) from the & Treeview onto the selected features, ensuring that Assign
to surfaces is selected click OK

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. Both inclined edges of the slab are to be simply supported in the Z
direction.

Assigning the Supports

e Select the 2 inclined Lines at
either end of the slab. (hold the
Shift key down to add to the first
selection).

-

Select these
Lines

e Drag and drop the support
attribute Fixed in Z from the
Treeview onto the selected
features.

) . —f=i= -
e Ensure Assign to lines and All
analysis loadcases are selected and click OK

The supports will be visualised.

Loading

Five loadcases will be considered, with an additional two combinations of these loads
created at the results processing stage.

137



Wood-Armer Bridge Slab Assessment

Modifying the Geometry to assign loading

To position knife edge loads additional Points are required at mid-span positions.

e Select the 3 horizontal Lines that
define the traffic lane
boundaries. (Hold the Shift key

Select these 3 Lines

down to add to the selection) | Ji
| Geometry e Select Use same divisions for
IM all lines and enter the number of
[By Spieing__ > divisions required for all as 2
In Equal
Divisions... - .
SVSRSs—— o Ensure the Delete original lines @
after splitting option is selected
and click OK e J
Additional Points will be created at
mid-span and existing Lines will be broken into 2 new Lines. The new Points will be
used later to define the position of the mid-span knife edge loads for each traffic lane.
Loadcase 1 - Self weight
| Attributes e Select the Body Force option and click Next
| Loading....

* Define the linear acceleration due to gravity in the Z direction as -9.81
e Enter the attribute name as Self Weight and click Finish

e With the whole model selected, drag and drop the loading attribute Self Weight

from the &% Treeview onto the selected features ensuring the loading is assigned to
Surfaces as Loadcase 1 and click OK

The self weight loading will .
be displayed.

L‘—‘—“

e In the & Loadcases
Treeview expand Analysis
1 then right-click on .
Loadcase 1 and select the
Rename option.

e Rename Loadcase 1 to i@
Self Weight i

W
o
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Loading...

Modelling

Loadcase 2 - Lane load (lower lane)

Select the first point, o '
hold down the Shift key I J
and select point 2, 3 and
4 in the order shown to
define the patch area. @4. Select this Point

3. Select this Point

In the Discrete panel
select the Patch option
and click Next

The coordinates of the - J
Points selected will be °
inserted into the coordinate . . ) .
fields. 1. Select this Point 2. Select this Point

Enter a load value of -15 (kN/m?) for each coordinate.

De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction and 0 in the y direction so that the number of loading points in the patch
y direction will be computed automatically from the aspect ratio of the patch.

Enter the attribute name as Lane load (lower) and click Finish

Note. The order in which the Points are selected determines the local x and y
directions of the patch load. The local x direction is from the first Point to the second
Point selected. The local y direction is from the second to the third Point.

Select the Point shown at
the origin of the
structure.

I
—

Drag and drop the
loading attribute Lane

g‘;‘d (lower) from the Select this Point o

Treeview onto the assign Patch Loading

selected Point.

Ensure  Options  for o ) I

loads outside search
area is set to Exclude all
load

Enter the loadcase as Lane load (lower) with a load factor of 1 and click OK

The loading will be displayed.
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Note. Because the coordinates of the patch load were taken from the coordinates of
the Points, the patch load must be assigned to the Point at the origin of the structure.

Loadcase 3 - Lane load (upper lane)

e Select the Points in the
order shown to define the
patch area for the upper
lane.

3. Select this Point @1

i
e In the Discrete panel / 4. Select this Point

select the Patch option -

and click Next 2. Select this Point
The coordinates of the 1. Select this Pomt
Points selected will be % JT
inserted in the coordinate
fields. Assign patch load to this Point

e Enter a load value of -15
(kN/m?) for each coordinate.

o De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction and 0 in the y direction.

e Enter the attribute name as Lane load (upper) and click Finish

e With the Point at the origin of the structure selected, drag and drop the loading
attribute Lane load (upper) from the &% Treeview onto the selected Point.

e Ensure Options for loads outside search area is set to Exclude all load

e Enter the loadcase as Lane load (upper) with a load factor of 1 and click OK
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| Attributes
Loading...

Modelling

Loadcase 4 - Knife edge load (lower lane)

e Select the Points in the
order shown to define the

knife edge load position i
for the lower lane. 2. Select this Point

Y,

e In the Discrete panel
select the Patch option
and click Next

1. Select this Point

e Select the Straight Line @

option. b Assign Knife load to this Point. [

The coordinates of the
Points selected will be inserted in the coordinate fields.

e Enter a load value of -32.24 (kN/m) for each coordinate.

o De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction.

o Enter the attribute name as Knife edge load (lower) and click Finish

Note. The order in which the Points are selected determines the local X direction of
the knife edge load. The Local X direction is from the first Point to the second Point
selected.

e With the Point at the origin selected, drag and drop the loading attribute Knife edge
load (lower) from the & Treeview onto the selected Point.

o Enter the loadcase as Knife edge load (lower) with a load factor of 1 and click OK

Load case 5 - Knife edge load (upper lane)

e Select the Points in the order shown 2 Select this Point

to define the knife edge load 7 1
position for the upper lane. .

e Select the Discrete Patch option / 1. Select this P%‘; /
and click Next

e Select the Straight Line option. _ , o /
Assign Knife load to this Point.

/

The coordinates of the Points selected
will be inserted in the coordinate fields. f

e Enter a load value of -32.24 (kN/m) for each coordinate.
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e De-select the Use default button in the Patch load divisions panel and enter 15 in the
x direction.

e Enter the attribute name as Knife edge load (upper) and click Finish

e With the Point at the origin selected, drag and drop the loading attribute Knife edge
loading (upper) from the & Treeview onto the selected Point.

e Enter the loadcase as Knife edge load (upper) with a load factor of 1 and click OK

Visualising Loadcases

Loadcases can be visualised at any j f

time by activating each loadcase in the A

(& Treeview.

o From the ‘E Treeview select the .

- LR B B B B A R

Lane_ load (lower) loadcase, click 4 3 5 b s 5 b s s b e s s s s
the right-hand mouse button and b e b b e b b s e s s oa
select the Set Active option. Mo b 6 4 4 4 4 5 4 6 4 0 b b 9

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U wood_armer.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Running the Analysis

O wood_armer.mys this is the LUSAS results file which is loaded
automatically into the () Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 wood_armer_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as wood_armer and click OK

e To recreate the model, select the file wood_armer_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.
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Wood-Armer Bridge Slab Assessment

Viewing the Results

Combinations

A combination will be created to apply the ultimate limit state (ULS) factors and lane
factors to loadcases 1 to 5. Typical ULS and lane factors can be found in relevant
design codes.

Dead load factor ULS
combination Loadcase Factor Factor
Calculation
O Dead load factor vy = 1.15 Self weight | v X Vs 1.265
U Additional factor v = 1.1 Lane load By X V1 X Vs 165
(lower)
Lane load Bz X Ya X Y3 1.65
Live load factors for ULS (upper)
combination Knife edge load | B1 X Ya X 3 1.65
O Lane factors ;=10 and [(1OWeD
B,=1.0 Knife edge load | B2 X ya X Ys3 1.65
U Live load factor yq = 1.5 (upper)

U Additional factor v = 1.1

Defining a Combination

Combinations can be created to view the combined effects of multiple loadcases on the
structure. A combination dataset Combination 1 is to be created in the {2 Treeview

| Analyses The combination properties dialog will appear. All 5 loadcases should be included in
|Basic Combination  the load combination panel.

e Select loadcase Self Weight hold the Shift key down, scroll down, and select Knife
edge load (upper).

e Click the LI button to add the loadcases to the combination dataset.

Note. To obtain the correct effect from the combined loads in this example the
/ Combination should only include one occurrence of each loadcase.

144




Viewing the Results

Assigning load factors

e In the Included panel on the Combination dialog, select the Self Weight loadcase
and enter load factor of 1.265 in the load factor text box.

e For each of the other 4 loadcases, select each loadcase in turn and enter a factor of
1.65

e Select the Grid button to check all the factors are entered correctly and click OK to
return to the combination dialog.

¢ Click OK to create the combination dataset.

Selecting Loadcase results
o Inthe ‘= Treeview right-click on Combination 1 and select the Set Active option.
o If present in the =¥ Treeview turn off the Geometry and Attributes layers.

e Turn on the display of the Mesh layer in the [ Treeview.

Contour Plots

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview.

The contour properties dialog will be displayed.

Moments in the X direction

e Select Force/Moment - Thick Plate contour results.
e Select the MX component.
e Click the OK button to display contours of MX for Combination 1.

e To display the mesh on top of the contours, select the Mesh entry in the
Treeview and drag on drop it on top of the Contours entry in the 5 Treeview.
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Marking Peak Values

The properties dialog of the values
layer will be displayed.

With nothing selected click the
right-hand mouse button in a
blank part of the graphics
window and select the Values
option to add the values layer to

the Treeview.

=1 3607TES

Select the Force/Moment — Thick Plate entity.
Select the MX component.

Select the Values Display tab and set Maxima and Minima values to display the
moments for the top 0.1% of results.

Click the OK button to redisplay the contours with peak values marked.

Moments in the Y direction

In the Treeview double-click
on the Contours layer.

Select the Force/Moment -
Thick Plate entity.

Select the MY component.

Click the OK button to display
contours of MY for Combination
1.

Note. The values layer is currently displaying results for MX.

Select Yes to change the values layer results to match those of the contours layer.

146



Viewing the Results

Moments in XY direction

e Inthe Treeview double-
click on the Contours layer.

e Select the Force/Moment -
Thick Plate entity.

e Select the MXY
component. Click the OK
button.

e Select Yes to change the
values layer results to match
those of the contours layer.

4.23038

Wood-Armer Reinforcement Moments

Note. For the following section, it is assumed that you are familiar with the theory of
Wood Armer as an explanation is beyond the scope of this example. If additional
information is required consult the LUSAS Theory Manual. Initially, Wood Armer
reinforcement moments Mx(B) in the bottom surface of the slab will be calculated.

Wood Armer Moments in X direction of the bottom of the slab

o In the =¥ Treeview double-click on the Contours layer.

o Select the Force/Moment - Thick Plate entity.

o Select the MX(B) component to view contour of Wood Armer moments in the X
direction for the bottom of the slab. Click the OK button.

e Select Yes to change the values layer results to match those of the contours layer.

From the resulting Wood Armer
plot it can be seen that the
maximum value of Mx(B) is
1545 KkNm. This value is
compared with the maximum
slab capacity (1700 kNm) to
determine the safe load carrying
capacity. In this case the slab
passes the assessment.

147



Wood-Armer Bridge Slab Assessment

Wood Armer Moments in Y direction of the bottom of the slab

The Wood Armer moments in the direction of the reinforcement on the bottom Surface
My(B), are now to be examined.

¢ Inthe = Treeview double-click on the Contours layer.

e Select the Force/Moment - Thick Plate entity.

e Select the MY(B) component to view contours of Wood Armer moments in the Y
direction for the bottom of the slab.

e Click the OK button.
e Select Yes to change the values layer results to match those of the contours layer.

The plot indicates a maximum
applied sagging Wood Armer
moment My(B) of 389 kNm
This exceeds the slab capacity of
300 kNm and therefore this slab
fails assessment.

03115

Note. Normally the analysis
would be continued to calculate
the reduction in live load that
would be necessary to obtain a
situation where the applied moment My(B) equals the capacity of the slab My*(B). This
would result in a restriction in the load carrying capacity of the slab.

Wood Armer - Discussion

It is generally accepted that the Wood Armer equations when used in the assessment of
the load carrying capacity of slabs provide a safe but conservative estimate of the
structural capacity. It is possible to obtain significant improvements using alternative
equations based on the fundamental principles of Wood Armer.

Note. A detailed explanation of the modified equations is beyond the scope of this
example, however the user may find it beneficial to consult the following references:

U Concrete Bridge Design to BS5400. L.A Clark. Published by Construction
Press. Appendix A. Equations For Plate Design.

U The Assessment of Reinforced Concrete Slabs. S.R Denton, C.J Burgoyne.
The Structural Engineer. Vol. 74. No. 9. May 7.

In outline, the method adopts a safety factor approach, where the user inputs the slab
capacity of the reinforcement and the reinforcement skew angle. Since the slab can
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Viewing the Results

potentially fail in flexure about any axis in the plane of the slab, the method examines
the applied moment field (Mx, My, Mxy) against the moment capacity field (Mx*,
My*, Mxy*) for all possible reinforcement skew angles.

The method returns minimum safety factors for top (hogging) and bottom (sagging)
reinforcement for each nodal position.

Note. Top and bottom safety factors are possible at any single position due to the
application of mixed moment fields.

Wood Armer Assessment

In the [&* Treeview delete the Values layer.

e In the Treeview double-click on the Contours layer and select the
Force/Moment — Thick Plate entity.

e Select the MULil(B) component to select contours of Utility factors in the bottom of
the slab.

e Click the Wood Armer button. RER Rt

& Wood-Armer (bending only)

Formulation
L] Oﬂ the WOOd Armer OpthﬂS dla|Og ensure ’Vr' Clark-Wielsem (axial farce included)

the Reinforcement skew angle is set to 90 Renforcement skew angle [0
and the Distances to the centre of the Distance from top surface to center of top reinforcement | 0.0
rei nforcement are Set to 0l Distance from bottom surface to center of bottom reinforcement | 9.0

K Factor
K factor for non-minimised area of reinforcement | 1.0 ‘

W Assessment

The moment capacity of the slab in the

sagging and hogging zones needs to be Resstive momentfforce n the x-direction (top) | 1700
entered. Resistive momentfforce in the y- or alpha-direction (top) | 300

Resistive moment/force in the x-direction (bottom) | 1700
o Enter the Resistive moment in the X Resistive moment/force in the y- or alpha-direction (bottom) | 300
direction (top) as 1700

Cancel | Hep |

e Enter the Resistive moment in the y direction (top) as 300

e Enter the Resistive moment in the x direction (bottom) as 1700

e Enter the Resistive moment in the y direction (bottom) as 300

e Click the OK button to return to the contour dialog.

e Click the OK button to display contours of safety for the moment capacities entered.

Note. Specifying the Distance from top or bottom surface to centre of top or bottom
reinforcement is not applicable for Thick Plate elements. It is only used with Shell and
Ribbed Plate Elements.
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Wood-Armer Bridge Slab Assessment

Note. Wood Armer skew angles are measured anticlockwise from the x-axis towards
the y-axis.

Note. In the Wood Armer  combinstion
dialog, hogging moment capacity E”"““F°'°:fh"::;;")‘

ayn ampanent ]
values are entered as +ve (positive) ’

values and the sagging moment .0.11130,

capacity values are entered as -ve 0222813

(negative) values. 033302
0445227

0556524
065754
0770147

0.290454

1.00176
Max 100421 at Hode &7
Min 2.54876E-3  at Mode 18

Changing the Contour range

If a utility factor plot shows values of less than 1.0, the slab is deemed to satisfy the
reinforcement criteria and no live load reduction is necessary.

To help clarify whether any regions of the slab have failed the assessment the contour
range will be modified.

e In the Treeview double-click on the Contours layer and select the Contour
Range tab.

e Set the contour Interval as 0.2 and the Value to pass through as 1
e Click the OK button to finish.

Contours of utility factors from 0 combination 1

to 1 will be displayed showing a  Entity: Farcemtoment N B |
small region in the centre of the  Component: MutiE) I B U
slab that has failed the iy
assessment according to the 02 | B ]
moment capacities used. o4 Y L AN |
oe B N

. R

This completes the example. Max 1.00431 st Node 57

Min 2.54876E-2  at Hode 12
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Description

Grillage Load
Optimisation

For software product(s): | LUSAS Bridge and LUSAS Bridge Plus

With product option(s): | Autoloader.
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example illustrates how the vehicle load optimisation facility is applied to grillage
models. Autoloader vehicle load optimisation is used using the reciprocal influence

method.
5
500 £
¥ - 8
750, [ ' 0 4550
1400 | | | ! | | | i
t |

F1450+—2400—+—2400—+—24|00—+—2400—+—2400—+1450»{
Cross Section

30400 30400

Abutment

—
-

7300

—

-

Road carriageway as Central Radius 500m
defined by kerb lines Support

Carriageway Definition
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Grillage Load Optimisation

The structure to be analysed consists of steel plate girders supporting an in-situ
reinforced concrete deck slab. Two spans of 30.4m each (skew span measurement) span
between the centreline of the support bearings.

The parapet beams are cast onto the structure after the deck slab has cured. This will
make the edge beam properties different from the internal beams however for simplicity
this will be ignored in this example. This assumption makes both the internal and edge
beam properties the same. The properties are computed assuming 6 transverse beams in
each span.

Note. The section properties stated are for the composite sections ignoring shear lag
effects, i.e. taking into account the full width of the slab. The composite sections have
been transformed using short term concrete modulii and are stated in “steel” units in the
table below.

Section Property Table ,(A\Arsfnrg (:32/32/ m:) Jm!
Edge Beam/Internal Beams (Uncracked) 0.12359 | 0.03777 0.697E-3
Edge Beam/Internal Beams (Cracked) 0.04151 | 0.01387 5.366E-6
Transverse Beams 0.1188 0.5012E-3 | 0.997E-3
Skew Beam 0.0684 0.2886E-3 | 0.575E-3
Diaphragms 0.05775 | 0.029E-3 0.107E-3

The structure will be designed to carry full HA loading and 30 units of HB loading as
derived from BD37/88.

Units of KN, m, t, s, C are used throughout.
Objectives
The required output from the analysis consists of:
O ULS and SLS values for selected locations on the structure.

Keywords

2D, Grillage, Autoloader, Load optimisation, Load visualisation, Influence

surface, Basic Load Combination, Smart Load Combination, Envelope

Associated Files

U spaced_beam_geometry.vbs carries out the definition of the section
properties.
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Modelling

Modelling

0 spaced_beam_modelling.vbs carries out the modelling of the example
without the loading applied.

Vehicle load optimisation in LUSAS

Vehicle load optimisation (VLO) makes use of influence surfaces and influence
analysis to identify the most onerous vehicle loading patterns on bridges for a chosen
design code and to apply these loading patterns to LUSAS models. A vehicle load
optimisation wizard provides the means of defining parameters, for a particular design
code, to generate the most critical traffic loading pattern for each influence shape under
consideration. The actual vehicle load optimisation software that is used to generate this
loading depends upon the design code chosen.

e For traffic loading assessment to Eurocode EN-1991-2, Australia AS5100-2:2004
and New Zealand (Transit New Zealand Bridge Manual) LUSAS Traffic Load
Optimisation (LUSAS TLO) software is used.

e For vehicle loading assessment to other supported design codes, Autoloader Vehicle
Load Optimisation software is used.

In this example, the grillage is loaded according to design code BD37/88, so
Autoloader is used.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as spaced_beam

e Use the Default working folder.

e Enter the title as Two span grillage analysis with load optimisation
e Select model units of kN,m,t,s,C

e Ensure the timescale units are Seconds
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| Bridge

Grillage Wizard...

Grillage Load Optimisation

e Ensure the analysis type is Structural

e Ensure the startup model template is set to None
e Select the Vertical Z axis option.

e Click the OK button.

Note. It is useful to save the model regularly as the example progresses. This allows a
previously saved model to be re-loaded if a mistake is made that cannot be corrected
easily by a new user.

Feature Geometry

The grillage geometry will be created using the Grillage Wizard.
e Select the Set defaults button

e Select Spaced beam and slab deck and ensure the cracked section is 15%. Click
Next

e The grillage is Straight with 40 degrees skew. Click Next
e Select an Orthogonal grillage arrangement and click Next

e Enter the width of grillage as 12 and the number of longitudinal beams including
edge beams as 6. Ensure Evenly spaced beams are used and click Next

e Change the number of spans to 2

e For each span enter the length of span as 30.4 and change the number of internal
transverse beams to 6

7

—u
.

f S UL

[ ]
Click Finish to generate the grillage model.

Defining the Geometric Properties

The geometric properties for this model are listed in the section property table at the
beginning of this example. However, for ease of use they will be read in using a file that
is supplied.
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| File

Modelling

| Script

| Run Script...

Open the file spaced beam geometry.vbs which is located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

Assigning Geometric Properties

This is best done by using copy and paste in the & and [2] Treeview panes.

Select the Edge Beam/Internal Beams (Uncracked) properties from the &
Treeview and click on the button.

In the L=] Treeview select the Longitudinal Uncracked Section group and click on

the El button.

Confirmation of the assignment will appear in the text window.

Select the Edge Beam/Internal Beams (Cracked) properties from the & Treeview
and click on the button.

In the Treeview select the Longitudinal Cracked Section group and click on

the El button.

Select the Transverse Beams properties from the & Treeview and click on the

button.

In the Treeview select the Transverse Intermediate Beams group and click on

the El button.

In the Treeview select the Transverse Central Beams group and click on the

El button.

Select the Skew Beams properties from the & Treeview and click on the
button.

In the L=] Treeview select the Transverse Skew Beams group and click on the EI
button.

Select the Diaphragms properties from the & Treeview and click on the
button.
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Grillage Load Optimisation

In the Treeview select the Internal Diaphragms group and click on the EI
button.

In the L=l Treeview select the End Diaphragms group and click on the El button.

Checking for correct geometric assignment

Turn off the display of the Mesh layer from the [=F Treeview.

Double click on the Geometry layer in the Treeview and select Assignment
from the Colour by drop down list.

Click the Set button and select Geometric from the Attribute Type drop down list.
Geometric Key

Edge Beaminternal Beams (Uncracked)

Diaphragms

- Skewy Beam

Tranzsverse Beams

Edge Beamidnternal Beams (Cracked)

h_
1
|
|
|
|
|
|
|
|
|
=S
|
|
|
|
|
|
|
I_
-

With the Generate key option selected click the OK button to return to the
Geometry properties dialog and OK again to display the geometry coloured by
geometric assignment with the key annotated.

To remove the ‘Colour by Attribute’ assignment double click on Geometry in the

Treeview, select Own Colour from the Colour by drop down list and click OK
to update the display.
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| Attributes

Material >
Material Library...

| Bridge

Bridge Loading >
Gravity

Modelling

Defining the Material

o Select material Mild Steel of type Ungraded from the from the drop-down list and
click OK to add the material dataset to the &b Treeview.

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Mild Steel Ungraded) from the & Treeview onto the
selected features.

Note. Because the geometric properties provided are transformed section properties
(as mentioned in the example’s description) Mild Steel properties are assigned to the
complete model.

Supports

The deck is supported in the vertical direction at each of the diaphragms. Since there
are no in-plane degrees of freedom no in-plane supports are required. The grillage
wizard automatically restrains the grillage from vertical displacement at each
diaphragm.

Note. If in-plane effects such as braking forces are to be considered the grillage
elements should be replaced by 3D beam elements and the appropriate properties and
supports should be assigned.

Self-Weight
This command adds Gravity -ve Z to the &b Treeview.

o With the whole model selected, drag and drop the loading dataset BFP1 (Gravity -

ve Z) from the & Treeview onto the selected features. Ensure the Assign to lines
option is selected and click OK to assign to Loadcase 1.

The gravity loading will be visualised on the model.

'
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| Attributes

Grillage Load Optimisation

| Influence
Reciprocal

| Attributes

Theorem...

| Influence
Reciprocal

| Attributes

Theorem...

[ Influence
Reciprocal

Theorem...

>

e From the (& Treeview expand Analysis 1 and then, using the right-hand mouse
button, select Loadcase 1 and select the Rename option. Change the loadcase name
to Self Weight

Loading the model using the Vehicle Load Optimisation
(Autoloader) facility.

In order to use the vehicle load optimisation facility the locations at which the
optimised load combinations are to be calculated and the parameter to be computed
must be chosen. To do this, influence attributes are defined and assigned to the model.
LUSAS then calculates the influence surfaces for any specified position in the structure
using the Muller-Breslau principle whereby the mesh is automatically “broken” at each
specified node and automatically constrained to act in the required manner. An
influence surface is generated for each of the chosen locations and parameters.

For this example three influence surfaces will be defined.

Defining Influence Attributes

Influence Point 1

The first influence attribute will be used to investigate the reaction at the left hand
abutment.

e Select a Reaction influence type for a Vertical axis influence direction for a
Positive displacement direction. Enter the influence attribute name as Reaction
Support 1 and click OK.

The influence attribute will be added to the c&: Treeview.

Influence Point 2
The second influence attribute will be used to investigate mid span bending in the first
span.

e Select a Moment influence type About Transverse axis direction for a Negative
displacement direction (because we are interested in the maximum sagging
moment). Enter the influence attribute name as Bending Span 1 and click OK.

Influence Point 3

The third influence surface attribute will be used to investigate the hogging moments at
the central pier.

e Select a Moment influence type About Transverse axis direction for a Positive
displacement direction (because we are interested in the maximum hogging
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Modelling

moment). Enter the influence attribute name as Bending Internal Support and
click OK.

Note. Longitudinal and Transverse directions are specified using the % Direction

definition object in the & Treeview . In this example the longitudinal direction is
defined to be the Global X direction, and the transverse direction is always assumed to
be orthogonal to the longitudinal direction.

Turning loading visualisation on and off

Iil At any time during this example any applied loading can, for reasons of clarity, be
turned on and off by selecting the Loading on /off button.

Assigning Influence Attributes

Influence attributes can be assigned to nodes or points. When modelling grillages
created by the grillage wizard there will always be a node at a point on the model, so
influence attributes could be assigned to points. But, in general usage, and for slab
analysis especially, influence attributes are better assigned to nodes. Influence attributes
can be assigned to as many nodes (or points) on the model as necessary. So, for
example, the Sagging Span 1 influence attribute could be assigned to all nodes in the
first span to specify influences for every node even though all nodes do not necessarily
need to be examined for particular influence surface examinations. However, for this
example, and for speed and clarity, only one node will be selected for each influence
attribute.

e  Turn off the display of the Geometry layer in the = Treeview.
e Turn on the display of the Mesh layer in the = Treeview
e If necessary turn off any loading visualisation.

1. Select this node

i
"‘\ H ?_> Select this node

2. Select this node

o

The first influence attribute will investigate the reaction near the centre of the left hand
abutment.
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e Select the node on the end diaphragm as shown.

e Drag and drop the influence attribute Reaction Support 1 from the & Treeview
onto the selected feature.

The second influence attribute will investigate edge mid-span bending in span 1.

e  Select the mid-span node at the edge of span 1 as shown.

e Drag and drop the influence attribute Bending Span 1 from the & Treeview onto
the selected feature

The third influence attribute will investigate hogging near the centre of the internal
support.

e Select the node at the internal support as shown.

e Drag and drop the influence attribute Bending Internal Support from the &
Treeview onto the selected feature

Visualising the Defined Influence Points

Influence attribute assignments
are visualised as they are assigned
to the model. To check that the
influence attribute orientations are
correct (meaning that the correct
influence directions have been
defined) an isometric view of the
model should be used.

El Select the isometric button.

e Ensure that the influence
visualisations are as shown

Using the Vehicle Load Optimisation facility to calculate
the worst case loading patterns.

The vehicle load optimiser (Autoloader) automates the creation of load datasets in
accordance with the chosen loading code for the locations and effects specified.

Before invoking the Vehicle Load Optimisation Wizard the kerb lines need to be
defined. This can be done by specifying coordinates but is best done by defining kerb
lines on the model.
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| Geometry
Line >
| ArciCircle >
From
Coords/Points

| Geometry
Line
| ArciCircle >
From
Coords/Points

|

| File

Save

Modelling

@l Select the Home button to return the model to the default view.

In the =¥ Treeview turn on the display of the Geometry layer.

Defining Kerb Lines

Specify the first point as (-5, 1) the second point as (75, 1). Define the third point
as (35, 20) and select the Direction option for the third point.

Enter the radius as 500 and ensure that Minor Arc is selected.
Click OK to define the first kerb line.

Specify the first point as (-5.584, 8.2766) and the second point as (75.584, 8.2766).
Define the third point as (35, 20) and set the Direction option for the third point.

Enter a radius of 507.3 and ensure that Minor Arc is selected
Click the OK button to define the second kerb line.

Select the first and second kerb line. (Use Shift to add to the initial selection)

L ]

"

Save the model
El Save the model file.

Rebuilding a model after a previous failed analysis

If a previous analysis of this example has failed you need to return to this point to
continue after having run the supplied file stated.
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| Bridge

Grillage Load Optimisation

Vehicle Load

Optimisation. ..

Carrying out Vehicle Load Optimisation

Ensure the two kerb lines are selected.

With the kerbs selected the vehicle load optimisation can begin.

Select the Defaults
button to reset any — Loading aptions
Settl ngs from any Country IUniled Kingdom j Optional code settings... |
preViOUS VehiC|e Ioad Design code IBD3?#88 j Optional loading parameters... |
optimisation runs.

— Solution process

Select U n |ted Kl ngdom ¥ Generate influence sulfaces Define carriageways... |
from the Country drop V' Generate optimised loading Set influence surfaces... |
dOWﬂ IISt' Analysis IVLD Analpsis 2 j
Select BD37/88 from the = Mame [0 Funt

Design Code d rop dOWﬂ Mote that the model will be zaved when OF. iz pressed

lists. Defaults | 0K | Cancel | Help |

VLO Analysis 2 will be automatically entered for the Analysis entry in the (&
Treeview. (Note that an alternative name can be entered by selecting the New option
from the drop-down list).

Enter the VLO run Name as VLO Run 1

Select the Optional code settings button.

The BD37/88 optional code settings will appear.

Ensure the options Use
HA Loading, Use HB | Standaid BD37/88 ptions
Loading and Use KEL ¥ Use HA lnading ¥ Use KEL loading ™ Use cusping
Loading are selected. [ Use HE loading Nurber of HB urits [ 30

Set the number of HB || Brewarefe
un |tS to 30 — Loading combinations to be analysed

Ultimate Lirit state [LILS] Serviceahility Limit state [SLS)
DeSEIBCt the Optlon tO ¥ Combination 1 ¥ Combination 2 ¥ Combination 1 ¥ Combination 2

Use cusping

— Advanced BD37/88 options

Click OK to set the [ Edit advanced BD37/88 code opfions Ldyanzed.. |
selected options and
return to the main Detaute |
vehicle load optimisation
dialog.

Cancel | Help |
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Select the Optional loading parameters button to display the optional loading
parameters dialog.

e Ensure the vehicle library is set as \<Lusas Installation
Folder>\Programs\Scripts\atl\VehicleFiles\autoload.vec

e Select HB from the drop down Vehicles list.
e Set Longitudinal increment to 0.25 and Transverse increment to 0.25

e Ensure vehicle direction is set to Both and click OK to set the options and return
to the main vehicle load optimisation dialog.

Note. By selecting ‘Edit Advanced Code Options’ on the Optional code settings
dialog and clicking the Advanced button some of the lesser used loading options may
be modified. This is also available for the loading options.

Having specified the loading options the carriageway positions need to be defined. In
this example the carriageway positions are defined from the selected kerb Lines.

e Select the Define carriageways button.

e Select the Kerbs from selection option and click Apply to define the carriageways
and return to the main dialog.

Finally the influence surfaces to be utilised must be defined.
e Select the Set influence surfaces button.
e Ensure Include all influence surfaces is selected.

e Ensure that each loaded influence area is set to Positive in the grid. This will
instruct Autoloader to solve for the worst positive effects on each of the specified
influence surfaces.

e  Ensure the increment for influence surfaces is set to 0.25
e Click OK to set the influence data and return to the main dialog.
The optimisation parameters are now set-up.

e Lastly, ensure the Generate influence surfaces and Generate optimised loading
are selected and click OK to carry out the load optimisation.

LUSAS Modeller will run the Solver to generate each of the three influence surfaces
and then run Autoloader to compute the worst position of vehicles for each influence
surface, generate the loadcases in Modeller.
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| File
[New...
| File
| Script >
| Run Script...

Grillage Load Optimisation

Running the analysis

Finally, the model needs to be solved using those critical loadcases:

e Press the Solve Now ;l button and on the dialog ensure every analysis is selected
and click the OK button to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the () Treeview.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding the Model

If errors have been made in defining the model that for some reason you cannot correct,
a file is provided to re-create the model information correctly.

U spaced beam_modelling.vbs carries out the modelling of the example
up to the point of using the vehicle load optimisation facility.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as spaced_beam and click OK

To recreate the model up to the point of using the vehicle load optimisation facility,
select the file spaced_beam_modelling.vbs located in the \LUSAS Installation
Folder>\Examples\Modeller directory.

Now return to the section entitled Vehicle Load Optimisation earlier in this example
and continue from that point.

Viewing the Results

Analysis loadcase results for VLO Run 1 are present in the () Treeview.
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Note. Because each influence attribute may be assigned to many nodes, the
coordinates of the node to which an attribute is assigned are also included in the
loadcase name in order to make it unique.

Load Visualisation

If it is required to visualise the load pattern for a particular loadcase, this can be done
by setting the results loadcase to be active.

If the Attributes layer is present and the |i| Loading on/off button is depressed
(signifying it is ‘on’) the loading patterns for the various results loadcases can be
displayed:

e In the @ Treeview expand both the VLO Analysis and Vechile Load
Optimisation Run 1 branches, then right-click on the model loadcase Bending
Span 1 - (Point...) - ULS1/Positive (4) and select the Set Active option to display

the load pattern.

"

Reactions at Influence Point 1

A plot showing the reactions is to be displayed.
e Turn off the display of the Geometry and Attributes layers in the =¥ Treeview.

o In the ‘B Treeview right-click on the results loadcase Reaction Support 1 —
(Point...) - ULS1/Positive (2) and select the Set Active option.

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties will be displayed.
e Select entity Reaction results for the component vertical reaction FZ
e Select the Values Display tab

e Plot the top 10% of the maxima values
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e  Set the Number of significant figuresto 4

e  Select the Choose Font button

e Select a font Arial style Bold size of 12

e  Click OK to return to the values properties dialog and OK again.

The design reaction at the fixed bearing (previously selected for influence surface
analysis) for the current loadcase Reaction Support 1 — (Point...) - ULS1/Positive (2)
will be displayed.

I bad .4
\‘\ A
e In the & Treeview, right-click on the Reaction Support 1- (Point..) -

ULS2/Positive (8) loadcase and select the Set Active option to display the design
reaction value.

I 3.
\‘4, "
e Select the remaining Reaction Support 1 results loadcases in turn and choose Set

Active to display the other corresponding SLS reaction values which are shown in
the following table:

7

|/

Location

(Group hame) Quantity ULS1 | ULS2 | SLS1 | SLS2

Reaction Support 1

(End diaphragms) Vertical reaction (FZ) 654.4 | 553.7 | 553.7 | 503.4
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Moments at Influence Point 2

To view the bending moments in an edge beam the groups facility will be used in
conjunction with the Diagrams layer.

In the Treeview right-click on Edge Beams group and select the Set as Only
Visible option.

Turn off the display of the Values layer in the = Treeview

In the (2! Treeview, right-click on the Bending Span 1 - (Point...) - ULS1/Positive
(4) loadcase and select the Set Active option

Add the Diagrams layer to the Treeview
Select entity Force/Moment — Thick Grillage results for the bending moment My
Select the Diagram Display tab

Select the Label values option, Label only if selected option, Orientate flat to
screen/page option and the Window summary option. Deselect the Peaks Only
option. Set the % of element length to 50, the label font to be size 20, the font
Angle to 45 and the significant figures to 4

Click OK to finish.

The window summary shows the maximum and minimum values.

Use the Zoom in button to enlarge the left-hand end of the lower-beam.

Drag a box around the beams of interest to view moment values on the beam.
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Scale: 1: 402,095

Zoom: 242782

Eve: (0.0,00,1.0)
Linearidynamic anakysis
Loadcase: 4:Bending Span 1 - (15575, 0.0, 0.0) - UL Positive (4)

Results file: spaced_heam.mys

Diagram entity: ForceMoment - Thick Grillage

Diagram component: hy

Diagram maximum 581 785 at Gauss point 1 of element 163
Diagram minimum -1 53267E3 st Gauss point 1 of element 24

Diagram scale: 1: 3.91474E-3

By changing the active loadcase this table of results for the design of the edge beam can
be generated.

Location

(Group name) Quantity ULS1 |ULS2 |SLS1 |SLS2

Lower edge beam

(Edge Beams) | Bending moment (My) | -1533 | 1207 | -1297 | 1179

Note. By selecting Peaks Only in the Diagram Display tab the labels can be limited
only to the maximum and minimum in the selection.

Note. If the values layer was used to investigate bending moments at points in the
grillage, care must be taken to ensure that unaveraged values are displayed for any
number of grillage elements coming together at a node rather than averaged values. If
so done, end shrinkage settings will allow the separate values to be seen in isolation.

Moments at Influence Point 3

e In the L=] Treeview right-click on Longitudinal Cracked Section group and select
the Set as Only Visible option.

o In the & Treeview, right-click on the Bending Internal Support - (X)) -
UL S1/Positive (7) loadcase and select the Set Active option.
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e Drag a box around the beams of interest to view hogging moment values on the
beam.

Scale: 1: 155 261

Zoaorm: 100.0

Eve: (0.0,0.0,1.00

Linearidynamic analysis

Loadcase: "7 Bending Internal Support - (36,4415, 7.2, 0.00 - ULS1 Positive (7)"

Results file: spaced_beam mys

Disgram entity: ForceMloment - Thick Grillage

Diagratm component; by

Disgram maximum 1.60122E3 at Gauss point 1 of element 198

Diagram minimum -522 973 at Gauss point 11 of element 200 —— — — — —

Disgram scale: 1; 3.74714E-3

By changing the active loadcase the remaining ULS and SLS results for the design of
the longitudinal beam over the support can be generated.

Location

(Group name) Quantity ULS1 | ULS2 | SLS1 | SLS2

Central pier
(Longitudinal Bending moment (My) 1601 | 1355 | 1355 1232
Cracked Beams)

This completes the example.
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Description

Bridge Slab Traffic
Load Optimisation

For software product(s): | LUSAS Bridge and LUSAS Bridge Plus

With product option(s): | LUSAS Traffic Load Optimisation (TLO).

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

This example uses the LUSAS TLO software option to aid in the linear static analysis
of a 3-span curved concrete bridge deck subject to Eurocode traffic loading.

N

Points of interest for influence surface generation

The structure is modelled using thick plate elements, representing a deck of inner radius
75m, outer radius 86m and thickness 0.7m. The deck has a width of 11m consisting of a
10m wide carriageway region and two 0.5m wide verges. The live loading is to be
calculated for three defined influence surfaces using the LUSAS TLO software option.

Units used are kN, m, t, s, C throughout.

Note. LUSAS TLO is a software option for LUSAS Bridge. It extends the vehicle
loading capabilities in LUSAS Bridge and produces worst-case traffic load effects more
easily and much faster than by manual methods. LUSAS TLO generates the most
onerous traffic load patterns according to a selected code of practice, based upon
influence surfaces for specified load effects (moments, shears, reactions, stresses etc) at
selected locations in the structure. A number of Eurocode National Annexes and other
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codes are supported. This example analyses a bridge deck using EN1991-2
Recommended Values. Subsequent analysis for comparison purposes is carried out
using the UK and Swedish National Annex options.

Modelling Objectives
The operations in the creation of the model are as follows:

Sweep a curved deck from a line.

Mesh the Surfaces with thick plate elements (regular mesh).

Define and assign geometric properties to describe the slab thickness.
Define and assign material properties.

Define and assign bearing supports.

Define and assign dead loading.

Define three influence surfaces which will allow calculation of the most onerous
traffic load pattern for:

1. Mid-span bending, inner curve, first span.
2. Mid-span bending, mid-node, second span.
3. Reaction at the first internal support.

U Use LUSAS TLO to calculate the most onerous traffic load pattern for the three
influence surfaces.

(I W W Wy Wy Iy

Keywords

2D, Slab, Modelling, Eurocode, Element Axes, Influence Surface, LUSAS TLO,
Vehicle Load Optimisation, Load Combination, Bending Moments, Reactions,
Transformed Results, Peak Values

Associated Files

U deck_modelling.vbs carries out the modelling of the slab deck for
subsequent use with the LUSAS TLO software option.

Vehicle load optimisation in LUSAS

Vehicle load optimisation (VLO) makes use of influence surfaces and influence
analysis to identify the most onerous vehicle loading patterns on bridges for a chosen
design code and to apply these loading patterns to LUSAS models. A vehicle load
optimisation wizard provides the means of defining parameters, for a particular design
code, to generate the most critical traffic loading pattern for each influence shape under
consideration. The actual vehicle load optimisation software that is used to generate this
loading depends upon the design code chosen.
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Modelling

e For traffic loading assessment to Eurocode EN-1991-2, Australia AS5100-2:2004
and New Zealand (Transit New Zealand Bridge Manual) LUSAS Traffic Load
Optimisation (LUSAS TLO) software is used.

e For vehicle loading assessment to other supported design codes, Autoloader Vehicle
Load Optimisation software is used.

In this example, the bridge deck is loaded according to EN1991-2 Recommended
Values, so LUSAS Traffic Load Optimisation is used.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as deck

Note. When saving a model for use with Autoloader a filename of 8 or less characters
must be specified.

e Enter the title as Deck analysis using traffic load optimisation
e Use the Default working folder.

e Set model units of kN,m,t,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the model template Standard

e Select the Vertical Z axis option.

e Click OK

Note. Save the model regularly as the example progresses. This allows a previously
saved model to be re-loaded if a mistake is made that cannot be corrected easily.
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| Geometry
[ Line >
Coordinates...
| Geometry
| Surface >
By Sweeping...
| Attributes
Mesh >
Surface...

Bridge Slab Traffic Load Optimisation

lly] .
The Undo button ﬂ may also be used to correct a mistake. The undo button allows
any number of actions since the last save to be undone.

Geometry

In this model, one span of the complete bridge deck is modelled in its entirety
(including specifying geometric properties, material, supports, etc.) before it is then
copied to form the complete 3-span structural model.

il Enter coordinates of (0,75) and (0,86) to define a Line representing the end of the
deck.
e Click the OK button to finish.

e Select the Line just drawn.

él Select the Rotate option and enter an angle of -7.5 1
degrees to rotate about the Z-axis about the origin 0,0

e Click OK to sweep the Line to create a surface

Meshing

This analysis will consider only out-of-plane bending effects, and no in-plane behaviour
therefore plate elements will be used. Note that when thick plates are used care must be
taken to ensure that results are transformed correctly when plotting contours and values
of bending moments.

e Select Thick plate, Quadrilateral, Linear elements.
Do not specify any mesh discretisation parameters,
this will be controlled by the mesh divisions on the
lines.

e Enter the dataset name as Thick plates and click OK

e With the whole model selected, drag and drop the

surface mesh dataset Thick plates from the
Treeview onto the selected features.
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Model Properties...

| Attributes

Geometric >
Surface...

| Attributes

Material >
Material Library...

Modelling

The default number of line mesh divisions of 4 divisions
per line will be drawn. This gives a somewhat coarse
mesh so the default number of line mesh divisions will
now be changed.

e With the Meshing tab selected, set the default number
of mesh divisions to 6 and click OK

The new mesh divisions will be displayed.

Geometric Properties

e Enter a thickness of 0.7

The eccentricity box should, in this case, be left blank. Using an eccentricity would
infer some in-plane effects, when, as described above, this analysis is intended to
consider only out-of-plane effects. In 3D structures where behaviour is dependent upon
both flexural and membrane effects— shell elements may be used.

e Enter the dataset name as Slab thickness and click OK

e With the whole model selected, drag and drop the

geometric dataset Slab thickness from the
Treeview onto the selected features.

Geometric property assignments are visualised by default.

e In the Treeview re-order the layers so that the
Attributes layer is at the top, the Mesh layer is in the
middle, and the Geometry layer is at the bottom.

Material Properties

e Select material Concrete of type Ungraded and click OK to add the material
dataset to the &% Treeview.

e With the whole model selected (Ctrl and A keys together) drag and drop the

material dataset Isol (Concrete Ungraded) from the & Treeview onto the selected
features and assign to the selected surfaces by clicking the OK button.

Supports

LUSAS provides the more common types of support by default. These can be seen in

the &b Treeview. In this example the deck is to be simply supported so the Fixed in Z
support will be used.

175



| Geometry

Bridge Slab Traffic Load Optimisation

Surface
Copy...

e Select the 2 support Lines shown.

e Drag and drop the support dataset Fixed in

Z from the & Treeview onto the selected &

Lines.
e Ensure the Assign to lines and All analysis Select
i . these 2
loadcases options are selected and click OK Lines

The supports will be visualised on the model.

To check the location and direction of the
supports:

El Use the isometric view button to rotate the
model.

e To complete the full model of the bridge deck
select the whole model using the Ctrl and A
keys together.

M Select the Rotate option and copy the features
selected through an angle of -7.5 degrees about the Z-axis and about the origin 0,0

o Enter the number of copies as 2 and click the OK button.

The full 3-span model of the bridge deck will be created.

Note. Many of the more common tasks are provided in a context menu for the View
window. With the model geometry selected clicking the right-hand mouse button within
the view will display a context menu with Copy, Delete, Move and Sweep.
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Self-Weight
| Bridge This command adds BFP1 (Gravity -ve Z) to the &b Treeview.
Bridge Loading >
Gravity e With the whole model selected, drag and drop the loading dataset BFP1 Gravity -
ve Z from the &b Treeview onto the selected features. Ensure the Assign to
surfaces option is selected and click OK to assign to Analysis 1, Loadcase 1.
The gravity loading will be visualised on the model.
e Inthe (5 Treeview, using the right-hand mouse button, select Loadcase 1 and select
the Rename option. Change the loadcase name to Self Weight
Defining a local coordinate system
Since this model is a curved deck a cylindrical local coordinate system will be used for
the direction definition. Specifying a direction definition sets the vertical, longitudinal
and transverse axes for a model to assist with model orientation and the calculation of
particular effects. A local direction definition is used for aligning influence attributes
along a singly curved bridge deck.
| Attributes e Select the Cylindrical option and ensure that the Z-axis option is set. Enter a
| Local Coordinate.... dataset name of Cylindrical about Z-axis and click OK
To use this local coordinate system:
| utilities ¢ In the longitudinal section of the dialog set the local axis to be Cylindrical about
| Direction definition... Z-axis for Theta and click OK.
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| Influence
Reciprocal
Theorem...

Influence Attributes

In order to use the vehicle load optimisation facility, it is necessary to identify what
guantity is to be optimised and at what location in the structure. This is achieved by
specifying appropriate influence surfaces - by defining and assigning influence
attributes to the model. LUSAS generates influence surfaces for each of the chosen
locations and load effects, and in this case, by using the Muller-Breslau (reciprocal)
theorem. Note that Direct Method influence attributes are also available and provide
different capabilities.

To make it easier to select the nodes required to define the influence parameters the
geometric and load visualisation will be removed from the display.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

|i| Select the loading on/off button to turn-off the loading visualisation

e Turn off the display of the Geometry layer in the [ Treeview.

For this example three influence surfaces will be defined.

Influence Surface Definition - Edge Mid-span Bending

The first influence attribute to be defined will be used to investigate mid span edge
bending in the first span.

e Select a Moment influence type nfluence

About transverse influence Iflencetype  [Momert ¥

direction ~ for a  Negative Inlence drectian  [4bout vanovee 3]

displacement direction (because we | Demcenemidiscion [Nessie 3]

are interested in the maximum

sagging moment). Attribute [Bending span 1 = = e
e Enter the influence attribute name as

Bending span 1 and click OK. ok | _oencel | oy | Hep |
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| Attributes

| Influence
Reciprocal

Theorem...

Modelling

e Select the mid-span node at the
inside edge of the first span.

e Drag and drop the influence
attribute Bending span 1 from

the cﬁ: Treeview onto the
selected node.

This adds an influence assignment
(with a corresponding coordinate)

to the @ Treeview.

Note. Influence attributes can be assigned to as many nodes or points on the model as
necessary. So, for example, the Bending span 1 influence attribute could be assigned to
all nodes in the first span to specify influences for every node (even though not all
nodes are necessarily required to be examined). However, for this example, and for
speed and clarity reasons, only one node will be selected for each influence attribute.

Influence Surface Definition — Mid-span Bending Span 2

The second influence attribute to be defined will be used to investigate mid-span
bending in the middle of the slab in the second span.

e Select a Moment influence type About transverse influence direction for a
Negative displacement direction (because we are interested in the maximum
sagging moment).

e Enter the influence attribute name
as Bending span 2 and click
OK.

e Select the node at mid-span of the
second span.

e Drag and drop the influence
attribute Bending span 2 from
the & Treeview onto the
selected node.

This adds the influence assignment to the () Treeview.

Tip. Giving influence attribute names that relate to each span and support (rather than
just defining one influence attribute called ‘Bending’ or ‘Reaction’ enables easier
identification of the influence results in the =) Treeview.
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Influence Surface Definition - Maximum Reaction

The third influence attribute to be defined will be used to investigate the maximum
reaction at the inner edge of the second line of supports.

| Attributes Select a Reaction influence type in the Vertical axis influence direction for a Positive
linfluence > displacement direction.
Reciprocal
Theorem..___ o Enter the influence attribute
name as Reaction support 2
and click OK.

e Select the node at the edge of
the first support as shown.

e Drag and drop the influence
attribute Reaction support 2
from the &b Treeview onto the
selected node.

Visualising the Defined Influence Points

Influence attribute assignments are visualised as they are assigned to the model. To
check that the influence attribute orientations are correct (meaning that the correct
influence directions have been defined) a plan view of the model should be used in this
case

@l Select the Home button to
return the model view to a plan
view.

e Ensure that the influence
visualisations are in the
orientations shown.

Define the Kerb Lines

Kerb lines are used to define the extent of a loadable carriageway.

e Turn on the display of the Geometry layer in the = Treeview.

e Select the Point at the left-bottom corner of the deck
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| Geometry
| Paint
| Copy...

| Geometry
| Paint
| Copy...

| Geometry
| Line >
| By Sweeping. ..

| File
|Save

| File
[New...

| File

| Script >
|Run Script...

Modelling

ﬂ Enter a translation of 0.5 in the Y direction. Click OK.

e Select the Point just created

ﬂ Enter a translation of 10 in the Y direction. Click OK.

e Select the two Points that have been created

él Select the Rotate option and enter an angle of -22.5 degrees to rotate about the Z-
axis about the origin 0,0

e Click OK to sweep the
Points to create a two lines
representing the kerbs

Save the model

El Save the model file.

This completes the preparation of the model for influence analysis.

Rebuilding the Model

If errors have been made in the modelling of this example that for some reason you
cannot correct, a file is provided to re-create the model information correctly, allowing
a subsequent analysis to be run successfully.

U deck modelling.vbs carries out the modelling of the example including
the loading.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as deck

e To recreate the model, select the file deck_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.
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Vehicle Load

Optimisation. ..

Using the Vehicle Load Optimisation facility to calculate
the most critical loading patterns

The vehicle load optimisation software option automates the creation of traffic load
patterns in accordance with a selected design code for locations specified on the model.
The example as written uses EN1991-2 Recommended Values, which is supported by
the LUSAS TLO software option. Other EN1991-2 National Annexes may be chosen.
Results for selected other National Annexes are shown at the end of the example.

Select the kerb lines

Prior to running the vehicle load
optimisation the kerb positions
defining the extent of the
loadable area of carriageway
must be selected. Ensure that the
Geometry layer is turned-on,
then:

e Select the two lines
representing the kerb
positions / extent of the traffic lane.

Define Vehicle Load Optimisation parameters

e First select the Defaults button
to reset any VLO settings from Liading options
any prevlous use Country IEWDDE j Optional code settings. . |

Design code IENT 991-2 Recommended V alue: j Optional loading parameters. |

e Select Europe from the Country  saltionprocess
drop down list.

v Generate influence surfaces Define carriageways... |

¥ Generate optimised loading Set influence sufaces. |

e Select EN1991-2
Recommended Values from the = Anebss VL0 #nshss2 =
Design code drop down list. Name VL0 Fun

Mote that the model will be saved when DK is pressed

e VLO Analysis 2 will be _0ea | ok | cwcd | ver |
automatically entered for the

Analysis entry in the (X Treeview. (Note that an alternative name can be entered by
selecting the New option from the drop-down list).

e Enter the VLO run Name as VLO Run 1
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Browse the optional code settings

° Se I ect the O pti Onal COde ENl‘]l*Z Remmnended Vaues
- . epresentatve values require
settings button and the optional ¢ g
loading parameters dialog will || ®consatenesn
appear for the design code 7 FeeE

™ Bussipemenent (FsiE]
selected.

losdgoupstoinclde —————|
¥ Group 1a- LM1
IV Group 4 - LM4
IV Group 5-LM3

Wehicle(s) | 5W18002000ow .

[¥ Include associated LM1

On this dialog any .representative L
values that are required and load s vefcatens il
groups that are to be included can be
specified. Special vehicle types can

be specified and advanced settings B

Edit advanced
[ EN1931-2/EM1930 Advarced)

oplions

0K | Cancel Help

can be defined. No changes are
required for this example.

Note that a single special vehicle (SVV1800200low) is specified as a default in these
recommended values and that a vehicle(s) appropriate to the structure being designed

should be specified in practice.

e Click the OK button to accept the default values and return to the main VLO dialog

Browse the optional loading parameters

e Onthe main VLO dialog, select the Optional loading parameters button

e On this Options dialog ensure the
H H H H ‘ehicle options
Longitudinal m_crement is set to 0.25, i =
the Transverse increment is set to 0.25 O

and the Vehicle direction is set to Both.

Wehicle direction

IBoth =

e Click OK to return to the main Vehicle Detauts [[ Ok ]

Cancel | Help

Load Optimisation dialog.

Define the carriageways

e On the main VLO dialog, select the Define
carriageways... button.

Because the kerb lines have been selected the carriageway
shape and angle of carriageway are known. Kerbs from
selection will be automatically selected

e Click Apply to return to the main Vehicle Load
Optimisation dialog.

Setup Carriageway Properties

[ Carriageway details

Camiageway shape  [Coned 7]
Mumber of carriageways I 1 3:
Angle of carriageway |2250—
Kerb posiions ———————————————————
1 Kerbs from tabular inp
@ Kerbs from selection

Apply | Cancel Help
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Define the influence surfaces

Vehicle Load Optimisation - Influence

e On the main Vehicle Load
Optimisation dialog, select | usamisiciuerce: Lot ofnnces 0 bo aalyosd
the Set influence surfaces (e
button.

e Ensure the Include all
influence surfaces option

is selected.

° Ensure the Increment fOI’ Search area to be used for reciprocal influences |De15un =l
influence surfaces is Set t0  newnentiorintuence surees mfrzs
025 Default ok | camd | Hap |

e Ensure the Positive direction option is selected for each influence
e Click OK to return to the main load optimisation dialog.

Important. The definition of the data for the load optimisation is now complete but
before pressing the final OK button (which would run the vehicle load optimisation
analysis) for the purposes of this example the influence surfaces will be visualised:

Solving and Visualising Influence Surfaces

If it is required to visualise influence surfaces and confirm they are correct before they
are used to generate optimised loading patterns, this can be optionally done. With the
main Vehicle Load Optimisation dialog displayed:

o Deselect the Generate optimised loading option and click the OK button.

The LUSAS Solver will process each influence surface in turn, but note that it is not
until the Solve Now button is pressed (see next step) that loadcase results for the

influence surfaces are added to the @ Treeview.

e Press the Solve Now ;l button and deselect the Analysis 1 option to leave just
the Reciprocal Influence Analysis check box ticked. Click the OK button.

e When solved, the @ Treeview will contain one results file for each influence
surface, and an Influence Shape entry will be added to the 5= Treeview.

e |If present, turn-off the display of the Mesh and Geometry layers from the
Treeview.

e Add or ensure that the Influence shape entry is present in the Treeview, and
ensure that a deformation of 6mm is specified.
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e Inthe Treeview double-click on the Attributes entry, click the Supports tab,
and select the All button. Select the option From results file and click OK.

@l Rotate the model to an isometric view.

o From the ‘X Treeview right-click on each results loadcase and select the Set
Active option to view each influence surface.

Bending span 1 (moment) influence
surface

Bending span 2 (moment) influence
surface

Reaction support 2 (reaction) influence
surface
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Generating Optimised Loading Definitions

e Double-click the VLO Run 1 entry in the () Treeview to re-access the settings
made for this analysis.

e Deselect the Generate Influence Surfaces option to make use of the previously
generated influence surfaces.

e Select the Generate optimised loading option.
e Click OK to run the vehicle optimisation process.

This loading optimisation will take just a few seconds on modern personal computers,
and when successfully completed, Characteristic, Combination and Frequent loadcases

will appear for each influence surface in the (X Treeview.

Visualising Load Definitions

e Inthe = Treeview turn off the display of the Influence shape layer.

e Inthe =" Treeview turn on the display of the Mesh layer.
Iil Select the loading on/off button to turn-on the loading visualisation

= =
I_I If necessary, select the supports on/off button to turn-on the support visualisation

The load definition may be visualised for each loadcase as follows:

Viewing Characteristic Loading for Edge Mid-span 1

e Inthe (L) Treeview right-click
on the loadcase Bending
span 1 - (xy) -
Characteristic and pick the
Set Active option.

Here, it can be seen that Group la
dominates and the load pattern is
made up of LM1 tandem systems
and LM1 udl patches. The 10m
carriageway width accommodates three 3m wide lanes. With reference to EN1991-
2:2003 table 4.2 and clause 4.2.4 (4), Lane Number 1, with the heaviest tandem and udl
loads, is positioned adjacent to the influence definition on one side of the deck. Moving
away from the location of interest, lanes 2 and 3 appear in order. The remaining area
(1m wide) appears on the far side of the bridge deck. Spans 1 and 3 only are loaded
(span 2 is not part of the adverse area).
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Viewing Characteristic Loading for Mid-span Bending Span 2

o In the = Treeview right-
click on the loadcase
Bending span 2 - (xy) -
Characteristic and pick the
Set Active option.

Here, again, Group la dominates
and the load pattern is made up
of LM1 tandem systems and
LML udl patches. Lane Number
1, with the heaviest tandem and udl loads, is positioned adjacent to the influence
definition, near the middle of the deck. Lanes 2 and 3 appear each side of Lane 1 and
the 1m wide remaining area appears on the opposite side of the bridge deck compared
to that when considering the previous loadcase. This illustrates how the ranking and
location of lanes is modified as appropriate (EN1991-2:2003 clause 4.2.4(2)). Span 2
only is loaded (spans 1 & 3 are not part of the adverse area).

Viewing Characteristic Loading for Reaction at Support 2

e In the .@ Treeview right-
click on the loadcase
Reaction support 2 - (x,y) -
Characteristic and pick the
Set Active option.

In this last example, giving
maximum reaction at the inner
support, Group 5 dominates and
the load pattern is made up of
LM3 with associated LM1 tandems and udl patches. The SV1800/200 is positioned
adjacent to the influence definition, near the edge of the deck over spans 1 and 2. This
is considered to be Lane Number 1 (EN1991-2:2003 Annex A clause A.3). Lanes 2 and
3 appear on the far side of the deck and are loaded only in the adverse area which
happens to be in span 3. The 1m wide remaining area appears between lanes 1 and 3,
illustrating yet another arrangement of lane rank and location, used to generate the most
onerous traffic load pattern.

Note. The VLO run includes loading arrangements but no results. Results are
available only after the VLO analysis has been solved.

Solving for the optimised loading arrangements

Only the VLO analysis has to be solved in order to produce the results for the optimised
loading arrangements for each influence assignment.
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| Basic Combination

e Press the Solve Now El button.

The Solve Now dialog indicates that the VLO analysis results are not up to date and
that they need to be solved. The other two analyses are unselected by default, as their
results are up to date.

e Press OK to solve the VLO run.

Viewing Load Combinations

The LUSAS TLO facility outputs a design value — Characteristic, Combination or
Frequent, with the meaning of each given in the TLO Help. In this example the vehicle
loading is assumed to be the dominant effect and all other variable actions (wind, snow,
temperature etc.) are being ignored. For this case, and in accordance with EN1990
6.4.3.2(3) equation 6.10, the loads can be combined as yg*[dead loads] + yo*[traffic
loads]. According to clause A2.3.1(4), for the design of structural members not
involving geotechnical actions, the y factors can be found in Table A2.4(B) as yg = 1.35
and yq = 1.5 for traffic. So, to define a basic combination:

On the Combination Properties dialog:
e From the model listing add Self Weight to the included panel.
e Add Bending span 1 - (x,y) - Characteristic to the included panel.

e Click the Grid button and enter factors of 1.35 for self weight loadcase and 1.5 for
the Bending span 1 loadcase

e Change the combination name to Combination Bending Span 1 and click the OK
button to update the combination in the () Treeview.

Plotting Contours of Moment and Peak Values

o In the X! Treeview right-click on the loadcase Combination Bending span 1 and
pick the Set Active option.

e The Solve Now dialog is displayed showing the status of the analyses that have been
defined. Click OK to resolve the analyses indicated as needing to be solved.

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview. Note that by default, and in accordance with established theory, thick
plate element results are given along a chosen global axis. Because we wish to look
at radial results along the deck the cylindrical local coordinate system must be
selected in order to make the appropriate results components available for selection.

188



| File

Save

Modelling

Select Entity Force/Moment - Thick Plate and then select the Transformed button
and select the Local coordinate option. Ensure Cylindrical about Z-axis is
selected in the drop down list. Leave the Shell plane for resultants as theta/z and
click OK.

Now, as a result of transforming the results a new component is available in the
Component drop down list. Selected moments in the theta direction Mt

Click the OK button to display contours of moments in the longitudinal direction.

To display the mesh on
top of the contours, select
the Mesh entry in the
Treeview and drag and
drop it onto/below the
Contours entry in the
Treeview.

With no features selected
click the right-hand mouse
button in a blank part of the graphics window and select the Values option to add

the values layer to the = Treeview.

The values properties dialog will be displayed.

Select Entity Force/Moment - Thick Plate and Component moments in the theta
direction Mt, and select Averaged at nodes.

Select the Values Display tab.
Deselect the Symbols display option.

Deselect the Maxima option and select the Minima option since the sagging
moment is negative. Change the percentage of values to display to 1

Set the number of significant figures to 4

Click the OK button to display contours of moments in the longitudinal direction
with the bending moment value displayed.

Plotting stress contours and peak values for other load combinations and for other
influence points of interest may be obtained in a similar manner to that described above.

Save the model

El Save the model file.
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Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Discussion

Traffic Load Optimisation for EN1991-2 design codes

To illustrate general usage this example analysed traffic load optimisation to EN1991-2
using the Recommended Values design code option.

By re-selecting the lines representing the kerbs on the Geometry layer and selecting an
appropriate design code on the main Vehicle Load Optimisation dialog and re-running
the traffic load optimisation analysis, the results for other supported EN1991-2 Design
Code and National Annexes values can be similarly obtained. When re-running the
LUSAS TLO facility on the existing model care should be taken to ensure that the
correct loadcase is included in the load combination and that the correct load factor has
been specified.

Traffic Load Optimisation for EN1991-2 UK

By following a similar procedure to that previously described the optimised load
definitions for EN1991-2 UK (using a single SV80 special vehicle) can be obtained
along with a contour plot for a basic combination of self weight and combination results
for bending in span 1, as shown in the following images.

Optimised Characteristic Loading for Optimised Characteristic Loading for
Influence Point at Edge Mid-span 1 Influence Point at Mid-span Bending Span 2

Optimised Characteristic Loading for the Combination results for Influence Point
Influence Point at Reaction at Support 2 at Edge Mid-span 1
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Here, the two bending influences show Group 1A loading to be dominant. The LM1
tandem and LM1 udl are however different in value to those in the earlier example due
to the use of the appropriate adjustment factors from NA to BS EN1991-2 Table NA.1.
The reaction influence shows the Group 5 to be dominant. The UK SV80 appears in
Lane Number 1, with associated LM1 also appearing in Lane Number 1,with a
minimum 5m distance from the SV to the first axle of the LM1 TS. Lane rank and
location are similar to those described in the earlier example.

Traffic Load Optimisation for EN1991-2 Sweden

By following a similar procedure to that previously described the optimised load
definitions for EN1991-2 Sweden (using all Complementary load model loads from ‘a’
to ‘I’) can be obtained along with a contour plot for a basic combination of self weight
and combination results for bending in span 1, as shown in the following images.

Optimised Characteristic Loading for the Optimised Characteristic Loading for the
Influence Point at Edge Mid-span 1 Influence Point at Mid-span Bending Span 2

Optimised Characteristic Loading for the Combination results for the Influence Point at
Influence Point at Reaction at Support 2 Edge Mid-span 1

Here, the two bending influences show Group 1A loading to be dominant. In
accordance with SIS/PAS NA to EN 1991-2:2003 clause 4.3.2(3) and VVFS 2009:19
Chapter 6, clause 4, Table 7.1, adjustment factors for the LM1 tandem and LM1 udl are
applied — hence there is no LM1 tandem in Lane Number 3 (factor a43=0). Other
comments on the EN1991-2 load patterns above also apply here. The reaction influence
shows the Swedish Complementary Load Model to be dominant. Type L vehicles
appear in Lanes 1 & 2, with udl g appearing in Lane 3 and no loading in the “remaining
area”. Lane rank and location are similar to those described in the earlier example.
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Description

Vehicle Load
Optimisation of a
Box Beam Bridge

For software product(s): | Bridge and Bridge Plus
With product option(s):

Description

A 5-span concrete box curved bridge is modelled with beams to illustrate the use of the
Direct Method of Influence (DMI) and the Vehicle Load Optimization (VLO) facilities
in LUSAS.

Span 1

Span 2

South

A pre-defined base model with assigned mesh, material and support attributes is used
in this example.

Units used are kN, m, kg, s, C throughout.
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| File
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| File

Save As...

Vehicle Load Optimisation of a Box Beam Bridge

Objectives

The required steps in the analysis consist of;

U Run a Direct Influence Method Analysis to calculate the effects of a unit load
O Define influence attributes and assign them onto the model

O Create influence surfaces

O Create optimised vehicle loading results with VLO

Keywords

Bridge, Concrete, Box Girder, Direct Influence Method, Vehicle Load
Optimisation

Associated Files

U curved_bridge_preliminary.mdl Basic beam model of the bridge.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Loading the model

To start this example, open the read-only file curved_bridge_preliminary.mdl located
in the \<LUSAS Installation Folder>\Examples\Modeller directory.

The basic bridge geometry will be displayed.
e Save the file as \<LUSAS Installation Folder>\Projects\curved_bridge
e Save the model into this new folder as curved_bridge

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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Model Description

The 5-span, box girder bridge has spans of 45m, 50m, 50m, 50m and 45m, all set-out to
a horizontal curvature of 510m radius. For simplicity the cross section of the bridge is
considered constant across its length, and the deck is supported on 5.5m high abutments
and 12.5m high circular pier columns, which are considered fully integral with it. The
box girder of the deck, including cantilever outstands, is 11.5 m wide. The carriageway
itself is 7.7m wide, with space for a footway on the inside and hard standing margin on
the outside.

The deck is modelled as a series of beams along the centreline of the carriageway at a
radius of 510m. The kerb lines defining the extent of the loadable carriageway are
defined at the deck level, above the nodal line, using lines of 506.55m radius and
514.25m radius — a difference of 7.7m, which relates to the width of the carriageway.

The geometric lines of this model have been assigned a line mesh of thick beam
elements with 10 divisions, and a cylindrical coordinate system has been used to
orientate the abutments and piers supports. Concrete EU f,=50MPa has been assigned
to all members. Pin supports restrain the base of the piers and other pin supports,
having the additional fixity, THY, are used at the abutments. A local cylindrical
coordinate system has been assigned to the end points to orientate the supports as
needed.

The Direct Method Influence method is to be used for vehicle load optimisation
analysis instead of the Reciprocal Theorem because it allows the structure to be
analysed as a simple line-beam model.
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| Reference Path...

Vehicle Load Optimisation of a Box Beam Bridge

| Attributes

| Search Area. .

| Analyses

Direct Method

Influence Analysis...

Defining a reference path

e A reference path will be created to be used as centreline to define a grid which will
be automatically used for loading locations and creating the influence shape in
Direct Method Influence Analysis. The use of a reference path is recommended for
most vehicle loading and load optimisation situations.

e From the Treeview right-click on Deck and click Select Members to select the
lines representing the bridge centreline.

e Change the name to be Bridge Centreline and click OK. A corresponding path
definition entry will be created in the m’j}' Treeview.

Defining a search area

A search area can be used to limit the area or features over which loads are applied, so
that the effect of the load on certain features may be removed from the analysis. It is
strongly recommended to define a search area for VLO analyses.

e Change the name to Deck and click OK.

o From the &b Treeview, drag and drop the newly defined Deck search area on to the
model to assign the attribute to the already selected bridge centrelines.

Defining a direct method influence analysis

A Direct Method Influence analysis is defined in order to investigate the most onerous
traffic load patterns on the carriageway, to a selected code of practice. The direct
method influence enables the construction of influence surfaces for any results
component at any node in the structure.

e Choose Deck as the Search area in order to apply a unit load only on the deck
beams.

For a line beam model, where the geometric section represents a beam with a loadable
top slab, a grid of points must be defined to represent the slab. This virtual grid is
equivalent to the nodes or points present in a shell or plate model and is used to create
an influence surface for location of interest.

e Ensure the Grid option is selected, and that the chosen Centreline is the previously
defined Bridge Centreline reference path.

e Set a Transverse width of 11.5. This is the width of the grid to be loaded for
influence analysis. Grid settings control the number of load locations within this
defined width.

196
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locations within the defined width and search area length. For this analysis the default
spacing will be used resulting in a minimum of 50 longitudinal points by 2 transverse
points. Using a larger number of transverse points across a single beam will not make
the analysis more accurate, and is not required because results are only calculated for
the two extreme fibres. If a very fine grid was defined the solution stage may take some
time, as the solution time is proportional to the mesh and grid density.

Note. The Grid Settings advanced dialog controls the spacing and number of load

e Change the name to DMI and press OK to exit the dialog.

A defined grid is now shown on the model and will be used
to apply the unity load on the grid locations that are defined
on the structure.

The grid can be displayed or hidden on the screen.

e From the 5 Treeview right click on DMI and select
Show Grid to un-tick the entry and make the grid
invisible.

Running the Analysis: Influence Analysis

e Press the Solve Now EI button. On the Solve Now
dialog ensure both Analysis 1 and DMI are checked and
press OK to run the analysis.

If the analysis is successful...

Analysis loadcase results are added to the @ Treeview.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to the output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.
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| Influence
Direct

Method...

Defining influence attributes

Now that the influence analysis has been solved the construction of influence surfaces
for any component and any node in the structure can take place.

e Select Entity as Force/Moment-Thick 3D Beam
e Ensure the Direction is Local
e Select My as the Component

e Choose Automatically choose elements for averaging to create an individual
influence based on the average of all element values at the node of interest.

e Enter My Influence as name and press Apply

e Repeat to define influence attributes for Mx and the Fx components, naming them
Mx Influence and Fx Influence respectively. Press OK after defining the final
attribute to close the dialog.

Once created, an influence attribute is held in the & Treeview for assignment to
selected nodes or points. Subsequent assignment of the same attribute to other nodes or
points of interest will use the same influence type settings.

e From the I= Treeview turn Geometry and Utilities off.

e Select the node in the mid-span of span 2 (Node 1490) and assign the My Influence
from the &b Treeview onto it.

A new influence loadcase will be added to the DMI analysis in the (5 Treeview,
indicating the name and position of the influence attribute assigned.

e Assign Mx Influence from the &b Treeview to the centre of span 3 (Node 1071).

e Assign Mx Influence from the &b Treeview to the base of the south abutment
(Node 25).

Note that each Mx Influence assignment creates a new influence loadcase in the DMI
analysis (X Treeview.

e From the l=F Treeview turn Geometry on,

e Assign Fx Influence from the & Treeview to the head of the span 3/4 pier (Point
4).

Three new Fx Influence loadcases will be added to the “E! Treeview. Each influence
loadcase name identifies the specific higher-order feature for which the effects will be
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assessed. In this example Fx Influence (Fx) — Point 4 — (Line 9) represents the
influence shape for the axial load in the top of the pier, whilst Point 4 — (Line 4) and
Point 4 — (Line 3) represents the influence shape for the in-plane load at the connection
along spans 3 and 4 respectively.

o From the ‘X! Treeview right-click Fx Influence — Point 4 — (Line 9) and choose Set
Active to view the influence shape for the axial load at the top of pier 3/4.

e With no features selected right-click in a blank part of the Graphics window and
select the Influence shape option.

e From the =¥ Treeview turn Geometry off,

Note. In large models with lots of elements, nodes and attributes you can quickly
locate an assigned influence by right clicking on the Direct Method Influence Analysis

attribute assignment entry in the () Treeview and then choosing Find. A temporary
indicator will appear, highlighting the target node with the assigned influence attribute.

Contouring the influence results

After the influence attributes have been defined and assigned, contours can be added to
the view to indicate just what effect the degree and direction of influence loading
applied along the surface will have on the assigned node.

e From the (= Treeview right-click the My Influence and select Set Active

e With no features selected right-click in a blank part of the Graphics window and
select the Contours option to add the Contours layer to the [=F Treeview.

e Select the Entity Influence result. Note that the Component inf will be
automatically selected.
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e Select the Contour Display tab and tick Deform

e Press OK to exit the dialog.

The contours can be simplified to indicate which areas of the structure, when loaded,
will have a positive, or negative, influence of the selected influence assignment.

e Double-click the Contours layer to the I=* Treeview to open the properties dialog
e Select the Contour Range tab.
e Ensure Number is selected and change the value to 1

e Press OK to exit the dialog.

Positive influence areas are shown in red, negative influence areas are shown in blue..
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Running the Analysis: Influence Analysis

Vehicle Load Optimisation

Now that influence attributes have been defined and assigned, the VLO facility can be
used to define optimised traffic loading for the bridge, based on a chosen code of
practice. In this example EN1991-2 UK will be used.

e From the Treeview turn off Contours and Influence shape and turn on
Geometry

e In the Groups Treeview, right-click on the Kerblines group, and then select
Select Members to select the lines representing the extent of the carriageway.

o First select the Defaults button to reset any VLO settings from any previous use.

e Select United Kingdom from the Country drop down list and choose EN1991-2
UK 2009 as the Design code.

For simplicity only the effects of a characteristic LM1 load will be considered in this
example.

e Press Optional Code settings and deselect all options to leave Characteristic as
the only representative values required, and Group la -LM1 as the only one of the
load groups to include. Press OK to exit the dialog.

e Press Define carriageways. Ensure Kerbs from selection is selected and press
Apply to exit the dialog.

e Press Set influence surfaces and use the LI button to add My Influence to the
list of influences to be analysed.

e Ensure that both Positive and Negative are selected for the My Influence to be
analysed. This means that the VLO will produce loading for positive and negative
effects of My. Press OK to return to the main VLO dialog.

e To specify a non-default analysis name choose New from the drop-down list, and
enter the analysis name to be VLO DMI

e Change the VLO run Name to be LM1 Span 2 My
e Press OK to exit the dialog and generate optimised loading.

In the ™= Treeview the new VLO DMI analysis will be created. This contains the LM1

Span 2 My ¥ VLO run, which includes a positive and a negative My Influence
assignment.

Note. The VLO run includes loading arrangements but no results. Results are
available only after the VLO analysis has been solved.
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Check loading visualisation settings

e From the = Treeview double-click Attributes
e Select the Loading tab and press Settings... button

e Ensure Show discrete loading by definition is selected and press OK to exit the
dialog.

e Press OK to return to the model.

o From the ‘X! Treeview select the My Influence (My) - Negative placed under the
VLO DMI and set it active.

e Press Iil to visualise loading.

The optimised loading for

the characteristic case of
EN1991-2 UK that gives

the maximum My effect in

the mid-span of span 2 for
negative influence will be
displayed.

Solving optimised loading arrangements

Only the VLO analysis has to be solved in order to produce the results for the optimised
loading arrangements for each influence assignment.

e Press the Solve NOWEI button.

The Solve Now dialog indicates that the VLO analysis results are not up to date and
that they need to be solved. The other two analyses are unselected by default, as their
results are up to date.

e Press OK to solve the VLO run.

The results will be loaded on top of the current model, with the first influence analysis
(My Influence (My) — Positive) set active.

Plotting bending moments

e From the = Treeview turn off the Geometry and Attributes layers.
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e With no features selected right-click in a blank part of the Graphics window and
select the Diagrams option to add the Diagrams layer to the = Treeview

e From the diagram properties drop-down menu, pick Force/Moment — Thick 3D
Beam from the entity and My from the component drop down list.

e From the Diagram Display tab untick the Also use for labels option, select
Decimal places and change the value to 0

e Press the Label font... button and change the style to Bold
e Press OK to return to the properties dialog, and then press OK exit.
e From the (& Treeview, within the VLO DMI analysis entry select My Influence

(My) - Negative and set it active.

10011,

B7h2.

-16023.

3397

9019 B260.

The diagram shows the worst-case sagging moment, My, for the centre of the second
span, due to characteristic LM1 loading.

This completes the example.
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Description

BRO Slab Analysis

For software product(s): | LUSAS Bridge.

With product option(s): None

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

&

Modelling

This example uses a previously created LUSAS bridge model that contains Swedish
BRO loadings and loadcases. The BRO load combination wizard is used to investigate
worst case positive and negative effects.

The structure is modelled using thick plate
elements, representing a deck of inner
radius 75m, outer radius 86m and
thickness 0.7m. The deck has a width of
11m consisting of a 10m wide carriageway
region and two 0.5m wide verges.

Objectives

U Generation of load combination in accordance with Swedish bridge code BRO

Keywords

2D, Slab, BRO Load Combinations, BRO Wizard, Positive Effects, Negative
Effects

Associated Files

0 deck_comb_loaded.mdl Model file of the structure.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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BRO Slab Analysis

|Open...

| File

|Save As...

Creating a new Model

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog. Select the Cancel button. Select the menu command
File>Open and then browse to the \<Lusas Installation Folder> \Examples\Modeller
directory and select the deck_comb_loaded.mdl file.

Open the read-only file deck_comb_loaded.mdl located in the \<LUSAS Installation
Folder>\Examples\Modeller directory.

Loadcases considered

The model in use was created using the Swedish BRO startup template. When using a
country-code specific template such as this, a number of blank loadcases are created in

the ‘& Treeview. These are the characteristic loadcases that are considered possible
within the Swedish code of practice BRO. Individual vehicle and lane loadings have

also been created in the &% Treeview and assigned to these loadcases. The BRO load
combination wizard will combine them in accordance with the Swedish code.

The following characteristic loadcases have been assigned to the model:

e Dead Load

Surfacing
e Support yielding 1
e Support yielding 2
e Support yielding 3
e Support yielding 4
e Temperature 3
e Equivalent load 1 to Equivalent load 10
e View the BRO loadings and loadcases in the & and (2 Treeviews.

e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called deck_comb_loaded

e Save the model into this new folder as deck comb_loaded This helps keep all
relevant files separate from other analyses and is good practice.
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normally be defined using the || - sweden Options

Note. Loadcases  would

Bridge > Bridge Loading > Vehicle 4 load... | Heaw veticl osdina. |
Sweden  menu entry which

would dlsplay the dlalog shown Single wheel load... | Fatique wehicle loading... |
HOWGVGr, because the purpose Special vehicle loading... | Classification Yehicle... |
of this example is to concentrate : —

on Showing the use of the BRO Lane loading... | Train Loading... |
Combination ~ Wizard  these Vehicls B Ioad.. |

loadcases have already been
defined and assigned to the
model that is in use.

Help |

Running the Analysis
With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to begin
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, two files will be created in the Associated Model Data directory where the
model file resides:

T U0 deck_comb_loaded.out this output file contains details of model data,
H assigned attributes and selected statistics of the analysis.

U deck_comb_loaded.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

Viewing the Results

BRO Combinations

The BRO combination wizard allows you to choose which loads to combine into
combinations. By selecting the combination type i.e. Comb4A (Combination 4A), the
wizard defaults the load coefficients to the correct values as stated in table 22-1 of
BRO. Once all the required permanent, variable and live loads have been selected the
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resultant combination can be produced. The resultant combination will be formed by
combining a combination of permanent loads, support yielding combination or
envelope, a combination of variable loads and envelopes of live loading.

Note. The BRO combination wizard can only be used if the BRO loadcase template
/ has been specified to define the characteristic loadcases at the Model Startup stage.

| Bridge The BRO Combination Wizard dialog will appear.
Loading

Combinatins >« Select the Set

[BRO...
defaUItS bUtton' Welcome to the BRO combination wizard
4 SeIeCt To begin to generate a BRO combination. choose which combination pou require and click
combination Mext to continue.
Comb 4A
— BRO Combination options
» Ensure the Fleaze zelect type of combination required.
Number of -~ - - - -~ -
variable Caomb 1 Comb 2 Comb 3 + Comb 44, Comb 4B Comb 54
loadcases is set O Comb58 C CombEC € Comb6 C Comb? © Comb® € Combd
to4
i Murnber of wariable loads to be included in the combination [ 4
e Click Next
Set defaults | Mext > | Cancel | Help |
. For the
permanent load — Permanent load twpe zelection
type selection
ensure the Dead Dend Lond Cvatung
load and ead Load: v verburden I
Superimposed
dead: Deck Superimpozed Deck Sutfacing [V Earth pressure Active [
Ssu rfaCing el Passive [~
options are w . r .
If 1t I=l
selected ‘ ater pressune o | reshiess force o II:
. ClICk the Next ‘ Shrinkage During erection [~ | ke
button to
continue.
< Back | Mext > | Cancel Help
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e In the Support

ylE‘Idlng section — Load type selection
select the
Combine
enve I 0 pe of Support yielding: " Combine loadcases selectively
IOadcases Option. +  Combine ervelope of lbadcases
e Click the Next Suppart yieldhg case 1 & Support yielding case 6 7
bUttOﬂ to Suppart yieldng case 2 [ Suppart pielding case 7 [
. Support yieldngcase 3 & Support yielding case 8 7
continue. Support yieldng case 4 [F Support yieldng case 9 7
Support yieldngcase 5 7 Support yielding caze 10 7
< Back Next > Cancel Help

e No user defined

permanent loads — Load type selection
have been User: Permanent load1 [ Permarent factar i Yariable factor [
defme(_j for this User: Pemanent load 2 [~ Permanent factar i Yariable factor [
anaIySIS B &Y Uzer: Permanent load3 [~ Permanent factor [ Wariable factar [
(_ansure the dlalog User. Permanent load 4 [~ Permarent factar [ Yariable factor [
is left blank and L ,
R User: Pemanent load5 [~ Permanent factar | ‘Warable factar i
click Next to S . —
. User. Permanent loadE [~ Permarent factar i Wariable factor [
continue. | |
User: Pemanent load 7 [~ Permanent factar 1 Yariable factar [
Uzer: Permanent load® [ Permarent factar q Wariable factor [
User. Permanent loadd [~ Permarent factar [ Yariable factor [
User: Pemanent load 10 [~ Permanent factar | Wariable factar [
< Back Mewt > Cancel Help
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BRO Slab Analysis

e For the variable

|Oad type — Yariable load type zelection
selection pick
Temperature ‘ Surface load r | ‘ Fatique load = ‘
type Temp 3
i ‘ Braking force r | ‘ Lateral farce | ‘
e Click Next to
continue. lze and curent r | ‘ Sric Il ‘
‘Wind loading o | Temperaturs Temp1 [
Temp2 [
‘ \Water pressure r | Temp3

‘ Surcharge o | ‘ Accident loads ol ‘

< Back | Mest > | Cancel Help |

e No user defined

variable loads — Load type zelection
have been User: Wanable load 1 I Permanent Factar U— ‘ariable Factar -|—
defl ne(_j for thlS User: Wariable load 2 r Permarnent factor D_ Warigble Factor 1_
anaIySIS A SO User: Wariable load 2 I Pemanent factar [ Yariable Factar 1—
_ensure the dlal_og Uszer: Wariable load 4 r Permanent factor [ ‘ariable factor -|—
15 blank and CIICk Uszer: Yariable load & I Permatent factor ] ariable factor ‘I_
Next continue. : : L
User: Wariable load & I Permanent factor [ Yariable factor [
User: Wariable load 7 r Permarnent factor D_ Wariable Factor 1_
User: Wariable load 8 I Pemanent factar [ Yariable Factar 1—
User: Wariable load 9 r Permanent factor [ ‘Yariable Factar 1—
User Yariable load 10 [ Pemanent factar [ Variable Factar [
< Back Mewt > Catcel Help
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Viewing the Results

Finally, enter the

Equivalent
loads as
attributes  1:54-
64 (see the G
Treeview)
Leave the
Maintenance

and emergency
vehicles blank.

Select Finish to
generate the
BRO Resultant
combinations.

BRO Combination Wizard

Equivalent loads

— Yanable load type zelection

Combine the following equivalent load cases with the loadings selected previously to produce
the BRO factared load combinations.

Maintenance and emergency vehicles I

Has the live loading been produced uzing the vehicle load optimizer. o

| 1:54-64

Live load cazes selection (0:50,1:51,0:53,1:56-60)

Format - File ID : Loadzase Mumber...
[Firgt file loaded iz Mo.0]

< Back Finish Cancel Help

Displaying contours for BRO Max and Min Effects

If present, turn-off the display of the Geometry and Attributes layers in the

Treeview.

With no features selected, click the right-hand mouse button in a blank part of the
graphics area and select the Contours option to add the contours layer to the

Treeview.

The contours properties dialog will be displayed.

Select Entity Force/Moment - Thick Plate component moments in the X direction

MX and click OK

The Contour results for Loadcase 1 - Dead Load will be displayed.
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BRO Slab Analysis

Loadcase: 1:Dead Load
Ertity: ForceMdoment - Thick Plate
Component: hix

AS6 618
17 463
78.309 J
391545
o
391545
78309 -
117 463 -
. 156 B8

Mzximum 195 326 st node 19
Minirmum -157 085 st node 21

o In the 'E Treeview right-click on BRO Combination 4A:Resultant(Max) and
select the Set Active option to view the worst positive effects (i.e. hogging moments
and reactions). Select entity Force/Moment - Thick Plate and component MX to
be used to assess the relieving or adverse affects when processing the combinations
and click OK. To continue with partial results click OK

Caombining on: X

BROCombination 4.4 Resultant (730 (s L ' F
Ertity: ForceMoment - Thick Plate
Component: hix e
-95.3841
oo
95.3541
- 196765
295152
393.536 - 0

491 .92
590,505
Gt 655

Mgximum 774 934 ot node &
Minirmum -110.523 &t node 21

e Set combination the BRO Combination 4A:Resultant(Min) active to view worst
negative effects (i.e. sagging moments and vertical displacements). Select entity
Force/Moment - Thick Plate and component MX to be used to assess the relieving
or adverse affects when processing the combinations and click OK. To continue
with partial results click OK
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| File

Save

Viewing the Results

Combining on: i

BROCombinstion 44 Resutart (73) (Min)
Ertity: Forceoment - Thick Plate
Component: hX

-9559
-B62 663
-739.423

-B16.188

- -492.95
-363.713
-246 473
-123.238
on

Maximum 32 3628 at node 36
Mirirmum -1 OFE7EES at node 52

Additional results processing can be carried out in a similar manner to that described in
the Simple Slab example.

Save the model

El Save the model file.

Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.
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Description

Section Slicing of a
3D Shell Structure

For software product(s): | Any Plus version.

With product option(s): None

Description

This example uses the
Slice Resultants
Beams/Shells facility to
investigate the behaviour
of a bridge deck
modelled using thick
shell  elements. The
results are converted into
forces and moments of
an equivalent beam
using this facility.

Units used are N, m, kg,
s, C throughout.

Objectives
The output requirements of the analysis are:

U Forces and bending moments along length for whole structure
O Forces and bending moments associated with central girder effective width

Keywords
Force, Bending moments, Slicing, Shells.
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A

Modelling

| File

Open...

| File

Save As...

Section Slicing of a 3D Shell Structure

Associated Files

U shell_slicing.mdl Model file of the structure.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Creating a new Model

e To create the model, open the file shell _slicing.mdl located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

T A ¥

/;i s =

/4
S

; 2 -

El If necessary, click the isometric button to view the model in 3D
Iil If necessary, turn-on the display of the supports.

Iil If necessary, turn-on the display of the loading.

e Save the model to your local projects folder to prevent overwriting the model in the
examples directory.
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Modelling

In the ‘&' Treeview two loadcases can be seen. One corresponds to the self-weight of
the structure and the other to an applied load of a United Kingdom HB vehicle. For the
post-processing, a combination has also been defined which combines these two load
cases.

Turning off all layers other than the mesh allows visualisation of the general layout of
the model. The deck is 4.21m wide and consists of a concrete slab and three steel
girders as indicated in the following figures. The mesh discretisation of the model is
extremely coarse for the purpose of this example.

Note. When carrying out this type of slicing on realistic models it is recommended
that a much finer mesh discretisation is used to accurately capture the response of the
structure, particularly if 3- and 4-noded shell elements are being used for the modelling.

Idealisation of the Bridge Structure

For this example the idealisation of the bridge structure into the analysis model has
been done using only shell elements.

Top flange and
slab connected

Shell element modelling of the whole structure

Shell elements have been used for the girder components and also the concrete slab as
illustrated. For the modelling, discrete features have been defined for the top flange and
the slab since their materials are not identical. The slab has an eccentricity to define a
bending plane that is not coincident with the top flange and these two components are
combined using an equivalence attribute. This is just one of many ways that the
idealisation for this type of bridge structure can be undertaken.

Based upon this idealisation method the whole model showing element discretisation is
as shown:
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Section Slicing of a 3D Shell Structure

Alternative idealisations

The following figure shows the same structure but this time the shell elements
representing the top and bottom flanges of the girder have been replaced by beam
elements running along the top and bottom of the girder with the appropriate properties
for the flange members.

Beams for top
and bottom
flanges
Shells for web

Beam element modelling of flanges
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Running the Analysis

In the last figure the whole girder has been replaced by beam elements with appropriate
geometric properties and an eccentricity to offset the bending plane of the beams.

Actual modelling
location of beam

_—
1
!

\ Beam representing

complete girder with
eccentricity

Beam element modelling of the whole girder

The choice of which analysis idealisation should be used depends upon what is required
from the results of the analysis. For instance, if a curved girder analysis is being
performed and the lateral forces in the top and bottom flanges are required then Shell
element modelling of the whole structure or beam element modelling of the flanges (as
shown in the first two figures) are suitable but beam element modelling of the whole
girder (as shown in the last figure) is not.

Running the Analysis
With the model loaded:

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Viewing the Results

Analysis loadcase results are present in the C Treeview, and the loadcase results for
the self-weight loadcase will be set to be active by default.
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Section Slicing of a 3D Shell Structure

Plotting Deformed Shapes

e Ensure the Mesh, Geometry and Attributes layers are present and turned off in
the = Treeview.

e  With no features selected click the right-hand mouse button in a blank part of the
Graphics area and select the Deformed mesh option to add the deformed mesh
layer to the [=F Treeview.

| Utiities e  Show the Window Summary for an overview of the results.
| Annotation >
Window

Summary Seale=1:36.4909
- Zeom: 100.0

Ewe: (-0.57735, -0.57735, 0.57738)

LinearvDvnamic Analysis

Loadcase: 1

Self nieight

Results File: O

Maximum Displacement 0.1201E-01 at Hode 16

Computing Forces And Bending Moments For
Combination

e Turn off the Deformed Mesh and Annotation layers in the [I=F Treeview.

e With no features selected click the right-hand mouse button in a blank part of the

Graphics area and select the Mesh option to add the mesh layer to the
Treeview. In the mesh dialog box click the OK button to accept the default values.

e With no features selected click the right-hand mouse button in a blank part of the

Graphics area and select the Geometry option to add the geometry layer to the
Treeview. In the geometry dialog box click the OK button to accept the default
values.
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Viewing the Results

In the /=) Treeview expand Analysis 1 then right-click on Combination and select
the Set Active option. The results for the combined effects of the factored self
weight and HB vehicle load will now be available.

Select the centre line of the model (Line 11). This line will be used to define the
path along which the slicing will take place.

Straight line 11

Faintz : 1,25
Surfaces: 3, 4.5
Mah:Mull_4_1

There are 8 itemz at thiz position
Press Tab to cpele through them

o Bl Set the view axis to be along the global Z-axis by pressing the Z-axis
button at the bottom of the graphics area.

The current Modeller window should look as follows:

Note. Whilst visualisation of the model can be done using an isometric view the
definition of the slice cutting planes must, for this example at least, always be done with
the model viewed along the global Z-axis.
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| utilities
Slice Resultants
Beams/Shells

Section Slicing of a 3D Shell Structure

With the centre line of the model (Line 11) still selected:
The slicing dialog will be displayed.

—Slice locations

L4 SeleCt the Incremental " From points or hodes in selection
d |5tance fI’Om Start Of path * Incremental distances from start of path e.g. 16210,2@5
option. | o15@1

" Abzolute distances from start of path e.g. 10,1520

e Enter 0;15@1 into the |
associated box which will cut
. . Dzt f f igin b
slices at the start of the line | aatd cih koo 2o | 00
(Om) and every 1m up to and || “Sice aptions
il’]CIuding 15m taments abaut (¢ Meutral asiz ¢ Path intersection

. Set the Distance from [ Effective width I I helide whole elements o

reference origin to start of ¥ Smooth camers on path
path (Chalnage) to O Slicename prefis I Slice

e Select the Neutral axis option | [ %***
® Active Al 7 Selected e.g1,2-4,8|—
to calculate the forces and

moments about the sliced
section neutral axis.

Defaults | aK | Cancel | Help |

e Ensure that the Effective width option is deselected.

e  Set the slice Slicename prefix to Slice . This will be the prefix for the naming of
the sliced sections.

e Click the OK button to start the automated slicing the model.

Note. Three methods are available for the definition of the slice locations. From
points or nodes in selection allows the definition of the slicing locations by projection
of the points/nodes onto the slicing path. Incremental distances from start of path
allows the definition of progressive slice distances governed by the supplied
increments. These increments can be positive or negative so long as the accumulated
distance is within the path length. The Absolute distances from start of path allows
the definition of known distances along the slicing path for slices to be taken.

Note. Smooth corners on path is used to traverse sharp corners in the defined
slicing path. If smoothing is selected then the orientation of the slice plane is set to be at
an angle of half the path angle change at the connection if this location coincides with a
slice. If smoothing is not selected, two slices will be taken at a sharp corner with angles
taken from both lines/arcs at the connection.

The forces and moments for the slices are output in a grid as indicated in the following
figure. The output is relative to the slice axes and consists of the following information:
Slice title, distance associated with slice location, the global coordinates of the sliced
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Viewing the Results

section neutral axis, shear forces (Px and Py), axial force (Pz), bending moments (Mx
and My) and torsion (Mz). If moments are calculated about the path intersection then
the coordinates will be equal to the location on the path associated with the distances
selected.

I Slice Dutput H=E

A B C 1] E F G H 1 J K

1 Title : Dist © X hd z Px Py Pz Mz My Mz

2 |Slicet1 : 0.0 0 00 (0.0 00413928 6.0132E-6 -1.73950E6: 1.37817E-3 -380.803E3 0.0685263E-3 -0 087 2636E-3

3 |Slice2 1.0 0 1.0 (0000413928 59578E-6 -1.5424B8E6: 1.79772E-3 (-1 82672E6 0.0797165E-3 :-0.0818528E-3

4 |slice3: 2.0 1 20 (0.0 0.0413928 5 96206E-6 -1 29537E6 2. 21727E-3 (-3.26355E6 |0.0909064E-3 (-0 0764406E-3

5 |Sliced : 3.0 ¢ 30 (0.0 :0.0413928:593661E-6:-1.04826E6: 2. 63652E-3 -4 7O035E6: 0.102097E-3 (-0.0710294E-3

B |Slice5: 40 ¢ 40 (0.0 :0.0413928560701E-6-518 625E3:0.160675E-3-5.63074E6 | 0.116992E-3 (-0.0291121E-3

7 |Slice6; 50 ;50 (0.0 00413928 562708E-6 -316.449E3:0.539391E-3 -6 03675E6 | 0.115474E-3 (-0.0260047E-3

8 |Slice? : 60 ¢ B0 0.0 00413928 5647T14E-6 114 2659E3:0.91 81 08E-3 -6, 24277E6: 0.113952E-3 : -0.022897E-3

w

Sliees : 70 ¢ 7.0 :0.0:0.04139268:566718E-6: 87 910263 | 1. 29652E-3 (-6 44875E6: 0.112431E-3 :-0.0197592E-3
10 =lice 9 : 5.0 ¢ 80 ;00 00413925 537092E-6:-87 910263 1.00211E-3 :-6.44183E6; 0.10699E-3 : 0.0371254E-3
11|Slice10: 8.0 : 90 : 00 00413925 53 31604E-6: 114 269E5 ; 0 86250E-3 :-6.24085E6 :0.0796455E-3 ; 0.0393478E-3
12|Zlice11: 100 0100 : 0.0 00413928 5 26112E-6: 316 449E3 :0.723043E-3:-6.039585E6:0.0523055E-3 : 0.0615703E-3
13)Slice12: 110+ 11.0 : 0.0 :0.0413928 3 20609E-6 515.626E3 :0.583305E-3:-5.63005E6 :0.0249608E-3: 0.0537926E-3
14|Slice 13 120 :12.0 : 0.0 00413925 4 95544E-6: 1 D4526E6 | 3 40763E-3 -4 6945266 0.014193E-3 : 0.0144465E-3
15|5lice 14: 130 :13.0 : 0.0 00413923 4 84366E-6: 1 29537E6 | 2 81432E-3 :-3. 26285E6 :0.0101565E-3: 0.0224079E-3
16|Zlice15: 140 1140 : 0.0 (00413925 4 58257E-6 1 S4248E6 ¢ 22ME-3 -1 83139E6: 612229E-6 : 0.030363E-3
17|Slice 16: 150 : 150 : 0.0 00413925 4 5397 3E-6: 1 7895966 | 1 B27E9E-3 : -389.92E3 | 2.08845E-6 :0.033327EE-3

ak. I Cancel |

This grid can be resized and the results copied and pasted using the Ctrl + C and Ctrl
+ V keys into an application such as Microsoft Excel to generate force and bending
moment diagrams as illustrated.

Forces and Bending Moments

3.00E+06
T 2.00E+06 ./././.
Z 1.00E+06 — -
€t 0.00E+00 P S TP = S —
e 1 2 345 65 7 8 8 101112 13 14 15 = F¥
£ -100E+06 f1 2.3
g - Pz
= -2.00E+06 u
= -3.00E+06 X
= My
 -4.00E+06 y
S -5.00E+06 z
& _6.00E+06

-7.00E+06

Distance (m)
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Section Slicing of a 3D Shell Structure

e Click the Cancel button to close the slice output grid.

e Turn on the Annotation layer in the [=¥ Treeview.

The locations of the slices are indicated on the model as illustrated below. These
annotations include the physical location of the slice, its title and a local coordinate set
indicating the axes of the slice. If the option to calculate the forces and moments about
the neutral axis has been selected this local coordinate set will be defined at the neutral
axis location. If however the option to calculate the forces and moments about the slice
path has been selected, the local coordinate set will be defined at the intersection
between the slice path and the slice plane.

Helice s plice G aice ol e Elice—tElee—t Bliee—t Bice—Helie—=Elice 16
) Ly M ) i) hi) & M L) i) L Iy i) Ly Ly Ly
o Ficy Ay s iy Y A iy iy iy Ey iy M Ficy Fiiy Ficy
o iz

e Click on the El isometric button to view the model in 3D to view the extents of
the slices.
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| Utilities

Remove

Beam/Shell Slice
Annotations

| Utilities
Slice Resultants
Beams/Shells

Viewing the Results

Note. Whilst visualisation of the slices generated is possible in an isometric view the
definition of the slice cutting plane must, for this example at least, always be done with
the model viewed along the global Z-axis.

e Delete the current slice annotations.

Computing Forces and Bending Moments for Girder
Effective Width

o I NA Set the view axis to be along the global Z-axis

With the centre line of the model still selected:
The slicing dialog will be displayed. B

(~Glice locations

" From points o nodes in selection

° Select the Absolute distances from start of  Incremental distances ffom start of path e.q, 1@10,285
H TEE
path 0 ptl on. @ Absolute distances from stait of path e.g. 10,15.20
| 0255751012518

Note. List separators vary according to your PC’s | | bt ion sieercesigin [ o
regional locale settings. For example, English (UK) | sieessios

al’ld Eng|ISh (US) Settlngs Use a comma as a ||St Moments about " Netal axis  Path intersection
separator. French, Swedish and other language | .. . .oooms

settings use a semi-colon. Scenenesey | G |

I/ Effective width | 2.0 I Inchide whole elements only

o

Loadcase
Please enter whatever is appropriate to your region. [mcm CAl O Soknedeg124n |
In this example an English (UK) separator is shown. | | e [

e Enter 0,2.5,5,7.5,10,12.5,15 (using an appropriate list separator for your regional
settings) into the associated box. This will cut slices at the start of the line (Om) and
every 2.5m up to and including 15m.

e Set the Distance from reference origin to start of path (chainage) to 100 . The
start of the slicing path will therefore have a distance/chainage of 100m and the end
of the slicing path will have a distance/chainage of 115m.

e Select the Effective width option and enter 2.0 in the associated box. This will set
the effective width to be 2.0m centred on the slicing path (i.e. 1.0m either side)

e Set the slice Slicename prefix to Girder2 (Eff) . This will be the prefix for the
naming of the sliced sections.

e Click the OK button to start slicing the model.

The forces and moments for the slices are output in a grid as shown:
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Section Slicing of a 3D Shell Structure

I Slice Output H=] E3

A B C D E F G H 1 J K

1 Title Dist : ¥ A z Px Py Pz [ oy Mz

2| Girder2 (eff)1 100.0; 0.0 (0.079355E-15i0.0622735 -5 50705E-6 |-753.004E3 108 22263 |-27 2035E3 | -2 50777E-6 {-0.0113935E-3

3| Girder2 (effi2  102.5: 25 0.079355E-15:0.0622755 -6.95906E-6 :-442 901E3 :-616.576E3 -1 4575166 :0.0215353E-3: -0.013383E-3

4| Gircder2 (effy 3 105.0! 5.0 0.079355E-15:0.0622785 0.564106E-6:-75.0993E3 (-1 1930566 -2.19555E6 :0.0353779E-3: -5.02519E-6

5| Girder2 (eff) 4 (-Z) 107.5: 7.5 0.079555E-15:0.0622755: 6.37162E-6 | 96.495E3 (-1 3837366 -2 3066266 :0.0419643E-3; -3.7045E-6

B|Girder2 (eff) 4 (+£):107.5 7.5 0.079333E-15:0.0622755: 8.95353E-6 ¢ -102.1E3 -1.38343E6:-2.30157E6:0.0428377E-3: §.30913E-6

| Girder2 (effi s 110.0:10.0 :0.079555E-15:0.06227535: 9.859TE-6 | 71.0146E3 (-1 1739566 -2 2040866 :0.0169316E-3:  6.9976E-6

8| Girder2 (effi6 1125125 0.079555E-15:0.0622755: 6.67232E-6 | 415.529E3 -508 673E3 -1 43586566 4 83055E-6 | 0.010497E-3

9| Girder2 (effiy 7 115.0:15.0 0.079555E-15:0.0622755: 2. 43091E-6 | 694 615E3 | 120.01E3 :-157 B93ES: 065744E-6 | 7.08315E-6

’TI Cancel |

Copying these results into a spreadsheet application and generating the graphs gives the
force and bending moment diagrams as shown:

Forces and Moments

__ 1.00E+06
g, 5.00E+05 —e— Seriesl
£ 0.00E+00 + —B— Series2
§ -5.00E+05 & Series3
,E.; -1.00E+06 Series4
%’ -1.50E+06 —x— Series5
L%: -2.00E+06 —e— Series6

-2.50E+06

Chainage (m)

e Click the Cancel button to close the slice output grid.

The locations and extents of the slices through the bridge are indicated on the model as
illustrated below. These annotations include the physical location, title and local axes as
before.
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Viewing the Results

===

AGirder2 (Eff) 1 ?rdeﬂ (Eff) 2 Trdei (Ef) 3 AGirder2 (EFf) 4 Trdeﬂ (Ef 5 AGirder2 (Ef) 6  AGirder2 (EF) 7
[ i i s

e Click on the EI isometric button to view the model in 3D to view the extents of
the slices.

| Utilities e Delete the current slice annotations.
Remove

Beam/Shell Slice

Annotations

This completes the example.

Notes

e  Curved structures can also be sliced using this facility.
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Description

Seismic Response
of a 2D Frame
(Frequency Domain)

For software product(s): | All (except LT versions)
With product option(s): | None.

Description

This example examines the Spectral

Response analysis of a 2D braced tower

frame. The geometry is simplified to a  Diagonal
wire-frame or stick representation, with  bracing
each of the structural members being

represented by Point and Line features

only.

9x4.5m
The model is comprised of thick beam high storeys
elements for the concrete column, beam

members, and steel diagonal bracing

members  which have pinned end G

connections. The structure is fully

restrained against displacement and 11273714

rotation at ground level. U L v

7 x 4.0m wide bays

Since the global response of the structure
is required, the model of the tower is
further simplified by meshing each Line with a single element. This will effectively
avoid the extraction of local panel modes for individual beams and columns. These
local modes could be investigated independently in a more detailed analysis.

The spectral response analysis is performed in three distinct stages. Firstly a natural
frequency analysis is performed. This is used here to calculate the first 10 natural
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A

Modelling

Seismic Response of a 2D Frame (Frequency Domain)

modes of vibration of the structure. The eigenvalues, frequencies and eigenvectors
(mode shapes) are stored and used in the subsequent spectral response analysis.
Although the natural frequencies are obtained from an eigenvalue analysis any
information regarding the magnitudes of deformations or moments is non-quantitative.

The second phase of the analysis is the spectral response calculation, in which the
spectral response computation is performed interactively as a results processing
operation using the Interactive Modal Dynamics (IMD) facility. This is an alternative to
performing a non-interactive spectral response analysis in LUSAS.

In a spectral response analysis, the structure is subjected to a support condition
excitation. In this example this is assumed to be the effect of Seismic/Earthquake
motion although any support motion could be envisaged. The excitation is specified as
a spectral curve, in terms of displacement, velocity or acceleration and represents an
envelope of these effects over a measured frequency range. Damping may also be
specified at this stage.

From the spectral analysis participation factors are obtained which indicate, for each
mode, the degree of structural response associated with this applied excitation.

The last phase of the analysis considers self weight in conjunction with the spectral
response and to this end two load combinations are defined from which worst case
force/moment envelopes may be obtained.

Units used are N, m, kg, s, C throughout.

Keywords

2D, Plane Frame, Beam, End Releases, Fleshing, Natural Frequency, Eigenvalue,
Spectral Response, Seismic, Axial Force, Shear Force, Bending Moment
Diagrams, Participation Factors, Modal Dynamics, Interactive Modal Dynamics
(IMD), Modal Response, Global Response, Graphing, Animation, Load
Combination.

Associated Files

U tower_modelling.vbs carries out the example modelling.
U tower_spectrum.vbs defines a typical spectral curve excitation.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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| Geometry >
Line >
Coordinates...

Modelling

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as tower

e Use the Default working folder.

e Enter the title as Tower

e Set model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Standard startup template.

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Column and Beam Members

il Enter coordinates of (0, 0), (0, 4.5), (4, 4.5) and (4, 0) and click OK to define the
first bay of the ground level storey.

Note. Sets of coordinates must be separated by commas or spaces unless the ‘Grid
Style” method is chosen. The Tab key is used to create new entry fields. The arrow
keys are used to move between entries.
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| Attributes

|Mesh
|Line...

| Attributes

| Geometric
|Line...

>

Seismic Response of a 2D Frame (Frequency Domain)

Meshing - Columns and Beams

As the global response of the structure is required only
one beam element need be used along each Line. This
will prevent LUSAS from picking up any panel modes
caused by local vibration of the columns and beams.

Select Thick Beam, 2 dimensional, Linear

elements.

Enter the number of divisions as 1

Enter the attribute name as Thick Beam and click

OK

With the whole model selected, drag and drop the Line mesh attribute Thick Beam
from the &% Treeview onto the selected features.

Geometric Properties - Columns and Beams

From the Usage section
select 2D Thick Beam from
the drop down list and
change the values on the
dialog to match those shown
in the table for a column
member.

Enter the attribute name as
Concrete  Column  and
select the Apply button to
create the attribute and re-
use the dialog.

Change the values on the
dialog to match those shown
in the table for a beam
member.

Change the attribute name to Concrete Beam and click OK

Column Beam

Member Member
Cross-sectional area 0.1 0.08
Second moment of area 0.8336-3 0.5336.3
about z axis 1zz) 033€ 2396
Effective Shear Area in 01 0.08
Y Direction (Asy) : '
Offset in y direction

0 0

(Ry)

Note. Whilst in practice column sizes would vary with height and beam sizes may
vary throughout the structure, in this example, for simplicity, all of the concrete
columns and beam sections are of the same size and assumed to be of solid square
section.
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| Attributes
| Material >
Material Library...
| Geometry
| Line >
Copy...

Modelling

e Select the 2 vertical Lines representing the column
members. (Hold the Shift key down to add to the
initial selection).

e Drag and drop the geometry attribute Concrete

Column from the & Treeview onto the selected
features.

e Select the horizontal Line representing the Beam. &

e Drag and drop the geometry attribute Concrete — #—f=f= .
Beam from the &b Treeview onto the selected Line.

Geometric property assignments are visualised by default. In general the diagrams in
this example will not show geometric visualisations.

Material Properties - Columns and Beams

e Select material Concrete from the drop down list, leave the grade Ungraded and
click OK to add the material attribute to the & Treeview.

The columns and beams are made of concrete.

e Select the whole model by either using the Ctrl and A keys to select all features or
by dragging a box around the model.

e Drag and drop the material attribute Isol (Concrete Ungraded) from the &
Treeview onto the selected features.

Copying the Column and Beam Members

Now that one bay has been fully defined it will be copied to form the other 6 bays of the
ground storey of the tower. With the whole model selected:

“arm

II1] Enter a translation in the X direction of 4 metres.

e Enter the number of . - . . - -
copies required as 6 M

e Click the OK button
to create 6 additional
bays.

g5
W

Bay 6 of the structure requires diagonal bracing to be added with the ends of both
members being free to rotate about the Z direction in order to model a pinned
connection.
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| Geometry
[ Line >
| Points. ..
| Attributes
| Geometric >
| Section Library...

Seismic Response of a 2D Frame (Frequency Domain)

Defining the Bracing Members

e Select 2 diagonally opposite Points in bay 6. (Hold the Shift key down to add to the
selection).

ilThe line will be drawn.

e Repeat for the other pair of diagonally opposite Points.

Meshing - Bracing Members

Only one beam element is to be used along each bracing member. However, the ends
of the bracing members must be free to rotate about the Z direction in order to model a
pinned connection, therefore the existing mesh dataset (as used for the beam and
column members) cannot be used. A new mesh dataset must now be created from the
existing one.

e Inthe c&n Treeview double-click the Thick Beam attribute name.

e Click the End releases button and set the First node end releases and Last node
end releases to allow Rotation about Z by selecting the option.

e Click the OK button to return to the Line mesh dialog.
¢ Change the dataset name to Thick Beam (Pinned Ends) and click the OK button.

e With the 2 Lines representing the bracing members selected. Drag and drop the Line

mesh attribute Thick Beam (Pinned Ends) from the &b Treeview onto the selected
features.

Note. The visualisation of M . - u - .
the beam end releases is J J I NHZ J
shown by default. If it is

required to turn-off their t THZ #HZ
visualisation select the

Treeview and double click on Mesh, select the Visualise tab and deselect the Beam
end releases option.

Geometric Properties - Bracing members

For the purposes of this example the bracing members are to be defined as Universal
Beams.

The standard sections dialog will appear.

¢ Inthe Usage section ensure that 2D Thick Beam is selected
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| Attributes
| Material >
Material Library...
| Geometry
| Line >
Copy...

Modelling

e From the UK Sections library select the Universal Beams (BS4) section type and
select the 254x146x43kg UB section.

e Enter an attribute name of Bracing Member and click the OK button to add the
Universal Beam attribute to the & Treeview.

e Select the 2 diagonal Lines representing the bracing members.

e Drag and drop the geometry attribute Bracing member (254x146x43kg UB major
y) from the &% Treeview onto the selected features.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

Material Properties - Bracing Members

e Select material Mild Steel from the drop down list, leave the grade Ungraded and
click OK to add the material attribute to the &% Treeview.

e With the 2 bracing members selected, drag and drop the Material attribute 1s02
(Mild Steel Ungraded) from the &b Treeview onto the selected features.

The first bay of the ground storey of the tower is nhow completely defined. The support
conditions are not defined or assigned yet because this bay will be copied upwards to
create other storeys where supports will not be required.

Copying the Model Features

The other storeys of the tower can now be generated by copying selected features
through specified distances in the Y direction.

e Select the whole model using the Ctrl and A keys together.

Sarm

LI Enter a translation in the Y direction of 4.5 metres. Enter the attribute name as
Y=4.5. Click the Save button to save the attribute for re-use. Enter the number of
copies required as 2 and click the OK button to finish to generate two additional
storeys.

Note. All attributes assigned to the features on the ground level storey, for example,
line mesh, geometric and material properties, will be duplicated on the other storeys
automatically when the new features are created by copying.
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e Drag a box around the Drag a box to select only these bays
bays shown to create m- - T T T T T T T T T T 1
the next level of the : :
structure. | |
| |
|GeL?r:';e"y . M Select the attribute :_ J'
Copy... Y=4.5 from the drop e ] k
down list and click the
OK button to create 1
copy of the features il
selected.
fofo L - L L ] -
e Drag a box around the bays shown Drag a box to select
to create the next level of the only these bays
structure. i‘ ________ ]
- 1 [
|GeL?:;e"y S Il select the attribute Y=4.5 from | I
Copy... the drop down list and click the OK :_ :
button to create 1 copy of the features T T T k
selected.
T—[}{} L ] L i ]
e Drag a box around the bay shown Drag a box to select
which will be used to create the only this bay
remaining levels of the structure. =)
— I
[ [
1 . |
L |
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| Geometry

Line
Copy...

Modelling

ﬂ Select the attributeY=4.5 !
e Change the number of copies to 4

e Click the OK button to create the remaining levels. !

Supports

LUSAS provides the more common types of support by
default. These can be seen in the & Treeview. The
tower must be fully restrained at the base, therefore 3
degrees of freedom (U, V and rotation about the Z axis)
must be restrained. A fully fixed support type is &—4=f= & &
therefore required.

Assigning the Supports

e Drag a box around the 8 Points along the
base of the structure.

e From the & Treeview drag and drop the
support attribute Fully Fixed onto the
selected features, ensure the All analysis
loadcases option is selected and click OK

The model geometry is now complete.

Loading

Note. No static structural loading is required for the first part of this analysis because
the spectral combination is carried out during results processing using the results from
the natural frequency analysis which is independent of applied loading. The modelling
will now be completed by defining the controls necessary to extract the natural
frequencies.
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Eigenvalue Analysis Control

Since the first stage of a spectral response analysis involves a computation of the
natural modes of vibration an initial eigenvalue extraction analysis must be carried out.
The solution parameters for eigenvalue analysis are specified using an eigenvalue
control dataset. In this example the first 10 natural modes of vibration of the tower are
computed.

Eigenvalue analysis control properties are defined as properties of the loadcase.

e Inthe @ Treeview, expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

Eigenvalue Eq
Solution IFrequenc_l,J j Value
Mumber of eigenvalues 10
™ Include modal damping Sieh danmpitg .. | Shift to be applied 0|
Eigervealues required IMinimum j
— Range specified az

% Frequency = Eigenvalue

Type of eigensalver | Default j

- Bigerivector normalisation ¥ Stum sequence check for missing eigenvaluss

" Unity ' Mass = Stiffress N 4
vanced... |
0k I Cancel | Help |

The following parameters need to be specified:

e Set the Number of eigenvalues as 10

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis when results processing.

e Click the OK button to finish.
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| File

Running the Analysis

| Save

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (5] Treeview

In addition, 2 files will be created in the new Associated Model Data directory where
the model file resides:

U tower.out this output file contains details of model data, assigned attributes
and selected statistics of the analysis.

U tower.mys this is the LUSAS results file which is loaded automatically into
the /= Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 tower_modelling.vbs carries out the modelling of the example.
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| File

New...

| File

[ Script

>

Run Script...

Seismic Response of a 2D Frame (Frequency Domain)

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as tower

e To recreate the model, select the file tower_modelling.vbs located in the \LUSAS
Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

| utilities

Print Results
Wizard...

Eigenvalue loadcase results are present in the C! Treeview, with Eigenvalue 1 set to be
active by default.

Plotting Mode Shapes

e Turn off the display of the Mesh, Geometry and Attributes layers in the
Treeview.

e By default the Deformed mesh layer is visible.
To see other mode shapes:

o In the & Treeview right-click on Eigenvalue 2
and select the Set Active option. The deformed
mesh plot for Eigenvalue 2 will be displayed.

e By setting each Eigenvalue to be active the
deformed mesh can be seen for all mode shapes.

Note. The mode shape for eigenvalue 1 may be
inverted. This is because the sense is arbitrary since
during vibration deformed shape will appear in both
directions.

Printing Eigenvalue Results

Eigenvalue results for the whole structure can be displayed in the Text Output window.
Ensue Active is selected and press Next. Then select None from the Entity drop down

list. Ensure Eigenvalues is displayed in the Type drop down list and click Finish. The
Eigenvalue results will be printed to the Text Output window. Error norms may vary.
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Viewing the Results

Results File = L:\models\tower.mys ID 0

MODE EIGENVALUE FREQUENCY ERROR NORM
1 147.296 1.93160 0.945062E-12

2 1527.44 6.22017 0.252379E-12

3 7481.98 13.7667 0.992755E-13

4 12463.9 17.7683 0.261939E-12

5 16464.9 20.4221 0.968822E-13

6 26008.4 25.6671 0.346929E-12

7 31861.1 28.4087 0.455993E-10

8 33854.1 29.2837 0.157390E-07

9 34920.0 29.7411 0.110320E-06

10 35963.4 30.1822 0.499202E-06

Note. The frequency in Hertz can be obtained by dividing the square root of the
eigenvalue by 27t. The period of vibration in seconds is obtained using the reciprocal of
frequency (1/frequency). Values of error norm may vary from those shown.

Caution. The system eigenvectors have been normalised (in this case with respect to
mass) therefore any derived quantities such as displacement and moment are also
normalised and are not true design values.

. E Close the text window by selecting the close button in the top right hand corner
of the window.

e Use the maximise button to increase the size of the graphics window.

Spectral Response Analysis

Spectral response calculations are performed using the IMD (Interactive Modal
Dynamics) facility. Setting up the spectral response results involves the following steps:

U Define the Spectral Excitation curve.

O Define the dynamic excitation type (support motion acceleration in this
example), direction, and specify the type of results required using a CQC
(Combined Quadratic Combination) for spectral response.

U Set the IMD loadcase to be active.

The spectral combination results can be displayed using a deformed shape plot or force
and moment diagrams.

Note. Additional damping information may also be set. Unlike results from a natural
frequency analysis, the output values obtained from a spectral combination are design
values.
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| File
| Script
| Run Script....

| Analyses
[IMD Loadcase. ..

Seismic Response of a 2D Frame (Frequency Domain)

Stage 1 - Defining a Spectral Excitation Curve

Values for the spectral excitation
curve need to be specified. For this
analysis Acceleration versus Period
values are to be used with a damping
value of 5%.

Note. The Utilities > Response
Spectra command would normally be
used to define response spectra data.
However, to simplify entering the
required data, the full response
spectrum definition for this example
is contained in a command file.

Acceleration

Tower Response Spectra

L D I I I R B
T
df-diee-
354 IR RO U U U [
ke T U I
1 1 1 1 1
25 L e I I e
1 1 1 1 1 1
2'"'I"'T"'I'"'I"'l'"'l"'T
154 -4 t-n
[ BRRREE EE R EEREEE SERE
05 i t t t t t t
o] Lyl = Lo = L ] L
— — [} [} Loy} o

Fariad

Acceleration £ Period

e In the \<LusaslnstallationFolder>\Examples\Modeller directory select the file

tower_spectrum.vbs and click OK

e A response spectra dataset TOWER and corresponding graph datasets containing
the spectral data for period and acceleration will be created in the " Treeview.

Stage 2 - Defining the Dynamic Excitation

e Select Support Motion from the
Excitation drop down list and
Spectral from the Results drop

down list. Ensure the Use all modes

option is selected.

e Change the IMD loadcase name to
be IMD Spectral Response

e Click the Excitation Set button.

IMD Loadcase [ %]

Damping

Type

Excitation | Support Motion hd Set...
Results Spectral - Set...

Mad
INDne 2

Set damping... |

¥ Use all modes

Selectmodes,

Marmn

] IIMD Spectral Response

[Earce] Aepl Help

Cloze I
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Viewing the Results

e On the Support Motion dialog select
Acceleration SUppOFt motion Option in the X € Displacement " Velocity ' Acceleration
direction which is Relative

WVectar

. o s e
e Click the OK button to return to the IMD rimpeciﬁed ! ‘

loadcase dialog. e
g ®oQo Fregency domain
v IDD— Iespohze motion type

-

= IDD— IHeIative I
QK I Cancel I Help |

e On the IMD loadcase dialog click the EESEliEIIE]
Resu|t5 Set buttOI’l Type of spectral response ICQC cambination 'l
['amping wariation corection Im
. to responze spectum
e On the Spectral Response dialog setthe o .
type of spectral response to CQC  Frequency " Displacement
Combination  with the damping & Peiod « Velocy
variation correction set as None. The (¢ Aeeelersicn
response spectrum TOWER read in ‘ Percent damping |00 ‘
from the command file will already be Poriod PR Rm—— =
selected in the drop down list. 1] 02 053
2 028 0.82
) 3 | os 1.29
e Click the OK button to return to the | o 7
IMD loadcase dialog. - 2 =
~ Spectral responze
e Click the OK button to finish. TOWER X Huan

oK I Cancel | Help

Selecting the IMD Results Loadcase

o In the & Treeview right-click on the IMD Spectral Response loadcase name and
select the Set Active option.

The spectral combination results are now activated. Any subsequent results plots, such
as deformed shapes or moments, will be for the spectral combination results only.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Whilst previous results have been viewed using this mode of operation,
in order to allow additional information to be added without obscuring the model, Page
Layout Mode will be used instead.
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[ View
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| Page Layout Mode

| File

| Page Setup...

The graphics window will resize to show the mesh layer on an A4 size piece of paper.

Set the page layout to Portrait and click OK

Displaying Results for Spectral Combination

A plot showing the tower deformed shape, bending moment and axial force for the
spectral combination is to be displayed.

o Delete the Deformed Mesh layer from the = Treeview.

e Add the Mesh layer to the =" Treeview.

Axial Force Diagram

e With no features selected, click the right-
hand mouse button in a blank part of the
Graphics area and select the Diagrams
option to add the Diagrams layer to the

Treeview.

e Select Force/Moment - Thick 2D Beam
results of axial force Fx in the members.

e Select the Diagram Display tab, select
the Label values option and choose the
Label only if selected option

e Click the OK button to finish.

Results will be calculated for the active IMD
spectral response loadcase and an axial force
diagram of stresses in each member will be J

displayed.

Displaying results on selected members

e Hovering over a member with the cursor will display previously chosen results
information for gauss points along that member.

e Selecting a member will display results for that member. Remember more than one
member can be selected by holding down the Shift key.
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Viewing the Results

El If necessary, use the Zoom in button to view results information.

These type of element results can also be plotted in isolation on selected model
features. This is covered later in the example.

Shear Force Diagram

e In the Treeview double-click on the
Diagrams layer. The diagram properties
will be displayed.

e Select Force/Moment - Thick 2D Beam
results of shear force Fy in the members.

e Click the OK button to finish.

e A shear force diagram of stresses in each
member will be displayed.
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| utilities

Annotation >
Window border

| File

Print Preview...

| utilities
Annotation >
Window border

[ View

Working Mode

Seismic Response of a 2D Frame (Frequency Domain)

Bending Moment Diagram

e In the Treeview double-click on the
Diagrams layer. The diagram properties
will be displayed.

e Select Force/Moment - Thick 2D Beam
results of bending moment Mz in the

members.
e Click the OK button to finish.
A bending moment diagram of stresses in - (_\
each member will be displayed.
I A L_x L
L b .
L
e |

Printing Results

Note. Text and border annotation may be added to the display from the Utilities>
Annotation menu.

To add a border to the display.
Now view how the results would print.

This shows how the bending moment results for the whole model will appear on printed
output.

e Click the Close button to exit the print preview window.

To remove the border from the display.

Plotting Results for a Selected Part of the Model

The graphics window will resize to show the model in normal working mode.

Note. Changing from Page Layout to Working Mode will resize and reposition any
displayed annotation. Page layout mode should be used when preparing a view for
printing. Working Mode should be used when viewing on the screen.
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| Geometry

Group >
New Group

Viewing the Results

If results are to be plotted for a selected part of the structure only, a Group may be
created of the area of interest. For example, to plot results of just the top 4 storeys of
the tower:

e Inthe Treeview double-click the Mesh layer, select Visualise tab and de-select
the option to visualise Beam end releases. Click the OK button.

e Drag a box around the upper 4 storeys of Dragabox M=~ ~71
the tower as shown. around these : :
features | |
Enter Upper 4 storeys for the group I I
name. Click the OK button to complete : :
creation of the group. | |
| |
e Click the right-hand mouse button on the | |
Upper 4 storeys group in the | |
Treeview, and select the Set as Only lL '
Visible option to turn on the display of (\ s Jk
this group only. L
I o L_;ﬂ L
L) -
-
L l

The results for just the upper 4 storeys will be displayed.
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e To add values to selected members double click on the

Diagrams layer in the Treeview and select the Diagram
Display tab.

e Ensure that the options to Label values and Label only if
selected are chosen.

e Set the number of significant figures to 4

e Choose the Label Font button and change the size to 11 and
click OK

e Change the Angle to 25
e Select the Scale tab and set the magnitude to 2

e Click OK and the diagram will be displayed without any
values because no elements have been selected.

e Select the horizontal elements and the labels of My (as
previously selected) will appear.

Note. Holding down the Shift key after the first selection will enable labels on more
than one element to be visualised.

Re-display the Whole Model

To re-display the whole model in working mode:

e Select the Treeview and click the right-hand mouse button on tower.mdl, and
select the Visible option to turn on the display of all groups. Select Yes to act on
subgroups as well.

Frequency Versus Participation Factor Graphs

A graph of Participation factors (for the X and Y directions) versus Frequency is to be
plotted. For the current spectral combination, where the applied ground motion is in the
X direction, the graph will show to what extent each structural mode is excited in the X
and Y directions. A large modal participation factor indicates a significant response in
that direction.

Using the Graph Wizard

The graph wizard provides a step-by-step means of selecting which results are to be
plotted on the X and Y axes of the graph. The X axis is always defined first.

248



Viewing the Results

| utilities e Ensure the Time history option is selected and click the Next button.

Graph Wizard...

e Select the Named option and click the Next button.

e Select Natural Frequency from the drop down list and click the Next button.
The Y axis results to be graphed are now defined.

e Select Named results and click the Next button.

e Select Participation Factor X and click the Next button.

Additional information for the graph may now to be added.

e Enter the Y axis title as Participation Factor X axis

e Ensure that the Show symbols button is selected.

e Click the Finish button to display the graph.

Note. If no graph or axis titles are entered default names will be used.

Note. The sign of the participation factor displayed on the graph is arbitrary as the
/ mode shape from which it is derived can have a positive or negative amplitude.
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LUSAS will create the graph in a new window and display the values used in an
adjacent table. To see the graph at the best resolution enlarge the window to a full size
view.
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| Graph Wizard...

From the graph it can be seen that the first 3 modes are dominated by the motion in the
X direction.

A graph of Participation factor in the Y direction will now be plotted on top of the
existing graph.

e Ensure the Time history option is selected and click the Next button.
e Select the Previously Defined option. Click the Next button.

e Select Natural Frequency results. Click the Next button.

The Y axis results to be graphed are now defined.

e Select Named results and click the Next button.

e Select Participation Factor Y. Click the Next button.

The results are to be plotted on top of the existing graph so no additional title
information is to be added.

e Select the Add to existing graph option and ensure that the previous graph name
Graph 1 is selected.

e Click the Finish button.
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The Participation factors for the Y axis are superimposed on the graph.
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| Edit

Edit Graph
Properties...

Viewing the Results

From the graph it can be seen that the fourth mode shape is dominated by motion in the
Y direction.

Note. The graph properties may be modified by clicking the right-hand mouse button
in the graph display area and selecting the Edit Graph Properties option.

To change the symbols on the second graph dataset:

Select the Curves tab and the second dataset Participation Factor Y / Natural
Frequency from the dropdown list.

Change the symbol to Square

Select the Symbol Start Colour and select dark blue
Select the Line Colour and select the same dark blue
Click OK to action the change.
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Creating Animations of Mode Shapes

The dominant mode shapes (Eigenvalue results 1, 2, 3 and 4) caused by the applied
response spectra will now be animated. To see the deformations in the structure the
deformed mesh layer must be displayed.

Re-select the window containing the model data and use the maximise button

to increase the size to fill the graphic area.
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e Turn off the display of the Mesh, Diagram and Annotation layers in the
Treeview.

e Add the Deformed mesh layer and OK the dialog properties.

o In the ‘5 Treeview right-click on Results File Eigenvalue 1 and select the Set
Active option.

The deformed shape for Eigenvalue 1 will now be displayed.

| utilities e Ensure the Active loadcase button is selected and select the Next button.

Animation Wizard...

e Use a Sine deformation with 14 frames. Set the deformation magnitude of 6 mm for
therange O to 1

e Click Finish to build and display the animation.

THZ HZ

e To see the animation at the best resolution enlarge the window to a full size view.

The buttons at the bottom of the window may be used to slow-down, speed-up, pause,
step through frame by frame, or stop the animation.

252



| File

Viewing the Results

| Save As AVI...

| File

| Save

| Analyses

Generate Structural
Analysis...

Saving Animations

Animations may be saved for replay in LUSAS at any time or saved for display in other
windows animation players.

e Ensure the animation window is the active window.

e Save the animation to your projects folder and enter tower_1 for the animation file
name. An .avi file extension is automatically appended to the file name.

e Animations can be compressed to save disk space by altering the Compress Video
slider.

El Save the model file.

Viewing the effects of self weight and spectral response

Spectral loadcases can be combined with other loadcases to provide results which
include dead and live loads but since spectral loadcases are computed from an
eigenvalue analysis the sign of the spectral displacements is always positive. The most
adverse results can, however, be obtained using load combinations.

e Add a new structural analysis to
the mOdel General |Inih’al Deformaﬁonsl
Set thi lysi th X X
e Ensure Set this analysis as the ™ base souctra s ertfombsseansbss A

base structural analysis is not
selected, and that Inherit from
base analysis is selected.

e Name the analysis Analysis 2 and
press OK Mame | Analysis 2

OK | Cancel | Apply | Help |

Loading from self weight can be automatically added to any loadcase by enabling
gravity in the () Treeview.

o In the ‘X! Treeview expand Analysis 2 and then right-click on Loadcase 2 and
rename it to be Self Weight

o Inthe "= Treeview right-click on Self Weight and select Gravity
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Running the Analysis

El Open the Solve Now dialog. Ensure that Analysis 2 is selected and press OK.

Viewing the Results
After a successful analysis the Self Weight results file will be added to the (2 Treeview.

Defining Self weight and Spectral load combinations

Two basic load combinations will now be created to view the combined effects of the
self weight and spectral results; one for self weight plus the spectral results and one for
self weight minus the spectral results.

| Analyses The combination properties dialog will appear.
Basic Combination...
Available Induded Load factor | 1.0 Grid...
File [model =l IB)File 0: 3: Self Weight
QFiIE 0: 2: IMD Spectral Response
Name Type | Res file
(3 t:loadease 1 [1}
{F) 3:5elf Weight 0
(8 2:MD Spectral Respo... 0
>>
<<
< | 2l
Mame I Self Weight + Spectral Response
Type Ir-lone j
OK | Cancel | Apply | Help

e Ensure results file model is selected from the drop down list.

e Select Self Weight and click the il button to add the loadcase to the load
combination. Leave the load factor set as 1.0

e Select IMD Spectral Results and click the LI button to add the Spectral results
loadcase to the load combination. Leave the load factor set as 1.0

e Enter Self Weight + Spectral Response for the combination name

e Click the OK button to finish.
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| Analyses

Basic Combination...

| File

Save

Viewing the Results

Note. The IMD Spectral Results loadcase references the eigenvalues held in the
Analysis 1 results file.

The previous procedure is repeated to create a second basic load combination.

Ensure the file model is selected from the drop down list.
Include the Self Weight loadcase with a load factor set to 1.0

From the model file include all the IMD Spectral Results and set the load factor for
as-1.0

Enter Self Weight - Spectral Response for the combination name

Click the OK button to finish.

El Save the model file. This also saves any created load combinations with the model.

By setting a Self Weight and Spectral Response load combination active, shear force
and bending moments can be viewed for each combination. Use or modify the
Diagrams layer to view values on the frame.
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This completes the example.

255



Seismic Response of a 2D Frame (Frequency Domain)

256



Description

Seismic Response
of a 3D Frame
(Frequency Domain)

For software product(s): | All (except LT versions)
With product option(s): | None.
Note: This example exceeds the limits of the LUSAS Teaching and Training version.

Description

This example examines the spectral
response of a 2-storey 3D frame.

/\
IV
VA

\/

The geometry of the structure has P SN

been simplified to a wire-frame or €§%§>’§Q
stick representation with each of the ’$'4$%§"
members of the structure being ‘ S N

)

represented by a line feature only. TR

SIS
Units used are N, m, kg, s, C qx‘ﬂ
throughout. "‘i
Objectives

The required output from the analysis consists of:
U Axial force and bending diagram from a CQC combination.

Keywords

Seismic, Spectral, Response, Mass Participation, Interactive Modal Dynamics,
Excitation, Eigenvalue, CQC Combination.
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Seismic Response of a 3D Frame (Frequency Domain)

Associated Files

0 3D_frame.mdl Model of the structure.

U 3D_frame_spectrum_EC8.vbs defines a typical spectral curve to
Eurocode 8

Discussion

The mesh definition used on a dynamic analysis is somewhat different from that used
on a static stress analysis. In a static analysis, and with experience, it is usually not too
difficult to estimate where the high stresses are likely to occur. These estimates can
then be used to develop a meshing strategy with a fine mesh in high stress locations and
a coarse mesh in less critical locations. For a dynamic analysis the interaction between
the stiffness and inertia forces will lead to deflected shapes which can be very different
from those expected in a static analysis.

In a dynamic analysis both stiffness and mass distribution has to be considered.
Generally, the best strategy for a dynamic analysis is to have a uniform mesh over the
entire structure but in stiff regions a more coarse mesh can be used. In regions that are
more flexible, or where heavy masses are located, the mesh can be more refined.

In this example the global behaviour of the building is being considered for earthquake
response. The lower frequencies will be dominant in this analysis and a relatively
coarse mesh will suffice. If the higher frequencies are important, or if a local response
due to panel modes for individual beams and columns is to be considered, a revised
mesh with more elements would need to be considered.

The spectral response analysis is performed in two distinct stages:

1. A natural frequency analysis is performed. This is used here to calculate the first 30
natural modes of vibration of the structure. The eigenvalues, frequencies and
eigenvectors (mode shapes) are stored and used in the subsequent spectral response
analysis. In order to carry out a spectral analysis the modes must be normalised
with respect to the mass. Although natural frequencies are obtained from an
eigenvalue analysis any information regarding the magnitudes of deformations or
moments is hon-quantitative.

2. A spectral response calculation is performed interactively as a results processing
operation using the Interactive Modal Dynamics (IMD) facility. This is an
alternative to performing a non-interactive spectral response analysis in LUSAS
Solver.

In a spectral response analysis, the structure is subjected to support excitation. In this
example this is assumed to be the effect of seismic motion although any support motion
could be envisaged. The excitation is specified as a spectral curve, in terms of period
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Modelling

| File

Open...

Modelling

versus acceleration. Damping, implicitly included in the spectral curve, may also be
specified at this stage.

From the eigen analysis, participation factors indicate, for each mode, the degree of
structural response associated with an applied excitation. In the spectral analysis a mode
combination is calculated from which a worst-case displacement/moment envelope may
be obtained.

Running LUSAS Modeller
For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Building and loading the model

For this example a model file is provided:

To create the model, open the read only file 3d_frame.mdl located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

@l If necessary, select the isometric button to view the frame in 3D.
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| File

Save As

| File

Save

Seismic Response of a 3D Frame (Frequency Domain)

Save the model

El Save the model file to the \<Lusas Installation Folder> \Projects directory.

Note. No static structural loading is required for this analysis because a spectral
combination is carried out during results processing using the results from the natural
frequency analysis which is independent of applied loading.

The modelling will now be completed by defining the controls necessary to extract the
natural frequencies.

Defining Eigenvalue controls

Eigenvalue controls are defined as properties of the loadcase.

e In the (&' Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Eigenvalue from the Controls menu.

The Eigenvalue dialog will appear.

The following parameters need to be specified:

e Set the Number of eigenvalues as 30

e Ensure the Shift to be applied is set as 0

e Ensure the Type of eigensolver is set as Default

Note. Eigenvector normalisation is set to Mass by default. This is essential if the
eigenvectors are to be used for subsequent IMD analysis in results processing as they
are in this case.

e Click the OK button to finish.

El Save the model file.

Running the Analysis

With the model loaded:

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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Viewing the Results

Viewing the Results

| utilities

[ Annotation
Window

Summary

Analysis loadcase results for each eigenvalue can be seen in the (5 Treeview.
Eigenvalue 1 is set to be active by default.

Plotting Mode Shapes
e Turn off the display of the Mesh, Geometry and Attributes layers in the

Treeview.

e With no features selected click the right-hand mouse button in a blank part of the

Graphics area and select the Deformed mesh option to add the deformed mesh
layer to the Treeview. Select the Visualise tab and, if selected, de-select the
Beam end release option. Click the OK button to accept the remaining default
values and display the deformed mesh for Eigenvalue 1.

e Show the Window Summary for an overview of the results.

Seale=1:131.208
Zoom:100.0
Eve: (-0.57735, -0.57735, 0.57735)
Eigenvalue Analysis

Cump: 1

Eigenvector 1

Fesults File: 0

Eigenvalue: 3829

Natural Frequeney 3114

Error Horm: 0.1226E-11

haximum Displacement0.S549E-02 at Hode 73
Entity: Stress
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| Utilities

Print Results Wizard

Seismic Response of a 3D Frame (Frequency Domain)

Note. The window summary displays the values of the eigenvalue and the natural
frequency and also a value for displacement at a node. It should be noted that the
displacement value is non-quantitative and is related to the amount of mass in a
particular mode using the mass normalisation technique. Therefore the only items that
can be found using a basic eigenvalue analysis are the frequency and the mode shape.

Note. The mode shape may be inverted from that shown above. This is because the
sense is arbitrary since during vibration deformed shape will appear in both directions.

e In the & Treeview right-click on Eigenvalue 2 and select the Set Active option.
The deformed mesh plot for Eigenvalue 2 will be displayed.

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode
shapes.

Printing Eigenvalue Results

Eigenvalue results for the whole structure can be displayed in the Text Output window.
e Choose Active loadcases and click Next.

e Select None from the Entity drop down list. Ensure Eigenvalues is displayed in the
Type drop down list and click Finish.

The Eigenvalue results will be printed to the Text Output window. For inspection only
the first 10 modes will be printed here.

MODE EIGENVALUE FREQUENCY ERROR NORM

1 382.904 3.11433 0.168140E-11
2 1011.29 5.06126 0.774353E-12
3 1599.54 6.36527 0.431202E-12
4 1891.32 6.92154 0.236809E-12
5 2336.34 7.69287 0.571844E-12
6 2525.21 7.99777 0.384185E-12
7 3924.31 9.97015 0.421926E-12
4153.57 10.2572 0.260236E-12

9 4183.07 10.2936 0.248550E-12
10 6658.98 12.9874 0.380041E-12
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| utilities

Print Results
Wizard...

Viewing the Results

Note. The frequency in Hertz can be obtained by dividing the square root of the
eigenvalue by 2x, and the period of vibration in seconds is obtained using the reciprocal
of frequency (1/frequency). Values of error norm may vary from those shown.

Caution. The system eigenvectors have been normalised (in this case with respect to
mass) therefore any derived quantities such as displacement and moment are also
normalised and are not true design values.

e Close the text window by selecting the close button in the top right hand corner of
the window.

Checking the Mass Participation Factor

Note. In order to carry out a successful response analysis you should ensure that a
significant proportion of the total mass has been accounted for in the analysis. This
requires checking that around 90% of the total mass is in the global x and y directions.
Failure to check that a significant proportion of the total mass has been accounted may
lead to important modes being missed and subsequent errors in the resulting response
analysis results.

e Ensure Active loadcases is chosen and click Next.

e Select None from the Entity drop down list. Ensure Sum Mass Participation
Factors is displayed in the Type combo box and click Finish. The Sum Mass
Participation Factors results will be printed to the Text Output window.

For inspection only modes 20 to 25 will be printed here. In can be seen that the 90%
value has been achieved in mode 22.

MODE SUM MASS X SUM MASS Y SUM MASS Z
20 0.861201 0.933385 0.122995E-01
21 0.870885 0.937375 0.123688E-01
22 0.945303 0.937380 0.123710E-01
23 0.945422 0.937388 0.130555E-01
24 0.945428 0.937470 0.304988
25 0.945451 0.937589 0.308786

e Close the text window by selecting the close button in the top right hand corner of
the window.

e Use the maximise button to increase the size of the graphics window.
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| File
| Script >
| Run Script....

| Analyses
[IMD Loadcase. ..

Seismic Response of a 3D Frame (Frequency Domain)

Spectral Response Analysis

Spectral response calculations are performed using the IMD (Interactive Modal
Dynamics) facility. This involves defining the spectral curve and excitation and
specifying the results required in an IMD loadcase. The spectral results can then be
interrogated by setting the IMD loadcase active.

With spectral response analysis additional damping information may also be set. Unlike
results from a natural frequency analysis, the output values obtained from a spectral
combination are design values.

Stage 1 : Defining a Spectral Excitation Curve

Values for the spectral excitation curve need to be specified. For this analysis
Acceleration versus Period values are to be used.

3d_frame_spectrum_ec8.vbs defines response spectrum to Eurocode EC8.

e Select the file 3d_frame_spectrum_ec8.vbs, which is located in the \<LUSAS
Installation Folder>\Examples\Modeller directory. Click OK

e A response spectra dataset 3D_frame_spectrum containing the spectral data for
period and acceleration will be created in the " Treeview.

Stage 2 : Defining the Dynamic Excitation

An Interactive Modal Dynamics loadcase IMD 1 will be added to the Treeview.

e Select Support Motion from the Excitation drop down list and Spectral from the
Results drop down list. Ensure the Use all modes option is selected.

e Click the Excitation Set button.

e Ensure the Acceleration support motion option is set to a User specified direction
which is Relative. In the box next to the X direction enter the value of 1.0 and in
the box next to the Y direction enter the value of 0.6.

e Click the OK button to return to the IMD loadcase dialog.

Note. Using the user-specified option a single earthquake response can be applied in
multiple directions at the same time. In this case 100% of the earthquake response is
being applied in the X direction at the same time as 60% of the earthquake response is
being applied in the Y direction. In real-life situations, in the absence of additional
data, and depending upon the design code being used, a percentage of the horizontal
earthquake response could also be applied in the vertical Z-direction.
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Viewing the Results

Click the Results Set button.

On the Results dialog ensure the type of spectral response is CQC Combination
with the damping variation correction set as None. The response spectrum
3D_frame_spectrum read in from the supplied VBS file will already be selected in
the drop down list.

Click the OK button to return to the IMD loadcase dialog.

Click the OK button to finish.

Note. There are a number of different methods of carrying out modal combinations:

1.

If the natural frequencies are well separated the square root of the sum of the
squares (SRSS) has been shown to produce acceptable results.

For a situation where the modes have close separation of natural frequencies then an
absolute sum (AbsSum) is taken on the assumption that they can peak in phase with
each other.

Alternatively a compete quadratic combination (CQC) method can be used (as in
this example) which effectively combines both the SRSS and AbsSum methods as it
accounts for the separation between modes.

Note. If the defined damping differs from that inherent in the spectral curve a
correction may be applied. There are a number of damping variation correction options
available for use. For more details on these see the Theory Manual.
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Stage 3: Selecting the IMD Results Loadcase

In the ¢ Treeview right-click on the IMD Loadcase 1 loadcase name and select the
Set Active option.

Scale=1:130.83
Zoom: 100.0
Evye: (-0.57725, -0.57735, 057738
Spectral Responze Analysis

CQC Combination

Spectrum: 1

faximum Displacement ] 77ATE-0Z at Hode 143

Stage 4 : Displaying the Spectral Combination Results

Plots showing the axial force and bending moments in the members for the spectral
combination is to be displayed.

e Inthe Treeview right-click the group named Columns and Set as Only Visible
to only view the column members.

e Turn off the display of the Deformed Mesh layer in the = Treeview .

e With no features selected, click the right-hand mouse button in a blank part of the

Graphics area and select the Diagrams option to add the Diagrams layer to the
Treeview.

e Select Force/Moment - Thick 3D Beam results of axial force Fx in the members.
Select the Diagram display tab and select the Label values option. Plot values on
80% of the element length. Click the OK button to finish.

266



Viewing the Results

Note that the Orientate by element axes and Orientate flat to screen/page option are
greyed-out because they have no relevance for axial stress diagrams. A ‘flat to
screen/page’ plot is obtained by default.

Scale=1:125.497

Zoom: 1000

Eve: (-0.57735, -0.57735,0.57730)
Spectral Responze Analysis

COC Combination
| |
Spectrum: 1

Maximum Dizplacement 0.72569E-02 at Hode/ 79 |
Entity: Forcefhloment | !

Diagram Component: Fx
MAK 8525, at WGP 141 | |
bl 1249 at EIFGP 27/ | |

DIAGRAM Scale: 1/0 1667 1 |

Y“J_.ﬂ’x

Results will be calculated for the active IMD load case and an axial force diagram of
force in each member will be displayed. If necessary, use the Zoom in button to view
results information. These type of results can also be plotted in isolation on selected
model features.

e Inthe =" Treeview double-click the Diagram layer to view its properties.

e Select Force/Moment - Thick 3D Beam results of axial force My in the members.
Click the OK button to finish.
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Scale: 10 144649

Zaom: 100.0
Eve: (-0.57735, -0.57735, 0.57735) R
Spectral response analysis
CQC combination 49803 ITHTES
Spectrum: 30_frame_spectrum 39857
Losdcase: ZIMD 1 s BE14E3
1849883 3
Diagram entity: ForceMoment - Thick 30 Beam \E -é%%aE
{25104E3 054E4E3
Diagram component: Wy 409399
Ba0 859 1930
Diagram maximum 13.3543E3 at Gauss point 1 of element 12
330563 BE2TYES
Dizgram minimum 3. 29566 at Gauss point 6 of glemert 9 7 459963
; fL7R4BES BASESES
Diagram scale: 1; 0.448294E-.
35705E3 3834E3 47031
466,164
242E3 O4ERIES
issasaEa anssr
33543E3 9.21516E3 25 575
3 PaRES
g 17039E3 96043
7
S i
91016E3 05.644
06,624
45353 9755E3 24 056
60.02
W4TI4ES
12366663 ! PEATSES 1E558E3
90,155
2108263 54 885
B7ES
. 74494E3
v X
07.536

Note that Orientate by element axes is the default diagram display option for all
components other than Fx. This can be changed by selecting the Diagram display tab
and selecting Orientate flat to screen / page as necessary.

. _
® ;a\,e El Save the model file.

This completes the example.
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Description

Buckling Analysis of
a Plate Girder

For software product(s): | Any Plus version.
With product option(s): | None.
Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The buckling behaviour 16000 |
of a steel plate girder
with web stiffeners is to | | | | | | | | | | | | |

be examined. H—SOObearing F—-‘istiﬁeners at 1500 centres +—-‘ 500bearing—H
The girder is supported - e -
at both ends by fixed

. 101 b
and  roller  bearing — e
supports. A cross-slab b S stfencre

connection to the girder
provides a partial lateral
restraint. A distributed Modeling
load representing Helght
transverse steel decking

is applied to a selected
part of the web of the |Aldegan
girder. The steel plates

30mm flanges

Lateral

Modelling units used support

are modelled using thin | aemeres T
shell (QSLS8) elements. j:

Units of kN, m, t, s, C
are used throughout the
example.
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Modelling

Buckling Analysis of a Plate Girder

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading.
O Animation
U Buckling load

Keywords

Simple Geometry, Plate Buckling, Linear Buckling, Eigenvalue Buckling, Deformed Mesh
Plot, Printing Eigenvalues.

Associated Files

U plate_girder_modelling.vbs carries out the modelling of the example. After
creating a new model and running this file, the example can be continued from
the section titled Running the Analysis.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating the Longitudinal Beam Model

e Enter the file name as plate_girder

e Use the Default working folder.

e Enter the title as Buckling analysis of a plate girder

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the Standard startup template.

e Select the Vertical Y axis option and click OK.
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| Geometry

| Line

>

Coordinates...

| Geometry

Modelling

| Surface

By Sweeping...

| Geometry

>

| Surface

| By Sweeping...

>

Feature Geometry

A cross-section of the girder is created initially and swept and copied into a half-model
before mirroring to create the full plate girder model.

il Enter coordinates of : :
(-0.1,0), (0,00 and (0.1,0) to | [
define Lines representing the | T . _ |
bottom flange of the girder. e '
Click the OK button.

e Drag a box around all the
features just drawn.

él Enter translation value of 0.1 in the Y direction to create surfaces that will define
part of the end stiffener. Click the OK button to finish.

e Drag a box around the 2 line i I
features shown. '

él Enter a translation value of 0.8 Select these featlires
in the Y direction and click OK to
create surfaces that will define part L
of the end stiffener.
The girder has a 500mm long bearing region at the end which
will be created first. J
e Select the 6 Lines representing the cross-section of the
girder as shown.

Select

these 6

lines

Ef

AN
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| Geometry

Surface >
By Sweeping...

N

| Geometry

Surface
Copy...

Buckling Analysis of a Plate Girder

Geometry

ﬂl Enter a translation value of 0.5 in the Z direction. Click the OK button to finish.

Note. Save the model regularly as the example progresses. The Undo button may be
used to correct any mistakes made since the last save.

Note. Holding down the L key while selecting ensures that only lines will be
selected. Similarly the P key limits the selection to Points, the S key; Surfaces, the V
key; Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes,
etc., which can be found in Modeller Manual.

El Use the Isometric button to view the model to a similar
view to that shown
The bearing region has a stiffener either side of it.

|

|

[

|

[

|

o Select the 4 surfaces representing the 2 end stiffeners. :
|

|

M Enter a value of 0.5 in the Z direction to copy the surfaces
to define the web stiffeners. Click OK to finish.

Select these 4
surfaces

Note. Many of the more common tasks are provided in the context menu. With the
model geometry selected right-hand within the view to make the context menu appear.
From this menu you can Copy, Delete, Move and Sweep.

The girder has 1500mm long internal panel sections along its length.
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| Geometry
Surface >
By Sweeping...
| Geometry
Surface >
Copy...

Modelling

e Select the 6 Lines representing the cross-section of
the girder. If necessary use the Zoom facility to
simplify the selection.

él Enter a translation value of 1.5 in the Z direction.
Click the OK button to finish.

¢ Right-click on the o b X coordinates readout display on the Status bar
and select Rotate +Z +Y.

e Hold down the Shift key on the N T T T T T T T T T T T~ !
keyboard and select the X
coordinate readout panel again
to obtain the reverse view
looking along the X-axis.

e Drag a box around all the &
features shown to select the first by
panel section and web stiffener. L

M Enter a value of 1.5 in the z
direction to copy the surfaces used to define the web and stiffener.

e Enter the number of copies as 9 and click the OK button.
Finally, the other bearing end to the girder has to be created.

e Drag a box around all the features shown to select the bearing end of the girder and
web stiffener.

$ o

—

1

_k Select these features

- i |
|
1
T
|
T

-
-
-
-
-
-

r—==="
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| Geometry

Surface
Copy...

Buckling Analysis of a Plate Girder

ﬂ Enter a value of 15.5 in the Z direction to copy the surfaces used to define the web
and stiffener. Click OK to finish.

D S D B D B A

Meshing the web stiffeners

Line mesh divisions will be used to control the surface mesh density for the plates. All
Lines defined so far have 4 Line mesh divisions by default. Certain Lines require
different divisions to be specified.

@l Select the home button to view the girder end on.

Line mesh

The Lines representing the top flange, lower flange, and part of the web and web
stiffeners require 1 mesh division to be assigned to them. These could be selected
individually in order to assign the line mesh division to them but LUSAS provides some
advanced selection / deselection tools for this type of work.

e Hold down the L key on the keyboard anddraga [~~~ =~~~ "~ '
box around the area shown to only select the

|
| g
. i | A
Lines within the box. :_ Y]
e Then, with the lines still selected, hold down the k
Control key and drag separate boxes around
each of the 3 points shown. 1. Hold down
the L key and
Note. Using the Control key in the manner box select
described deselects the lines going into the screen these features
from the previous box-selection. These lines will
therefore remain meshed with 4 line divisions. 2. Hold down
the Control key
and select the 3
inner features

as shown
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Modelling

@l Selection of lines

can be checked by using
the Isometric button.

Only the lines shown in
the  diagram  should
appear highlighted to
show that they have been
selected.

@l After checking, select the Home button to return the model to its initial view.

e With the lines selected drag and drop the Line mesh attribute Divisions=1 from the
& Treeview onto the selected features.

e In a similar fashion to that done for the top flange,

hold down the L key and drag a box around the 1. Hold down the
area shown to select all the Lines within. L key and box
select all
e Then, with the lines still selected, hold down the features shown

Control key, and drag separate boxes around each

of the 6 points shown to deselect the lines goin 2. Hold down

. P s . going Control key and
into the screen from the initial selection. select inner

. i Lo features shown
e Drag and drop the Line mesh attribute Divisions=1

from the e?b Treeview onto the selected features.

BG4 k
Surface mesh
| Attributes e Select Thin shell, Quadrilateral elements with Quadratic interpolation. LUSAS will
l% select QSL8 elements.
urface...

o Enter the attribute name as Thin Shells (QSL8) and click OK to finish.
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| Attributes

Geometric >
Surface...

Buckling Analysis of a Plate Girder

e Select the whole model (Control + A keys)

e Drag and drop the surface mesh attribute Thin

Shells (QSL8) from the & Treeview onto the
selected features.

The mesh will be drawn. Note that, by default, the
mesh nodes as shown on these accompanying
diagrams are not displayed.

El Use the Isometric button to view the mesh on
the model.

El Use the Zoom in button to check the mesh
definition.

o
il Use the resize button to show the whole model
il Use the Cursor button switch back to the normal cursor tool.

Geometric Properties

Three steel thicknesses are required to model the web, flanges and web stiffeners.

e Enter a value of 0.01 for the thickness. The eccentricity can be left blank. Enter the
attribute name as Thickness=0.01m. Click the Apply button to create the attribute.

e Amend the thickness to 0.015. Change the attribute name to Thickness=0.015m. Click
the Apply button to create the attribute.

e Amend the thickness to 0.03. Change the attribute name to Thickness=0.03m. Click
the OK button to finish.

@l Select the home button to view the beam end on.
e Select the whole model (Control + A keys)

e Drag and drop the geometry attribute Thickness=0.015m from the & Treeview
onto the selected features.

!l Select the fleshing on/off button to turn-off the geometric visualisation.
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Modelling

e Select the Surfaces representing the top and :‘ ________ !

I
bottom flanges. c_ 1 1 1 ‘k
e Drag and drop the geometry attribute 1 1
Thickness=0.03m from the & Treeview “y
onto the selected features. 1. Box select
‘ ‘ the top flange
2. Hold down
1 1 Shift key and
add bottom
flange to
J J selection
[ ]
Ny |

e Select the Surfaces representing the web.

e
I I
e Drag and drop the geometry attribute | |
Thickness=0.01m from the &% Treeview onto the IR
selected features. : :
e Once done, click on a blank part of the graphics : :
window to deselect the web surfaces. 11 11
I I
} !
I I
I
I I
I I
I I 1. Box
11| 1| selectthe
: : surfaces
L v of the web
11 I
i L
L_*
Checking attribute assignments

Note. Once assigned to the model, attributes such as geometry may be visualised.
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| Attributes

| Material >

Material
Library...

| Attributes

Support...

Buckling Analysis of a Plate Girder

e In the Treeview click the right-hand  ceometri ey
mouse button on the Geometry layer .mg:::;;g;gf
and select Properties.

Thickness 0.015

e On the Colour by drop-down menu
select Assignment then select the Set
button. Change the attribute type to
show Geometric attributes and click
OK. Finally, select Solid on the
geometry properties box and click OK

El Use the Isometric button to view the
model to a similar view to that shown.

o Check that the geometry assignments
have been correctly assigned and then
switch off the visualisation. In the Treeview click the right-hand mouse button
on the Geometry layer and select Properties.

e On the Colour by drop-down menu select Own colour then Finally, de-select Solid
on the geometry properties box and click OK

Material Properties

Select material Mild Steel from the drop-down list, leave the grade as Ungraded and
click OK to add the material attribute to the &b Treeview.

e With the whole model selected, drag and drop the material attribute Isol (Mild

Steel Ungraded) from the & Treeview onto the selected features. Click OK
ensuring it is assigned to all surfaces.

Supports

Three support conditions are required. A fixed bearing, a rolling bearing, and a lateral
restraint to the flange of the girder.

Set the translation in the X and Z directions to Fixed. Set the spring stiffness in the Y
direction to 200e8 and specify that the Spring stiffness distribution is stiffness/unit area.
Enter the attribute name as Fixed Bearing. Click the Apply button to reuse the dialog for
the other support conditions.

e Set the translation in the Z direction to Free and leave all other translations as
specified previously. Enter the attribute name as Rolling Bearing. Click the Apply
button to reuse the dialog for the next support condition.
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Modelling

e Set the spring stiffness in the X direction to 100e8. Set the translation in the Y and z
directions to Free. Ensure that the Spring stiffness distribution is stiffness/unit length.
Enter the attribute name as Lateral Support. Click the OK button to finish.

El Use the Zoom in button to enlarge the view of the
left-hand end support.

il Use the Cursor button switch back to the normal
cursor tool.

e Select the 2 flange Surfaces shown. Take care to
not select the lowest web surface by mistake.

Note. For features lying underneath others in the
Graphics Window, continually clicking on a feature
will cycle through selecting different features in turn.

e Drag and drop the support attribute Fixed Bearing
from the & Treeview onto the selected features.

Click OK ensuring that it is assigned to Surfaces.

o
il Use the resize button to show the whole model.

El Use the Zoom in button to enlarge the view of the
right-hand end support.

Select
these 2 surfaces

il Use the Cursor button switch back to the normal cursor tool.

e Select the equivalent 2 lower Surfaces for the right-hand support.

o Drag and drop the support attribute Rolling Bearing from the &b Treeview onto the
selected features. Click OK ensuring that it is assigned to Surfaces.
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| Attributes

Buckling Analysis of a Plate Girder

| Loading. ..

@l To help assign the lateral supports return the model to
the default home view.

Drag a box around the Point shown (All Lines in the same
plane will be selected).

Drag and drop the support attribute Lateral Support from

the &b Treeview onto the selected features, Click OK
ensuring that the support attribute is assigned to Lines.

Loading

Self-weight will be applied to the model as a property of the
analysis.

In the (2 Treeview, expand Analysis 1 then right-click on
Loadcase 1 and select Gravity to apply self-weight to the
model

In addition to the self-weight, a uniformly distributed load is
to be applied to the flange of the beam.

Select the Global Distributed option and click Next

Select this Point

Enter a load of -10 in the Y direction and specify that the load distribution be Per
Unit Area. Enter the attribute name as Imposed Loading and click the Finish

button.
Select the Surfaces of the top flange as shown

Drag and drop the loading attribute Imposed Loading

from the & Treeview onto the selected features. Click OK
assigning it to Surfaces as Loadcase 1

Click in a blank area of the view window to deselect any
currently selected features

This completes the modelling of the girder.

Box select the top

flange
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| File

Save

Running the Analysis

Eigenvalue Analysis Control

By default an eigenvalue analysis extracts the natural modes of vibration of a structure.
It can also be used to solve buckling load analysis problems. The solution parameters
for buckling analysis are specified using an eigenvalue control attribute. In this example
only the 1st natural mode of buckling of the girder is to be investigated.

Eigenvalue analysis control is defined as a property of a loadcase.

e In the (5 Treeview right-click on Loadcase 1 and select Eigenvalue from the
Controls menu.

e Select a Buckling Load solution for the Minimum number of eigenvalues.
e Change the type of eigensolver to be used to Subspace Jacobi

e Enter the Number of eigenvalues to be calculated as 1

e Enter the Number of starting iteration vectors as 2

e Enter the Shift to be applied as -10

e Click the OK button.

Note. The use of a shift and the Subspace Jacobi solver is required when applying
uniformly distributed spring supports to quadratic elements in an eigenvalue analysis.
This is due to the theoretical negative stiffnesses required by the shape functions to
evenly distribute the support stiffness. During the analysis a number of negative pivot
warnings will be shown, due to these theoretical values, which can be ignored.

Saving the model

El To save the model file.

Running the Analysis

With the model loaded:
El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to run the
analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Buckling Analysis of a Plate Girder

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition will be created in the Associated Model Data directory where the model file
resides, including:

U plate_girder.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U plate_girder.mys this is the LUSAS results file which is loaded automatically
into the & Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O plate_girder_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as plate_girder

To recreate the model, select the file plate_girder_modelling.vbs which is located in
the \<LUSAS Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the () Treeview.

El Select an isometric view of the model.
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Viewing the Results

e Turn off the display of the Attributes, Geometry and Mesh layers in the [=* Treeview.

Deformed Mesh Plot

e Turn on, and then double-click the Deformed mesh layer to the [&* Treeview.
o From the Deformations tab, select Specify factor and enter a factor of 2.5

o Click the OK button to display the first eigenmode shape.

Printing the Buckling Load Factors

In an eigenvalue buckling analysis, the load factors are equivalent to the eigenvalues.
Load factors are the values by which the applied load is factored to cause buckling in
the respective modes. Eigenvalue results for the whole model can be displayed in the

text window.
| Utilities e Change the entity type to None, ensure that results type Eigenvalues is selected and
Print Resuits click the Finish button.

Wizard...
The Eigenvalue results will be printed to the text window with the Load factors being
given in the eigenvalue results column. Error norms may vary.
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Buckling Analysis of a Plate Girder

Results File = DiA\FeaUsersWtom\Models\148Examples\girderupdatelfissociated IIAI

MODE EIGENVALUE LOAD FACTOR ERROR NORM
1 9.87597 9.87597 0.262586E-D6

w
1 | 3

4 4 » k% Modelinfo } 1:Figenvalue 1 [

Calculating the Critical Buckling Load

The applied load must be multiplied by the first load factor (9.87597) to give the value
of loading which causes buckling in the first mode shape. The initial buckling load is
therefore 9.87 x the applied dead and live load.

Note. An applied load of unity could be used in an eigenvalue analysis - in which case
the eigenvalues produced would also represent the critical loads at which the structure
would buckle. However, to prevent potential convergence problems with the analysis it
is more usual to apply actual in-service loading and multiply the applied load by the
eigenvalue to give the critical buckling load for each eigenvalue.

This completes the example.

Important Notes Relating to Buckling Analysis

This example has taken you through the process of carrying out a linear buckling
analysis on a plate girder. Linear buckling analysis is a technique that can be used to
estimate the load that can be supported by a structure prior to structural instability or
collapse. However a number of points should be considered when carrying out this
type of analysis:

e Buckling analysis is dependent on applied loading. All the loads on the structure
must be applied in a single loadcase, this being loadcase 1. In addition, load factors
appropriate to the analysis should be included when the loads are assigned.

e Buckling analysis is dependent on the initial model geometry being considered. A
perfectly straight (and undeformed) model will provide different answers from a
model with imperfect geometry. If required, an imperfection can be built into the
initial model either by manually defining the appropriate geometry or by using the
deformed mesh from one analysis as the starting point for a further analysis. To do
the latter setup a new analysis using the Analyses > Generate Structural Analysis
menu and select a deformed mesh from the original analysis in the Initial
Deformations tab.

e An eigenvalue buckling analysis actually requires the use of elements with
geometrically nonlinear capabilities in order to create additional stress terms in the
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Viewing the Results

stiffness matrix. Some elements do not have a non-linear capability. Refer to the
finite element library before such an analysis is commenced.

The eigenvalue buckling analysis of the structure can only be used to provide the
mode shape of the structure and the critical buckling load. The stresses and
displacements that are obtained are relative to the unit normalised eigenvector and
are generally of no practical use. To obtain member forces for the girder it is
necessary to perform a further linear static analysis with the same combination of
loading on the structure. The stresses and displacements in the structure when the
critical load is applied may be obtained simply by performing a linear static analysis
with the loads factored to the buckling load previously derived. These may be
compared to other limit state criterion to determine the load carrying capacity of the
structure. The critical buckling stress for the mode under consideration will be
obtained from the same analysis. If required this can then be used with reference to
design codes to calculate the value of the slenderness parameter for lateral torsional

buckling At and the limiting compressive stress o

This analysis type will provide both local and global buckling modes. However,
engineering judgement is necessary to determine which buckling mode is critical in
order to select the appropriate buckling load factor.

If a load factor very close to unity is derived, it would normally be prudent to carry
out further investigation, removing some of the assumptions in the initial analysis
and perhaps carrying out a nonlinear analysis.
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Description

Nonlinear Analysis
of a Concrete Beam

For software product: Any Plus version. Bridge Plus version for the discussion.
With product options: Nonlinear.

Description
A nonlinear plane stress analysis  All dimensions in millimetres Point Load C-L
is to be carried out on a model of a 200 0
reinforced concrete beam. ! ,f‘ls
The reinforcement is provided in
the lower face of the beam and has 10N
a total cross-sectional area of ”

’ o

400 mm<. The superposition of BAR3 Elements  QPMS Elements

nodal degrees of freedom assumes

that the concrete and il 3 ! F@{
reinforcement  are  perfectly | | T
bonded. It is assumed that the self- £ e

weight of the beam is negligible ol
compared with the applied load F1650—+—l650—>< -
and that the effects of any shear

reinforcement can be ignored.

Due to the symmetrical nature of the problem, only the left-hand span of the beam is
modelled. The beam is simply supported at the left-hand end with a symmetry support
at the right-hand axis of symmetry. A concentrated vertical load is applied to the top of
the beam 1200mm from the left-hand end. The concrete section is represented by plane
stress (QPM8) elements, and the reinforcement bars are represented by bar (BAR3)
elements. A nonlinear concrete cracking material model will be applied to the plane
stress elements and a von Mises plastic material will be applied to the reinforcement
bars.

Units of N, mm, t, s, C are used throughout.
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Modelling

Nonlinear Analysis of a Concrete Beam

Objectives
The behaviour of the beam under cracking/yielding is to be examined by producing the
following:

O A Deformed Mesh Plot showing the final deformed shape.

O A Load Displacement Graph for the top node on the axis of symmetry
of the beam.

0 Stress contour plot showing the stress distribution in the beam.
O Crack pattern plot showing the crack patterns produced.

O Animation of stresses and crack patterns for selected load
increments.

O A graph of variation in stress through selected slice sections through
the beam.

Keywords

2D, Plane Stress, Bar Elements, Nonlinear Concrete Model, Element Selection,
Concrete Cracking, Steel Reinforcement, Groups, Crack Patterns, Animation,
Graphing, Load Displacement Curve, Slice Sections

Associated Files

U beam_nl_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as beam_nl

e Use the Default working folder.
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Modelling

e Enter the title as Nonlinear Concrete Beam
e SettheunitsasN, mm,t, s, C
e Leave the timescale units as Seconds
e Ensure an analysis type of Structural is set.
e Select the model startup template Standard
e Select the Vertical Y Axis option.
e Click the OK button.
Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Geometry

|Gﬁ_?rr:3e"y S il Enter coordinates of (0, 0),

[ [

[ [
Coordinates... (1200, 0) and (1650, 0) to definetwo | |
Lines representing the bottom of the | |

left hand span of the beam. Clickthe L —— == —— ——— — — — —— — k
OK button to finish. Drag a box to select these 2 Lines

e Select both Lines just drawn by
dragging a selection box around them.

|G|eso$fzz S L5 Enter a transtation value of 25 in the Y direction to create the Surface which

[By Sweeping... represents the concrete cover from the face of the beam to the centreline of the
reinforcement.

e Click the OK button.

e Select the upper Lines of both of
the Surfaces just drawn as shown.

Select these 2 Lines

SRVAERN:

|G|e;5':f§tcz = 4l Enter a translation value of 275 in the Y direction to create the Surface which
“[Bysweeping..  represents the extent of the concrete above the centreline of the reinforcement.

e Click the OK button.
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| Geometry

| Group

| New Group

| Geometry

| Group

| New Group

| Attributes

|Mesh
|Line...

>

Nonlinear Analysis of a Concrete Beam

The model should appear as shown.

—

Defining Groups

To simplify the assignment of model attributes certain model features will be grouped

together to allow selection by name in the Treeview as opposed to selection by
cursor in the graphics window. The 2 Lines representing the reinforcement bars are to
be grouped together:

e Ensure the 2 Lines are still selected Select these 2 Lines

as shown.
/> \

! i / \ E
Enter Bars for the group name. i

e Click the OK button to complete
creation of the group.

The Surfaces representing the concrete are to be grouped together.

e Holding-down the S key, (and 7~~~ """ T T T T T T T T T T
noting that the cursor changes to | I
show the type of feature that will be ! '

[ [
selected) drag a box around the I
whole model to select only the L __________________ _k
Surfaces defining the concrete. Drag a box to select only Surfaces

Enter Concrete for the group
name. Click the OK button to complete creation of the group.

Note. In this example, model attributes will be defined but not assigned to the model
straight away. They will be assigned to the model later by making use of the Groups
facility.

Defining the Mesh Reinforcement Bars

Separate mesh datasets need to be defined for the reinforcement bars and the concrete.
For the reinforcement bars a uniform mesh is to be used to the right of the applied load
and a graded mesh is to be used on the horizontal lines to the left of the applied load.

The reinforcement bars will be modelled using Line meshes.

e Set Generic element type to Bar, Number of dimensions to 2 dimensional and
Interpolation order to Quadratic
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| Attributes

Modelling

|Mesh
|Surface...

| Attributes

| Geometric
|Line...

>

Ensure the Number of divisions is set to 4

Enter the attribute name as Bar Elements - Divs=4

Click the Apply button to create the attribute in the & Treeview and leave the
dialog visible to allow additional datasets to be defined.

Change the Number of divisions to 6 and click the Spacing button.
Select a Uniform transition ratio of first to last element of 2 and click OK
Change the attribute name to Bar Elements - Divs=6 graded

Click the OK button to finish to add the attribute to the & Treeview.

Defining the Mesh Concrete

The concrete will be modelled using a Surface mesh with Line mesh divisions to
control the mesh density..

Select Plane stress, Quadrilateral, Quadratic elements.
Enter the attribute name as Plane Stress - Concrete
Click the OK button to add the attribute to the & Treeview.

The default mesh density of 4 divisions per line is sufficient for the Surface to the
right of the applied load. A graded line mesh will be created for use on the Surface
to the left of the applied load

In the & Treeview double click the Line mesh attribute name Bar Elements -
Divs=6 graded

The Line mesh properties dialog will appear.

Change the attribute type to None

Change the attribute name to Divisions=6 graded

Click the OK button to add the attribute to the & Treeview.

Defining the Geometric Properties

Select Bar/Link from the drop down list and enter a value of 400 for the total cross
sectional area of the reinforcement.

Enter the attribute name as Steel Area and click the OK button to add the attribute
to the & Treeview.

291



| Attributes

Nonlinear Analysis of a Concrete Beam

| Geometric
| Surface...

| Attributes

| Material

| Isotropic...

| Attributes

| Material
|Isotropic. ..

e Enter a value of 150 for the thickness. Leave the eccentricity blank.
e Enter the attribute name as Beam Thickness and click the OK button to add the
attribute to the & Treeview.

Defining the Material Properties

Nonlinear steel properties will be defined for the reinforcing bar elements.

e Enter Young's modulus as 210e3 and Poisson's ratio as 0.3 and leave the mass
density field blank.

e Click the Plastic option and enter an Initial uniaxial yield stress of 300

e Select the Hardening option, click the Hardening gradient button and enter a
hardening Slope value of 2121 with a Plastic strain of 1

e Enter the attribute name as Nonlinear Steel
e Click the OK button to add the attribute to the & Treeview.

Nonlinear concrete material properties will be defined for the Surface elements
representing the concrete.

e Enter a Young's modulus of 42000, a Poisson's ratio of 0.2 and leave the mass
density field blank.

e Click the Plastic option and from the drop-down list select Concrete

e For the plastic model Type choose Smoothed Multi Crack (model 102)
e Enter a Uniaxial compressive strength value of 31.58

e Enter a Uniaxial tensile strength value of 3.158

e Press the Advanced... button

¢ In the Advanced Concrete Properties dialog change the Strain at end of softening
curve to be 0.003 and press OK to return.

e Enter the attribute name as Nonlinear Concrete

e Click the OK button to add the attribute to the c&n Treeview.

Assigning Attributes to the Bars

The various Line and Surface mesh, geometric and material attributes defined
previously will now be assigned to the model using the groups that have been defined.
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In the L=] Treeview right-click the group name Bars. Select the Set as Only Visible
option. The features in the group will be displayed.

Select the left hand Line of the two Select this Line for

Lines representing the bars. ﬂBar Elements - Divs=6 graded
i

Drag and drop the Line mesh

attribute Bar Elements - Divs=6 ﬁ
graded from the & Treeview onto Select this Line for
the selected Line. Bar Elements - Divs=4

Select the right hand Line of the two Lines representing the bars.

Drag and drop the Line mesh attribute Bar Elements - Divs=4 from the 63;
Treeview onto the selected Line.

In the Treeview double-click on
the Mesh entry and select Show
nodes.

-

The Line mesh divisions will be seen defined with the spacing as shown.

Select both Lines.

Drag and drop the geometric attribute Steel Area from the &b Treeview onto the
selected features.

Drag and drop the material attribute Nonlinear Steel from the & Treeview onto
the selected features.

Note. The diagrams in this example show element nodes. To see these at any time you

can go to the Treeview and double-click the Mesh layer. On the Mesh tab select
Show nodes and click the Close button.

Assigning Attributes to the Concrete

In the Treeview right-click the group name Concrete. Select the Set as Only
Visible option.

The Lines in the Bars group will be removed from the display and the Concrete group
will be displayed.
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Nonlinear Analysis of a Concrete Beam

e Select the left-top and left- Select this Line
bottom Lines as shown. &

o From the &b Treeview drag and
drop the Line mesh attribute

Divisions=6 graded onto the **
selected features. ﬂ
... and this Line

e Select the whole model using the
Ctrl and A keys together.

T

e Drag and drop the Surface mesh attribute Plane Stress - Concrete from the 63;
Treeview onto the selected features.

A graded mesh will be drawn on the
left-hand Surface and a uniform
mesh will be drawn on the right-
hand Surface. =

e Drag and drop the geometry attribute Beam Thickness from the & Treeview onto
the selected features.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation. If at any
time during the example you wish to visualise the geometry select this button.

e With the whole model still selected, drag and drop the material attribute Nonlinear

Concrete from the b Treeview onto the selected features. Ensure the Assign to
surfaces option is selected and click OK

The mesh on the Lines representing the cover to the centreline of the reinforcement
needs to be altered. This is because they currently have a default Line mesh of 4
divisions per line when only 1 division per line is required.

e Drag boxes to select the 3 7
Lines as shown. (Remember [ T17 | [l
to hold the Shift key down 1] | et
after the first line is selected :_ o J'k L J'k

so the other lines are added to - ‘k L -

the selection)
Drag 3 boxes to select these 3 Lines
e Drag and drop the Line mesh

attribute Divisions=1 from the & Treeview onto the selected Lines.

The mesh will be redisplayed with the revised mesh pattern.
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| Attributes

Modelling

[ Loading...

Making all groups visible

e From the L] Treeview right-click the group heading name beam_nl.mdl. Select the
Set as Only Visible option. Click Yes to act on sub groups as well.

All features in the model will now be
displayed as shown.

Supports

When using the Standard template, LUSAS provides the more common types of
support by default. These can be seen in the & Treeview. The beam is to be simply
supported in the Y direction at the left-hand end and a horizontal restraint in the X
direction is required to satisfy the symmetry requirements at mid-span.

e Select the lowest Select these 2 Lines
Point at the left hand for support 'Fixed in Qj
end of the model as X' A
shown. e

4

e Drag and drop the

1

support attribute = f
Fixed in Y from the T . L
& Treeview onto the Select lower Point for

selected Point. Ensure support ‘Fixed in Y

the Assign to points
and All analysis loadcases options are selected and click OK

e Drag a box around the 2 Lines at the right hand end of the model as shown.

e Drag and drop the support attribute Fixed in X from the & Treeview onto the
selected Lines. Ensure the Assign to lines and All analysis loadcases options are
selected and click OK

Loading

A single concentrated load is to be applied to the Point at the top of the beam. A unit
load will be applied and the load factor in the nonlinear control will be used to control
the magnitude of loading.

e With the Concentrated option selected click Next
e Enter a loading value of -1 in the component Concentrated load in Y Dir

e Enter the attribute name as Point Load and click Finish
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e Select the Point on the Select this Point
top of the beam as %
shown.

e Drag and drop the —
loading dataset Point % -t
Load from the - =R

Treeview onto the
selected Point.

e Ensure the Assign to points option is set and click OK to assign the load to
Analysis 1, Loadcase 1.

Nonlinear Control

Nonlinear analysis control properties are defined as properties of a loadcase. The
nonlinear analysis is to be terminated when the beam deflection at mid span reaches a
limiting value.

e Select the point shown. Select this Point

e In the @ Treeview %7
expand Analysis 1 —
then right-click on 3
Loadcase 1 and select 4 ™
Nonlinear & — —p
Transient from the

Controls menu.
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Modelling

The Nonlinear & Transient dialog will appear:

Monlinear & Transient

~ Incrementation
[v Monlinear

Incrementation Im
Starting load factor IEDEIEI—
Max change in load factor I 2000

Max total load factor ID—

v Adjust load based on convergence

Iterations per increment I 10

[ Geostatic step

Solution strategy
[" | Same as previous loadcase

o

Max number of iterations

Residual force norm

ury

Incremental displacement norm 0

Advanced...

r Incremental LUSAS file output
™| 5ame as previous loadzase

Output file

—I'!‘d"a”md' = Flat file

- — Restart file
I\_c-nsc-lll:latlc-n "'I
Initial time step III'E'— Max number of saved restarts |0

Log file

™| Tire domain

Total response time 100.0EG

T

™| Butamatic tme sEepping History file

Advanced. |
~Common to all

Max time steps or increments I a
0K I Cancel Help

Select the Nonlinear option and set Incrementation to Automatic

e The initial load to be applied is the actual load applied to the model multiplied by
the starting load factor. Set the Starting load factor to 5000

e Enter the Max change in load factor as 2000 to restrict the second and subsequent
load increment sizes to ensure sufficient points are obtained to observe the load
deflection behaviour of the beam.

e Change the Max total load factor to 0 as the solution is to be terminated on the
limiting displacement at mid span.

e Change the number of desired Iterations per increment to 10

Note. If the number of iterations on the previous increment is less than the desired
/ number the next load increment will be increased (up to the maximum change in load
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increment) while if the number of iterations is less than the desired number the next
load increment will be reduced.

In the Solution strategy section of the dialog, ensure the Maximum number of
iterations is set to 25

Leave the Residual force norm as 0.1 and the Incremental displacement norm to
1 so convergence of the solution at each load increment will be achieved when the
out of balance forces are as less than 0.1% of the reactions and the iterative change
in displacements is less than 1% of the displacements for that load increment.

Select the Advanced button in the Incrementation section of the dialog.

Advanced Nonlinear Incrementation Parameters I

— Automatic incremention — Termination criteria
. ) : ¥ Teminate on value of limiting «ariable
Stiffriezs ratio to gwitch to arc-length IUU =
Fuaint rurmber 13

[ Use arc length contral \Variable type

Arc-length calculation ICrisfieId "I
W alue

™| Belative displacement arc [Ength procedine

: . . . — Step reduction
7| Guide are lenath solition with curent stiffress 2

¥ &llow step reduction
I | s ront with brestresidual e : .
b awimum step reductions 5

Arc-length restart load factar 0.a Load reduction factar 05

11

|

Arc-length restart load change 0o Load increase factor 20

0k, I Cancel | Help |

Ensure that the Stiffness ratio to switch to arc length value is set to 0.0
Select the Terminate on value of limiting variable option.

The selected point number (this may differ depending on how the model was
created) will appear in the Point number drop down list.

Set the Variable type to V to monitor the deflection at the selected point in the Y
direction.

Enter a value of -3 so the analysis is terminated when the central deflection reaches
this value.

In the Step reduction section ensure the Allow step reduction option is selected.

Click OK to return to the Nonlinear & Transient dialog.
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| File

Model Properties. ..

| File
| Save

Running the Analysis

e Click OK again to set the loadcase properties.

One additional setting is required for this analysis to ensure no element mechanisms are
induced as the material yields.

e Select the Solution tab.

e Click on the Element Options button and select the Fine integration for stiffness
and mass option.

e Click the OK button to return the Model Properties dialog.
e Click the OK button to finish.

Save the model

The model is now complete and the model data is to be saved before an analysis is run
using the LUSAS Solver.

El Save the model file.

Running the Analysis

El Open the Solve Now dialog, and press OK to run the analysis.
During the analysis 2 files will be created:

U beam_nl.out this contains the statistics of the analysis, for example how
much disk space was used, how much CPU time was used, and any errors or
warning messages from LUSAS, and so on. Always check the LUSAS output
file for error messages.

U beam_nl.mys this is the LUSAS results database which will be used for
results processing.

Note. Warnings will be written to the text output window during this analysis.
Warnings are not to be confused with errors which normally stop an analysis from
being run. The warnings are written to advise you of modelling-related issues that are
found during the analysis and of the steps LUSAS has taken (if any) to allow the
analysis to continue.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.
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| File
[New...
| File
| Script >
| Run Script...

Nonlinear Analysis of a Concrete Beam

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Select No to not view
the output file. Any errors listed in the text output window should be corrected in
LUSAS Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U0 beam_nl_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as beam_nl

To recreate the model, select the file beam_nl_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the G Treeview, and the loadcase results for
load increment 1 are set to be active by default.

Changing the Active Results Loadcase

o Inthe ™= Treeview right-click on the last load increment Increment 6 Load Factor
= 15000 and select the Set Active option.

Deformed Shape

e In the Treeview turn off
the Geometry, Attributes
and Mesh layers by right
clicking on each entry and ' _—
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| utilities

Viewing the Results

| Graph Wizard...

selecting the On/Off option.

Creating a Load versus Displacement Graph

A graph of displacement at mid- Select this Node
span is to be plotted against the

applied load. To do this a node on

the line of symmetry is selected:

e With the Deformed mesh layer
visible, select the top node on —
the axis of symmetry as shown.

Using the Graph Wizard

The graph wizard provides a step-by-step means of selecting which results are to be
plotted on the X and Y axes of the graph. The X axis is always defined first.

Ensure the Time history option is selected and click the Next button.

Ensure the Nodal results is selected and click Next

Select entity Displacement for component resultant displacement RSLT

The node number selected earlier will be displayed in the drop-down list.

Click the Next button.

The Y axis results to be graphed are now defined.
e Select the Named option and click Next
e Select Total Load Factor from the drop down list.

e Click the Next button.
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e Leave all title information e
blank and click the Finish ™00
button to display the load Eggg B
deformation graph. Jomm |-

11000 f--

Note. Graphs can be oo

modified using the right hand ™

mouse button in the graph 2

window and selecting the Edit 5

Graph Properties option. 5000

E Close the graph window.
Use the maximise button to increase the size of the graphics window.

e Inthe =" Treeview turn off the Deformed mesh layer.

Maximum Principal Stress Contour Plots

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview.

The properties dialog will be displayed.

e Select entity Stress - I —————

Plane Stress for
e orsrs e |
x direction, SX

¢ Inthe Contour Display tab deselect Deform.

e Click the OK button to display contours of stresses for the final load increment.

Viewing Crack Patterns

e With no features selected, click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The properties dialog will be displayed.
e Select Stress - Plane Stress contour results of type Crack/crush

e Select Values Display tab and press the Failure details... button to change the pen
colour that is used to plot negative yield to Black.
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| utilities

Animation Wizard...

Viewing the Results

Click the OK button to I e ——

display the cracking
pattern for final load
increment  superimposed

onto the stress contours.

Animating the Results

As an alternative to viewing results individually for each loadcase, the change of stress
due to the increasing load increments can be animated instead. To ensure consistent
contour values throughout the animation the interval of the range of contours is to be
specified.

In the = Treeview double-click on the Contours layer.

The contour properties will be displayed.

Select the Contour Range tab and click the Interval option and set the contour
interval as 1

Click the Maximum button and set the maximum value as 3
Click the Minimum button and set the minimum value as -16
Click the Set as global range and Use global range options.

Click the OK button to redisplay the stress contours using the new contour range.

Using the Animation Wizard

Note. The buttons at the bottom of the
window may be used to slow-down,
speed-up, pause, step through frame by
frame, or stop the animation.

Select the Load History option and
click the Next button.

Select the All loadcases option and
select the Finish button to create the

ot 1 e
oy s L i

A = x4 afp|[> 7 ANEEEN

Saving Animations

Animations may be saved for replay in Windows animation players.
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| File

Save As AVI...

| utilities

Graph Through 2D

Nonlinear Analysis of a Concrete Beam

e Ensure the animation window is the active window.

e Browse to your projects folder and enter beam_nl for the animation file name. An
.avi file extension is automatically appended to the file name. Click Save

Note. Animations can be compressed to save disk space by changing the
Compression Quality. Reducing the quality will, however, result in a lower definition
image. It is also possible to reduce file size by setting smaller dimensions on the first
page of the Animation Wizard.

E Close the animation window, choosing not to save changes.

M [=]ES Enlarge the model window to a full size view.

Creating a slice section of results

In this example a graph is to be plotted of the variation in stress through the specified
section of the beam. The X axis values of distance are defined by the section slice. The
Y axis results are specified from the graph wizard dialog.

e Ensure the Snap to grid option is selected and a grid size of 100 is specified.
e Click the OK button.

Note. The snap to grid dialog will only appear if the model is viewed in the XY plane.

If necessary, return the model to the default starting view by clicking < N/A, on

the status bar at the bottom of the graphics window.

e Using the screen ruler as a
guide, click and drag the
cursor as shown to define
the location of a section
slice through the beam at
a distance of 1600 from
the left-hand end.

e Select Stress - Plane
Stress results for Stress SX and click the Next button.

e | eave all title information blank.
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Viewing the Results

e Click the Finish button to
create the graph of stress
through the section of beam.

- 1:1:Loadease 1(12)

5K

[y e e s s I o
S = W o O ™ = W o

—_ = = —

Coordinates (1600,500,0) to (1600,-200,0)(11)
-#-5x - 1:1:Loadcase 1(12) f Coordinates (1600 500,07 to (1800 -200

200
220
240 -
260

[ |
[ |
[ ]

Adding Additional Results to a Graph

|Window e Re-select the window containing the results contours. The cursor will still be in

1 LUSAS View . .
beam_nl.mdl section slice mode.

Window 1

e Using the screen rulers as a
guide, click and drag the
cursor as shown to define
the location of a section
slice through the beam at a
distance of 1000 from the
left-hand end.

e Select Stress - Plane
Stress results for Stress SX and click the Next button.

e Click the Add to existing graph option.

e Click the Finish button to add
the results for the second slice
section to the existing graph.

| Window e Re-select the existing graph to

2 Graph1:Graph 1 see the overlaid data

S¥ - 1:1:Loadcase 1(6)

240
260

o o
[ -]
oM

e R e | o O

NSE@@mE0d3IEDgA
Coordinates (1600,500,0) to {1600 -200,0)(5)

—#-5¥ - 1:1:Loadcase 1(8) / Coordinates (1600500,0) to (1600 ,-200 0)i5)

8- 5x- 1:1:Loadcase 1(3) / Coordinates (1000,500,0) to (1000,-200 03(7)

EI Close the graph window.

305



Nonlinear Analysis of a Concrete Beam

Plotting Crack Width Contours and Values

Crack width values as calculated by the use of the Smoothed Multi Crack Concrete
Model can be plotted in contour and value form:

e Double-click the Contours layer name in the Treeview.
The properties dialog will be displayed.

e Select entity Plastic strain - Plane Stress for component of stress in the x direction,
CWMax

e Select the Contour Range tab and deselect Use global range

o Deselect the Maximum button

e Deselect the Minimum button

e Set the contour Interval to be 0.005

e Click the OK button to redisplay the stress contours using the new contour range.
e Press Yes to confirm the Values layer will be adjusted to match.

Note. Contouring of crack width values effectively shows the elements affected by
cracking and identifies those elements where the maximum crack widths occur. This is
done using unaveraged, or unsmoothed values at nodes. To see the actual values of
crack width within elements (at the locations where the Crack/crush patterns were
plotted earlier in the example), values for gauss points need to be plotted.

To see the crack width values:

e Double click the Values layer
name in the Treeview.

e With the Values Results tab
active, select At Gauss Points.

e Select the Values Display tab and change the Font angle to 45 degrees.

e Click Close to update the display and show the actual crack width value calculated
at gauss points within the element.

This completes the example
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Discussion

Discussion

Plotting Crack Widths to EN1992-1-1

In this example nonlinear steel properties were defined for the reinforcing bar elements.
Reinforcement bar attributes (accessed from the Attributes > Geometric > Bar
reinforcement menu item) may alternatively be used to model the steel reinforcement
in reinforced concrete, but only if a linear steel material model is used to represent the
steel reinforcement and the Crack Widths calculation utility (accessed from the Bridge
> Crack Widths to EN1992-1-1 menu item) is employed.

When this is done, contours and values of crack widths can be plotted in accordance
with EN 1992-1-1:2004 Eurocode 2 by selecting the Entity Crack Widths EN 1992-1-
1 and the Component Maximum Crack Width on the Contour Properties dialog. Note
that a linear steel material model (rather than a nonlinear one) is required for the steel
reinforcement because of the steel strains used in the calculations.

Reinforcement bar attributes are similar to geometric line attributes but need to be
assigned to lines meshed with bar elements for a chosen analysis to enable a crack
width calculation to be carried out. Bar attributes may be defined for a single
reinforcing bar (a Discrete bar), as would be used in a 3D model, or be defined with
suitable properties to represent a bundle or simplified arrangement of bars (Equivalent
bar) as would be used typically in a 2D plane strain analysis.

When modelled in the way described for two 16mm diameter steel bars, the crack width
contours can be plotted along the bar elements (actually on the surface of the fleshed
bar section) corresponding to the steel strains used in the calculation, and not on any
concrete face or surface in the model. Contours and values are plotted for an active
loadcase (or combination) and are re-computed if a different loadcase is set active. This
visualisation method is used because the approach used in EN 1991-1-1:2009 to
calculate crack widths is generally unclear as to where the crack width calculation
applies.

A typical crack width contour plot for a bar reinforcement attribute defined for the steel
in this example is shown below. Unaveraged or gauss point values of crack widths
could be additionally added using a Values layer.
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Analysis: Analysis 1

Load : 6:Load 1,1 it & Load Factor = 15000.0

Results file: nl_beam_102_with_16mm_bar_attributes_linear_steel~Analysis 1.mys
Entity: Crack widths EN1992-1-1

Component: Maximum Crack Width {(Units: mm})

0.0
0.0117178 —*
0.0234355 -
0.0351533 »
[ e —
0.0585889 —»
0.0703066 rer 1 i = -{
0.0820244

. 0.0937422

Maximum 0.10546 at node 2 of element 31 Crack width calculation summary
Minimum 0.0 at node 1 of element 1 Attribute: two 16 dia bars, max crack spacing = 185.3mm, max crack width = 0.10546mm
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Description

Staged

Construction of a
Concrete Tower

with Creep

For software product(s): | Any Plus version.

With product option(s): | Nonlinear and Dynamic.

Description

A 20m high concrete tower of varying
cross-section is to be constructed in four
stages, each 5 metres high. The formwork
is struck 14 days after each stage is cast
and the casting sequence between each
stage is 60 days.

Simplified geometry has been used to
allow the example to concentrate on the
creation of staged construction loadcases,
the definition of the concrete creep
properties and running a creep analysis.

Concrete creep is carried out according to
CEB-FIP 1990 code. The modelling units
used are N, mm, t, s, C throughout.

4at1000 mm
||

I

5000 mm

5000 mm

I

5000 mm

I

5000 mm

Tower geometry and construction stages
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A

Modelling

Staged Construction of a Concrete Tower with Creep

Objectives
The required output from the analysis consists of:

e A comparison of the moments at the base of the tower after each construction stage.

e Maximum displacement of the tower after each construction stage and the change in
the maximum displacement value due to long-term creep.

Keywords

Birth, Death, Staged Construction, Activate, Deactivate, Long-Term, Creep, CEB-
FIP Concrete Model, Age, Casting, Reference Path

Associated Files

e concrete_tower_modelling.vbs carries out the modelling of the example.

Discussion

Structural concrete is unique among the major construction materials in that it
undergoes time-dependent changes in its properties. Generally, the concrete’s strength
will increase over time, but this increase in strength is accompanied by a certain degree
of shrinkage and creep. Particularly in large structures where several concrete pours
may take place over a period of months or years, the time-dependent nature of
concrete’s behaviour can have a significant effect on the behaviour of the structure and
these effects must be considered in analysis.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.
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| Geometry >
| Line >
| Coordinates...
| Geometry
| Line >
Copy...
| Attributes
[Mesh >
Line...

Modelling

Creating a new model

e Enter the file name as concrete_tower

e Use the Default working folder.

e Enter the title as Concrete creep example to model code CEB-FIP 1990

e Select units of N,mm,t,s,C

e Select timescale units of Days

e Ensure the Structural analysis type is selected.

e Leave the startup template as None

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Geometry

il Enter coordinates of (0, 0), and (1000, 5000), to define the first section of the
tower.

e Select the line just drawn.

Sarm

UI1] Enter a translation in the X direction of 1000 and in the Y direction of 5000
e Enter the number of copies required as 3 and click OK to create the next three
sections of the tower.

Defining and Assigning Mesh Attributes

e The tower is to be modelled with Thick Beam 3D Quadratic elements (BMI31
elements) with 6 divisions. These elements can correctly capture the effects of the
variation in section shape.

e Enter the attribute name as BMI31 6Div and click OK.

e Select all lines on the model and drag and drop the BMI131 6Div mesh from the &
Treeview onto the selected features.

e Click OK to assign a default element orientation using a beta angle of 0.
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| Utilities

Section Property
Calculator

>

Rectangular

| utilities

Sections > Solid

| Reference Path

T~

Staged Construction of a Concrete Tower with Creep

Caution. If constant cross-section beam elements were used to model the variation
in section shape instead of the quadratic elements used, care should be taken to ensure
that the line mesh was sufficiently fine to correctly capture the effects of the variation in
section shape.

Geometric Properties

There are two ways that the tapering shape of the tower could be modelled. The first
option would be to create a tapering beam geometric property for each individual line.
This would require different geometric attributes to be created for each of the four lines.

A more efficient method is to use a multi-varying section geometric attribute which
allows tapering along a reference path rather than along individual lines. By using this
type of geometric attribute, only a single attribute is required to describe the taper of the
tower from its base to tip.

To define the tower cross-section at the base
e On the Rectangular Solid Section Property dialog enter D=3000 and B=2000.
A name of RSS D=3000 B=2000 will be automatically created.

e Ensure Add to local library is selected and click Apply to calculate the section
properties, add the section to the local library and define another cross-section.

e Change the values to read D=1000 and B=1000.
A name of RSS D=1000 B=1000 will be automatically created.

e Ensure Add to local library is selected and click OK to calculate the section
properties and add the section to the local library.

All required section properties have now been defined and saved in the local user
library. They will be used to create multiple varying section line attributes which will be

automatically added to the &b treeview when the attribute is created.

Creating a reference path

For this example a reference path will be defined along the lines representing the tower.
This will be used when defining and assigning the varying section properties of the
tower.

e Box-select all lines representing the tower

e Leave the name set as Path 1 and click OK.
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| Attributes

| Geometric

>

Multiple Varying
Section...

Modelling

The direction of the path is shown by arrows now overlaid on each
line.

e Note. Model geometry can be used to generate a reference path
but no subsequent connection between the initial parent geometry
and reference path data exists.

e The visualisation of a reference path can be controlled via the
Utilities layer. If desired reference path visualisation can be
turned off using a context menu option for its entry in the

Utilities layer of the = Treeview.

Defining the multiple varying section line
property

A multiple varying geometric line attribute needs to be defined. This
will make use of the previously defined rectangular solid sections.

-

Define sections

H

e On the Multiple Varying Section dialog click in the Section cell
that currently reads 914x305x289kg UB and the launch dialog button M will appear
to allow a different pre-defined section to be chosen from a different section library.

e On the Enter Section dialog, click on the drop-down list button ﬂ to change the
selection from UK Sections to User Sections

e Ensure a Local library is being accessed.

e Select RSS D=3000 B=2000 from the list of local library items and then click OK
to add the section to the first row of the table on the Multiple Varying Section
dialog.

e On the Multiple Varying Section dialog press the TAB key to move between cells
and create a new row beneath the existing row.

e In the new Section cell (row 2) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
and select RSS D=1000 B=1000 from the drop-down list and click OK to add the
section to the table.

Note. Before a visualisation of the longitudinal and horizontal alignment of the cross-
section shapes can be displayed on the dialog, the shape interpolation method and
distance values need to be defined.
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Define shape interpolation method

To specify a shape interpolation method for —<SmmEELs

each defined section: [ = Ditare i
[0 ThekBeam =] Sealed to it sach line individualy
- [¥ Specily shape interpalation ’7{: glensieesnceayivatl jv
e The RSS D=3000 B=2000 section as the T | ‘ ‘ |
- - - Section Shape i Distance Edit.
first in the table is set by default to Start i o et
Delete:
e For the RSS D=1000 B=1000 section Fovece
entry click on the drop-down list button B

Align all sections to section 1 :’

¥l in the Shape Interpolation cell and Cizosh 2tz el ]
select Linear |
Define distance values ‘ :l
e Change the distance interpretation to be
Along reference path and ensure Pathl :
iS Selected. Section 1-1 Section 2-2
‘ Name |Tapering Tawer =l ﬂ @ ‘

Lastly a distance value at which the section
will apply should be specified. I = e |

e For the RSS D=1000 B=1000 section click in the Distance cell and enter 20397
(the true length of the tower).

Note. When specifying a distance value at which a defined section will apply it is
important to round-up to the next whole number (20397 in this case). If 20396 has been
specified the final section would not be applied to the topmost line on assignment, and
therefore not shown when fleshed.

Check alignment settings

The vertical and horizontal alignment of a pair or series of sections is controlled by the
Alignment options. All sections are aligned with respect to a chosen section.

e Select Centre to centre for both alignment options and set the section to align to
as 1.

Name the attribute

e Enter a name of Tapering Tower and click OK to add the multiple varying section

line attribute to the &% Treeview. Note that “(Varying — 2 sections)” is
automatically appended to the stated name.
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| Attributes
Material >
|Specialised >
Concrete
Creep
CEB/FIP...

Modelling

Assigning the varying geometric line property

e Box-select all lines representing the tower and drag and drop the Tapering Tower
(Varying — 2 sections) geometric line attribute from the & Treeview onto it.

Check and correct the orientation of sections used

@I Select the isometric view.

In this example, the 3m x 2m section at
the base of the tower has not been
oriented correctly for the line axes that are
in use. The cross sections at the bottom
and the top of the tower both need
rotating around their centroids. This is
done as follows:

o In the &b Treeview double-click on
the Tapering Tower (Varying — 2
sections) attribute name

e On the Multiple Varying Sections
dialog click in the Section cell for
row 1 and click on the launch dialog
button 3 to access the detail for RSS
D=3000 B=2000 and change the
Rotation about centroid to be 90
degrees and click OK.

e Click in the Section cell for row 2
and click on the launch dialog button
3 to access the detail for RSS
D=1000 B=1000 and change the
Rotation about centroid to be 90 degrees and click OK.

z z
Incorrect Correct

Material Properties

In addition to the common linear isotropic material properties (Young’s modulus at 28
days, Poisson’s ratio, mass density, and coefficient of thermal expansion), the mean
compressive strength at 28 days, relative humidity and cement type need to be
specified.

In this example, leave the Include shrinkage box ticked to include the effects of
shrinkage as well as creep in the material behaviour.
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The CEB-FIP creep calculations use a parameter called ‘nominal size’. This is
calculated as 2A/U where A is the area of the cross-section and U is the length of the
cross-section perimeter. In LUSAS you have the option of manually inputting the
nominal size by activating the nominal size radio button, or allowing LUSAS to
automatically calculate the nominal size by activating the specify the beam section
internal perimeter factor radio button. The internal perimeter factor is a factor applied
to the perimeter length of any internal voids when calculating the section perimeter U.
In this case the tower cross-section has no voids so the value has no effect.

e Ensure the values shown on the accompanying dialog are entered, enter a material
name of Concrete CEB-FIP Creep and click OK to create the material attribute.

Concrete Creep CEB-FIP (1990)

Component Value

Tangent modulus of elasticity 30.0E3

Poisson's ratio 0.2

Mass density 24E9

Coefficient of thermal expansion 10.0E-6

Mean compressive strength at 28 days 50.0

Cement type MNormal or rapid hardening

Relative humidity 70.0

Intemal perimeter factor D5

¥ Indude shrinkage

& Automatically calculate nominal size from section dimensions
™ Use full perimeter
' Spedfy internal perimeter factor

Mame | Concrete CEP-FIP Creep j é’ w

Close I Cancel | Apply | Help |

e Select the whole model (CTRL + A). From the & trecview drag and drop the
Concrete CEP-FIP Creep attribute onto the model to assign the new creep
material.
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| Attributes
[Support...
| Attributes
Age...

Modelling

Supports

o A fully fixed support is required therefore all degrees of translation and rotation in
the X, Y and Z axes must be set as Fixed. Enter an attribute name of Fully Fixed
and click OK

e Select the point at the base of the tower and from the &b treeview drag and drop the
support attribute Fully Fixed onto the selected feature, ensure the All analysis
loadcases option is selected and click OK

Loading

Only self weight will be applied in this analysis. The LUSAS auto-gravity facility can
be used to quickly apply gravity loading in all loadcases. This will be done later on
after creation of all the required loadcases.

Age

The age of a section within a creep analysis is important because the material properties
change with time. The age of a section is specified in days between the casting of the
section and when it is first activated in the analysis.

Note. The timescale units of days for the model were set on the New Model dialog at
the beginning of this example. Timescale units are distinct from the fundamental model
units (i.e. N, mm, t, s, C) and are provided as a convenience for long-duration analyses
like creep and consolidation.

Creating and Assigning an Age Attribute

It is assumed that all sections in the tower N
will be cast and the formwork struck 14 Age a actvation e [11

days after the component was first
activated. (If this was not the case separate
age attributes would be created and
assigned to each section as required) ok | concel | oy | Hep |

= e

e Name the attribute as 14 days to formwork strip and click OK
e Assign the age attribute to all lines in the model.

Note. If a construction includes precast sections, the age of a component might be 80
days, while the component may be activated at day 28 in the analysis for example.
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Creating Activation and Deactivation datasets

In order to carry out a creep analysis on the model the construction stages are modelled
using the birth and death facility within LUSAS.

| Attributes e Select the Activate option and click Next

Birth & Death...

e Enter the attribute name as Activate and click Apply. Then click Back so the dialog
can be reused to define the deactivate attribute.

e Select the Deactivate option and
CIICk NeXt ¥ Percentage to redistribute 100.0
° Se|eCt the Percentage to " Maintain relative position of internal nodes
redistribute option and leave the Constraint equatian type -
value as 100%. Enter the attribute
name as Deactivate, then press Name [Dzactate =1 Heem
Finish
< Back | [ext = | Finish Cancel | Apply | Help

Modelling of Construction Stage 1
@l Select the Home button to return the model to
the default view.

e Inthe Treeview expand Analysis 1 and rename
Loadcase 1 to Stage 1: 0 to 60 Days by right-
clicking its title and selecting Rename

All elements in the model which are not required
for the first stage analysis need to be de-activated.

e In the graphics window select the top three lines
of the tower. - Jk

Assign deactivation

dataset to top 3 stages

of construction

o From the ¢b Treeview drag and drop the
deactivation attribute Deactivate to the three
selected lines ensuring that it is assigned to
loadcase Stage 1: 0 to 60 Days
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Modelling

Defining loadcase properties

o In the ™= Treeview right-click Stage 1: 0 to 60 Days and, from the Controls menu
item, select the Nonlinear & Transient menu option.

e On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual.

e Enable the Time domain option. Select a Viscous time domain from the drop-down
options. Enter the initial time step as 4, the total response time as 60, ensure the
automatic time stepping option is not selected and set the maximum number of
time steps or increments as 15

e In the incremental LUSAS file output section enter a Plot file value of 5 to only
write out the results every 5 time steps. This will simplify the viewing of the results
by only creating a results file for the final time step of each loadcase.

e Click OK to return to the Modeller working window.

Monlinear & Transient

r~ Incrementation r Solution strategy
¥ Nonlinear I~ | same as previous loadcase
Incrementation lm Max number of iterations |12—
Starting load factor 0.1 Residual force norm IDI—
Max change in load factor IDH— Incremental displacement norm IID—
Max total load factor 1.0 Advanced... |
V| adjust Inad based on conyvergence
r~Incremental LUSAS file output
Iterations per increment |4— [T Same as previous lnadzase
™| Genstatic step Output file Il—
advanced... | Plot file |5—
¥ Time domain lm Restart fie ID—
T faeaT |4— Max number of saved restarts I 0
Total response time ISD— Log file I 1
[~ Automatic time stepping History file I 1
Advanced... |
r—Common to all
Max time steps or increments IIS—
CK I Cancel | Help |

Note. The total response time of 60 represents the 60-day time interval until the next
/ stage of the analysis is activated.

319
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Staged Construction of a Concrete Tower with Creep

| Loadcase. ..

e Having set all the Nonlinear & Transient options select OK to return to the
Modeller working window.

A Nonlinear and Transient object & will be added to the ‘! Treeview. Double-
clicking on this object will allow any changes to be made to the control properties.

Construction Stages 2 to 4

Stages 2 to 4 require loadcases to be generated to specify the duration of the
construction process. Lines on the model must be selected according to the construction
stage being considered and activation datasets must be assigned to these lines as
instructed below.

Stage 2

The elements in the second construction stage must be activated

e Enter the Loadcase hame as Stage 2: 60 to
120 Days and select OK

o In the ‘X! Treeview select Stage 2: 60 to
120 Days using the right-hand mouse J
button select Set Active {

mTT T 1
e In the graphics window select the second | |
line of the tower. : :
e With the second stage selected, assign the : :
activation attribute Activate from the éb L _ -
Treeview ensuring that it is assigned to ‘k
loadcase Stage 2: 60 to 120 Days Assign activation

~ dataset to the 2nd
stage of construction

Defining loadcase properties

o Inthe = Treeview right-click Stage 2: 60 to 120 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

e On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

e Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 120 and the maximum number of time
steps as 15.
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| Analyses

Modelling

|Loadcase...

Ensure Same as previous loadcase is selected for the Incremental LUSAS file
output.

Select OK to return to the Modeller working window.

Stage 3

The elements in the third construction stage now need to be activated.

Enter the Loadcase name as Stage 3: 120 '
to 180 Days and select OK f

In the 'E! Treeview right-click Stage 3: [~~~ "7 7
120 to 180 Days and select Set Active

In the graphics window select the third
stage of the tower.

L — —
With the third stage selected, assign the ‘k
activation attribute Activate from the &
Treeview, ensuring that it is assigned to
loadcase Stage 3: 120 to 180 Days

Assign activation
dataset to the 3rd
stage of construction

Defining loadcase properties

In the "= Treeview right-click Stage 3: 120 to 180 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 180 and the maximum number of time
steps as 15.

Ensure Same as previous loadcase is selected for the Incremental LUSAS file
output.

Press OK to return to the Modeller working window.

Verifying self weight and activation assignments

If you need to verify loading assignments such as self weight or to check when
particular lines (and hence elements) become active in an analysis select a line on the
model using the right-hand mouse button and select Properties. Select the Activate
Elements tab. Note that the ‘greyed-out’ loadcase is simply the current loadcase and
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Staged Construction of a Concrete Tower with Creep

| Loadcase...

| Analyses

| Loadcase...

may not be the actual loadcase that the properties are assigned to. Selecting the
Activate entry in the table of Assigned properties will show the loadcase to which the
activation is assigned.

Stage 4

The elements in the fourth construction stage T T I

need to be activated.

Enter the Loadcase name as Stage 4: 180
to 240 Days and select OK

In the “=! Treeview right-click Stage 4: T LY

180 to 240 Days and select Set Active . -
Assign activation

In the graphics window select the top line dataset to the 4th

of the tower. stage of construction

Drag and drop the activation attribute
Activate from the &% Treeview ensuring
that it is assigned to loadcase Stage 4:
180 to 240 Days

Defining loadcase properties

In the ‘X! Treeview right-click Stage 4: 180 to 240 Days and, from the Controls
menu item, select the Nonlinear & Transient menu option.

On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner and leave the incrementation type as Manual

Select the Time domain option and select a Viscous time domain. Enter the initial
time step as 4, the total response time as 240 and the maximum number of time
steps as 15. Select OK to return to the Modeller working window.

Click OK to return to the Modeller working window.

Long-term loadcase

This investigates long-term effects on the tower over time.

Enter the Loadcase name as Long-term: 240 to 1000 Days

In the ™= Treeview right-click loadcase Long-term: 240 to 1000 Days and select
the Nonlinear & Transient option from the Controls menu.
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| File

Save

Modelling

e On the Nonlinear & Transient dialog
select the Nonlinear option in the top-left [ . e ety octor s
hand corner and leave the incrementation | icton factor =
type as Manual Minimum time step III-.II-

Maximum time step

e Select the Time domain option and
select a Viscous time domain. Enter the
initial time step as 1, the total response
time as 1000 and the maximum number
of time steps as 20. Integration factor aipha

Integration factor beta

Minimum time step for termination
Termination value

100.0E6
I 0.0
I 0.0
Exponent for increasing time step (CEB-FIP) V. I 20
I 0.5
I L

e Select the Automatic time stepping
option and then select the Advanced

Integration factor gamma

¥ allow step reductions

bUtton Maximum step reductions
e On the Advanced time step parameters ok | concel | neo |

dialog select the Exponent for
increasing time step option and set the value to 2. Press OK to return to the
Nonlinear & Transient dialog.

e Having set all the Nonlinear & Transient options select OK to return to the
Modeller working window.

Note. Specifying an exponent for increasing time step will cause the time step
increments to increase in duration throughout a loadcase. This is particularly useful
with creep analyses where it is often desirable to start a loadcase with short time steps
but progress to larger time steps as the age of the concrete increases to investigate long-
term behaviour without using an excessive humber of time steps. The larger the value
specified in the exponent for increasing time step box, the greater the ratio of the final
to first time step size will be. The analysis will always use the number of time steps
specified in the max time steps or increments box.

Note. All lines in the model are now activated so no activation dataset needs to be
assigned to the model for this loadcase.
Applying Gravity as a property of the analysis

Now that all five loadcases have been created, in the (X treeview right-click the heading
Analysis 1 and select Add gravity. This will automatically assign gravity loading to all
loadcases.

El Save the model file.
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Running the Analysis

&

| File
[New...
| File
| Script >
| Run Script...

El Click the solve now button and press OK to run the analysis using LUSAS Solver
and load the results file

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data folder in the directory
where the model file resides:

e concrete_tower.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

e concrete_tower.mys this is the LUSAS results file which is loaded
automatically into the @ Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered are
written to the .out file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U concrete tower modelling.vbs carries out the modelling of the tower.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

Enter the file name as concrete_tower

e To recreate the model, select the file concrete_tower_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.
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Viewing the Results

Viewing the Results

Analysis loadcase results for each time step are added to the () Treeview. The time
step results for the first loadcase are set to be active by default.

Bending moments of Mz at the base of the tower are to be investigated for each stage of
the construction process, that is, after 60 days, 120 days, 180 days, 240 days and for a
long-term loadcase. A summary of results on each results plot also allows a comparison
of maximum displacements for each stage.

Stage 1 results

Turn off the Geometry, Mesh, Utilities and Attributes layers in = Treeview.

Double-click View Properties in the 5" Treeview. Select the View tab and ensure
the check box Show only activated elements is ticked. Press OK to apply changes
and return to the model.

In the 'Z) Treeview right-click on
Time Step 15 Time = 60.000 (days)
and select the Set Active option.

With no features selected click the
right-hand mouse button in a blank
part of the Graphics window and
select the Diagrams option. On the
dialog, select Force/Moment -
Thick 3D Beam contour results from
the entity drop down list and
component Mz.

Select the Diagram Display tab and
ensure Label values and Peaks only
are ticked. Press the Label font...
button to set the diagram font as
Arial, Bold, size 14. Press OK to

return and change the angle to -15°. t/

Select the Scale tab select Use a
local scale and Specify magnitude with a value of 10mm. Click OK to display the
diagrams layer.
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Stage 2 to 4 results

o In the '2 Treeview right-click on the loadcases noted in the following summary
table, and select the Set Active option to update the diagram results.

4 &
Fy
Time Step 30 Time Step 45 Time Step 60
Time = 120.000 Time = 180.000 Time = 240.000
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| utilities

Viewing the Results

| Graph Wizard...

Long-term loadcase

In the = Treeview right-click on Time Step 79 Time
=1000.00 (days) and select the Set Active option.

For the long-term loadcase the bending moment has not
changed from the stage 4 analysis since no additional
loading has been applied to the model. However, a
comparison of maximum displacement between time
steps would show an increase due to the effect of the
creep deformations.

Plotting a Graph of Deflection

The time-dependent creep effects can be plotted using the LUSAS Graph Wizard.
Ensure that the mesh and/or deformed mesh layers are visible,

Select the node at the top of the tower by holding the N key and clicking the node.
On the first page of the Graph Wizard, select Time History and click Next.

For the X-axis entity, select Named and ensure Whole Analysis is seleted. Click
Next.

For the X attribute named data, select Response Time and click Next.
For the Y-axis entity, select Nodal and click Next.

Select entity Displacement and component RSLT. The number of the selected node
should automatically be entered in the ‘specify node’ input box. Click Next.

Enter title Displacement of Tower Tip, X-axis label Time (days) and Y-axis label
Displacement (mm). Click Finish to plot the graph.
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Displacement of Tower Tip
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The graph clearly shows the four construction stages, and that the deflection increases
with time due to creep and shrinkage effects. Note that the tower tip is not actually
activated in the first three construction stages, but deflections of the deactivated mesh
can be plotted.

This completes the example.
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Description

3-Span Concrete

Box Beam Bridge of

Varying Section

For software product(s):

Bridge and Bridge Plus

With product option(s):

None

Description

A 3-span concrete box beam bridge of varying cross-section is to be modelled to
illustrate the use of the box section property calculator and the use of the multiple
varying sections facilities in LUSAS.

Two models are to be created; a preliminary model suitable for prototype / assessment
work and a more detailed model suitable for developing further into a staged
construction model. Simplified geometry is used for both to allow the example to
concentrate on the use of the box section property calculator and the multiple varying

section facilities that are used in modelling the structure.

329



3-Span Concrete Box Beam Bridge of Varying Section

Units used are KN, m, kg, s, C throughout
Objectives
The required output from the analysis consists of:

O A comparison of results from the preliminary model and the more detailed
model.

Keywords
Bridge, Concrete, Multiple VVarying Sections, Box

Associated Files

U concrete_box_bridge.mdl Basic beam model.

Discussion

The 3-span structure is comprised of varying hollow cross-sections with solid
diaphragm sections at the four supports. Cross-section properties for three void
locations on the structure (as shown in the image below) will be defined and used in the
creation of multiple varying section geometric line attributes which will then be
assigned to selected lines on the model.

163m overall length

| 39m clear span L 78m clear span L 39m clear span )
0.5m | 24m ) ‘ ‘ 3m 3m 0.5m
; \ i ™
1 2 33 2 1 2 33 2 1
i i
1 2 33 2 1 2 33 2 1
] | |0 -] ] ° 2 psd a3
o v s o [ ~ - 3 & & 3 8 |8
of [© o™~ | (T [t=] @ — —| |~ - - |
T [l T T
'Left Span' '‘Centre Span’ 'Right Span'
Section 1-1 Section 2-2 Section 3-3
'Span Solid' 'Span’ 'Intermediate’ 'Pier' 'Pier Solid'

Schematic showing the section locations at which the varying section definitions are based.

Other section properties, for solid diaphragm sections at the supports and at the ends of
the structure (shown on the image above), will also be defined and assigned as required.

330



Description

When building a model like this the bridge can either be represented as a ‘flat model’
using lines at a common level with offsets being assigned to the elements to represent to
eccentricity of the section properties about the line, or geometry lines could follow the
centroid of the sections to create a ‘curved’ model. If post tensioning is to be carried out
the model should be based upon a ‘curved” model. Both methods are valid but for this
example the ‘flat model” method will be used.

1§ |

\m/

‘Flat’ modelling method
(where lines following the centroid of one section with other sections offset to align to match)

e

Indicative diagram showing ‘Curved’ modelling method
(where all lines follow the centroid of sections)

Modelling details

The supplied basic beam model is a ‘Flat” model with clear spans of 39m, 78m and 39m
formed of single straight lines. During the initial part of the example multiple varying
section geometric line attributes are assigned to the single lines along with other section
properties and a simple linear analysis is carried out.

After creating the simple model a more detailed model is formed by splitting the lines
representing each span into shorter 3m long lengths in readiness for a future staged
construction analysis. In doing so 3 mesh divisions will be present on each 3m long
geometric line.

Caution. When modelling varying cross sections with constant section beam
elements care should be taken to ensure that sufficient elements have been assigned to
the line(s) representing the tapering beam to achieve accuracy of results. If varying
section beam elements are used, only one element per line may be required.
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Modelling : Preliminary Model

| File

Open...

| File

Save As...

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Loading the model

To create the model, open the read-only file Concrete_Box_Bridge.mdl located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

The basic bridge geometry will be displayed.

The geometric lines of this model have been assigned a line mesh of thick beam
elements with an element length of 1m. Concrete (ungraded) material properties, and a
structural gravity load have also been assigned. Fixed supports restrain the piers and
roller supports restrain the ends of the deck.

e In the \<LUSAS Installation Folder>\Projects\ folder create a new directory
called ConcreteBoxBridge

e Save the model into this new folder as concrete_box_bridge_preliminary

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.
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| utilities

Modelling : Preliminary Model

Section Property
Calculator

| Box Section

Defining Cross-sectional properties

To start, cross-section properties for three voided box sections that are used in all three

spans will be defined.

To define the voided span section

e Select the Complex section
option and enter values as
shown on the dialog
opposite.

Box section dimensions are:

e H=22
e Wh=3
e Wt=3

e Hm =0 (or leave blank)
e Th=0.2
e Tt=02

Cantilever slab dimensions are:

e Wc=35
e Tcl=04
e Tc2=0.2

Box: Section Property Calculator

Type
’7(‘ Simple section

= Complex section

1
m
2
13
g
7
b
g
&

~Cal details
Humber of cells 1 =
E
© Box section dimensions
H 2.2 Hmo |0
Wh |3 b |u.z
Wt 3 Tt 0.z
) )
| Cantilever slab dimensions —————————| 0
W —— Wt —
we [35 Tet [0 )
Extra points locations | Caloulated properties |
1z oz Point | Oftset(D) | Height ] a feae
Fi 25 08
Inx [4.26726
[~ Number of extra points F‘f 12i355 g-;
- 4
Top slab 1 =l Ty [el.6z74
op=s = BT 5 ik
Bottom slab | 1 = ol 1.27 0z Iny [-1,13641E-15
- ] B8.81331
Cantlever siab 1 =
ieb interior Face o = sy |22
— asx [4.916
el exterior o =
vt |0.81026
Mame | Span Load section. .. | Creategeumetry‘..l vb |1.38974
@' add talocal ibrary
€ ek o server bbrary Visualie... | Clearinputs
ok | cancel | wppy | mep |

To allow additional points to be entered in addition to P1 and P2 to define the cross-
sectional shape the following need to be set in the Number of extra points panel:

e Topslab=1
e Bottomslab=1

e Cantileverslab=1

Web interior face and web exterior face points are not required so are left set to zero.

e Enter the name as Span
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The complete set of values to be entered in the Extra points locations table are:

Point Offset (O) Height (H)
P1 2.5 0.4
P2 2.5 0.4
t1 1.65 0.2
bl 2.0 0.2
cl 1.27 0.2

e To see the section that will be
created by the values entered click
the Visualise button. Click Close

to return to the main dialog.

e Ensure Add to local library is

BZ

B1

selected and click Apply to
calculate the section properties,
add the section to the local library,
and allow you to continue to

define another section.

—*]f'—*@

B2 B4

Tip. Of the section properties calculated one, yt, (0.81026 for this section) should be
noted because it used in subsequent calculations of eccentricity / offset values for other

sections.

To define the voided intermediate section

¢ In the Box section dimensions panel change the value of H to be 3.2

e Change the name to be Intermediate and click Apply to calculate the section
properties, add the section to the local library, and allow you to continue to define

another section.

To define the voided section adjacent to the pier

¢ In the Box section dimensions panel change the value of H to be 5.2

e Change the name to be Pier and click Apply to calculate the section properties, add
the section to the local library, and allow you to continue to define another section.
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| utilities

Modelling : Preliminary Model

Section Property
Calculator

>

Rectangular

Sections > Solid

To define the solid pier section

e Inthe Type panel select Exclude void

e Change the name to be Pier Solid and click Apply to calculate the section
properties, add the section to the local library, and allow you to continue to define
another section.

Tip. The difference between the yt value of the Span section and the Pier Solid section
should be noted because this will be required later in the example to specify an
eccentricity / offset value for other sections. In this case the difference in values of yt is
2.4626 - 0.81026 = 1.65234

To define the solid span section

Existing defined sections such as that of the voided span section can be loaded into the
dialog for subsequent modification to create new or similar sections

e Click the Load section... button. Browse the sections in the local library to find the
Span entry and click OK to load its section details into the dialog.

e Inthe Type panel select Exclude void

e Change the name to be Span Solid ensure Add to local library is selected and click
OK to calculate the section properties, add the section to the local library, and finish
defining the deck sections.

Tip. The difference between the yt value of the Span section and the Span Solid
section should be noted because this will be required later in the example to specify an
eccentricity / offset value of one from the other. In this case the difference in values of
yt is 0.98225 - 0.81026 = 0.17199

To define the column section

° On the Rectangular Solld SeCtion Rectangular Solid Section Property Calculator
- _ i~ Dimensional data i~ Caleulated properties ——
I;rozperty dialog enter D=6 and 0o " T
= B |2 i ‘ e [0
A name of RSS D=6 B=2 will be -t-- 1D w [T
automatically created. l w [T
f—pB—l
- . J 126435
e Ensure Add to local library is .
- =y
selected and click OK to calculate
the section properties, add the | wam[Fso-ee-: e I
section to the local library, and T —
finish defining section properties. ® Aty

0K | cancel | ey | Hep |
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3-Span Concrete Box Beam Bridge of Varying Section

| Geometric

| Section Library...

>

All required section properties have now been defined and saved in the local user

library. The solid sections must now be added to the & Treeview in order to allow for
them to be assigned to the model. The voided span sections will be used to create

multiple varying section line attributes which will be automatically added to the &

Treeview when the attribute is created.

Adding the solid section geometric properties to the

Treeview

The standard sections dialog will
appear.

e Click on the drop-down list button

ﬂ to change the selection from UK
Sections to User Sections

e Ensure a Local
accessed.

library is being

e Click on the drop-down list button

ﬂ and select Span Solid from the
list of local library items.

e Change the name to be Span Solid

e Click the Apply button to add the

Span Solid line attribute to the &
Treeview and allow you to choose
another section.

e Click on the drop-down list button

ﬂ and select Pier solid from the list
of local library items.

e Change the name to be Pier Solid

" Enter Properties

Geometric Line
Usag
[3D Thick Beam =1| [user Sections |
Definition ILnEal ﬂ
" From Library
Rotation about centioid [0 «|° [Span Soid =l

100%

z

=N

Value

Cross sectional arsa (4)

15.045

Second moment of area about y axis (yy)

B.53077

Second moment of area about z axis (122)

78.9895

Froduct moment of area (iyz)

-5.BS263E-15

Torsion constant ()

16.4268

Effective shear area in v dirsction (Asy)

12,545

Effective shear area in z dirsction (Asz)

11.0

Offsetin y direction (Ry)

0o

Offset in z direction (Rz)

a0

Wisualise. . I Tapering >»

[Erase sechon.. | Plastic properties... |

Name ISpan Solid

= Hw

oK

Cancel | [ b |

Hela |

o Click the Apply button to add the Pier Solid line attribute to the & Treeview and

allow you to choose another section.
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| Attributes

Modelling : Preliminary Model

| Geometric

Section...

>

Multiple Varying

¢ Click on the drop-down list button ﬂ and select RSS D=6 B=2 from the list of local
library items

e Change the name to be Column

e Click the OK button to add the Column line attribute to the & Treeview.

Defining the multiple varying section line properties for
the Left Span

A multiple varying geometric line attribute needs to be defined for the left-hand span.
This will make use of the previously defined voided sections named Span, Intermediate
and Pier.

Define sections

e On the Multiple Varying Section dialog click in the Section cell that currently
reads 914x305x289kg UB and the launch dialog button 3 will appear to allow a
different pre-defined section to be chosen from a different section library.

e On the Enter Section dialog, click on the drop-down list button ﬂ to change the
selection from UK Sections to User Sections

e Ensure a Local library is being accessed.

e Click on the drop-down list button = and select Span from the list of local library
items and then click OK to add the section to the first row of the table on the
Multiple Varying Section dialog.

e On the Multiple Varying Section dialog press the TAB key to move between cells
and create a new row beneath the existing row. (Shape interpolation and distance
values will be entered after all sections have been added to the table)

e In the new Section cell (row 2) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
and select Intermediate from the drop-down list and click OK to add the section
to the table.

e Press the TAB key to move between cells and create a new row beneath the
existing row.

e In the new Section cell (row 3) click on the launch dialog button 3 again. The
drop-down list should still be showing User Sections for a Local library. Browse
and select Pier from the drop-down list and click OK to add the section to the
table.
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3-Span Concrete Box Beam Bridge of Varying Section

Note. As the multiple varying section is built-up in the table, a visualisation of the
longitudinal and vertical alignment and of the cross-section shapes used is displayed on
the dialog. Longitudinal section visualisation only takes place once all required data has
been entered and only for sections that are compatible.

Define shape interpolation method

To specify a shape interpolation method — FEESmEE
- - Usage Distance
for each defined section: T — (« e o e e sy

" Along reference path

¥ specify shape interpolation

e The Span section as the first in the W

Edit...
1 Section Shape Interpolation| Distance
table is set by default to Start 1 L -
2| ricmedte sxmhzd 245 Delete
e For the Intermediate section entry [ At & =
click on the drop-down list button _
- . . — ,m Align all sections to section |_1j
in the Shape Interpolation cell borental [come e ]| ntrplaton o proortie [Faned

and select Smoothed

e Repeat for the Pier section in the
cell below selecting Smoothed %

Define distance values C

Lastly we need to specify a distance E=En
value at which each section will apply.

wame [P span )

e For the Span section click in the
Distance cell and enter 0.5 = =l e

e For the Intermediate section enter 24.5

e For the Pier section enter 39.5 and click somewhere else on the dialog to cause the
visualisation to be updated for the last entered distance.

Note. Values entered are treated as proportional distances along a line (for example
entering 0, 10 and 20 would specify a section at either end and at a mid-point of any
line that was selected and assigned the geometric line attribute). Distances are also
mapped to the actual line length so entering 0, 0.5, and 1, in three separate cells would
produce the same result. But note that a section does not necessarily have to be defined
to start at a distance of 0, (as in this example). In this case the use of a non-zero starting
point of 0.5 (a chainage value representing the actual setting-out point of the section on
the model) as well using a corresponding intermediate and an end point appropriate to
the line beam length will help to ensure an easy conversion to a staged construction
model in the second part of this example. This will use the same chainage values in
conjunction with the reference path facility.
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Modelling : Preliminary Model

Check alignment settings

The vertical and horizontal alignment of a series of sections is controlled by the
Alignment options. All sections are aligned with respect to a chosen section.

e Ensure the alignment is Top to top, Centre to centre and with respect to section 1

Name the attribute

e Enter a name of Left Span and click Apply to add the multiple varying section line
attribute to the &% Treeview and allow you to continue to define another one.

Defining the multiple varying section line properties for
the Right Span
This can be done by reversing the order of the sections used for the left span and then

changing the distance values. This time, to prevent inadvertent overwriting of
previously defined line attributes we will name the attribute first.

Name the attribute

- - . - SEQE\ eam - ?:::\:d to fit each line individuall
e With the Multiple Varying Section %‘j (rmgmmm
dialog for the Left Span currently I~ e secton )
displayed overtype the Left Span Secton Lﬂm*‘m“‘ B —Im;t
. . 1| Pier Start 1235
name with Right Span Blrerci: o 15 beete
Flip
Define sections _ _
Vertical lm Align all sections to section

e Click the Flip button to change the e [ =l o S
order of the sections listed. o

1

Check Shape Interpolation type

e The Pier section should be set to :
Start D L =

Section 1-1 Section 2.2 Section 3-3

e The Intermediate section should be
set to Smoothed

Hame [Right Span =] eew

e The Span section should be set to
Smoothed o | el | aoot | neb |

Define Distance values

e For the Pier section click in the Distance cell and enter 123.5
e For the Intermediate section enter 138.5

e Repeat for the Pier section enter 162.5
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3-Span Concrete Box Beam Bridge of Varying Section

Check alignment

e Ensure that all sections are aligned Top to top, Centre to centre and with respect
to section 3 (because this is now the number identifier for the Span section)

Save the changes

e Click Apply to add the multiple varying section line attribute to the & Treeview,
and allow you to continue to define another one.

Defining the multiple varying section line properties for
the Centre Span

This can be done by using the symmetric option to mirror the sections used for the
Right Span and then changing the distance values.

Name the attribute

& Sealed o fit sach fine indivickally

3D Thick Beam 2

e With the Multiple Varying Section dialog
displayed for the Right Span overtype the
Right Span name with Centre Span

Define sections
vetied [fopoop 7]

e Click the Symmetric option to mirror the = e 3

sections listed.

Check Shape Interpolation type

e The Pier section should be set to Start

e The Intermediate section should be set to
Smoothed

e The Span section should be set to Smoothed

Define Distance values

Specify a distance value at which each section will apply:

e For the Pier section click in the Distance cell and enter 42.5
e For the Intermediate section enter 57.5

e Repeat for the Pier section enter 81.5

e Click somewhere else on the dialog to cause the visualisation to be updated for the
last entered distance.
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Modelling : Preliminary Model

Check alignment

e Ensure that all sections are aligned Top to top, Centre to centre and with respect
to section 3 (the number identifier for the main setting-out section)

Save the changes

e Click OK to add the multiple varying section line attribute to the &b Treeview and
stop defining any more.

Note. Where all sections have been defined using either a LUSAS supplied standard
library item or one of the LUSAS standard section generators an ‘exact’ calculation is
made to arrive at intermediate section properties based upon the defined shape
interpolation method.

Assigning the varying geometric line properties

e Select the 39m long line representing the left-hand clear span of the bridge and
drag and drop the Left Span (Varying — 3 Sections) geometric line attribute from

the & Treeview onto it.

e Select the 39m long line representing the right-hand clear span of the bridge and
drag and drop the Right Span (Varying — 3 Sections) geometric line attribute onto
it.

e Select the 78m long line representing the centre clear span of the bridge and drag
and drop the Centre Span (Varying — 5 Sections) geometric line attribute onto it.

After assignment (and with fleshing turned on) the model will look like this:
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Right Span

N

Centre Span

Y

Left Span

N

Assigning the solid geometric deck properties

The solid sections at the ends of the deck and at column locations now need to be
assigned to the model.

TN Select the Y axis button to view the side elevation of the model.

_______

Drag a box around

Drag a box around
this line

this line

o Box-select the lines at either end of the bridge defining the solid section and drag

and drop the Span Solid (Span Solid major Z) geometric line attribute onto the
selection.

_______

_______

Drag a box around
this line

Drag a box around
this line
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Modelling : Preliminary Model

e Box-select the 2 lines at both internal supports defining the solid section of the
deck and drag and drop the Pier Solid (Pier Solid major Z) geometric line
attribute onto the selection.

Adjusting the centroid offsets for solid sections

In assigning the geometric line attributes for the solid sections of the deck it can be seen
that differences in centroid values in the y direction cause the solid sections to sit too
high with respect to the varying sections (which were all set-out with a vertical
alignment with respect to the centroid of the section named Span that sits at the left-
hand end of the structure). As a result the offset values for these solid sections need
amending.

e Inthe & Treeview, double-click the Span Solid (Span solid major Z) entry. Enter
a value of 0.17199 for the Offset in z direction (ez). This was calculated and noted
with a Tip marker earlier in the example.

e Inthe & Treeview, double-click the Pier Solid (Pier Solid major Z) entry. Enter a
value of 1.65234 for the Offset in z direction (ez). This value was calculated and
noted with a Tip marker earlier in the example.

Assigning the main column properties

I

% Select the 2 lines

representing the piers

e Select the lines representing the columns (piers) and drag and drop the Column
(RSS D=6 B=2 major z) geometric line attribute onto the selection.

e Rotate the model to a suitable 3D view
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| File

Save

3-Span Concrete Box Beam Bridge of Varying Section

El Save the model file.

The preliminary model is now complete and ready to be solved.

Running the Analysis : Preliminary Model

&

;l Open the Solve Now dialog. Ensure Analysis 1 is checked and press OK to run
the analysis.

Note. Normally a general warning relating to the use of sufficient constant beam
elements will be displayed (however in this example it has been turned off) whenever a
model containing multiple varying geometric line attributes is solved.

If the analysis is successful...
Analysis loadcase results are added to the G Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_box_bridge_preliminary.out this output file contains
details of model data, assigned attributes and selected analysis statistics.
U concrete_box_bridge_preliminary.mys this is the LUSAS results

file which is loaded automatically into the () Treeview to allow results to be
viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to the output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.
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Viewing the Results : Preliminary Model

Viewing the Results : Preliminary Model

Analysis loadcase results are present in the (5 Treeview.

Add a contour layer

With no features selected click the right-hand mouse button in a blank part of the

Graphics window and select the Contours option to add the contour layer to the
Treeview.

From the drop down menu in the dialog, pick Stress — Thick 3D Beam from the
entity drop down list and pick Sx(Fx,My,Mz) from the component drop down list.

Click OK to display stress contours on the fleshed shape.

Add a diagrams layer

With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Diagrams option to add the diagrams layer to the
Treeview.

From the drop down menu in the dialog, pick Force/Moment — Thick 3D Beam
from the entity drop down list and My from the component drop down list.

Select the Diagram Display tab and deselect Label values. Select the Scale tab and
enter a magnitude of 18. Click OK to display a bending moment diagram on the
fleshed shape.

Loadoass: 1:Loadoass 1

Results file: concrete_box_bridge_preliminary mys
Entity: Stress - Thick 30 Beam

Component: Sx(Fx, My, Mz)

-B84162E3
-54733E3
-4.10487E3

-2 736B5E3
-1 3683263
oo

13683263

2 73669E3
. 4 10497E5

This completes the preliminary part of the example.
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Modelling : Detailed Model

| File

| Save As...

| File

Close All Results
Files

| File

| Model Properties...

| utilities

| Reference Path

The preliminary model has clear spans of 39m, 78m and 39m formed of single lines. A
more detailed model is to be formed by splitting the lines representing each span into
shorter 3m long lengths in readiness for a future staged construction analysis. To allow
this to happen a reference path is created and the multiple varying section geometric
line attributes are updated to make use of the reference path that is defined prior to the
lines representing the spans being split into the smaller number of line divisions. No re-
assignment of geometric properties need be made to the lines created by splitting the
existing lines. The multiple varying section geometric line attributes will automatically
be applied to the lines using the reference path facility.

e Enter the model file name as concrete_box_bridge_detailed and click the Save
button.

e  Close the previous result files, for clarity.

Changing the model description

e Change the model title to Concrete Box Beam Bridge Detailed Model and click
OK

Creating a reference path

A reference path defines a route through a model that provides a concept of distance to
each point in the model. Those distances can be used in the definition of a varying
section, such that when the section is assigned to lines, the path is used to interpret
which part of the section is appropriate to each line. Bridge engineers refer to this
reference path concept as chainage.

For this example and for clarity a reference path will be defined above the model using
the path definition dialog.

e Enter coordinates of (0, 0, 10) in the first row of the table. Press the TAB key and
enter coordinates of (163,0,10) in the second row, ensuring the Type remains
Straight, as default.

e Accept all the default values and click OK to define a reference path above and of
the same overall length as lines defining the deck in the model. A corresponding

path definition entry will be created in the < Treeview.
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Modelling : Detailed Model

Note. In its simplest form a reference path can be defined as a line between two points
(quite separate from the model data, as in this case) if a straight path is to be
considered, or be created from the model geometry itself and contain as many defining
points as the lines from which it has been created (by using the Utilities > Reference
Path menu item) in which case the coordinates of all lines selected would be listed in
the Path Definition table. If the latter is done it is important to remember that the model
geometry has been used to arrive at the points required to generate a reference path but
no connection between the model geometry and reference path data exists.

Editing multiple varying section geometric properties

To make use of the reference path all multiple varying section geometric line attributes
need to be edited to refer to it.

o In the &b Treeview, double-click the Left )
Span (Varying - 3 Sections) entry. -

IV Specify shape interpolation
™ Symmetic section

e On the Multiple Varying Section dialog -
change the Distance Interpretation setting to i
Along reference path and ensure that Pathl
is selected. Click OK to update.

e Repeat the above procedure for the Right

Span (Varying - 3 Sections) entry in the &
Treeview.

e Repeat the above procedure for the Centre

Span (Varying - 5 Sections) entry in the &
Treeview.
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3-Span Concrete Box Beam Bridge of Varying Section

Split the lines representing the clear spans

The single lines representing each clear span are to be split into 3m lengths to represent
each proposed construction stage.

e Select the two 39m long lines representing the left and right clear spans of the
bridge

Select this line

Select this line

| Geometry e Select Use same divisions for all lines and Enter 13 for the number of divisions.
Line > Ensure that Delete original lines after splitting is selected and press OK.
By Splitting >
In Equal
Divisions

e Lastly, select the 78m long line representing the centre span of the bridge

Select this line

| Geometry e Enter 26 for the number of divisions and ensure that Delete original lines after
Line > splitting is selected.
By Splitting >
In Equal
Divisions
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| File

Running the Analysis : Detailed Model

Save

Splitting the lines in this way produces the following model which is now ready for
further manipulation (not covered in this example) to allow a staged construction
analysis to be carried out.

El Save the model file.

The detailed model is now complete and ready to be solved.

Running the Analysis : Detailed Model

A

;l Open the Solve Now dialog. Ensure Analysis 1 is checked and press OK to run
the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_box_bridge_detailed.out this output file contains details of
model data, assigned attributes and selected analysis statistics.

U concrete_box_bridge_detailed.mys this is the LUSAS results file

which is loaded automatically into the (5 Treeview to allow results to be
viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to a output files in addition to the text output window. Any errors listed in the text
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3-Span Concrete Box Beam Bridge of Varying Section

output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Viewing the Results : Detailed Model

When the detailed model has been built immediately after creating and viewing results
for the preliminary model the Contour and Diagrams layers will already be present in

the = Treeview and the stress contours and diagram plot will be as shown below.

Loadcase: 1 Loadcase 1

Results file: concrete_box_btidge_detailed mys
Entity: Stress - Thick 30 Beam

Component: Sx(Fx, My, Mz)

-B.8B4162E3
-5 4733E3
-4.10497E3

- -2.736ESE3
-1.36632E3
g

1.36832E3

2 73665E3
. 4.10497E3

The results obtained can be seen to be identical to those obtained from the simple
preliminary model.

This completes the detailed modelling part of the example.
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Description

Segmental
Construction of a
Post Tensioned
Bridge

For software product(s): | LUSAS Civil & Structural Plus and LUSAS Bridge Plus
With product option(s): | Nonlinear

Description

The construction of a balanced cantilever segmentally constructed bridge is to be
modelled using a beam analysis.
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Segmental Construction of a Post Tensioned Bridge

A complete analysis of a balanced cantilever segmentally constructed bridge is a
complex and large analysis to undertake. In this example the geometry has been
simplified to concentrate on the definition of the staged construction process and to
illustrate the definition and assignment of tendon properties.

An internal span of the bridge is modelled with segments being placed from adjacent
piers with a final closing segment to join the two constructions together as shown on the
next diagram.

i

e — I.. J|

7 N B \
A N
- T T [ —
T~ —\
A A

Each stage of the construction analysis considers a 6m long section being added to the
construction. These are: Stage 1 (top-left), Stage 2 (top-right), Stage 3 and Stage 4
(middle) and Stage 5 (bottom)

Units used are kN, m, t, s, C throughout.

The example incorporates staged construction and the assignment of multiple tendon
prestress loading.

Objectives
The output requirements of the analysis are:

U4 Maximum moments during construction
Keywords
Staged Construction, Multiple Tendon Prestress Wizard
Associated Files

U segmental_bridge_modelling.vbs carries out the modelling of the
structure.
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Modelling

| Geometry >
Line >

Coordinates...

| Geometry
Line

Copy...

Modelling

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Segmental Bridge

e Use the Default working folder.

e Enter the title as Segmental bridge including prestress and creep
e Select model units of KN, m, t, s, C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Ensure the startup template None is selected.

e Ensure the Vertical Y Axis option is selected and click OK.

Defining the Geometry

il Enter coordinates of (0, 0, 0), and (6, 0, 0), to define the first segment of the bridge
and click OK

e Select the line just drawn.

Sarm

LI Enter a translation in the X direction of 6

e  Enter the number of copies required as 4 and click OK

—

v
7
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| Attributes

|Mesh
| Line...

| Attributes

| Geometric
|Line...

>

Segmental Construction of a Post Tensioned Bridge

Defining and Assigning Mesh Attributes

e The bridge is to be modelled with Thick Soeiieai
nonlinear beam elements (BTS3 -
tructural
elements)
+" Element description  Use default spacing
. . Stuctural element type:
e Ensure that 3 dimensional elements of Frr e e [ PP
H H H Murnber of dimensians
Linear interpolation order are selected. e a—— —
Interpolation arder
e Enter 6 for the number of mesh divisions. Linear | S
. . " Element name " Element length
e Enter the attribute name as Thick = |
Nonlinear Beam and click OK
End releases..
e Selectall Im_es on the_ model and drag and N [Tk v = 4w
drop the Thick Nonlinear Beam mesh
;ro;n the &b Treeview onto the selected — [ s || oo |
eatures.

e Click OK to accept default element orientation.

Note. Forces and moments for a thick nonlinear beam element are constant along each
element’s length. As a result, sufficient elements should be used to get the desired
accuracy. In this example 6 mesh divisions have been chosen for simplicity, more may
be needed in real-life modelling situations.

Defining and Assigning Geometric Properties

The bridge is formed from box sections of a
constant width and depth. Five construction - Sl

5|
stages are to be modelled. Each of the stages P l =
H H Rotation sbout centroid [0 -] © :l'
uses the same section properties. N =
In this example the geometric properties have
already been calculated and will be defined
manually and then assigned to the model. ,
T*)

e With the 3D Thick Beam option selected —

enter the box section properties in the Vales = e T

column as follows: e
A = 5.36886, | s
lyy = 17.4844, 1zz = 4.63749, lyz = 0.0, ETE | W= S |
Jxx = 7.98955, e oo
Asy =2.55135, Asz = 3.87119,
ey=0.0andez=0.0 ok || cmet | | seor | s
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| Attributes
[ Material >
Material Library...
| Attributes
| Support. ..
| Bridge

Bridge Loading >
(Graviy

Gravi

Modelling

e Enter the attribute name as Box Section and click OK.

e Select all the lines on the model (hold down Ctrl + A keys) and drag and drop the
Box Section geometry material from the & Treeview onto the selected features

Defining the Material
e Select material Concrete of grade Ungraded from the drop down lists, and click
OK to add the material attribute to the &b Treeview.

e Select all lines on the model and drag and drop the Isol (Concrete Ungraded)
material from the &% Treeview onto the selected features.

Note. For this example an allowable tensile stress of 4 N/mm?” and an allowable
compressive stress of 20 N/mm? will be considered for the concrete section.

Supports

o A fully fixed support is required so all translations in the X, Y and Z and rotation
about the X, Y and Z axes must be Fixed. Enter a attribute name of Fully Fixed
and click OK

e Select the points at both ends of the bridge model and, from the & Treeview, drag
and drop the support attribute Fully Fixed onto the selected features, ensure the All
analysis loadcases option is selected and click OK

Loading

As well as the self-weight of the structure the effects of the prestress force will also be
considered in this analysis. Firstly, the self-weight will be defined.

A loading attribute named BFP1 (Gravity —ve Y) will be created in the &b Treeview.

Note. If using the Civil version a gravity load may be defined from the Attributes>
Loading> Structural> Body Force menu by specifying —9.81 as Linear acceleration in
the Y direction.

Self-weight loading is not to be applied yet. It will be applied during the definition of
the staged construction process.
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| Attributes

Segmental Construction of a Post Tensioned Bridge

| Birth and Death. ..

Creating Activation and Deactivation Datasets

In order to carry out a staged construction analysis the birth and death facility is used.

e Select the Activate option and click Next

e Enter the attribute name as Activate and click Apply

¢ Click Back so the deactivate attribute can be defined.

o Select the Deactivate option and click Next

e Select Percentage to redistribute and ensure the value is 100%. Enter the attribute
name as Deactivate and click Finish

Modelling of Construction Stage 1

o In the ‘& Treeview expand Analysis 1 then rename Loadcase 1 to be Stage 1 by
selecting Loadcase 1 with the right-hand mouse button and using the Rename
option.

All elements in the model not required for the first stage analysis need to be de-
activated.

e In the graphics window select the three lines defining the segments that are not
required in stage 1.

Fal=s
TE=E

~H

e From the ¢b Treeview and with the three segments selected, assign the deactivation
attribute Deactivate ensuring that it is assigned to loadcase Stage 1 and click OK

Assigning Loading

e Now select the two lines representing the active segments at either end. Assign the
BFP1 (Gravity —ve Y) loading to Stage 1 and click OK

Defining Loadcase Properties

o In the {Z Treeview select Stage 1 using the right-hand mouse button and select
Nonlinear and Transient from the Controls menu.
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Modelling

e On the Nonlinear & Transient dialog select the Nonlinear option in the top-left
hand corner, leave the incrementation type as Manual and click OK to accept all
default entries.

Construction Stages 2 to 3

Stages 2 and 3 require loadcases to be generated to specify the duration of the
construction process. Lines on the model must be selected according to the construction
stage being considered and activation attributes must be assigned to these lines.

Stage 2

The elements in the second construction stage must now be activated

e In the graphics window select the segments to be added in Stage 2 of the
construction sequence.

—ed]

e Assign the activation attribute Activate from the & Treeview. Enter Stage 2 in the
loadcase combo box and ensure that Set as the active loadcase is checked. Click
OK to finish activation of the selected sections.

Assigning Loading

e Now select all the activated segments (i.e. the lines representing the segments from
Stage 1 as well as the lines representing the segments from Stage 2) and assign the
BFP1 (Gravity —ve Y) loading to these lines ensuring the loadcase is set to Stage 2.
Click OK to complete the loading assignment.

Note. As the Stage 1 loadcase has been set as nonlinear with manual control the
subsequent loadcase controls do not need to be defined as they will take the properties
defined in loadcase 1.

Note. If you need to verify loading assignments such as self-weight or to check when
particular lines (and hence elements) become active in an analysis select a line on the
model and then, using the right-hand mouse button, select Properties. Select the
Activate Elements tab. Selecting the Activate entry in the right-hand table of Assigned
properties will show the loadcase to which the activation is assigned.
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Stage 3

The elements in the third construction stage now need to be activated.

b=
e *

. AN
T

e In the graphics window select the segment to be added in Stage 3 of the construction
sequence.

e With the middle segment selected, assign the activation attribute Activate from the

& Treeview. Enter Stage 3 in the loadcase combo box and ensure the Set as the
active loadcase is checked. Click OK to finish the activation of the selected
section.

Assigning Loading

e Now select all of the activated segments (i.e. all lines in the model) and assign the
BFP1 (Gravity —ve Y) loading ensuring the loadcase is set to Stage 3. Click OK to
complete the loading assignment.

Note. The active elements at each stage can be visualised by removing the Geometry
layer, selecting the Show activated only option on the mesh properties dialog and then
activating each loadcase in turn.

This completes the definition of the model geometry and the staged construction
process.

Rebuilding a model after a previous failed analysis

If a previous analysis of this example has failed you need to return here to continue
after having run the supplied file stated.

Prestress Loading

The calculation and assignment of the equivalent prestress force to the loadcases
already created is carried out by using the multiple tendon prestress wizard. It requires
the following to be defined:

1. Design code and elastic shortening criteria

2. Tendon profiles
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| Prestress Wizard >
| Multiple Tendon...

3. Tendon properties
4. Tendon loadings

5.  Tendon loading assignments

Once entered, and once the multiple tendon prestress wizard has been run, values for
each of these entries are retained and can be viewed and subsequently modified by re-
running the wizard. Previously calculated equivalent loadings are automatically re-

calculated.

Using the Multiple Tendon Prestress Wizard

Lines on the model will be selected during the use of the wizard, so:

e Ensure that the Geometry layer is present in the [5=* Treeview.

i
e Ensure that the BS5400 design Thae tendon Prostrees v E
code is selected from the drop Dssigncode |
down list. Elesc shotering

e Ensure that the User-defined
option for elastic shortening is @ et
selected and then click Set

© Ignare effects

¢ Based on design code SEse

Set losses.

losses... to proceed to the

E|aStIC ShOI‘tenlng _ |nCI’ementa| I Fieset previous presiress frput

J= | Beorm eleshcheck

dialog. P

ciock | Mew> | cencel

| Help |

e Enter the losses as 100, 95 and 90 percent.
(Use the Tab key to create each new line. )

e Click OK to return to the first dialog.

e Click Next to proceed to the Tendon Profile
dialog.

Elastic Shortening - Incremental

Percentage of applied load remaining after
attaching subsequent tendons

Load (%}

After 15t stressing of segment

100

After 2nd stressing of segment

93

After subseguert stressing of segment

a0

QK I Cancel

Help
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Defining the Tendon Profiles

Any number of tendon profiles can be defined on the tendon profile page prior to
moving on to the next page of the Multiple Tendon Wizard. By entering a name the
Create button becomes active and tendon details can be defined. Entering another name
stores the previously defined profile and enables another set of data to be entered, and

SO on.

Tendon Profile [ %]

x = distance along assigned line(s)
y = distance along y axis of assigned element at x
z = distance along z axis of assigned element at x

3d space |Twc 2d planes I

0.5

Type x (m) ¥ (m) z (m)
1 Start 0.0 1.0 0.0
2 Straight 6.0 1.0 0.0

" Global coordinates

* Local coordinates mapped to lines Insert | Delete

I~ smoathing

Hinimu kadius & Cut corner: /\
I 0.0 | Offset line /—'—‘\

-01
-0.3
-0.5

0.3
0.1

o1 2 3 4 6 7
x
1.5
1.3
1.1
[R:]
07
0.5
01 2z 3 4 6 7
x
Reverse | Flip |

Mame I Short tendon profile

=] & aofn

Create | Renamel Delete |

< Back I Next > I Cancel |

Help |

e Enter the attribute name as Short Tendon Profile and click the Create button.

e Ensure the option Local coordinates mapped to lines is selected

e Enter the tendon profile into the grid as

Type X (m) Y (m) Z (m)
Start 0 1 0
Straight 6 1 0

e Now, to start entering another tendon profile, enter the name as Long Tendon
Profile and click the Create button. In doing so, this stores the previous short
tendon profile values and clears the grid for the long tendon profile values to be

entered.
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e Enter the tendon profile into the grid as follows:

Type X (m) Y (m) Z (m)
Start 0 1 0
Straight 12 1 0

e Lastly, enter the attribute name as Full Tendon Profile and click the Create button.

e Enter the tendon profile into the X, Y, Z part of the grid as follows:

Type X (m) Y (m) Z (m)
Start 0 1 0
Parabola Bulge 15 -1 0
Parabola End 30 1 0

e Change the Type settings from Straight to be as shown by clicking inside the cell
and selecting Parabola Bulge for the second row and Parabola End for the last

row.

Tendon Profile [ x|

% = distance along assigned line(s)
y = distance along v axis of assigned element at x
z = distance along z axis of assigned element at x

3d space |Two 2d planes I

0.5
Type x {m) y (m) z (m)
1 |Start 0.0 10 00 03
2a_ |Parzbola Bulge 15.0 -1.0 0.0 0.1
2b  |Parsbola End 30.0 1.0 0.0 3 z
-0.1
-0.3
-0.5
[t} 10 1 20 2 30
0.9|
0.4]
" Global coordinates y 01
' Local coordinates mapped to lines Insert | Deleta 0.5
I smoothing ER
- . - 1] 5 10 15 20 25 30
[elimimurm radius % Gtk cormer: /—_-\\ x
0.0 = Offset line /"‘\
Reverse | Flip |

MName IFuIITendon Profile j i’ (30f 3) Create | Renamel Delete |

< Back I Mext > I Cancel | Help |
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Note. Tendon profile definitions can be reviewed before proceeding further by
clicking the up and down buttons adjacent to the tendon profile name.

e Click Next to proceed to the Tendon Properties dialog.

Defining the Tendon Properties

The Multi-strand prestressing system being considered here consists of 12, 15mm
diameter strands that give a nominal area of 1800mm?

e  Enter the attribute name as Essatlilenonkiopertic:
Strand Properties and click s [ i B —
the Create button Rielaxation loss |25 4
todulus of elasticity |200EE kN /m#
e Enter the tendon area as 1800 Shinkegecostt 0223 |
Short term losses——————————
e Enter duct friction coeff. as = Crespooell,  [DO36ES PN
0.2
Duct friction cocff. lgg— Stress at transfer |15E3 kM
e Select Long term losses

Defaults
Any number of tendon properties
could be defined on this page prior ez =] e oo | Renane] Do |
to moving on to the next page of
the Multiple Tendon Wizard. <Bock [ Wewr | Comel | Hep |

e Accept the defaults for the remaining properties by clicking the Next button.

Defining the Tendon Loading

This page allows a tendon load to be associated with previously entered profiles and
properties.

For tendon 1:
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e Enter the attribute name
as Tendon 1 and click Uit
the Create button.  Endi I End2

o Enter the prestress force = PesmsesfEr | A1 e
as 2E3 sip [ m [oo W

e Ensure that jacking from

End 1 Only |S Selected F’rufi\eIShUllTenanPrUliIa jﬂ

and enter the slip as 2E-

3 Property IStrand Properties j ;I
e  Ensure the profile combo

bOX IS Set tO ShOI’t Abtribute | Tendon 1 = :II [10of1] [Ereate Henamel Delete |

tendon profile and the

property combo box is <Back [ Mew> | Cancel | Hep |

set to Strand Properties

For tendon 2:

e Enter the attribute name as Tendon 2 and click the Create button.

e Enter the prestress force as 2E3

e  Ensure that jacking from End 2 only is selected and enter the slip as 2E-3

e Ensure the profile combo box is set to Short tendon profile and the property
combo box is set to Strand Properties

For tendon 3:

e Enter the attribute name as Tendon 3 and click the Create button.

e Enter the prestress force as 2E3

e  Ensure that the jacking from End 1 only is selected and enter the slip as 2E-3

e Change the profile combo box so that Long tendon profile is displayed and the
property combo box so that Strand Properties is displayed.

For tendon 4:
e Enter the attribute name as Tendon 4 and click the Create button.
e Enter the prestress force as 2E3

e Ensure that the jacking from End 2 only is selected and enter the slip as 2E-3
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e Change the profile combo box so that Long tendon profile is displayed and ensure
the property combo box is set to Strand Properties

For tendon 5:

Enter the attribute name as Tendon 5 and click the Create button.

Enter the prestress force as 4E3

Ensure that the jacking from End 1 and End 2 is selected and enter the slip as 4E-3
at each end.

Change the profile combo box so that Full tendon profile is displayed and ensure
the property combo box is set to Strand Properties

Note. Tendon loading assignments can be reviewed and corrected if necessary before
proceeding further by clicking the up and down buttons adjacent to the tendon profile
name.

e Click Next to proceed to the Tendon Loading Assignment dialog.

Defining the Tendon Loading Assignment(s)

The page of the wizard allows the IeeRaliioiid

Assign to lin Loadca:

assignment of the tendon loads that e s T

have been defined in the previous _ oy fomadcton_| g:g:; |
dialog to selected lines on the model. N Ere— |

. @ offetfomends [00  m
Click the New button and the — crwm=

Assignment will change to 1

¥ compute loading
¥ Generate graph datasets
v Ge

te report

b Drag the dlalog SO that the “xamples\SegBridge \Segmental Bridge. html _l
analysis model can be clearly I™ Inhesettng outnfomatn

seen in the graphics window I
ceate [[1 =] Newloadcases
Assignment |1 B j (1of 1) New Delete

<ok [ Fmn | cancel | Hep |

e Select the line tendon 1 acts on.

i I
I I
.‘i |
I . o . . N ¥l
I I

—se]
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On the Tendon Loading Assignment dialog click the Copy from selection button
and the selected line number will be entered in the text box.

Ensure the tendon combo box has Tendon 1 displayed.

In the loadcases section of the dialog, ensure Stage 1, Stage 2 and Stage 3 are
selected.

Ensure Generate graph datasets is selected.

Note. Clicking a higher loadcase will select or deselect loadcases beneath it.

Click the New button and the Assignment will change to 2.

Select the line tendon 2 acts on.

Fal=s
T L & &

Click the Copy from selection button and the selected line number will be entered
in the text box.

Change the tendon combo box so that Tendon 2 is displayed.

In the loadcases section of the dialog, ensure Stage 1, Stage 2 and Stage 3 are
selected

Click the New button and the Assignment will change to 3.

Select the two lines tendon 3 acts on.

R,
P

Click the Copy from selection button and the selected line numbers will be
entered in the text box.

Change the tendon combo box so that Tendon 3 is displayed.
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In the loadcases section of the dialog, ensure Stage 2 and Stage 3 only are selected
Click New and the Assignment will change to 4.

Select the two lines tendon 4 acts on.

L J
L J

Feaf=s
T

Click the Copy from selection button and the selected line numbers will be
displayed in the text box.

Change the tendon combo box so that Tendon 4 is displayed.

In the loadcases section of the dialog, ensure Stage 2 and Stage 3 only are selected
Click New and the Assignment will change to 5.

Select the lines tendon 5 acts on. (All the lines in the model.)

Click the Copy from selection button and the selected line numbers will be
displayed in the text box.

Change the tendon combo box so that Tendon 5 is displayed.

In the loadcases section of the dialog, ensure that the check box for Stage 3 only is
selected.

Ensure that the compute loading and generate graph datasets and generate

report options are selected. Graph datasets will be created in the < Treeview for
graphing if required. A report will be generated in the directory that you are
currently working in but this can be changed if required.

Select the Finish button to calculate and generate the equivalent prestress loading.

On completion, an HTML report will be opened automatically in the default web
browser. This report is also saved into the specified folder. The report is a complete
summary of the tendon profile, properties and loading assignments made.

On closing the report the tendon loading assignments on the model can be seen for
Stage 1. By changing the active loadcase the assignments can be seen for the other
construction stages also.
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Note. Tendon profile visualisations and the display of start and finish coordinates can
be controlled by changing the Current style setting to With coordinates on the
Utilities layer Properties dialog. Visualisations will then be identified by their start and
finish identifiers (1 or 2) and by the coordinates of these points. Because all tendons are
active in loadcase 3 the visualisations will overlap.

£.000,1.0,00) 2,(6.0,1.0,0.00 2,(12.0,1.0,00) 1,(18.0,1.0,0.0) 1,(24.0,1.0,0.0) 2,(30.0,1.0,0.0)

T ¥ r*

¥

Notes on Prestress Wizard-created data

In using the Prestress Wizard, prestress Ea Loading (&)
loading is added to the analysis model as Ea Discrate (5)
equivalent discrete point loading. Attributes =43 Point ()

.. . . = a Tendon force (5)
containing this data can be seen in the & 2:Assignment 1 Tendon 1
Treeview in the Tendon force folder. & Fhssignment 2 Tendon 2

& 4iAssignment 3 Tendon 3

Search areas are created and used & S:Assignment 4 Tendan 4
automatically by the prestress wizard to - Bihssignment 5 Tendon 5
define the target geometry (in this case, the =3 structural (1)
lines) to be loaded. These can be seen in the - b 1BFPL (Graviby -ve V)
K Ela Activate Elements (1)
Treeview. CL & Lactivate
. E a Deactivate Elerents (1)
Load ffactors are used to represent elastic & tiDeactivate
shortening and these can be seen for each - a5earch firea (S)
stage in the (5 Treeview. =2 E Tendon Force (S)
& 1:Assignment 1 Tendon 1
Graphing datasets (which allow of graphing &b Zihssignment 2 Tendon 2
f | dded h & 3ihssignment 3 Tendon 3
of prestress losses etc) are added to the & 4:assignment 4 Tendon 4
Treeview. B, Sihssignment 5 Tendon 5

Notes on editing Prestress Wizard-created data

If any tendon assignments are incorrect, the Multiple tendon prestress wizard may be
re-run (previously entered values will be retained) and the Next button can be clicked to
get to the tendon loading assignment page. Incorrect assignments can be deleted or
simply corrected as required before clicking the Finish button to recalculate the
equivalent tendon loading on the model.

Tendon profile data defined within the Prestress Wizard is also stored in the &

Treeview. Editing of tendon profile data in the < Treeview (that is, outside of the
wizard) is permitted but all attributes that require re-calculating by re-running the
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| Save

prestress wizard will be marked with the A symbol. Re-running the prestress wizard
will update all values accordingly.

Editing of any attribute data calculated and generated by the prestress wizard is not
permitted.

Save the model

El Saving the model file also saves all the multiple tendon prestress input. This allows
the prestress definition and assignment data to be modified by re-entering the multiple
tendon prestress wizard.

Running the Analysis

A

With the model loaded:

El Open the Solve now dialog. Ensure Analysis 1 is selected and press OK to run the
analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U segmental bridge.out this output file contains details of model data,
assigned attributes and selected statistics of the analysis.

U segmental bridge.mys this is the LUSAS results file which is loaded
automatically into the (&) Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Select Yes to view the
output file. Any errors listed in the text output window should be corrected in LUSAS
Modeller before saving the model and re-running the analysis. Note that a common
error is to forget to assign attribute data (such as geometry, mesh, supports, loading
etc.) to the model. If the errors cannot be identified the model may be rebuilt and the
prestress loading redefined.
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Viewing the Results

[New...

| File

| Script

| Run Script...

Rebuilding the Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model up to the point of defining the Prestress Loading.

0 segmental_bridge modelling.vbs carries out the geometric modelling
of this example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Segmental Bridge

e To recreate the model, select the file segmental_bridge _modelling.vbs located in
the \<LUSAS Installation Folder>\Examples\Modeller directory.

The geometry of the model has been created. Now return to the section entitled
Prestess Loading earlier in this example and re-define the tendon properties.

Viewing the Results

Analysis loadcase results are present in the (5 Treeview for each stage.

Bending moments of Mz over the segments are to be investigated for each stage of the
construction process. A summary of results on each results plot also allows a
comparison of maximum displacements for each stage.

In the following images the tendon profile visualisations are not shown. They can be
turned off by editing the tendon profile properties of the Utilities layer in the Layers
Treeview.

Stage 1 results

o Inthe ™ Treeview right-click on Stage 1 and select the Set Active Option.

e Turn off the display of the Mesh, Geometry, Utilities and Attributes layers from
the =" Treeview.

e If not there already add the Deformed mesh layer to the [=* Treeview.

e Using the Deformations... button at the bottom of the Treeview and specify
factor as 1E3. Click the Window summary option.
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e Add the Diagrams layer to the [=F Treeview. On the dialog, select Force/Moment
- Thick 3D Beam results from the entity drop-down list and component Mz. Select
the Diagram Display tab.

e  Select the Label values options and deselect the Peaks only option.

e  Set the % of element length to 60. Set the Angle to 90 degrees and the number of
significant figures to 4.

e Click OK to display the bending moment diagram for the active elements for Stage

B542E3
e
A

a

&7
5k
38
85.6

Note. The maximum deflection and maximum and minimum bending moments are
shown in the window summary.

Stage 2 results

o Inthe ™ Treeview right-click on Stage 2 and select the Set Active option.

Stage 3 results
o Inthe ‘X Treeview right-click on Stage 3 and select the Set Active option.

This completes the example.
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Description

Cable Tuning
Analysis of a
Pedestrian Bridge

For software product(s): | LUSAS Bridge / Bridge plus, LUSAS Civil & Structural/
Civil & Structural plus only

With product option(s): None.

Description

This example demonstrates the procedure for setting up a cable tuning analysis on a
simplified 3D beam model of a cable-stayed pedestrian bridge. Optimum cable forces to
maintain a flat deck and vertical tower under permanent loads are to be determined.

B ZAnalis

Units of kN, m, t, s, C are used throughout the analysis.
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Discussion

Modelling

Cable Tuning Analysis of a Pedestrian Bridge

Objectives

The required output from the analysis consists of:

O Calculation of cable forces required to maintain a horizontal deck and vertical
tower under permanent loading.

Keywords

Cable tuning analysis, targets, exact solution, linear

Associated Files

U cable_tuning.mdl contains the model geometry with all of the attributes
assigned. The example will use this model file as a starting point.

U cable_tuning_complete.mdl contains the complete model ready for
analysis.

Cable tuning analysis enables automatic calculation of cable forces to optimise certain
specified criteria, for example, to limit displacements in a bridge deck and/or tower
during construction.

The analysis of cable structures is strictly a nonlinear problem because the effects of
cable sag require large deflection theory (geometric nonlinearity) for accurate
estimation. However, because bridge cables are typically stressed to such a high force
that the amount of sag is small, it is often acceptable to idealise such analyses to
equivalent linear problems by neglecting the sag effects.

A common method of doing this is to represent the cables with a single linear bar
element. Bar elements only carry axial force (ho moment or shear) and by using a single
element no lateral deflection (i.e. sag) is permitted, so a reasonable approximation to
true cable behaviour is achieved. It is important to note that this method would
potentially permit the cable elements to carry compressive forces, so the predicted
forces must be checked to ensure this is not the case under any in-service combination
of loading.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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Open...

| File

Save As
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Creating the Model

For this example a model file is provided:
To create the model, open the read only file cable_tuning.mdl located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Save the model file to the \<Lusas Installation Folder> \Projects directory to
avoid over-writing the provided file.

il .
The Undo button ﬂ may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Model Supplied

The model geometry and attributes are already defined in the supplied model file.

The bridge to be analysed consists of a 46m high tower supporting a deck of total
length 108m.

The tower is a steel square hollow section, varying from 4m square at the base to 2m
square at the top, with 50mm thick walls throughout. It is fully fixed at its base and is
not connected directly to the deck where the two features cross.

The deck is a steel box section of total width 7m, having a cross-section as shown on
the following image. The deck consists of 9no. 12m spans between supporting cables.
The deck is pin-supported at the left-hand end and roller-supported at the other.
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B2 B1

&
régl

B3 B4

Steel box section for the deck

The lines representing the tower and the deck are meshed with thick 3D thick nonlinear
beam elements (BMI21). The lines representing the cables are each meshed with a
single 3D bar element (BRS2). Each cable is represented by a circular solid section of
50mm diameter.

Checking the Modelling so Far

The model contains a single analysis, with two linear structural loadcases — Self-
Weight (where the self weight is assigned to all members using ‘auto gravity’ as a
property of the analysis) and Surfacing (20kN/m assigned to the deck members only).

e Switch off section fleshing by clicking ll and rotate the model into the X-Z
plane by pressing T NAA, in the status bar.
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Print Results
Wizard...

| Analyses

Cable Tuning
Analysis. ..

Solving the Supplied model

El Press the Solve Now button to check the assignments made so far.

The Deformed Mesh layer will now be visible, and can be used to check that the
deformed shape for each of the two loadcases is reasonable.

e Check the reactions using Utilities> Print Results Wizard, then ensure that
Selected, All loadcases, for entity Reaction and for type Summary are selected
and click Finish.

e With the Self weight tab selected ensure that the total self-weight reaction is
11960kN. With the Surfacing tab selected ensure the total surfacing reaction is
2160kN (both in the Z-direction).

Creating a Cable Tuning Analysis

During the design of cable structures it is usually desirable to determine a set of cable
forces that will result in a certain deck profile. In this case we will calculate forces to
maintain a horizontal deck and vertical tower under permanent loading (gravity plus
surfacing). In LUSAS this can be done by setting up a ‘Cable Tuning Analysis’.

The first stage of this process is to select the lines representing the cables.

e In the & Treeview, right-click the geometric attribute Cable and click Select
assignments.

In the first tab of the Cable Tuning Analysis dialog you should see a list of the lines
which represent the cables under the Selected heading. Optimised forces for all of these
lines will be required.

e Click the All button in the middle of the dialog to copy them all to the Included list
on the right-hand side of the dialog.

e Switch to the Loadcases tab of the dialog.

This tab enables a combination of loads to be specified for optimising the cable forces.
In this instance we are interested in the bridge profile under permanent loads.

e Select both Self-Weight and Surfacing loadcases and click 2 in the centre of the
dialog to add both loadcases to the Included list.

e Switch to the Targets tab of the dialog.

Under the Targets tab the desired deflections and/or load effects from the cable tuning
analysis can be specified. In this instance we want to keep the deck flat and the tower
vertical, so we will specify that each of the points on the deck should have vertical
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deflection of zero and the point at the top of the tower will have a horizontal deflection
of zero.

e Move the dialog to the bottom-left-hand side of the screen and pan the model view
so that a clear image of the bridge is shown.

e Inthe = Treeview switch the Deformed mesh layer off.

e Holding the P key (to select only points), box select the whole deck with the
exception of the two end points as shown below. The two end points are
supported vertically so there is no need to fix their displacement.

— i

—g,l—H-—- ¥ Hold the 'P' key and select these points

¢ In the cable tuning dialog, click Add Selected. In the window that pops up, select
entity Displacement and set component DZ = 0. Click OK to add the selection of
points to the targets list.

e Click on the top point of the tower, then click Add Selected on the cable tuning
dialog again and specify entity Displacement and this time set component DX =0

e For this analysis the number of cables is equal to the number of targets so an Exact
solution can be calculated.

Note. If the number of cables exceeded the number of targets, there would be more
than one possible solution to the cable tuning problem. It would therefore be possible to
optimise the cable forces so that the targets were all met exactly, while some additional
criteria was also optimised; for example the lowest total force in the cables. This would
be set up by ticking the Optimised button at the top of the dialog and entering
optimisation data in the additional tab which appeared.

Note. If the number of targets exceeded the number of cables, an exact solution would
not be possible. In this case the Best Fit button should be ticked, and best fit data
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entered in the additional tab. It is usually possible to achieve a good match to the
desired targets using the Best Fit method.

To check that the correct solution method has been selected:

Click the Validate Input button in the bottom-left corner of the dialog. If the above
instructions have been followed correctly a pop-up stating Input is valid will be
shown. If not, check the three cable tuning tabs to determine the problem — there is
probably a mismatch between the number of cables and the number of targets.

Assuming that your inputs were successfully validated, click OK to conclude the
Cable Tuning setup. A Cable tuning analysis entry Cable tuning 1 will be added to

the 12 Treeview along with a loadcase entry for each of the cables selected for

tuning, and a cable tuning results entry shown by a s symbol representing a
loadcase that will contain the combination of optimised cable forces and the
loadcases specified during the cable tuning setup.

Solve the model again by clicking the Solve El button.

Viewing the results from the Cable Tuning Analysis

Set active the Cable Tuning 1 Results entry / combination by right-clicking the

Cable tuning entry 4 and selecting Set active to check that the targets have been
met.

In the Treeview switch the Deformed mesh layer on. This should show that the
deck points are all vertically aligned with the original flat deck profile, and that the
tower top point is horizontally aligned with the original vertical tower profile as
shown below.
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e To see the calculated load factors for individual cables, in the (X Treeview right-
click the loadcase Cable Tuning 1 Results and select Calculated Factors.

Calculated Factors

]|

Cables Loadcases Calculated Factor

1| Line:4 Loadcase 13 (Cable - Line: 4) 5 139E3
2| Line: 15 Loadcase 14 {Cable - Line: 15) 2027E3

3| Line: 16 Loadcase 15 {Cable - Line: 16) 1.53036E3
4| Line: 17 Loadcase 16 {Cable - Line: 17) 142843E3
5| Line: 18 Loadcase 17 {Cable - Line: 18) 1.42545E3
6| Line: 19 Loadcase 18 (Cable - Line: 15) 157153E3
7| Lne: 20 Loadcase 15 {Cable - Line: 20) 1.83762E3
8| Line: 21 Loadcase 20 ({Cable - Line: 21) 2.11483E3
9| Line: 22 Loadcase 21 {Cable - Line: 22) 2 83073E3

Close I Help

Note. Although the values shown in the Calculated Factors dialog cannot be edited,
they can be copied for pasting into spreadsheets and reports by selecting the data and

pressing Ctrl+C

This concludes the example.
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Description

3D Nonlinear Static
Analysis of a Cable
Stayed Mast

For software product: Any Plus version.
With product options: Nonlinear.

Description

A 10m tall mast with three supporting
guy cables is to be analysed. The guy
cables are spaced at 120° intervals
around the mast and are fixed at
ground level at a radius of 7m. Both
the mast and cables are made of steel
with a Young’s Modulus of 210e9 Pa,
Poisson’s Ratio of 0.3 and a mass
density of 7800 kg/m®.

X
Units of N, m, kg s, C are used T{
throughout.

Four load types are to be considered:

1. Initial force in the cables of
5000N.

2. Self-weight of the structure.
3. Horizontal wind load of 500 N/m distributed along the length of the mast.

4. A horizontal point load acting at the top of the mast of 5000 N.
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A

Modelling

3D Nonlinear Static Analysis of a Cable Stayed Mast

Objectives

The required output from the analysis consists of:

0 Deformed shape plot

O Force diagram and peak forces in cables

0 Bending moment and force diagram of the mast
0 Reaction summary at the base of the mast

Keywords

3D, Thick Nonlinear Beam, Nonlinear Control, Geometric Nonlinear Analysis,
Axial Force Diagram, Shear Force, Bending Moment Diagram

Associated Files

U mast_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name and model title as Mast
e Use the Default working folder.

e Set model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the model startup template Standard

e Select the Vertical Y axis option and click OK.
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| Geometry
Pont >
| Geometry
| Line >
By Sweeping...
| Geometry
| Paint >
Coordinates...
| Geometry
| Line >
| Paints...

Modelling

Defining the Geometry

El Enter co-ordinates of (0, 0, 0) and click OK to define a point at the bottom of the
mast.

e Select the Point

él Enter 10 in the Y direction (vertical) and click OK to sweep the point.

El Enter co-ordinates of (-7, 0, 0), (3.5, 0,
6.0622) and (3.5, 0, -6.0622). Click OK to
define points where the guy cables are fixed to
the ground.

El Select the isometric view button to rotate
the model so that all points are visible

o Define a cable by selecting a base Point
followed by an apex Point. (Use the Shift key
to make multiple selections)

il The lines defining the cable will be drawn.

e Repeat for the other two pairs of points.

Defining Groups

To simplify the assignment of model attributes and assist with post processing the
features will be grouped together.

e Select the Line representing the mast.

Select the Group button.

e Change the group name to Mast and click OK

e Select the three Lines representing the cables. (Use the Shift key to make multiple
selections)

Select the Group button.

e Change the group name to Cables and click OK
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3D Nonlinear Static Analysis of a Cable Stayed Mast

Meshing
The Line features are to be meshed using three-dimensional nonlinear beam elements.
| Attributes Select Thick nonlinear beam, 3 dimensional, Linear elements.
|% e Enter the attribute name as Mast and click the Apply button.

e Change the number of divisions per line to 10
e Change the attribute name to Cables and click the OK button
e Select the mast.

e Drag and drop the mesh attribute Mast from the Treeview onto the selected Line
features using an element orientation with a beta angle of 0. Click OK to assign.

e Select a line representing a cable and holding down the Shift key, select the other 2
lines representing the cables.

e Drag and drop the mesh attribute Cables from the Treeview onto the selected Line
features using an element orientation with a beta angle of 0. Click OK to assign.

Geometric Properties

The mast will be defined as a Circular Hollow Section (CHS).

| Attributes e From the Usage section select a 3D Thick Beam with no rotation specified.
| Geometric >
|SectionLibrary.. e From the UK Sections library select the CHS (EN10210) section type and select
the 168.3x8 CHS section.

e Enter an attribute name of Mast
¢ Click the OK button to add the CHS attribute to the Treeview.

The 10mm diameter guy cables will be defined with very low bending properties in
order to not attract any bending moments. A value of 1/100" of the actual bending
stiffness for the 10mm diameter cable will be used. The torsional constant and shear
area values are left unaltered.
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Modelling

| Attributes e From the Usage section ensure a 3D Thick Beam is selected
| Geometric
[Line... e Enter the properties shown below:

A=7.85e-5
lyy=5e-12
1zz=5e-12
lyz=0
J=1e-9
Asy=7.85e-5
Asz=7.85e-5
ey=0, ez=0

Note that these properties could have been derived by using the standard section
property calculator.

e Enter the attribute name as 10mm Cable and click the OK button.

The cable geometry dataset will be added to the Treeview.

Assigning Geometry Properties

e In the Treeview, right-click on the group name Mast. Choose the Select
Members option. Click Yes to deselect members already selected.

e Drag and drop the geometry attribute Mast (168.3x8 CHS major z) from the &
Treeview onto the selected Line. The section assigned will be visualised.

e In the Treeview, right-click on the group name Cables. Choose the Select
Members option. Click Yes to deselect members already selected.

e Drag and drop the geometry attribute 20mm Cable from the & Treeview onto the
selected Lines. Note that for manually entered section property data the section
properties cannot be visualised unless cross-section data is also defined (which will
not be done in this case)

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation.
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| Attributes

3D Nonlinear Static Analysis of a Cable Stayed Mast

| Material

| Material Library...

Material Properties

A linear approximation to steel properties will be used for the mast and cables.
e Select material Mild Steel, Ungraded, and click OK.

e Select the whole model (Control + A keys) and drag and drop the material attribute
Isol (Mild Steel Ungraded) from the &b Treeview onto the selected features.

Supports

The Standard template provides the more common types of support by default. These
can be seen in the Treeview. The structure will be supported at the base of the mast
with a fully fixed support condition. The cables will be supported in translation
directions only.

Assigning the Supports

e Select the Point at the base of the
mast.

e Drag and drop the support attribute
Fully Fixed onto the selected Point
for all loadcases. Click OK to assign.

e Select the 3 Points at the base of the
three cables.

e Drag and drop the support dataset
Pinned from the & Treeview onto
the selected Points for all loadcases.
Click OK to assign.

Loading

Four load types will be considered: Initial stresses in the cables, self-weight, horizontal
wind Load, and a point load acting at the top of the structure. The loading will be
assigned to four loadcases.

Load type 1 - Initial Stress

o Inthe & Treeview expand Analysis 1 then rename Loadcase 1 to be Initial stress
in cables by selecting Loadcase 1 with the right-hand mouse button and using the
rename option.
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Modelling

An initial force in the guy cables of 5000 N is to be defined and assigned to the model.
Since the elements used to represent the mast and cables are BTS3 elements which are
formulated using forces and strains (see the Element Reference Manual for details) the
force is entered by selecting the Stress and Strain option on the structural loading
dialog.

| Attributes e Select the Stress and Strain option and click Next
| Loading. ..

e Select a Line element description

e Select Thick nonlinear beam from the drop down list

e Ensure the Stress and Strain Type is set to Initial

e Enter a value of 5000 for Fx.

e Enter the attribute name as Initial Stress

e Click Finish to add attribute to the &% Treeview.

The copy and paste facility will be used to assign this loadcase to the cable group.

e Inthe & Treeview, right-click on the ¥
loading attribute Initial Stress and b
select the Copy option. g

e In the L= Treeview, right-click on the I hS
group name Cables and select the L e
Paste option. : M

e On the Loading Assignment dialog / #
select the loadcase name Initial ; Y
Stress in Cables. Click OK to assign .f K_ j
loadcase. ,.*'I ) 'f

.

Load type 2 - Self Weight @

Load type 2 represents the self-weight of the structure. This is modelled automatically
by applying gravity to the loadcase. The self-weight will be assigned to both Loadcase
2 and Loadcase 3 for reasons that are explained during the Nonlinear Analysis Control
section of this example.

| Analyses e Name the loadcase Self Weight
| Loadcase...

e Select the Automatically add gravity to this loadcase option and press Apply.

e Change the name to Self Weight Freeze and press OK to create the second self-
weight load type.
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| Attributes
| Loading...

| Attributes
| Loading...

3D Nonlinear Static Analysis of a Cable Stayed Mast

Load type 3 - Horizontal Wind Load

Load type 3 is a horizontal wind load of 500 N/m distributed along the length of the
mast.

e Select the Global Distributed option and
click Next

e Select the Per Unit Length option. Enter
a value of -500 N/m in the X direction.

e Enter the attribute name as Distributed
Wind Load.

e Click Finish to add the attribute to the &%
Treeview.

e In the & Treeview, right-click on the
loading attribute Distributed Wind Load
and select the Copy option.

e In the Treeview, right-click on the group name Mast and select the Paste
option.

e On the Loading Assignment dialog change the loadcase name to Wind and point
Load. Click OK to assign loadcase.

e Click OK to assign the loadcase.

Load type 4 - Concentrated Point Load
A point load of 5000 N is acting at the top of the mast.

e Select the Concentrated option and click
Next

e Enter a value of -5000 in the X direction.

e Enter the attribute name as Point Load

e Click Finish to add the attribute to the &
Treeview.

e Select the Point at the top of the mast then
drag and drop the loading attribute Point
Load from the & Treeview onto the
selected Point.
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Modelling

e Ensure that the loading is assigned as Wind and Point Load and press OK.

Nonlinear Analysis Control

Nonlinear control is defined as a property of a loadcase and must therefore be set for all
four loadcases required for this analysis.

Loadcase 1

o Inthe (™ Treeview, right-click on Initial Stress in Cables and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Manual control.
e Use default settings for this initial manual loadcase. Do not modify the dialog.

e Click OK to finish.

Note. A & Nonlinear and Transient object will be added to the Treeview. Double-
clicking on this object will allow any changes to be made to the control properties for
this loadcase.

Loadcase 2

Loadcase 2 (the self weight loadcase) uses automatic load incrementation. In doing so,
the load is applied as a very small initial step to overcome any potential convergence
problems. The specification of the number of iterations per increment determines how
the load step is varied from one increment to the next. The analysis generally
converges in 2 or 3 iterations. By setting this value to 12 the load step will rapidly
increase.

Note. In LUSAS, the use of automatic nonlinear incrementation immediately
following a manual nonlinear incrementation (as in this case) causes the results from the
previous analysis to be retained and used as the starting point for the subsequent
analysis.

o Inthe ™ Treeview, right-click on Self Weight and select Nonlinear & Transient
from the Controls menu.

e Select Nonlinear incrementation with Automatic control.
e Enter the Starting load factor as 0.01

e |eave the Max change in load factor setto 0

e Leave the Max total load factor as 1

e Set the Iterations per increment to 12
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3D Nonlinear Static Analysis of a Cable Stayed Mast

In the Incrementation section of the dialog select the Advanced button.
e Enter the Stiffness ratio to switch to arc length as 0. Click the OK button.

e Ensure that the Solution strategy and Incremental LUSAS file output are set to
Same as previous loadcase.

e Click the OK button to finish.

Loadcase 3

Loadcase 3 reapplies the self-weight in a single Manual load step. This effectively
freezes the self-weight load allowing the wind loadcase 4 to be incrementally increased.
If an Automatic (loadcase 4) nonlinear control were to follow a previous Automatic
(loadcase 2) nonlinear control then the loading would be overwritten.

Note. In LUSAS, using manual nonlinear incrementation immediately following an
automatic nonlinear incrementation (as in this case) allows a subsequent automatic
nonlinear incrementation to be applied without overwriting any previous loading.

o Inthe (& Treeview, right-click on Self Weight Freeze and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Manual control.

e Ensure that the Solution strategy and Incremental LUSAS file output are set to
same as previous loadcase.

e Click the OK button to finish.

Loadcase 4

Loadcase 4 applies the wind and point load using Automatic load incrementation. In a
similar manner to that used for loadcase 2.

o Inthe(E Treeview, right-click on Wind and Point Load and select Nonlinear &
Transient from the Controls menu.

e Select Nonlinear incrementation with Automatic control.
e Enter the Starting load factor as 0.01

e Leave the Max change in load factor setto 0

e | eave the Max total load factor as 1

e Set the Iterations per increment to 12

¢ Inthe Incrementation section of the dialog select the Advanced button.
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| File

| Save

Running the Analysis

e Enter the Stiffness ratio to switch to arc length as 0. Click the OK button.

e In the Solution strategy section of the dialog deselect the Same as previous
loadcase option and then select the Advanced button.

e Set the Maximum number of line searches to 0 and click OK

e Click the OK button to finish.

Defining a Geometric Nonlinear analysis

One additional setting is required to allow a geometric nonlinear analysis to take place.
e Double-click on the ¥ Nonlinear analysis options object in the (5 Treeview.

e Select the Co-rotational Formulation option.

e Click the OK button to finish.

Note. The & Nonlinear analysis options object sets parameters for the whole

analysis and the ¥ Nonlinear and Transient object sets control properties for each
loadcase.

Save the Model

The model is now complete and the model data is to be saved before an analysis is run
using the LUSAS Solver.

El Save the model file.

Running the Analysis

With the model loaded:
El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis from Modeller.

During the analysis 2 files will be created:

0 mast.out this contains the statistics of the analysis, for example how much
disk space was used, how much CPU time was used, and any errors or warning
messages from LUSAS. Always check the output file for error messages.
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| File
[New...
| File
| Script >
| Run Script...

3D Nonlinear Static Analysis of a Cable Stayed Mast

O mast.mys This is the LUSAS results database which will be used for results
processing.
If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview and the results for the first
loadcase will be set active by default.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

U mast_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as mast

To recreate the model, select the file mast_modelling.vbs located in the \SLUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results

Viewing the Results

Selecting the results to be viewed

The loadcase results for the first loadcase (in this case the initial stress in cables) are set
to be active by default.
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Viewing the Results

Note. With reference to the loadcase results
opposite, the first increment relates to the
initial stress loadcase. The first set of load
factor increments relate to the self-weight
loadcase. Increment 7 relates to the ‘freezing’
of the self-weight loadcase prior to loading
the structure with the wind and point load.
The remaining load factor increments relate to
the application of the wind and point loading
on the on the pre-stressed structure.

Deformed Mesh Plot

e If present in the Treeview
turn off the Geometry, and
Attribute layers.

e Click Close to accept the default
properties and view the deformed
mesh for the first results loadcase
Initial Stress in Cables

e Turn off the Mesh layer

=

& ® | 18 |

=23 mast.mdl
223 Loadcases
=423 Stuctural
@ T:lnitial Stress in Cables

-

(B 25 el weight

@ 3:5elf Weight Freeze

@ 4\wfind and Point Load

b
W Monlinear analysis options

-1 Supports

-[Z3 Loading

% MNonlinear and Trarsient
- B2 Tncrement 1

-[Z3 Loading

% MNonlinear and Trarsient

17 Zlncrement 2 Load Factor = 0.100000E-01
+17 Flncrement 3 Load Factor = 0.446410E-01
17 &lncrement 4 Load Factor = 0164641
-7 Elncrement 5 Load Factor = 0580333

-~ Blncrement 6 Load Factor = 1.00000

-[Z3 Loading
% MNonlinear and Trarsient
-7 Tinciement 7

-1 Loading

~ Wy Monlinear and Trarsient

17 &lncrement & Load Factor = 0.100000E-01
FIncrement 3 Load Factor = 0.344343E-01
10:Increment 10 Load Factor = 0.944343E -1
11:Increment 11 Load Factor = 0241464
1ZIncrement 12 Load Factor = 0601 464
1Z:Increment 13 Load Factor = 1.00000

-l
-l
-l
-l

47474474

MNone

j Specify... |
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3D Nonlinear Static Analysis of a Cable Stayed Mast

Axial Force Diagram for Initial Stresses

e With no features selected,
click  the  right-hand F11.91E3
mouse button in a blank
part of the graphics
window and select the YEddEs
Diagrams option to add
the diagrams layer to the

& Treeview. !
e Select the entity Force
/Moment - Thick 3D -11.91E3
Beam of component Fx Z
(axial force) 4.844E3

. 4:B44E3
e Select the Diagram

Display tab and select the Label values and Peak values option. Untick the Also
use for labels option and set the number of significant figures to 4.

e Click OK to add the Diagrams layer to the display.

Combined Initial Stress and Self weight

e In the (B Treeview right-
click on the on the last
results increment inside the
Self Weight section for
Load Factor = 1.00000
and select the Set Active frapER
option.

F12A4TE3

This shows axial force from
the combined effect of the L I

initial stress and the self- <  14.78E3
weight on the mast. 7

4.346E3
4-346E3
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Viewing the Results

Combined Initial Stress, Self Weight and Wind Load

o In the ™= Treeview right-
click on the last results
increment in the Wind
and Point load section
for Load Factor =
1.00000 and select the 12.05E3
Set Active option.

F20.6E3

This shows axial force for

the combined effect of the & o
initial stress, the self-weight <

and the wind loading on the ~12.983

mast. .

12.08E3

311.4

Axial Force Diagram for the mast only

e Inthe L=l Treeview, right-click on the group name Mast and select the Set as Only
Visible option.

Shear Force Diagram for the mast

e Inthe Treeview double-click on the Diagrams entry and select Force/Moment
— Thick 3D Beam results for axial force Fy. Click OK to update the graphics
window.

Bending Moment Diagram

e Inthe Treeview double-click on the Diagrams entry and select Force/Moment
— Thick 3D Beam results for bending moment Mz. Click OK to update the graphics
window.
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| utilities

3D Nonlinear Static Analysis of a Cable Stayed Mast

| Print results wizard

F1.157E3

F20.BE3 .445E3
2723E3
bk b b iaeres
< “72.9E3 < <
z 26383 I z
Axial force Fx Shear force Fy Bending moment Mz

Plotting Reactions at the Mast and Cable Supports

In the = Treeview turn off the Diagrams layer.

With no features selected, click the
right-hand mouse button in a blank
part of the graphics window and
select the All Visible option.

With no features selected, click the
right-hand mouse button in a blank
part of the graphics window and
select the Values option to add the
values layer to the Treeview.
Select results of entity Reaction of
component RSLT. 02 514

Select the Values Display tab and plot 100% of Maxima values

Click the OK button.

Printing a Results Summary of Reactions

With the last results increment for a load factor of 1.0 still selected in the Treeview:

Select Active

Select entity Reaction for type Component.
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Viewing the Results

e Click Finish to view the tabulated results summary

" LUSAS Yiew: Reaction Components in Global Axes Loadcase =

13 Results File = ... [H[=] E3

Mode & Fx F FZ S Tl MZ RSLT
1 Mode F¥ F FZ B Tl MW RELT
2 1 3.21B96ES: 23.2951E3 53.5529E12 0.259115E-9 1 44685E-9 -7 .29504E3 25 5142E5
3 10 192825 0 -2400527 (0.226054E-6 an 0.0 an 305.514
4 30 3.45793E5 9E574F1ES -6.00337ES an 0.0 an 12.0734E3
a =] 3.48793E3: 9874 HES 6.00357ES an 0.0 an 12.0734E3

|4 | 4 I }l 3] |'\\ MModel infio }\ 13:Increment 13 Load Factor = 1.00000 fr

Note. The values of FZ, MX and MY for node 1 vary slightly from those shown from
/ machine to machine. These values are effectively zero.

This completes the example.
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Description

2D Consolidation
under a Strip
Footing

For software product(s):

Any Plus version.

With product option(s):

Nonlinear.

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The pore  water
pressure dissipation
and settlement in a
soil following the
application of a
distributed load is to
be investigated.

Horizontal
displacement at the
left edge is restrained

to model the
symmetrical
boundary condition.
Vertical

displacement at the
base of the soil is
restrained as the soil
rests on solid rock.

I

fsm-

LS
} 100m }
o Young’s modulus of the soil ~ E= 34.7 x 10° kN/m?
; Poisson’s ratio v=0.35
§ Density p=19tm?
Bulk modulus of water Ky = 2.2 x 106 kN/m?
Void ratio e=1.174
Unit weight of water 7= 9.812 kN/m?
Soil permeability kx=ky=kz=1.0 x 10" m/s

The pore pressure at ground level is prescribed to zero.

Units of kN, m, t, s, C are used throughout.
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&

Modelling

2D Consolidation under a Strip Footing

Objectives

The required output from the analysis consists of:

U Settlement at the centre of the footing with time.

O Pore pressure distribution immediately after application of the load (undrained
response)

U Pore water pressure dissipation with time at the centre of the footing

Keywords

Consolidation, Pore Water Pressure, Time Stepping, Nonlinear, Transient,
Settlement, Two Phase Materials, Default Assignments, Graphing

Associated Files

U pwp_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the File name as pwp

e Use the Default working folder.

e Enter the title as Consolidation under a Strip Footing

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Select the startup template Standard

e Select the Vertical Y axis option and click OK.
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| Attributes
|Mesh >
Surface...

Modelling

Note. The Undo button may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Prior to defining the geometry of the model default surface mesh and material
properties will be set-up.

Mesh Definition

Since this analysis requires the modelling of pore water pressure, plane-strain two phase
elements will be used.

e Select Plane strain two phase, Quadrilateral, Quadratic elements. Ensure the
Regular mesh option is selected with Automatic divisions so that Modeller uses
the mesh divisions assigned to each line.

e Give the attribute the name Plane Strain Two Phase and click the OK button to
add the mesh attribute to the & Treeview.

o In the &b Treeview click on the mesh attribute Plane Strain Two Phase with the
right-hand mouse button and select the Set Default option. This will ensure all
newly created surfaces will be assigned the elements defined in this mesh attribute.

Material Properties

For consolidation analysis both the elastic and two-phase soil properties need to be
defined. The overall ‘equivalent’ bulk modulus of the soil is related to the bulk modulus
of the pore fluid and the bulk modulus of the solid soil particles by the formula:

1 n N I-n) n
Ke Kf Ks Kf

Where
Ke is the equivalent bulk modulus of the soil
Kf is the bulk modulus of the pore fluid
Ks is the bulk modulus of the solid soil particles
n is the porosity of the soil

The porosity of the soil is related to the void ratio by the formula:

e
Porosity N =——=0.54
l+e
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2D Consolidation under a Strip Footing

| Attributes e Enter the isotropic material properties for the soil as Young’s Modulus 34.7E3,
| Material _ > Poisson’s Ratio 0.35 and Mass density 1.9
Isotropic...

e Click on the Two phase check box at the top right-hand corner of the dialog and
select the Undrained option.

Using the following properties
[~ Plastic [ Creep [ Damage [~ shrinkage [~ viscous ¥ Two phase
'Hlastic Two Phase |
& Undrained Value
 partially drained Bulk modulus of solid phase 2266
SR eI Bulk modulus of fluid phase 3528
™ Piecewise linear partially drained Porosity of medium D54
Unit weight of fluid 5812
DEFinE CUrYES ., | Hydralic conductivity in global X direction 0.01e-6
Hydralic conductivity in global Y direction 0.01e-6
Hydralic conductivity in global Z direction 0.00e-6
Density of fluid 0.1
Mame | Fissured Clay| j ﬂ (new)
O | Cancel | Apply | Help

e Enter the properties as shown in the dialog above..

Note. For the purposes of this example and to comply with a corresponding test case
/ the bulk modulus the undrained bulk modulus of the soil is set to be the same as that of
the pore fluid.

e Enter the attribute name as Fissured Clay and click the OK button to add the
attribute to the &% Treeview.

o In the &b Treeview click on the attribute Fissured Clay with the right-hand mouse
button and select the Set Default option. This will ensure all newly created features
will be assigned the properties defined in this material attribute.
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| Geometry
[Surface >
| Geometry
[Surface >
Coordinates...
| Attributes
Mesh >
Line...

Modelling

Feature Geometry

_I Enter coordinates of (0, 0), (5, 0), (5, 10) and (0, 10) to define the soil under the
load. Use the Tab key to move to the next entry field on the dialog. When all
coordinates have been entered click the OK button.

J Enter the coordinates of (5, 0), (100, 0), (100, 10), (5, 10) to define the remainder
of the soil.

Mesh Grading

Define a Line mesh with element type None and 16 divisions.
Select the Spacing button.

Choose the Uniform transition option and set the Ratio of first to last element to
0.1

Click OK to accept the spacing properties.

Give the attribute name as Null 16 Graded and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

Define a Line mesh with 12 divisions.

Select the Spacing button.

Enter the Uniform transition option and set the Ratio of first to last element to 5
Click OK to accept the spacing properties.

Give the attribute name as Null 12 Graded and click OK to add the attribute to the
c&; Treeview.
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| Attributes

Support...

2D Consolidation under a Strip Footing

Select these 2 horizontal Lines
and assign "Null 16 Graded"

N\
N =

Select these 3 vertical Lines and assign "Null 12 Graded"

L

Select the horizontal lines of the larger surface as shown and assign the mesh attribute
Null 16 Graded

e Select all the vertical lines as shown (Use the Shift key to add to the initial
selection) and assign the mesh attribute Null 12 Graded

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line, and using the Geometry>Line>Reverse menu.

Supports

Define a support to prescribe zero pore pressure.

e Click on the option to make the Pore pressure Fixed

e Enter the attribute name as Fixed PWP and click the OK button.
Assign the supports to the model.

e Select the vertical Line on the left-hand side of the model and drag and drop the
support attribute Fixed in X from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

e Select the 2 horizontal Lines representing the base of the soil and drag and drop the
support attribute Fixed in Y from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases
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| Attributes

Loading...

Modelling

e Select the Line at ground level on the right-hand side of the model (see image) and

drag and drop the support attribute Fixed PWP from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support
attribute to All analysis loadcases

Select this line

Loading

o Select the Face option and click Next
e Enter loading of 3450 in the y Direction
o Enter the attribute name of Distributed Load and click the Finish button.

e Select the top line on the left-hand side of the model and drag and drop the
Distributed Load attribute onto the selection. With the Assign to lines option
selected click OK to assign the loadcase attribute to Loadcase 1.

Select this line

niirallie ul g fral fral g g fral m fral g E g ]

Analysis Control

With this consolidation problem an automatic time stepping procedure is adopted. This
is because consolidation is a typical diffusion process in which the field changes rapidly
at the start of the process before settling down to a steady state condition a considerable
time after the initial load is applied. The automatic time stepping procedure enables the
time step to be modified so that the small time steps required at the start of the problem
can be increased as the analysis progresses. In some cases the overall response time can
be orders of magnitude larger than the initial time step.

The initial time step is important since the early variations in pore pressure must be
accurately accounted for. Vermeer and Verruijt suggest the following criteria for
determining the initial time step where Ah is the minimum distance between nodes.
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9.812
At > Lo (Ahy? x 0.14% ~ 100 secs

6EK T 6x34.7E3 X 1E-8

Note. The distance between two nodes can be determined by selecting the two nodes
/ and then picking the Utilities>Mesh>Distance between Nodes entry.

o In the "= Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Nonlinear & Transient from the Controls menu.

Nonlinear & Transient

— Incrementation — Solution stategy
v Maonlingar [~ Same as previous lnadcase
Incrementation I tanual - l M number of iterations I'I 2
Starting load factor ID.1 Rezidual force nom ID.1
tax change in load factar ID.D Incremental dizplacement naorm I'I 0
Max tatal laad Factar I‘I.D Advanced... |
v | fidljust mad based »
he dnsiled Based o corvE e — Incremental LUSAS file output
Iterations per increment I4 = Same as previous lnadeags
Advanced! | Output file |1
Flat fils I'I
¥ Time domain
I Conszolidation - I Restart file ID
Initial time step 100 I ax number of saved restarts ID
Total response time: 1E7 Log file I'I
¥ &utomatic time stepping History file I'I
Advanced... |

— Commah to all

Idax time steps or increments IED
oK I Cancel Help

In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 100

e Select the Automatic time stepping option.

e Select the Advanced button in the Time domain section of the dialog.
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| File

Save

Running the Analysis

On the Advance time step parameters
dialog set the Time step increment
restriction factor to 2

Set the Minimum time step to 100
Set the Maximum time step to 1E7

Set the Minimum time step for
termination to 0

Click OK to return to the Nonlinear
and Transient control dialog.

On the Nonlinear and Transient
control dialog set Max time steps or
increments to 50

Click OK to set the loadcase control.

Saving the model

El Save the model file.

Running the Analysis

A

If the analysis is successful...

Advanced Time Step Parameters
Time step scale safety factor 0.9
Time step increment restriction factor IZ—
Minimum time step 100
Maximum time step I].E?—
Minimum time step for termination ID—
Termination value IT
Expoment: For increasing time. step (CEE-FIFT I.H—
Integration factor alpha IT
Integration factor beta IID—
Integration factor gamma I 0.5
[~ Allow step reductions
Maximum step reductions IS—
Cancel | Help |

Analysis loadcase results are added to the (2 Treeview.

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U pwp.out this output file contains details of model data, assigned attributes

and selected statistics of the analysis.

U pwp.mys this is the LUSAS results file which is loaded automatically into
the Treeview to allow results processing to take place.
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| File

New...

| File
Script >
Run Script...

2D Consolidation under a Strip Footing

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O pwp_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as pwp

e To recreate the model, select the file pwp_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Loadcase results can be seen in the ¢! Treeview and results for the first time step are
set active by default.

o If present, turn off the Geometry, Mesh and Attributes layers in the [l Treeview.

Settlement

e Click the Deformations button in the Treeview and select the Specify factor
option. Specify a factor of 1 and click OK to visualise the deformed mesh for the
first time step.

P
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| utilities

Graph Wizard...

Viewing the Results

A graph of the deformation over time will be created using the graph wizard.
e Zoom into the left-hand side of the Select this node

model and select the node on the

centre line at the centre of the

oy S

e With the Time history option ]
selected click Next

Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next

¥

e Select Response Time from the
drop down list and click Next

Secondly define the data for the Y axis.
e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specified single node drop down list.
Click Next

For the X Scale enter Manual values of minimum 100 and maximum 10e6
respectively.

e Select the Use logarithmic scale option.
e Title the graph as Settlement under centre of footing

e Click Finish to display the graph of settlement over time under the centre of the
strip footing.
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Consalidation under a strip footing

oettlement under centre of footing

-0.45
0.5

085 [
0B i
-0.65

PR . S T R P,

Disp ¥ Made 18(16)

Response Time(15)
#-Disp ¥ Mode 18(16) / Response Time(13)

E Close the graph window
Maximise the graphics window.

Pore water pressure

The distribution of pore pressure is to be shown using contours.

e With no features selected click the right-hand mouse button in a blank part of the
graphics area and select Contours to add the contours layer to the = Treeview.

e Select Displacement from the Entity drop down list and PRES from the component
drop down list.

e Select the Contour Range tab and set the Interval to 250

e Click the OK button to display contours of the undrained pore pressure distribution
(Time step 0) immediately after the loading is applied.
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| utilities

Graph Wizard...

Viewing the Results

Note. The dissipation of pore water pressure over time may be observed by creating
an animation of the contour display.

e To observe the distribution of pore water pressure at a particular time after the

application of loading activate the appropriate time step from the () Treeview by
selecting the time step with the right-hand mouse button and choosing the Set
Active option.

The dissipation of pore water pressure under the footing is to be presented on a graph.
o Select the node on the centreline under the footing as before.

o With the Time history option selected click Next

Firstly define the data to be used for the X axis

o Selected the Named option and click Next

e Select Response Time from the drop down list and click Next

Secondly define the data for the Y axis

e With the Nodal option selected and click Next

o Select Displacement from the Entity drop down list and PRES from the Component
drop down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next
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| utilities

Graph Wizard...

2D Consolidation under a Strip Footing

e For the X Scale
ensure that
Manual values of

Consalidation under a strip footing

Dissipation of pare water pressure

e For the Y Scale
leave the values as a0n
the defaults.

minimum 100 and 2500
maximum  10e6 '
respectively  are 4
used. 2000 i
§ '

e Select the Use = 1500 i
Logarithmic > :

le opti E :

scale option = 1000 3

e Title the graph as o
Dissipation  of =] = =] = ] S
— (] - - — -—
pore water - = =
pressure -
Fesponse TimeH)

e Click Finish to _
display the -Node 18(10) / Response Time(H)

dissipation of pore water pressure over time under the centre of the strip footing.

E Close the graph window.
Maximise the graphics window.

As the pore water dissipates the load is carried by the soil. The increase in effective
stress in soil can be observed on a graph of effective stress against response time.

e Ensure the node on the centreline under the footing still selected.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis

e Select the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis

e With the Nodal option selected and click Next

e Select Stress - Plane Strain from the Entity drop down list and SY from the
Component drop down list.
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Viewing the Results

e The extent to be Consolidation under a strip footing
graphed will be

set to Specified
single node and
the node selected
will be seen in the
Specify node
field. Click Next

Effective soil stress

-1000

-1500

e For the X Scale -2000

ensure that
Manual values of
minimum 100 and
maximum  10e6
respectively  are

used. 23500
=
e Select the Use =

Logarithmic
scale option.

FREYEIT
|
i
i
i

[NERLN
FRYEIT

L1 N

atress 3% Mode 18(14)

1000
10000
100000

Response Time(13)
o For the Y Scale  -#Stress S Mode 18(14) / Response Time(13)
leave the values as
the defaults.
o Title the graph as Effective soil stress

e Click Finish to display the graph of the effective soil stress over time under the
centre of the strip footing.

This completes the example.
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Description

Drained Nonlinear
Analysis of a
Retaining Wall

For software product(s): | Any Plus version.

With product option(s): | Nonlinear

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The behaviour of a single
propped retaining wall is to
be investigated in the long
term. Drained  soil
parameters are used
throughout.

Horizontal displacement is
restrained at the left and
right hand edge and both
horizontal and  vertical
displacement is restrained at
the base of the soil as the
soil rests on solid rock.

The wall is ‘wished-in-place’
in that construction of the
wall is not modelled.

Units of kN, m, t, s, C are
used throughout.

Original ground level
20m —»‘ l
Excavation
t015.26m

Wall 1m thick

101m
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Modelling

Drained Nonlinear Analysis of a Retaining Wall

Objectives
The required output from the analysis consists of:

U Displacement of the wall toe towards the excavation
O Surface heave immediately behind the wall

O Contours of plastic strain around the excavation

O Prop force per m length of wall

O Bending moment in the wall at 10m depth

Keywords

Retaining wall, Drained, Nonlinear, Excavation, Surface heave, Plane strain, Prop
force, Bending Moment

Associated Files

U drained_wall_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file.

Creating a new model

e Enter the File name as drained_wall.

e Use the Default working folder.

e Enter the title as Drained analysis of a propped retaining wall.

e Select model units of kN,m,t,s,C from the drop down list provided.
e Ensure the timescale units are Seconds

e Ensure the analysis type is Structural

e Set the startup template as None

e Select the Vertical Y axis option and click OK.

414



| Attributes

[Mesh

| Surface...

| Utilities

| Variation...

Modelling

Note. Save the model regularly as the example progresses. Use the undo command
to undo mistakes as far back as the last save.

Mesh Definition

The surfaces are to be meshed using plane-strain quadrilaterals with a quadratic
interpolation order (QPNS).

e Select the Plane Strain, Quadrilateral, Quadratic elements. Ensure the Regular
mesh option is selected with Automatic divisions so that Modeller uses the mesh
divisions assigned to each line.

e Give the attribute the name Plane Strain quads and click the OK button to add the
mesh attribute to the &% Treeview.

e Inthe & Treeview click on the mesh attribute Plane Strain quads with the right-
hand mouse button and select the Set Default option. This will ensure all newly
created surfaces will be assigned the elements defined in this mesh attribute.

General Field Variations

The Young’s Modulus of the soil and the in situ stresses vary with depth and therefore
general field variations are required.
e Select General Field Variation and press Next.

e Enter the function as -6000*Y and the attribute name as y_maod for the definition of

Young’s Modulus with depth and click Apply to add the attribute to the &
Treeview and keep the dialog active.

e Enter a new function as 20*Y and the attribute name as sig_v for the definition of
vertical stress and click Apply.

e Enter a new function as 2*20*Y and the attribute name as sig_h for the definition of
horizontal stress and click Finish.

Note. The LUSAS convention assumes that negative stresses are compressive. The
Y coordinate datum is at ground level and so increasing depth will lead to increasingly
negative Y coordinates. The variations as entered will ensure that stresses increase
negatively with depth while the Young’s Modulus increases positively with depth.

Feature Geometry
e Turn off the display of the Mesh layer in = Treeview.
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| Geometry
Line
Coordinates...

\%

| Geometry
Surface >
By Sweeping...

| Geometry

Surface >
By Sweeping...

| Geometry
Point >
Move...

Drained Nonlinear Analysis of a Retaining Wall

il Enter coordinates of (0, 0), (20, 0), (21, 0), (25, 0) and (101, 0) to define four lines
representing the original ground level (all Z coordinates should be zero or left blank).
Use the Tab key to move to the next entry field on the dialog. When all coordinates

have been entered click the OK button.

e Press CTRL-A to select all the Lines just drawn.

él Ensure the Translate option is selected and enter a value of —-1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Drag a box around these 4 Lines

e Select the bottom four horizontal Lines by dragging a box around them.

él Ensure the Translate option is selected and enter a value of —1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Repeat the preceding commands eight times, selecting the bottom four lines of the
model each time and sweep the lines by -2.0, -2.13, -2.13, -2.0, -2.0, -2.0, -2.49 and

-2.25 metres in Y as shown above.

Point B/\

EJ
Point A Q/}]

e Select Point A shown.

ﬂ Ensure the Translate option is selected and enter a value of =81 in Y.

¢ Click OK to move the Point.
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Modelling

e Select Point B shown.

|GeF?(;nin‘:"y S I Ensure the Translate option is selected and enter a value of -33.25in Y.
Move... . .
e Click OK to move the Point.
o Select the two Lines shown. i
| Geometry . —
Surface S ﬁl Ensure the Translate option is
By Sweeping... selected and enter a value of —81 in
Y.
Click OK to sweep the Lines to
create the Surfaces.
Select these 2 lines
e Select the Point shown. ]
|Ge;,’;:§"y S B ensure the Transtate option
Move... is selected and enter a value of 38
in X.

e Click OK to move the Point.

Select this point
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Drained Nonlinear Analysis of a Retaining Wall

e Select the two Points shown. b
Geomet . —
| eL?:;ery > il Create a Line between the
Paints... two selected Points.
Select these points
e Select the Line just drawn
along with the three Lines as e
shown.
Geomet
| eso:r}zcz S EI Create a Surface from the
Lines... four selected Lines.
I@ Select'these 4 lines
Mesh Grading
| Attributes e Define a Line mesh with element type None and 1 division.
Mesh >
lne.. e Enter the attribute name as Null 1 and click the Apply button to add the attribute to

the &% Treeview and keep the dialog active.
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Modelling

e Define a Line mesh with 5 divisions.

e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to 4
e Click OK to accept the spacing properties.

e Give the attribute name as Null 5 Graded and click Apply to add the attribute to
the &% Treeview and keep the dialog active.

e Define a Line mesh with 10 divisions.
e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to
0.2

e Click OK to accept the spacing properties.
e Give the attribute name as Null 10 Graded and click OK to add the attribute to the
c&; Treeview.

Assigning the mesh attributes

.
T

|
[l
OTntTan
!
|

TITTIR

I |

Lines to assign Null .dataset

N L
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Drained Nonlinear Analysis of a Retaining Wall

e Box-select the lines as shown and assign the mesh attribute Null 1.

Note. The selection of some of the sets of lines as shown in the next two images is
best done by changing the selection cursor and additionally using a special keyboard
shortcut which causes any lines passing through a box-selection to be selected.

To prepare for this:

M Change the cursor to the Select Lines cursor.

e Hold down the ALT key and ,
box-select each  set of ppr——1
horizontal lines as shown in the t t
preceding image and assign the : :
mesh attribute Null 5 Graded. i

Lines to assign Null 5.graded dataset
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Modelling

e Select the remaining lines as 1
shown and assign the mesh v poo=—---oooooooooo o ,
attribute Null 10 Graded. - .

Lines toj3

——

Go———————

Note. See the Keyboard Shortcut Guide for more details on the use of keyboard
/ shortcuts.

e Turn on the Mesh layer in the &
Treeview to see the mesh.

Note. If the mesh is graded with the smaller elements at the wrong end of a line

reverse the line by selecting the line using the Geometry>Line>Reverse menu
selection. If errors have been made in mesh assignments simply re-select any lines with
an incorrect mesh assignment and re-assign the correct line mesh.
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| Attributes
| Material >
Isotropic...

Drained Nonlinear Analysis of a Retaining Wall

Material Properties

An isotropic elastic material will be used for the retaining wall while an isotropic
nonlinear material utilising the Mohr-Coulomb failure surface will be used for the soil.

With the Elastic tab selected enter the isotropic material properties for the wall as
Young’s Modulus 28E6 kN/m? Poisson’s Ratio 0.15 and Mass Density 2.03874
tonne/m”.

e Enter the attribute name as Concrete Wall.

e Click the Apply button to add the attribute to the & Treeview and keep the dialog
active.

e With the Elastic tab selected enter the isotropic material properties for the soil as
Young’s Modulus 1*y mod, Poisson’s Ratio 0.2 and Mass Density 2.03874
tonne/m®.

Note. The 1*y mod indicates that the Young’s Modulus is defined by a variation
scaled by a factor of 1. As an alternative to typing in the formula, enter 1 in the grid
location and click on the 3 button. Select the y_mod variation from the drop down list.

e Click the Plastic option and from the Model drop-down list select the Mohr-
Coulomb (model 65) entry.

e Enter an Initial cohesion value of 0

e Enter an Initial friction angle value of 25

e Enter an Final friction angle value of 25

e Enter a Dilation angle value of 25

¢ In the tension section enter a Cohesion hardening value of 0

¢ In the tension section enter a Limiting plastic strain value of 1000

e Enter the attribute name as Nonlinear Soil

e Click the OK button to add the attribute to the c&n Treeview.
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Modelling

Using the following properties
[V Plastic I Creep

"Elastic FPlastic |

| Damage

™ shrinkage

™ viscous

I Two phase

Model IMohr -Coulomb {madel 55)

[~

Value

Initial cohesion

Initial friction angle

25

Final friction angle

25

Dilation angle

25

Tension

Cohesion

hardening|

Limiting
plastic
strain

1 0

1000

MName |Monlinear Soil

j ﬂ (new)

oK | Cancell

Nxvlvl

Help

Assigning material properties

To assign the material properties groups will be used. Groups are very useful in
allowing features of the model to be turned-on and off to aid the assignment of
attributes or the viewing of results on selected features of the model.

il Change the cursor back to the normal cursor.

e Select the ten surfaces that form the retaining wall as shown.
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| Geometry
Group >
New Group...
| Geometry
Grou >
New Group...
| Attributes
Support...

Drained Nonlinear Analysis of a Retaining Wall

Era-FET T
T

Surfaces to assign Cpncrete Wall materi

NOTE: Mesh not shown for clarity

Create a group containing the wall elements only and rename it Wall. Click OK.

e With the ten surfaces of the wall still selected drag and drop the material attribute

Concrete Wall from the &b Treeview onto the selection. With the Assign to
surfaces option selected click OK to assign the material attribute.

e Inthe L=l Treeview right-click on the Wall group and select Invisible.

e Select the whole visible model by pressing the Ctrl-A keys.

Create a group containing the soil elements only and rename it Soil. Click OK.

e Drag and drop the material attribute Nonlinear Soil from the & Treeview onto the
selection. With the Assign to surfaces option selected click OK to assign the
material attribute.

e Inthe L=l Treeview right-click on the Wall group and select Visible.

Supports

Define supports to prescribe zero horizontal displacement as well as zero horizontal and
vertical displacement.

e Click on the option to fix the Translation in X.
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Modelling

e Enter the attribute name as Fixed in X and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

e Click on the option to fix the Translation in Y.

e Enter the attribute name as Fixed in X and Y and click the OK button to add the
attribute to the & Treeview.

Assign the supports to the model.

Select the vertical Lines on the left-hand side and right-hand side of the model and drag

and drop the support attribute Fixed in X from the & Treeview onto the selection.
With the Assign to lines option selected click OK to assign the support attribute to All
loadcases.

e Select the 3 horizontal Lines representing the bottom limit of the soil and drag and

drop the support attribute Fixed in X and Y from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support
attribute to All analysis loadcases.

e Select the Point which
represents the top-left
corner of the concrete
wall as shown and
drag and drop the
support attribute Fixed
in X from the &
Treeview onto the
selection.  With the
Assign  to  Points
option selected click —. \ \_,
OK to assign the
support attribute to All. ™ \
analysis  loadcases. "
This support ] \

represents the prop. ] \ —

elect this Point

|1
/e

/
|

T 1
Loading

The initial in situ ground conditions must be established in the first loadcase of the
analysis. This is carried out using a stress and strain type load and a gravity (body
force) load.
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| Attributes
| Loading...

| Attributes
| Loading...

Drained Nonlinear Analysis of a Retaining Wall

e Select the Stress and Strain option and click Next

e On the Stress and
Strain dialog ensure ~Usage —
the Stress And Strain @ Element dsscription — Teh
Type is set to Initial [ @) (L (o Eee (b giy 1*3i09—v
e Select a Surface [ ekt = et
element description [Prane stan =i B
|3 dimensional j Ez

e Select Plane strain
from the drop down
list r—

o Enter 1%sig_h for Sx. | [ o
(This can be done  Residual (4L only]
most easily by clicking

€ Element name

in the rlght-hgnd side e [ st e ==
of the Sx field and
selecting the variation _

< Back | = | Finizh | Cancel | Apply | Help |

attribute  from  the
drop-down list)

e Enter 1*sig_v for Sy.

e Enter O for Sxy

e Enter 1*sig_h for Sz. The remaining fields may be left blank (to signify zero)
e Enter the attribute name as In situ stress and click Finish.

e Select the Body force tab from the Structural Loading dialog and click Next
e Enter -9.81 in Linear acceleration in Y Dir.

e Enter the attribute name as Gravity and click Finish.

Assign the loads to the model.

The in-situ stress is to be assigned to the whole model.

e Select the whole model by pressing Ctrl-A and drag and drop the loading attribute

In situ stress from the Treeview onto the selection. With the Assign to
Surfaces option selected rename the loading attribute to Loadcase 1 and click OK.

Gravity is assigned to the whole model
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Modelling

e With the whole model selected drag and drop the loading attribute Gravity from the

&b Treeview onto the selection. With the Assign to Surfaces option selected click
OK to assign the loading attribute to Loadcase 1

e Inthe = Treeview drag and drop the Geometry layer name beneath the Attributes
layer name.

Birth and Death

The Birth and Death feature must be used to simulate the removal of soil during
excavation in front of the wall. Excavation will take place over eight loadcases.

| Attributes e Select the Deactivate tab and click Next. Select Percentage to Redistribute and
|Birth and Death... ensure the value is set to 100%. Enter the attribute name as Excavation.

¢ Click Finish to add the attribute to the c&: Treeview.
Assign the deactivation to the model.

e Use the zoom-in button to enlarge the view of the 4
top-left corner of the model.

e Select the top surface representing the first layer
of soil to be removed in front of the retaining wall
and drag and drop the deactivation attribute
Excavation from the 63; Treeview onto the
selection. With the Assign to surfaces option e
selected enter the Loadcase name as Excavation
to —1.50m and click OK to assign the attribute.

e Select the next surface down in front of the wall and drag and drop the deactivation
attribute Excavation from the & Treeview onto the selection. With the Assign to
surfaces option selected enter the Loadcase name as Excavation to —3.00m and
click OK to assign the attribute.

e Repeat this procedure, selecting the next surface down each time and renaming the
loadcases Excavation to —5.00m, Excavation to —7.13m, Excavation to —9.26m,
Excavation to —-11.26m, Excavation to -13.26m and Excavation to —15.26m
respectively. The adjacent image shows the final excavation assignment made.

Note. Deactivated surfaces (and hence elements) can be visualised and checked by
/ setting each loadcase active in the (X! Treeview.
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| File

Drained Nonlinear Analysis of a Retaining Wall

| Save

Analysis Control

The use of a Mohr-Coulomb nonlinear material in this example dictates that a nonlinear
analysis control must be specified.

e Inthe (& Treeview right-click on Loadcase 1 and rename it to In situ

o In the 2 Treeview right-click on In situ and select Nonlinear & Transient from
the Controls menu.

In the Incrementation

Sectlon r~Incrementation ~ Solution strategy
¥ Morlinzar I Sameias previcus lnadcase
- Incrementation lm tar number of iterations ISD—
Se I eCt the N on I Inear Starting load factar IW Residual foree norm 0.0l
Optlon A and C_hoose tdax change in load factor IU Incremental displacement norm lnm—
Manual incrementation. Mas total load factor [ Advanced.. |
) ¥ | £:citist [oed|bases onconvergense histon
|ﬂ the SO|UtI0n Strategy Iterations per increment |4 - Incremental LUISAS file output
SeCtIOH Options... Sdvanced)., I= | Same as previousInadbase
Output file: 1
e Set the Max number [Trema <] Pitfie I
of iterations to 50. Ll [ Festat s E—
Total responge time IW
- . : tax number of saved restaits |0
] Set the Resldual force J2 | sitomatic b stemping talt l—
Log fil 1
norm to 0.01. e - —
I ax time steps of increments IU i
e Set the Incremental
. QK I C. 1 Hel
displacement norm to ad | |

0.01.

e Click OK to set the loadcase control.

Saving the model

El Save the model file.

Running the Analysis

El Open the Solve Now dialog. Press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.
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| File
[New...
| File
| Script >
| Run Script...

Viewing the Results

If the analysis is successful...
Analysis loadcase results are added to the (5 Treeview

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U drained_wall.out this output file contains details of model data, assigned

attributes and selected statistics of the analysis.

U drained_wall.mys this is the LUSAS results file which is loaded
automatically into the Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. A common mistake made when using LUSAS Modeller for the first
time is to forget to assign particular attribute data (geometry, mesh, supports, loading
etc.) to the model. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If errors are listed that for some reason cannot be corrected, a file is provided to re-
create the model information correctly, allowing a subsequent analysis to be run
successfully.

U drained_wall_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as drained_wall

To recreate the model, select the file drained_wall_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results

Viewing the Results

Loadcase results can be seen in the @ Treeview, and the load case results for the first
time step (increment 1) are set active by default.
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Drained Nonlinear Analysis of a Retaining Wall

o |If present, turn off the Geometry, Mesh, Utilities and Attributes in the it
Treeview.
Wall Displacement

o In the (& Treeview right-click on the results for Excavation to —13.26m and Set
Active.

o If not already on, add the Deformed mesh to add the deformed mesh layer to the
Treeview.

o Press the Deformations... button in the Treeview, select the Specify factor
option and specify a factor of 5. Press OK to return.

o Double click the View properties control in the Treeview. On the Mesh tab
ensure the option to Show activated only is selected. Click OK to visualise the
deformed mesh for the active elements at increment 8, magnified by a factor of 5.

.

AT

|
RN

[
f"il
/

A graph of the deformation of the wall toe will be created using the graph wizard.

e Zoom into the top left-hand side of the model and select the node at the wall toe.
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| utilities

Graph Wizard...

Viewing the Results

e With the Time history option
selected click Next.

Y] Select this node

Firstly define the data to be used for
the X axis.

e Selected the Named option and

click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DX from the Component

drop down list.

e The selected node number will appear in the Specify node drop down list. Click

Next.

e Enter suitable text for the graph titles and click Finish to display the graph of

displacement of the wall toe towards the excavation.

02 Horizontal displacement of wall toe

0.15

=
i

0.05

placerment

o

&=-0.05

Dig

— 1 = WD Lo D
— ] o - L

Loadcase D
—#—Displacement X Node 460(8) / Loadcase D7)

o E Close the graph window.
. Maximise the graphics window.
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Graph Wizard...

Drained Nonlinear Analysis of a Retaining Wall

Surface Heave
e Select the node at the top of the back of the wall.

e With the Time history option .
selected click Next. L

Firstly define the data to be used for
the X axis.

e Selected the Named option and  Select this node
click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Surface heave behind wall
0.08 —

007 [
0.06 [---i-
0.05
0.04
008 [

Displacement

0.0z
0.01

0.01

F-J) D .
-7 R SR A

w0

(]
Loadcase ID

—#—Displacement ¥ Mode 750{10) / Loadcase ID(9)

. E Close the graph window then =J01X] maximise the graphics window.
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Viewing the Results

Plotting contours of plastic strain in the soil

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be selected.

In the Treeview right-click on the group name Soil and select Show Results >
Show Results Only On This Group

With no features selected click the right-hand mouse button in a blank part of the
graphics window and select Contours to add the contours layer to the 5= Treeview.

Select Plastic strain — Plane strain from the Entity drop down list and EPE from
the component drop down list.

Select the Contour Range tab and set the Maximum to 0.01 (1% strain).

Click the OK button to display contours of the plastic strain distribution around the
wall.

Loadcase: §:Excavation to -13.26
Ertity: Plastic strain - Plane Strain
Component: EPE Eteee

oo
1.25E-3
25E-3

3.75E-3
5.0E-3
B.25E-3
78E-3
d.73E-3
0.0t

4

Maximum 0.375332 at node 301
Minimum 0.0 at node 2

Prop Force

Turn off the display of the Deformed Mesh and Contours layers in the
Treeview.

Turn on the display of the Mesh layer in the = Treeview.

In the L=l Treeview right-click on the group name Wall and select Show Results >
Show Results Only On This Group

Right-click on the group Wall in the L2l Treeview and select Set as Only Visible.
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Drained Nonlinear Analysis of a Retaining Wall

e Select the node at the top-left of the wall

that is supported by the prop in the X T

direction.
| utilities e With the Time history option selected click
Graph Wizard... Next.

Firstly define the data to be used for the X axis.

Select this node

e Selected the Named option and click Next.

e Select Loadcase ID from the drop down list
and click Next.

Secondly define the data for the Y axis.

e With the Nodal option selected and click Next.

e Select Reaction from the Entity drop down list and RSLT from the Component

drop down list.

e The selected node number will appear in the Specify node drop down list. Click

Next.
e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.
Prop force
1200

I

Resultant Reaction

=+

Loadcase ID{11)
—#—Resultant Reaction Node 1{12) / Loadcase [D(11)

Note. The resultant reaction has been graphed in the above figure. Since the wall is
/ propped only in the horizontal (X) direction at this location (see Supports section) there
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| Utiities

Viewing the Results

| Graph Through 2D...

is no reaction in the vertical direction and therefore the resultant reaction is identical to
the horizontal reaction.

. E Close the graph window.
. Maximise the graphics window.

Bending moment in the wall at 10m Depth

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be chosen.

e Turn off the Deformed mesh layers in the Treeview, and restore the Geometry
layer by right-hand clicking on a blank area of the model view and selecting
Geometry.

e Ensure the Snap to grid option is selected and enter a value of 1 for Grid size.
e Click on OK.

e Draw a line with the mouse through the wall at 10m depth as shown.

e Select Resultant effects from 2D model and select Bending stress in the list and
click Next.
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Slice Data E
' Results companent
Entity lm
[(IMean axial stress ;I
Companent 'l ¥ Bending stress
Transt " [CJactual axial stress
4|_rans SR [C1Mean shear stress
[Clactual shear stress
Srgles.. |
[
< Back I Hext > I Cancel | Help |

e Enter suitable text for the graph titles and click Finish. A graph is drawn and the
bending moment (and other information) is displayed in the Text output pane.

*#%#% ) Forcesz-Homent=s. Loadcase
Axial Force Per Unit Width
Shear Force Per Unit Width
Homent Per Unit Width

Section Depth

Hean Hormal Stress Sz

Hominal Bending Stres=s

.. .done

<]

2 Result=s File 1]
-51.20
—-148 .6
4280 .
1.000
-51.20
0.2568E+05

The bending moment reported is 4280 kN/m? per metre run of the wall.

This completes the example.
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Description

Embedded
Retaining Wall

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.
With product option(s): | Nonlinear.

Description

An embedded retaining wall is Surcharge, g=10kN/m 2
required to retain 6.5m of loose sand
along with an additional surcharge of

- A A A A A A
10kN/m% A 2D analysis is to be 2;
carried out with the soil represented ~=m Loose sand
b .. presen Prop 4 ) y=12kN/m 3
y Tri-linear earth pressure joint gg, force Kam0.20
material for both an unpropped and a Ko=0.65
propped wall condition. Kp=2.75

The units of the analysis are kN, m, t,
s, C throughout.

Objectives

O To calculate bending
moment and shear forces in
the embedded wall and
ensure that deflections are
within serviceable limits.

U To investigate the effects of
installing a prop and
reducing the pile length.

Keywords

Embedded, Retaining, Wall, Trilinear Earth Pressures, Modulus of Subgrade Reaction,
Soil-Structure Interaction, Geotechnics
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Modelling

| Geometry

Point >
Coordinates...

Embedded Retaining Wall

Associated Files

U embedded_wall_modelling.vbs carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model
e Enter the file name as Embedded Wall

e Use the Default working folder.
e Enter the title as Embedded Retaining Wall Example
e Select units of kN,m,t,s,C

e Ensure that the Timescale units are Seconds, the Analysis type is Structural and
the Startup template is set to None

e Choose Y as the vertical axis and click the OK button.
Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Wall Geometry

Enter coordinate (0, 0, 0) to define ground level and the top point of the wall. Click
the OK button to create a single point at the origin.

e Select the newly created Point.
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| Geometry
Surface >
Sweep...
| Geometry
Surface >
Sweep. ..
| Geometry
Surface >
Sweep...
| Geometry
Line >
Copy...
| Geometry
Line
Copy...
| Geometry
Line
Delete...

Modelling

ﬂl Sweep the selected point with a Y translation of -2.5 and click
the OK button to create the new Line.

e Select the newly created lower point

ﬂl Sweep the selected point with a Y translation of -4.0 and click
the OK button to define the new Line.

e Select the newly created bottom point

ﬁl Sweep the selected point with a Y translation of -20.0 then click
the OK button to define the new Line.

Note. Separate lines must be used to represent each change of soil
type.

Defining the Earth Geometry

The earth pressure acting on the wall is modelled using joint
elements connected between the wall itself and fixed supports.
Additional lines are required to assign the fixed sides of the joint
elements to.

Note. Joint elements should normally have a zero length,
however to reduced confusion from overlapping features during
definition they are usually initially located with a gap that is later
closed once the model has been setup.

e Select all lines and points (Ctrl + A)

ﬂ Copy all the geometry by 3.0 in the X direction and click
OK to define the retained soil.

e With the wall structure still selected:

ﬂ Copy all the geometry by -3.0 in the X direction and click
OK to define the retained soil.

E Select the upper two lines of the excavated side and delete them.
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| File
|Save

| Attributes
| Local Coordinates...

| Attributes
|Mesh >
Line...

Embedded Retaining Wall

The geometry is now complete. The central series of lines model the wall. The lines to
either side are used to model the soil. A load to model the propping force applied to the
upper part of the wall will be added to the model later in the example.

El Save the model file.

Meshing

Note. Due to the underlying implementation of the Tri-linear earth pressure material,
the joint elements that the soil material will be assigned to must be orientated in a
specific way. For both 2D and 3D joint elements the joint element local x axis must
align with the horizontal and connect the support to the structure. For 2D joint elements
local y axis must be aligned to the model vertical axis and for 3D joint elements the
local z must be aligned to the model vertical axis. The model vertical axis is defined in
the new model dialog and can be accessed subsequently by the Utilities > Vertical Axis
menu item.

Defining local coordinate systems

To ensure the joint elements are orientated correctly two local coordinate systems are
needed: one in the direction of the main model X axis, and one in an opposing
direction.

e Create a local Cartesian coordinate system rotated O .
degrees about the Z-axis with an Origin of (-3,0,0), enter b “1
the dataset name as Excavated and click Apply T< < ,

e Create a second local Cartesian coordinate system rotated
180 degrees about the Z-axis with an Origin of (3,0,0),
enter the dataset name as Retained and click OK

Defining element types

The joint elements are required to have displacements in the u
and v directions to represent horizontal and vertical pressures.
For this 2D problem the JNT3 element with only translational
freedoms is sufficient.

e Select the element type as Joint no rotational stiffness,
the number of dimensions as 2 dimensional and the
interpolation order as Linear. Select an Element length of
1.0. Enter the dataset name as Soil Mesh and click the OK
button.

The wall requires thick beam elements:
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Modelling

| Attributes e Select the element type as Thick beam, the number of dimensions as 2 dimensional
MT_?“ > and the interpolation order as Linear. Select an Element length of 1.0. Enter the
Ine...

dataset name as Thick Beam and click the OK button.

Assigning the elements

The wall is meshed first, and the joint elements are then assigned between the lines
representing the soil and the wall.

e Select the three central lines representing the wall and drag the dataset Thick Beam

the & Treeview onto the model.

e Select the left-hand line representing the excavated earth and
then, at the same time, also select the corresponding adjacent

line of the wall. Drag the dataset Soil Mesh from the
Treeview onto the model. In the Line Mesh Assignment dialog,
select Excavated from the specified local coordinates list and
ensure Mesh from master to slave is selected. Click OK to
complete the assignment

-

To assign the mesh for the retained side:

e Select the three central lines representing the wall.

Note. To make joint mesh assignments to sets of multiple lines the
/ selection memory must be used:

| Edit Add the lines to the selection memory.
Selection Memory >
| Set e Select the three lines on the far right representing the retained

soil. Drag the dataset Soil Mesh from the & Treeview onto the
model. In the Line Mesh Assignment dialog, select Retained
from the specified local coordinates list and ensure Mesh from
master to slave is selected. Click OK to complete the

Ty, A

assignment
| Edit This clears the selection memory.
Selection Memory >
Clear

Mesh layer properties (double-click the Mesh layer name in the Treeview) and selecting

Note. If necessary the joint element axes can be visualised and checked by editing the
Show element axes.
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| utilities
Section Property
Calculator >
Rectangular
Sections >
Solid...
| Attributes
Geometric >

Section Library...

| Attributes
Material >
Material Library...
| Attributes
Material >
Joint...

Embedded Retaining Wall

Geometric Properties

Geometric properties are visualised by default.

ll Select the fleshing on/off button to turn-off the geometric
visualisation.

Enter a depth D of 0.5 and a breadth B of 1.0. Enter a dataset
name of Wall, ensure Add to local library is selected and k
click the OK button.

In the Geometric Line dialog select 2D Thick Beam for the
usage, select User Sections in the top right list and dataset
Wall from the available Local sections. Enter the dataset Wall
1m run and click OK to create the geometric attribute.

Select the three lines representing the wall and drag the

geometric attribute Wall 1m run from the &b Treeview onto
the model.

In the Treeview re-order the layers so that the Attributes
layer is at the top of the Treeview, followed by the Mesh layer,
followed by Geometry layer.

Material Properties

Select material Concrete EU from the from drop-down list, select grade EN1992-1-

1 Table 3.1 fck=40MPa and click OK to add the material dataset to the c&n
Treeview.

Select the three lines representing the wall and drag and drop the geometry attribute

Isol (EN1992-1-1 Table 3.1 fck=40MPa) from the & Treeview onto the selected
lines.

In the Joint Material dialog select Trilinear Earth Pressure and select Next. Three
earth pressure material attributes are required: one for the Loose Sand, and two for
the Dense Sandy Clay (where one is for the retained side and one is for the
excavated side). All materials are to be defined for use with Two dimensional joint
elements with the defining geometry being Lines.
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Modelling

To create the Loose Sand material, enter the following properties:

Datum used for the calculation of effective overburden pressure | Zo 0.0
Surcharge (vertical load per unit area) q 10.0
Unit weight of soil Y 12.0
Angle of shearing resistance between soil and structure () 0.0
Coefficient of passive earth pressure Kp 2.75
Coefficient of passive earth pressure due to cohesion Kpc |0.0
Cohesion c' 0.0
Coefficient of at-rest earth pressure Ko 0.65
Coefficient of passive earth pressure due to cohesion Ka 0.20
Coefficient of active earth pressure due to cohesion Kac 0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0

Observing the local coordinate system established for the retained side, select
Active pressures to define just what the positive displacement of the local x axis
mobilises (i.e towards the wall) and Matches gravity (points down) to define just

what the positive direction of the local y axis represents.

Deselect Consider angle of structure, enter a dataset name of Loose Sand

Retained and click Apply to create the attribute.

Then, change the parameters to the following:

Datum used for the calculation of effective overburden pressure | Zo -6.5
Surcharge (vertical load per unit area) q 88.0
Unit weight of soil v 17.0
Angle of shearing resistance between soil and structure (3 0.0
Coefficient of passive earth pressure Kp 3.0
Coefficient of passive earth pressure due to cohesion Kpc ]0.0
Cohesion c' 0.0
Coefficient of at-rest earth pressure Ko 0.5
Coefficient of passive earth pressure due to cohesion Ka 0.33
Coefficient of active earth pressure due to cohesion Kac |0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0
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Embedded Retaining Wall

e Enter a dataset name of Dense Sand Retained and click Apply to create the
attribute.

Finally, change the Surcharge value to 0.0 and, observing the local coordinate system
established for the excavated side, ensure Active pressures is set to define just what the
positive displacement of the local x axis mobilises and select Opposes gravity (points
up) to define just what the positive direction of the local y axis represents. Leave any
other settings unchanged. Change the dataset name to Dense Sand Excavated and click
Finish to create the final soil material attribute.

Note. When creating soil layers, if a different soil weight is used for each layer the
overburden pressure from any soil layers above must be calculated manually and
entered as a surcharge. Where all layers have the same unit weight the datum for each
layer can be the same (i.e ground level) remembering that any additional surcharge (q)
at ground level needs to be included in the definition of all lower layers. In this example
the dense sandy clay on the retained side was given a surcharge of 88kN/m2. This was
calculated from the depth of sand above plus the applied surcharge such that g = 6.5x12
+10=288

e Select the upper two lines representing the loose sand on the retained side of the
wall (not the wall itself) and drag the material attribute Loose Sand Retained from

the e?b Treeview onto the model.

e Select the bottom line representing the dense sand on the retained side of the wall

and drag the material attribute Dense Sand Retained from the &b Treeview onto
the model.

e Select the line representing the dense sand on the excavated side of the wall and

drag the material attribute Dense Sand Excavated from the &% Treeview onto the
model.

Note. Earth pressure joint material attributes are held in the & Treeview. Context
menu entries named Edit Definition... and Edit Attribute... can also be seen by right
clicking on an attribute.

Note. Selecting the Edit Definition... menu entry or double clicking the attribute name
displays the original definition dialog with all the original input data for viewing or
editing.

Note. Selecting the Edit Attribute... menu entry displays the joint type and stored
piecewise linear joint material values that are used to define the earth pressure joint
material. These values may be changed but the link to the original definition dialog will
be broken.
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| Attributes

| Support...

| Attributes

| Support...

| File

|Save

Modelling

Supports

'y
For the wall it is assumed that a supported end condition exists. T—»

e Select a Fixed translation for the Y axis, enter a dataset name of
Fixed in Y and click OK to create the attribute.

e Select the point representing the bottom of the wall then drag the

support attribute Fixed Y from the the & Treeview onto the
model.

The Trilinear earth pressure material generates forces in the joint
elements appropriate to the position (depth) of the joint element in
the model. These forces must be resisted by supporting the free end
of the joint elements.

e Select Fixed translations for the X, Y and Z axes, enter a dataset
name of Fixed and click OK to create the attribute.

e Select the lines representing the excavated and retained soils and

drag the support attribute Fixed from the &b Treeview onto the
model. Accept the defaults in the assignment dialog.

Setting the Analysis

The Trilinear earth pressure material is a nonlinear material and therefore a nonlinear
analysis is required.

e In the Analyses (L) Treeview, right click on Loadcase 1. From the Context menu
select Controls > Nonlinear and Transient

¢ In the Nonlinear & Transient dialog check the Nonlinear check box and select the
OK button to return to the model.

Saving the model

El Save the model file.

Caution. For ease of definition the joint elements used have been inserted into the
model a set distance away from where they will be acting and, as a result, they have a
non-zero length. Prior to an analysis taking place, the lines and points representing the
soil should normally be set to be unmergeable prior to being moved to overlay the line
representing the wall. For some modelling situations the use of joint elements with a
non-zero length will produce unreliable results, and in general joint elements should
always be modelled with a zero-length. For clarity in this example merging has been
omitted, as there is no significant difference in the results obtained.
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Embedded Retaining Wall

To model joints with zero-length

To correctly model the soil joints the joint elements would normally be modelled with
zero-length. For this example this would be done as follows:

o Select the lines on either side of the wall that represent the soil.
e Select Geometry > Line> Make unmergable

o Select Geometry > Point> Make unmergable (because making a line unmergable
does not make the points defining it unmergable too.)

o Select the left-hand line representing the soil and select Geometry > Point> Make
unmergable and move the line 3 metres in the X direction

o Select the right-hand lines representing the soil and select Geometry > Point>
Make unmergable and move the line -3 metres in the X direction

o Save the model with an appropriate filename.

Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Note. For this analysis the use of non-coincident joints (i.e. omitting the merge step)
and linear beam elements within a nonlinear analysis will cause warnings to be written
to the text output window. These warnings can be ignored.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview

In addition, 2 files will be created in the Associated Model Data where the model file
resides:

U Retaining Wall~Analysis 1.out this output file contains details of model
data, assigned attributes and selected statistics of the analysis.

U Retaining Wall~Analysis 1.mys this is the LUSAS results file which is

loaded automatically into the () Treeview to allow results processing to take
place.
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| File
[New...
| File
| Script >
| Run Script...

Viewing the Results

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

0 embedded_wall _modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Embedded Wall

e To recreate the model, select the file embedded_wall_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the @ Treeview.

A Deformed mesh layer will be added to the Layers [=* Treeview.

e Double-click on the the Deformed WEEES
Mesh layer in the 5 Treeview and in  omer ™ |wsseel
the Mesh tab set the pen to be blue ¥ wirsfrome  pen# [3 =] [EEE] Chasse pen... |

™ salid . Macximum shade IEU-U %
° i i ™ Hidden parts | Dotted
Turn Othe Dlagrams Iayer In the ™ show nodes I outline only Thrashnld|25-0 %
Layers Treeview. In the Diagrams
Propertles dlalog Set the Entlty to % of elements remaining | 100.C
Force/Moment — Thick 2D Beam and colowrby [eshcor =] oot |
the Component to Mz

Close | Carncel | Apply: | Help I

e In the Layers Treeview, tick
Window Summary.
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| File
| Save

| Attributes
| Loading...

| Analyses
| Loadicase...

Embedded Retaining Wall

A maximum Bending Moment of 342kNm is seen to occur in the retaining wall.

Double click the Diagrams item in the Layers [=F Treeview. In the Diagrams Properties
dialog set the Entity to Force/Moment — Thick 2D Beam and the Component to Fy

A maximum Shear Force of 78kN is seen to occur in the retaining wall.

El Save the model file.

Turn on the Values layer in the Layers Treeview. In A

the Values Properties dialog set the Entity to 4\@
Displacement and the Component to DX | 9

On the Values Display tab check Show values of
Selection, check the Deform option, set a font Angle of
45°, click the choose font button and select a font size of
16, click the OK button to return to the Properties dialog
and click the OK button again to return to the model.

Select the top-most node of the deformed mesh to display
the maximum deflection. A maximum deflection of
100mm is seen to occur.
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In the Layers Treeview turn-off the display of the .
Diagrams, Values and Deformed mesh layers. *
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Loadcase 2: Adding a propping force

For this example the previously calculated deflection of the wall has been considered to
be too large and the wall is to be propped at a depth of 2.5m from the top of the wall.
The propping force will be modelled using a concentrated load that will be increased
incrementally to calculate the propping force required to reduce the deflection to
30mm. The calculated propping force can them be used to design the anchoring system.

Select Concentrated and click Next

Enter a value of 10 in the X direction, enter a dataset name of Prop Force and
click the Finish button to create the attribute

Click OK to create a second loadcase with the default name Loadcase 2
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Viewing the Results

Select the prop point on the wall at (0,-2.5). Drag and drop

the loading dataset Prop Force from the &b Treeview onto
the model »

In the Loading Assignment dialog select Single loadcase,
select Loadcase 2 from the Loadcase list and ensure that »
Set as active loadcase is checked. >

Click the OK button to make the assignment

In the Analyses C Treeview, right click on loadcase 2.
From the Context menu select Controls > Nonlinear and
Transient

In the Nonlinear & Transient dialog check the Nonlinear check box and select
Automatic Incrementation.

Set the Starting load factor to 1.0, set the Max change in load factor to 1.0 and
the Max total load factor to 10.0

Click the OK Button to make the changes and return to the model.

El Select the Solve Now button from the toolbar and click OK to run the analysis.

Designing the wall

In the Layers Treeview turn-on the display of the Diagrams, Values and
Deformed mesh layers.

With the top node of the wall selected (and the values still set to display the
horizontal displacement), set each of the load increments (load factors) of Loadcase
2 active in turn to investigate the effect of applying different prop forces to the top
of the wall. From this examination it can be seen that a 30mm top of wall
displacement is achieved at Increment 6. This increment has a load factor of 5.0
leading to a required propping force of 5x10 = 50kN.

Double click the Diagrams layer in the Layers Treeview. In the Diagrams
Properties dialog set the Entity to Force/Moment — Thick 2D Beam and the
Component to Mz
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| Geometry

| Point

| Move...

| File

| Save

Embedded Retaining Wall

The moments in the wall can now be seen to be significantly
reduced, with the maximum being 78kNm

Note. This example shows a prop force applied externally to the
wall. If a soil anchoring system were to be used to provide the
restraint, a different modelling approach would be necessary. In
addition, the propping force required to reduce the wall
deflections may not be achievable in practice due to the soil type.
In this case the design may require some iteration and re-running
of the analysis to achieve acceptable forces, moments and
deflections.

Once suitable deflections and design forces have been established
the required length of pile can be determined by reducing the
embedded length and ensuring the effect on the required
deflection is acceptable.

An initial estimate of the reduction can be sought by considering
where wall forces become negligible. To do this a diagram of
Shear force in the wall is to be plotted.

e In the Diagrams Properties dialog set the Entity to
Force/Moment — Thick 2D Beam and the Component to Fy

By inspection the shear within the wall for the bottom 5m length
is negligible and can be removed.

ﬂ Select the bottom three points of the model and enter 5 in Y translation. Click OK

to reduce the wall depth.

El Save the model file with a different name if desired.

El Select the Solve Now button from the toolbar and click OK to re-run the analysis.

With the top node of the wall selected and the values set to display the displacement, set
each of the load increments (load factors) of Loadcase 2 active in turn to investigate the
effect of applying different prop forces to the top of the wall. From this examination it
can be seen that a 30mm top of wall displacement is still achieved at Increment 6 so
the reduction in length has not altered the top of wall displacement. Maximum bending
moment in the wall is similarly unaltered. Further reduction in embedded length maybe

possible by repeating the previous steps and ensuring deflections remain suitable.

This concludes the example.
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Description

Trapezoidal earth
dam with drainage

toe

For software product(s):

Any Plus version

With product option(s):

Nonlinear, Dynamic, Thermal, Heat of hydration

Description

This example illustrates water seepage through a trapezoidal earth dam to drain in the
granular filter in the downstream toe. The flow unconfined, with the dam built on an

impermeable foundation.

On the upstream side, the water is at the reservoir level of 12m which results in
equipotential line along AB with maximum head of 12m. The filter drain on the
downstream side is considered fully effective.

The modelling units used are N, m, kg, s, C throughout.

Partially Saturated Sand

SIS SA ]
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Trapezoidal earth dam with drainage toe

Objectives

The required output from the analysis consists of;
U The calculation of steady-state seepage flow through the body of the dam.
U Contours of pore water pressures.
[

Keywords

Pore Pressure, Two Phase Material, Consolidation, Geostatic step, Transient,
Seepage

Associated Files

H U earth_dam_modelling.vbs carries out the modelling of the example.
i

Discussion

Not all the flow networks of an earth dam are known from the beginning. The free flow
surface, or top flow line (where the pressure is atmospheric), can only be approximated
when using hand methods. The upper most flow line inside an earth dam follows a
parabolic path, which is corrected to be tangential to the upstream slope and discharge
surface, as well as at different material boundaries. Earth dams almost always include
drainage filters (having a large value of permeability) positioned in the downstream
slope to keep seepage entirely within the dam, and prevent erosion of the downstream
surface.

There are two basic assumptions in such analyses:

a) Between two consecutive points of equipotential lines in contact with the free
surface there is a constant piezometric difference

b) At the point that the flow from the upstream side to the downstream side begins,
the upper most flow line is positioned perpendicular to the upstream slope of the
dam

Modelling

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.
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| Geometry
| Surface >
Coordinates...
| Geometry
Point >
Coordinates...
| Geometry
Surface >
Points...

Modelling

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Earth_dam

e Use the Default working folder

o Enter the title as Trapezoidal earth dam with drainage toe

e Select units of N, m, kg, s, C

e Select a timescale unit of Days

e Ensure the Structural analysis type is selected.

e Select a startup template of None

e Select the Vertical Y Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to

correct any mistakes made since the last save was done.

Defining the Geometry

X Y

J Enter the following coordinates to define the partially

saturated sand part of the dam. 0.0 0.0

17.8064 12.0

19.0345 | 12.8276

23.5862 | 12.8276

36.2038 | 4.34484

33.5172 0.0

El Enter the following coordinates (42.6207, 0.0) to define the downstream toe point.

J Holding down the P key to ensure only points are selected, box-select the three
points that form the bottom-right corner (Points 7, 6 and 5) in order to create the filter
discharge surface.

453



Trapezoidal earth dam with drainage toe

P4

il 6 P7
Defining and Assigning Mesh Attributes
| Attributes e Select Plane strain two phase elements types with Quadrilateral shape and
I% Quadratic interpolation order (QPN8P elements).
urrace. ..

e Unselect Automatic mesh, tick Element size and enter 0.5
o Enter the attribute name as QPN8P 0.5m and click OK

e Select the two surfaces on the model and drag and drop the QPN8P 0.5m mesh
from the Treeview onto both surfaces.

,0"::'0'
o ‘v
SIS
S
peSete et titie
SIS
SIS SR SN Ly
SRS SEOs S
% Q‘&O‘«»o}"&& XL
e riuunt et et 1
e

."'":'.:::.:':.::E:..;'%‘%&‘
Material Properties
| Attributes Two different materials need to be defined; one for the partially saturated sand and one
Material > for the filter. For this example both materials need two phase properties defined.

Isotropic...

Two-phase material properties are required when performing an analysis in which two-
phase elements are used to define a drained and undrained state for soil.

e With the Elastic tab selected enter a Young’s modulus 1.0E9, Poisson’s ratio 0.2
and Mass density 2.0E3.
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Modelling

e Tick Two phase option and select the Two phase tab. Ensure the Partially
drained option is selected, and enter the Bulk modulus of fluid phase as 1.0e9, the
Porosity of medium as 0.333333, the Unit weight of fluid as 10.0e3 the Hydraulic
conductivity in every global direction as 0.152e-3, the Density of the fluid as 1.0e3
and the Degree of saturation to be considered as fully saturated as 1.0.

[™ Plastic [~ Creep [~ Damage [~ shrinkage [~ viscous [+ Two phase

'Elastic Two Phase |

" Undrained Value
. . ; Bulk modulus of solid phase ]
P e Bulk modulus of flud phase 1069
" Piecewise linear partially drained Porosity of medium 0333333
Unit weight of fluid 10.0e3
Define curves... | Hydraulic conductivity in global X direction 0.152e-3
Hydraulic conductivity in global ' direction 0.152e-3
I Incompressible solids Hydraulic conductivity in global Z direction 0.152e-3
Density of fluid 1.0e3
Imeducible saturation 0.0
Degree of saturation to be considered as fully saturated 10

Mame | Partially Saturated Sand j ﬂ (new)

OK | Cancel | Apply | Help |

Note: Usually the value of Bulk modulus during the solid phase is substantially larger
than the fluid phase, and therefore does not typically form part of the geotechnical
testing. If the bulk modulus of solid phase is left as 0, LUSAS assumes an
incompressible solid phase.

Note: All time dependent material units (e.g. Hydraulic conductivity) are entered as
model units (i.e. seconds). The timescale units are only used when defining analysis
properties, such as nonlinear timesteps. The units expected by each input are shown as a
tooltip.
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| Analyses

Loadcase...

Trapezoidal earth dam with drainage toe

Press Define Curves to define a
new pressure-effective saturation
curve.

Enter the Rate of water extraction
as 1.3774, the Weight factor as
1.0 and the Air entry to -
0.261097.

Press OK to leave the curve
definition dialog.

Enter the Name of the newly
defined material as Partially
Saturated Sand and press Apply

Draining curve
Value
Rate of water extraction 1.3774
Weight factor 1.0
Air entry -0.261097
| Permeaility 0.0
¥ Filling curve is same as draining curve
" sSpedify filing curve
Scanning curve factor I 0.01
Value
Rate of water extraction 1.3774
Weight factor 10
Air entry 0261097
Permeability 0.0

To define the granular filter material; in the Two Phase tab, change the Hydraulic
conductivity to 1.0 in all three global (X, Y and Z) directions.

Change the attribute name to Filter and press OK

Assign the two attributes to their corresponding surfaces by dragging and dropping

them onto the relevant features.

Loadcases

to Initial Condition

Add a second loadcase, changing the name to Seepage and press OK.

The geometry specified for the dam represents the as-constructed state, prior to any
settlement and the filling of the reservoir. A geostatic loadcase will be used to model
the initial stresses in the earth structure (due to self-weight) without any deformation. A
second loadcase will then be used to apply the hydrostatic water pressure to the ‘as-
constructed’ dam.

o Inthe ™ Treeview right-click on Loadcase 1 and click rename. Change the name
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| Attributes

Modelling

[ Supports. ..

| Attributes

[ Supports. ..

Supports

Using two consecutive loadcases requires support attributes to be defined to both add
and remove the restraint to the model for each stage.

During the Initial Condition (geostatic) stage pore-water will be allowed to flow freely
through the dam to prevent the build-up of pore pressure during the construction stage.

e Leaving all other degrees of freedom Free, set Pore pressure to Fixed. Enter the
name of the support as Free Flow then press Apply to define a constant (zero)
pressure attribute.

e Switch the X and Y translation freedoms to Fixed. Change the attribute name to
Fixed XY (Free Flow) and press OK to define a fixed structure support.

Once the support attributes have been defined, they must be assigned to define the
initial condition.

e Inthe 'Z Treeview right-click on Initial Condition and press Set active

o Select both surfaces and, from the & Treeview, drag and drop the support attribute
Free Flow onto the model. Press OK to assign the support.

e Select the two bottom lines of the dam, and assign the Fixed XY (Free Flow)
support attribute. Press OK to assign the support.

During the seepage stage the pore pressure will be allowed to build-up within the
structure, with flow restricted to the drainage filter material in the downstream toe.

e Leaving all degrees of freedom Free (including Pore pressure). Enter the name of
the support as Seepage Flow and press Apply to define a ‘freeing’ support.

e Change the X and Y translation freedoms to Fixed and enter the name as Fixed XY
(Seepage Flow). Press OK to define a structural support that restricts flow.

Non-linear analyses inherit support conditions from the previous stage. These new
support attributes are therefore used to free the Pore pressure fixity where required.

o Inthe 'E Treeview right-click on Seepage and press Set active

e Select both surfaces and, from the & Treeview drag and drop the support attribute
Seepage Flow onto the model.

e In the Assign support dialog choose the From loadcase option, and select the
Seepage loadcase. Press OK to assign.
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| Attributes

Trapezoidal earth dam with drainage toe

[ Loading...

o Select the left-hand bottom line of the dam (i.e. not within the filter), and assign the
Fixed XY (Seepage Flow) support attribute, the ensuring From loadcase option
and Seepage loadcase are selected in the Assign support dialog.

There is no need to assign a new support attribute to the line at the bottom of the filter
material, as the required support, assigned in the previous loadcase (structurally fixed
with free flow), will carry forward.

Structural Loading
The effects of the self-weight of the dam will be modelled throughout this analysis and
can be applied as directly to the analysis.

o In the ™= Treeview right-click on Analysis 1 and select Gravity

For this analysis it will be assumed that the reservoir retained by the dam does not drain
significantly due to seepage, or emptying, and therefore the total pressure head can
remain fixed at 12m.

¢ In the Prescribed section select Displacement, click Next and in the Pore pressure
select the Fixed radio button and click the 3 button in the Displacement field.

¢ In the Unit Converter and Variation Utility dialog, select New... from the Variation
drop-down menu to open the Variation dialog.

e Select General Field Variation, click Next and enter 12-y in the function field.
e Click Function limits, then tick Max. x coordinate and enter a value of 17.8065

e Click OK, ensure Global Coordinates is selected, enter Hydrostatic Variation as
the name and click Finish to exit the dialog.

e To convert the variation, defined in m-
head, to hydrostatic pressure, select kN/m? - [Fumit converter
from the Unit converter options. Then Frrei
enter a value of 10 in the Convert from [10.0 [lomz =]
box. and click OK

To model units
| 10.0E3 |

e Name the attribute Hydrostatic Pressure
and click Finish J—Variah’on

x |Hydrostatic Variation j

Cancel Help |
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Modelling

e Select the bottom line of the upstream slope of the dam (line 1) and from the &
Treeview and drag and drop the loading attribute Hydrostatic Pressure onto the
selected line, ensure the loadcase Seepage is selected, then click OK

Non-Linear Control

Use of Geostatic steps and two-phase consolidation materials are inherently non-linear.

o Inthe "= Treeview right-click Initial Condition and select the Nonlinear &
Transient option from the Controls menu.

A % Nonlinear and Transient entry will be added to the Treeview. Double-clicking on
this entry will allow any changes to be made to the control properties.

¢ Inthe Nonlinear & Transient dialog select the Nonlinear option in the top-left hand
corner and leave the incrementation type as Manual

e Select the Geostatic step option.

e Change the Incremental displacement norm to 0. This leads to convergence being
assessed based on the (total) Displacement norm. Click OK to exit the dialog.

Note: Most geotechnical problems begin from a geostatic state where the undisturbed
soil or rock body remains in equilibrium with the prescribed boundary conditions and
geostatic loads, including gravity. The geostatic step produces zero deformations, but
establishes the initial stress field that can be used in a subsequent static or coupled field
diffusion/stress analysis.

o Inthe = Treeview right-click on Seepage and select the Nonlinear & Transient
option from the Controls menu.

e In the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option and select a Consolidation time domain. Enter the
initial time step as 0.01, the total response time as 30 and the maximum number of
time steps as 30. Note that analysis time is measured in days, which was the
timescale option set when creating the model.

e Tick the Automatic time stepping option, press Advanced and change the Time
step increment restriction factor to 5.0 and the Maximum time step to 5.0. As
consolidation/seepage effects decay exponentially this will allow the time interval to
grow accordingly. Press OK to exit the dialog.

e Ensure the Solution strategy is set to Same as previous loadcase
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| File

A

Trapezoidal earth dam with drainage toe

[New...

e Having set all the Nonlinear & Transient options select OK to return to the
Modeller graphics window.

Running the Analysis

El Open the Solve Now dialog, ensure Analysis 1 is selected and press OK to solve.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

In addition, solution files will be created in the Associated Model Data\Earth dam
folder.

U Earth_dam.dat this data file contains details of model data and assigned
attributes.

U Earth_dam.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U Earth_dam.mys this is the LUSAS results file from the analysis which is
loaded automatically into the () Treeview to allow results to be viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to the output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Rebuilding the Model

If errors have been made in the modelling of this example that for some reason you
cannot correct, a file is provided to re-create the model information correctly, allowing
a subsequent analysis to be run successfully.

0 earth_dam_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as earth_dam

460



Viewing the Results

| File e To recreate the model, select the file earth_dam_modelling.vbs located in the

Script 2 \<LUSAS Installation Folder>\Examples\Modeller directory.
Run Script...

;l Run the analysis to generate the results.

Viewing the Results

Analysis loadcase results for each time step are present in the () Treeview.

Viewing the Initial Stress Distribution

Two steps take place in Initial Condition; a first increment and then the Geostatic step.

o In the ‘! Treeview right-click on the Initial Condition result-set for Increment 1
and Set Active.

e In the Treeview turn-off the Mesh and Attributes layers. Press the
Deformations... button, select Specify factor enter a factor of 2.0e3 and press OK.

e With no features selected right click in a blank part of the Graphics window and
select the Contours option to add the Contours layer to the [ Treeview.

e On the dialog set the results entity to Stress — Plain Strain and component SY,, then
press OK.

The results from Increment 1 show how the structure would behave if gravity was
applied to the structure immediately after construction. This is used to get the ‘in-situ’
stresses then used for the Geostatic step.
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Trapezoidal earth dam with drainage toe

e Inthe ™= Treeview right-click on the Initial Condition result-set for Geostatic Step
and Set Active.

In the Geostatic Step, the deformations are set to zero (to match the as-built geometry)
with in-situ stresses maintained
Viewing The Phreatic Line Development

o In the ‘X! Treeview right-click on the Seepage result-set for Time Step 1, and Set
Active.

¢ Inthe = Treeview switch off the Deformed Mesh layer.

e Double-click the Contours layer in the Treeview. On the dialog, set the results
entity to Displacement and component to PRES.

e Select the Contour Display tab and deselect Deform.

e Select the Contour Range tab and set an Automatic contour range using an
Interval of 10e3. Enter a Maximum value of 120e3 (12m head) a Minimum value of
0. Click OK.
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| utilities

Viewing the Results

Print Results
Wizard...

By setting each time-step active (right-click the time-step in the (1) Treeview and Set
Active) in turn the gradual development of a semi-steady state seepage flow can be
seen. During the first three time-steps (~7.5 hours) the effects of primary consolidation
can be observed. From the fourth time-step onwards, however, there is very little
change between results.

o In the /= Treeview right-click on the Seepage result-set for Time Step 10, and Set
Active.

From the basic parabola, the top flow (zero pressure) line curves correctly upward on
the upstream side, and downward reaching the filter toe.

Dam Discharge

To calculate the seepage flowrate into the filter (i.e. the rate of water draining through it
the body of the dam), the flow reaction of the filter bed is going to be used (as water is
being drained only from this location).

e Select the bottom line of the toe-drain filter and press to define a new Group.
Enter the name as Filter and press OK to create the new group.

Ensure that the last time-step increment of the Seepage results (Time Step 10) is set
active in the = Treeview:

e Select Active.

e Select the entity Reaction and use the results type Component.

e Press the Extent... button and select new created group Filter.

e Press Finish to view the tabulated results summary.
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Trapezoidal earth dam with drainage toe

E; LUSAS View: Reaction Components in Global Axes Loadca... [lj[=] E3
MNode & Fx Y VFlo RSLT “
1 Node FX Fr VFio RSLT ™
2 172 -£5.01233E3: 17.18BE3 0.0 18.1834E3
3 3704 -5.82473 165582 : -437734E-6: 175085
4 3705 -11.1895E3 : 33.7825E3 0.0 35.5827E3
5 370g -5.35537E3 ; 16.5152E3 125022 17.3618E3
G ror -10.0438E3 : 32.2052E3 0.0 33 7365E3
7 3708 -4 82496E3 : 15.7607TE3 42 3815 16.4828E3
8 3709 -5.2668459E3 ¢ 30.79E3 0.0 32 1542E3
9 3o -4 45435E3 : 15.045E3 15.8754 15.6934E3
10 KTAN -3.61125E3 : 29.3719E3 0.0 30.6033E3
11 3rz -4 15867E3 : 14.3347E3 577938 14 9258E3
12 3T3 -3.0357E3 | 27.944E3 0.0 25.0776E3 —
13 3714 -3.88883E3 : 13.6144E3 233988 14 1589E3
14 3Ts -7.52503E3 : 26.4823E3 0.0 27 5MTE3
15 3rie -3.64544E3 : 12.871E3 1.05219 13.3773E3
16 YA -7.06183E3 : 24 9613E3 0.0 25.941E3
17 3rs -3.41982E3 : 12.092E3 0.514106 ; 12.5883E3
13 KTAL] H56231E3 : 23.3587E3 0.0 24 2T91E3
19 3720 -3.20349E3 ; 11.2674E3 0.26854 11.714E3
20 3721 -5.19059E3 : 21.6578E3 0.0 22 5252E3
21 3T -2 93804E3 ; 10.3904E3 0.14719 10.8115E3
22 3723 -5.75343E3 : 19.8484E3 0.0 20.6655E3 ;I
4 4 » M\ Modelinfo }5 12:Seepage, Time Step 10 Time = 0.259200E-

The value of VFlo is the volume of flow during the selected time-step. Considering the
semi-steady flow achieved by 30 days, the average flow-rate into the filter drain can be
calculated from the total discharge shown in these results over the duration of the time-
step between the last and second-to-last increments.

e Save the results in a spreadsheet by right clicking on the Print Results Wizard output
and selecting Save as Microsoft Excel.

e Sum the VFlo column to get the total discharge over the time-step (193m°).

e ldentify the time of the last and second-to-last timesteps from the (X Treeview 4.2
days)

e Divide the total discharge over the final interval to calculate the average flow rate
into the filter dam (45.9m*/day/m)

This completes the example.
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Description

Staged
Construction of a
Concrete Dam

For software product(s): | Any Plus version
With product option(s): Nonlinear, Dynamic, Thermal, Heat of hydration

Description

A 30m hlgh Loadeaze: 61:Time Step 60 Time = 22.5201
COHCI’ete dam, Results file: Concrete_Dam-Thermal.mys

tapering from 10m Responze time: 235291
thick at the base to  Ertity: Potential
31735m th|Ck at Component: PHI (Units: C)

the crest is to be
constructed in we

250
three stages, each

0.0
10 metres high. 380
Each stage is . a0

added 10 days 40
after the previous 500
stage, and the .0
analysis runs for a .0

total of 30 days.

Animations are created showing the variation of temperature and stress during its
construction.

Simplified geometry is used to allow the example to concentrate on the definition of the
concrete heat of hydration loading and staged construction techniques required.

Units used are N, m, kg, s, C throughout
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A

Modelling

Staged Construction of a Concrete Dam

Objectives

The required output from the analysis consists of:

O A time history of the temperature throughout the dam during construction.

O A time history of the distribution of maximum principal stress (S1) throughout
the dam.

Keywords

Birth, Death, Staged Construction, Activate, Deactivate, Heat of hydration, Semi-
coupled analysis, Concrete

Associated Files

U concrete_dam_geometric_modelling.vbs carries out the geometric
modelling of the example.

U concrete_dam_modelling.vbs carries out the complete modelling of
the example to a ready to run stage.

Discussion

Concrete is generally unique among structural materials in that it interacts with its
environment undergoing unavoidable physical and chemical volume changes. Concrete
exhibits certain characteristics such as ageing, creep and shrinkage, which are
collectively known as time dependent deformations; these are dealt with in other
examples in this manual. See the Concrete Tower example if age and creep is of interest
to you.

The process of hydration is an exothermic chemical reaction, which leads to large
amounts of heat generation. This leads to thermal stresses, which may potentially cause
the concrete to crack. A semi-coupled analysis can be used to investigate the connection
between the heat generated due to concrete hydration and the thermal stresses induced
as a result.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

466



Modelling

started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Note. This example is written assuming a new LUSAS Modeller session has been

Creating a new model

e Enter the file name as Concrete_Dam

e Use the Default working folder

o Enter the title as Concrete dam example to model heat of hydration
e Set the Timescale units to Days and the Model units to N,m,kg,s,C

e Ensure the Coupled user interface is selected.

e Select a startup template of None

e Select the Vertical Z Axis option.

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
/ correct any mistakes made since the last save was done.

Defining the Geometry

The base of the dam is 10m
thick, 54.97m along its
centreline, and subtends an angle
of 30 degrees. The thickness of
the dam tapers with increasing
height in a nonlinear manner
(such that the thickness at the
abutments is very slightly larger
than at the centre of the dam).

Since the geometry of the dam is
not the focus of this example a
script file has been provided which will automatically create the model.

| File e Select the file concrete_dam_geometric_modelling.vbs which is located in the

cht Sot > \<LUSAS Installation Folder>\Examples\Modeller directory and click OK
un Script...
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| Group

| New Group

| Geometry

| Group

| New Group

| Geometry

| Group

~ [NewGroup

| File

| Model properties...

| Attributes

[Mesh
|Line...

>

El Select the isometric button which, because of the way the geometry has been
defined, will give a front view of the dam. The three volumes represent the three stages
of construction.

Defining Groups

It is useful in staged construction analysis to make use of the group facility in LUSAS.
This allows parts of the model to be displayed in isolation according to the construction
stage being modelled and simplifies the viewing of results.

e Select the lowest volume representing the concrete in construction stage 1.

Enter the group name as Stage 1 and click OK to finish defining the group.

e With the previous volume still selected, hold the Shift key down and add the middle
volume representing construction stage 2 to the selection.

Enter the group name as Stage 2 and click OK to finish defining the group.

e With the previous two volumes still selected, hold the Shift key down and add the
upper volume representing construction stage 3 to the selection.

Enter the group name as Stage 3 and click OK to finish defining the group.

Defining and Assigning Mesh Attributes

To ensure a well-proportioned mesh, line mesh attributes will be assigned to define a
mesh with three elements through the thickness of the dam, and eight elements across
the width of the dam. Vertically, lines defining each volume will be split into two
divisions. To create this mesh arrangement both default and individual line mesh
divisions will be used.

e On the Model Properties dialog select the Meshing tab. Change the default line
divisions to 3 and click OK.

This specifies the default number of mesh divisions to be used along a line unless a line
mesh attribute is subsequently assigned.

e On the Line Mesh dialog ensure that the Structural element type is set to None. Set
the number of divisions to 2, name the attribute Divisions = 2 and click Apply to
create the attribute.

e Change the number of divisions to 8, change the name to Divisions = 8 and click
OK.
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Tip. To assign these mesh divisions to the model the selection of lines could be done
individually, but lines can also be selected by holding-down the L key while box-
selecting with the mouse. When this is done any part of a line that is within the area
dragged is selected.

Select the twelve near-vertical lines that define four edges of the dam. Assign the
line mesh attribute Divisions = 2 from the & Treeview onto the selected features.

Select the eight horizontal curved lines from the model. Assign the line mesh
attribute Divisions = 8 from the &% Treeview onto the selected features.

The dam is to be modelled
with  Stress, Hexahedral,
Linear elements (HX8M
elements) in the structural
analysis. By clicking on the
Thermal tab it can be seen that
these elements are —
automatically coupled to Field, I

Hexahedral, Linear elements R

(HF8 elements) in the thermal q‘—*—

analysis. Ensure that a

Regular mesh is used. (The mesh spacing will be governed by the assigned line
mesh attributes). Enter the dataset name as Coupled Brick Elements and click OK

Select all volumes in the model (or use the Ctrl + A keys to select all features) and

drag and drop the Coupled Brick Elements mesh from the &b Treeview onto the
selected features.

Material Properties

Enter a Young’s modulus of 309, a Poisson’s ratio of 0.2, and a mass density of
2.4e3. Click the Thermal expansion check box and enter a Coefficient of thermal
expansion of 10e-6.

Click on the Thermal tab. Leave the Phase change state set to None and enter a
Thermal conductivity of 2.0 (J/m?s°C) and a Specific heat coefficient of 2.5075E6
(I/m3°C).

The heat of concrete hydration thermal loading will now be defined.

Select Concrete Heat of Hydration from the Exothermic behaviour panel. Then
set the Exotherm option to Concrete for Cement type Type I. Note that the
timescale units have already been set when the model was first created and will be
used in any heat of hydration analysis.
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e Set the remaining values required in the dialog as follows: Weight of cement 307,
Water/Cementitious ratio 0.47, Weight of slag 0, Weight of fly ash 0, CaO content
of fly ash 0, Assumed cure temperature 21.1

e Change the attribute name to Concrete Ungraded and click OK. See the following
dialog for confirmation of the thermal values required:

[+ Elastic ¥ Thermal
[ Plastic o Creep o Damage o Shrinkage [ Viscous [~ Two phasze
Easte Thermall
Phase change state INone j Value
Thermal conductivity 20
Volumetric heat capacity 2 5075E6

r~ Exothermic behaviour
~ Value
Nene Weight of cement per unit volume 307.0
* Concrete Heat of Hydratior Water/Cementitiows ratio 047
Weight of slag per unit volume 0.0
Ci t -
ement type Typel Weight of fly ash per unit volume 00
Cal content of fty ash (%) 0.0
Assumed cure temperature 211
Mame |Concrete Ungraded j ﬂ (&)

Close I Cancel | Apply | Help |

Note. The Specific heat coefficient is the specific heat capacity multiplied by the
density.

Note. When computing the heat due to the rate of hydration of concrete, hours or days
are convenient units to use for the time step and elapsed time. Due to the way the
solution algorithms are formulated this is independent of the fundamental units of
seconds and Newtons that are defined for the model.

N

Note. The concrete heat of hydration loading is a type of internal heat generation.
/ From the input parameters LUSAS automatically calculates the amount and rate of this
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internal heat generation based on formulae presented in published research by Schindler
and Folliard. Reference [S18] LUSAS Theory Manual.

Assign the Material Properties

e With all three volumes in the model selected, drag and drop Concrete Ungraded

from the &b Treeview onto the selected volumes. Press OK to assign to Analysis
1. (This analysis name will be renamed later to be ‘Structural’)

Note. In a coupled analysis, a material with Elastic and Thermal properties defined
should always be assigned to the Structural analysis.

Structural Supports

A fully fixed support is required for the base and abutments of the dam. All degrees of
translation in the X, Y and Z-axes must therefore be set as Fixed. Enter the attribute
name as Fixed and click OK

e Select the surfaces that
define the base and F———
abutments of the dam and
from the c&: Treeview
drag and drop the support
attribute Fixed onto the
selected features, ensure I D
the Analysis 1 and the All
analysis loadcases option
is selected and click OK -

Tip. Hold-down the Shift +S
keys and box-select the surfaces required.

Thermal Supports

A thermal support needs to be defined for use later in the example.

e Ensure the temperature support is set to Free and enter the attribute name as Free
and click OK.

Do not assign this support to the model yet. It is to be used during the activation and
deactivation of the thermal loadcases to free-up elements that have had their
temperature restrained at the concrete placement temperature.
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Thermal Loading

Several thermal loads need to be defined for applying to the model later. Environmental
temperature loads for the air and ground temperatures will be defined first, followed by
the initial concrete placement temperature.

Air temperature

e Select Environmental Temperature and click Next

e Enter a value of 21.1 (°C) for the environmental temperature, and 8.333 (J/m%s-°C)
for the convection heat transfer coefficient. Leave the other two inputs blank. Enter
the attribute name as Air temperature. Click Apply

Ground temperature

e In the first row of the dialog, keep the value of 21.1 (°C) for the environmental
temperature, but over-type a value of 2.777 (J/m?s.°C) for the convection heat
transfer coefficient. Change the attribute name to Ground temperature and click
Finish

Initial concrete temperature

The initial concrete temperature will be defined:
e Select Prescribed Temperature and click Next

e Select Fixed and enter a value of 21.1 (°C). Ensure the Total option is selected.
Enter the attribute name as Initial concrete temperature. Click Finish

Modelling Staged Construction

In order to correctly model the staged construction of the dam, volumes (and hence,
elements) in the model must only be included in the analysis after they have been
constructed. Similarly, loading attributes (such as surface heat transfer) will need to be
applied only for a certain portion of the analysis to reflect the construction stage being
considered. In general, model attributes are assigned and changed using Loadcases,
whilst loading attributes that apply during particular times during an analysis are
applied to selected features of the model using Load curves.

Creating Activation and Deactivation datasets

Modelling of staged construction processes that require activation and deactivation of
elements is carried out in LUSAS using the birth and death facility.

e Choose the Activate option and click Next
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e Enter the attribute name as Activate and click Apply. Then click Back so the dialog
can be reused to define the deactivate attribute.

e Choose the Deactivate option and click Next

e Enter the attribute name as Deactivate, select Percentage to redistribute and leave
the value as 100%, then select Finish

When building staged construction models it is often very helpful to see the elements
that are actually activated in the loadcase being viewed.

e In the I= Treeview, double-click the View properties control, and under the View
tab ensure the Show only activated elements option is selected, then click OK.

Defining Loadcase properties

o In the ‘2 Treeview two analysis entries can be seen — one structural and one
thermal. These are created automatically as a result of selecting a Coupled user

interface option at the beginning of the example There is also a ® Coupled
analysis options object. Loadcases need to be created for each construction stage to
be modelled — for both the structural loadings and for the thermal loadings.

Defining a structural initialisation loadcase

To make the model easier to manipulate, the default analysis names will be changed to
something more descriptive.

e Inthe @ Treeview right-click on = Analysis 1 and rename it to Structural

e In the {5 Treeview right-click on = Analysis 1 (Thermal) and rename it to
Thermal

Defining a structural initialisation loadcase

e Right-click on Structural > Loadcase 1 and rename it to Structural Initialisation

e Select Structural Initialisation using the right-hand mouse button and from the
Controls menu select the Nonlinear and Transient option.

e On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option. Choose a Viscous time domain from the drop-
down list. Enter the Initial time step as 1le-6, leave the Total response time as its
default value, and set the Max time steps or increments to 1

¢ Click OK to return to the Modeller window.
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Note. The small initial time step of 1e-6 has been used to minimise the curing effects
during this loadcase.

Note. In this instance the large default total response time has no significance because
only one time step is processed. This load case will finish after the first small time step.

Defining a structural loadcase for construction stage 1

Ensure the Structural analysis is selected, then enter a loadcase name of Structural
stage 1 and click OK

Select Structural stage 1 using the right-hand mouse button and from the Controls
menu select the Nonlinear and Transient option.

On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

Select the Time domain option. Choose a Viscous time domain from the drop-
down list. Enter the Initial time step as 0.05, the Total response time as 10, and set
the Max time steps or increments to 100

Select the Automatic time stepping option and then click the Advanced button.

On the Advanced Time Step Parameters dialog set the Time step increment
restriction factor to 1.5, the minimum time step to 0.05 and the Maximum time step
to 0.5 This will allow the time step to increase from its initial value of 0.05 up to the
maximum value of 0.5 and thus reduce the number of increments required.

Click OK to close the Advanced Time Step Parameters dialog and return to the
Nonlinear & Transient dialog. On this dialog pick the Coupling button and change
the Interval between coupled reads and the Interval between coupled writes to
0.05, and click OK. Click OK to return to the Modeller window.

Defining a structural loadcase for construction stage 2

Loadcases can be copied and pasted in the Treeview. This saves having to re-enter
similar details for each loadcase. Then, just the different values can be defined for each
newly copied loadcase.

Click on loadcase Structural stage 1. Press the copy toolbar button, followed

by the El paste toolbar button. This will create a new loadcase that is an exact
copy named Copy of Structural stage 1. Rename this new structural loadcase to
Structural stage 2
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o Double-click the & Nonlinear and Transient object for Structural stage 2 and
set the total response time as 20

Defining a structural loadcase for construction stage 3

e Repeat the last two procedures to create another copy of the first loadcase called
Structural stage 3, but set the total response time as 30

Defining a thermal initialisation loadcase

¢ Right-click on the thermal Loadcase 2 and rename it to Thermal Initialisation

e Select Thermal Initialisation using the right-hand mouse button and from the
Controls menu select the Nonlinear and Transient option.

e On the Nonlinear & Transient dialog select the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option. Choose a Thermal time domain from the drop-
down list. Enter the Initial time step as le-6, leave the Total response time as its
default value, and set the Max time steps or increments to 1

e In the Solution Strategy section set the Max number of iterations to 15
e Click OK to return to the Modeller window.

Note. The small initial time step of 1e-6 has been used to minimise the curing effects
during this loadcase.

Note. In this instance again, the large default total response time has no significance
because only one time step is processed. This load case will finish after the first small
time step.

Defining a thermal loadcase for construction stage 1

e Select the Thermal analysis
e Enter a loadcase name of Thermal stage 1

e Click on loadcase Thermal stage 1 using the right-hand mouse button and from the
Controls menu choose the Nonlinear and Transient option.

e On the Nonlinear & Transient dialog tick the Nonlinear option and leave the
incrementation type as Manual

e Select the Time domain option and note that the Thermal time domain option is
the only one available for selection. Enter the Initial time step as 0.05, the Total
response time as 10, and set the Max time steps or increments to 100
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e Ensure the Automatic time stepping option is selected and then click the
Advanced button.

e On the Advanced Time Step Parameters dialog set the Time step increment
restriction factor to 1.5, the minimum time step to 0.05 and the Maximum time step
t0 0.5

e Click OK to close the Advanced Time Step Parameters dialog and return to the
Nonlinear & Transient dialog. On this dialog, pick the Coupling button and change
the Interval between coupled reads and the Interval between coupled writes to
0.05, and click OK. Click OK to return to the Modeller window.

Now create a copy of this loadcase:

Defining a thermal loadcase for construction stage 2

e Click on loadcase Thermal stage 1. Press the copy toolbar button, followed by

the EI paste toolbar button. This will create a new loadcase that is an exact copy
named Copy of Thermal stage 1. Rename this new structural loadcase to Thermal
stage 2

o Double-click the ¥ Nonlinear and Transient object for Thermal stage 2, set the
total response time as 20

Defining a thermal loadcase for construction stage 3

e Repeat the last procedure to create another copy of the first loadcase called
Thermal stage 3, but set the total response time as 30

All loadcases have now been defined. Element activations and model attributes will be
assigned to these loadcases later.

Note. The total response time in each loadcase represents the total time at which that
loadcase in the analysis ends, and the next one begins.

Set coupled analysis options

In this analysis, the thermal results affect the structural behaviour (that is, temperatures
cause thermal stresses), but the structural results do not affect the thermal behaviour. A
semi-coupled analysis is therefore required, and the appropriate coupled analysis
options must be chosen.
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« Double click on the % Coupled analysis options
object in the (X Treeview. Cowplgpe  [Themallist 7]

" Parallel coupling
Set the coupling type as Thermal first from the drop ¥ Initalse reference temperatures
down list ™ Suppress recalculation of view factors
' " Step coupling

e Select the Initialise reference temperatures ' Tine co.ping

0pt|0n First data write at ID.DS
First data read at ID.DS
e Ensure the Time coupling radio button is selected. ok | cancel |[ ek |

e Set the First data write to 0.05 and the First data
read to 0.05 (i.e. every step)

e Click OK

Load Curves

Load curves are used to describe the variation of the loading in nonlinear, transient and
Fourier analyses. In a transient thermal analysis, such as in this example, the
environmental temperature loading on specific surfaces of the dam will change with
time. As the construction progresses some surfaces that were initially external surfaces
(that could dissipate heat to the outside environment) become internal ones that can
only dissipate heat to other parts of the structure.

Defining Load Curves

e Right-click on the = Thermal analysis icon, and choose New and Load Curve to
open the Load Curve dialog box.

Defining a concrete placement load curve:

e Inthe User-defined section of the dialog enter a Time of 0 and a Factor 1, press the
Tab key to create a new row. On this new row enter a Time of 30 and a Factor of
1. Leave the default values of Activation time (0.0) and Scaling factor (1.0)
unchanged. Name the load curve Concrete placement and click Apply
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% User-defined ¢~ Standard curve £ Yariation
3 Tim; Fa::l1nr Type Sine K Termination time I':'Zi
< 2 ] Amplitude I':— Sampling increment I'I'I—
Frequency I 0.0 I lone defined j
Phase angle I 0.0 3
Activation time IUU— Scaling factor IIU—
Analysis IThermaI i
Mame IConcrete platement
ITI Cancel | Apply | Help |

With reference to data that follows, repeat this procedure four more times to add

four more load curves called External surface stage 1, External surface stage 2,
External surface stage 3 and Base and abutments. The User-defined area of each
of the dialog boxes should be filled-in according to the tables that follow.

Time Factor
0 1
9.999 1

Table 1. External surface stage 1

Time Factor
20 1
30 1

Table 3. External surface stage 3

Time Factor
10 1
19.999 1

Table 2. External surface stage 2

Time Factor
0 1
30 1

Table 4. Base and abutments
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Assigning Activation and Deactivation attributes

Construction Stage 1

The elements not required for the first
construction stage must be deactivated.

e In the Graphics window select the top
two volumes of the dam.

Structural activation/deactivation

e Drag and drop the deactivation attribute Deactivate from the & Treeview,
ensuring that it is assigned to analysis Structural and loadcase Structural
Initialisation and then clicking OK

Because the option to show the activated mesh only was set earlier in the example the
view window will update to show only the mesh elements for the lowest volume.

Thermal activation/deactivation

e With the top two volumes still selected, assign the deactivation attribute

Deactivate from the ¢ Treeview onto the selected features ensuring that it is
assigned to analysis Thermal and loadcase Thermal Initialisation

Verifying self weight and activation assignments

e If, during the course of this example, you need to check when particular elements
become active in an analysis, select a feature and then, using the right-hand mouse
button, choose Properties. Go to the Activate Elements tab. Highlighting an entry
in the right-hand panel (that shows the assigned attributes) will show the loadcase
in which the activation is assigned in the Loadcase box.

Construction Stage 2

The elements in the second construction stage now need to be activated.

e In the graphics window select only the second stage of the dam (i.e. the middle
volume).

Structural activation/deactivation

e Assign the activation attribute Activate
from the &b Treeview, ensuring that it is
assigned to analysis Structure and
loadcase Structural Stage 2, then and
clicking OK
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Thermal activation/deactivation

e  With the middle volume still selected, assign the activation attribute Activate from
the &b Treeview ensuring that it is assigned to analysis Thermal and loadcase

Thermal Stage 2
Construction Stage 3

The elements in the third construction stage
now need to be activated.

e In the graphics window select only the top
volume of the dam.

Structural activation/deactivation —

e Assign the activation dataset Activate from -

the &% Treeview, ensuring that it is assigned to analysis Structural and loadcase
Structural stage 3, and then clicking OK

Thermal activation/deactivation

e  With the top volume still selected, assign the activation attribute Activate from the

Treeview ensuring that it is assigned to analysis Thermal loadcase Thermal
stage 3

Adding self-weight

In the @ Treeview right-click on the = Structural analysis icon and select Add
gravity to apply self-weight loading to all the structural loadcases in the analysis.

Note. Loadcases with automatic self-weight loading can easily be identified by the
& gravity loadcase icon.

Assigning thermal loading (load curves)

Load curves were defined to model the thermal loading and these need to be assigned to
appropriate features of the model.

Assigning the Initial Concrete Temperature

The Initial Concrete Temperature attribute will apply to all the stages of the model as
they are activated.
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e With all three volumes selected, assign the
thermal loading attribute Initial Concrete
Temperature from the & Treeview,
ensuring that it is assigned to Load curve
Concrete Placement in the drop-down list
before clicking OK.

e e ——

—

Assigning ground temperature

Ground temperature loading only applies to selected surfaces. These could be selected
one-by-one but, as an alternative, they can also be selected by through their support
assignment. First, a structural loadcase must be set active to allow selection of an
assigned structural attribute:

e Inthe .@ Treeview right-click on the Structural Initialisation loadcase and select
Set active.

e In the & Treeview right-click on the Supports entry Fixed and choose Select
Assignments

e With the bottom and side surfaces only
selected, assign the thermal loading
attribute Ground temperature from the
& Treeview, ensuring that it is assigned to
Load curve Base and abutments in the
drop-down list before clicking OK.

Assigning air temperatures and thermal supports

The surfaces in contact with the air change as the construction progresses. To help
ensure the correct surfaces are selected prior to assigning air temperature loading the
pre-defined Groups (that were set-up at the start of the example to mimic the
construction process) will be used. Thermal supports also need to be assigned to the
model at each construction stage to free-up nodes in the model that are restrained at a
prescribed temperature by the LUSAS Modeller.

Construction Stage 1

e In the Treeview right-click on the group name Stage 1 and select the Set as
Only Visible option.

e Click in the graphics area to allow a keyboard short-cut to be used.
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Holding-down the Shift + S keys
select the front, back and top
Surfaces of the concrete that forms
stage 1

Assign the thermal loading attribute

Air temperature from the & Treeview, ensuring that it is assigned to Load curve
External surface stage 1 in the drop down menu before clicking OK

Select the Volume and assign the thermal support Free from the & Treeview,
ensuring that it is assigned to volumes and selecting Thermal stage 1 from the
loadcase drop down list before clicking OK

Construction Stage 2

In the Treeview right-click on
the group name Stage 2 and select
the Set as Only Visible option.

Click in the graphics area to allow
a keyboard short-cut to be used.

Holding-down the Shift + S keys
select the front, back and top surfaces of the concrete that forms stage 2 (5 surfaces
in total)

Assign the thermal loading attribute Air temperature from the & Treeview,
ensuring that it is assigned to Load curve External surface stage 2 in the drop
down menu before clicking OK

Select the two Volumes representing this construction stage and assign the thermal
support Free from the & Treeview, ensuring that it is assigned to volumes, and the
Thermal analysis. Enable From loadcase (nonlinear and transient analysis) and
then select Thermal stage 2 from the loadcase drop down list before clicking OK

Construction Stage 3

In the Treeview right-click on the group name Stage 3 and select the Set as
Only Visible option.

Click in the graphics area to allow a keyboard short-cut to be used.
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e Holding-down the Shift + S keys
select the front, back and top surfaces
of the concrete that forms stage 3 (7
surfaces in total)

e Assign the thermal loading attribute
Air temperature from the &K
Treeview, ensuring that it is assigned
to Load curve External surface
stage 3 in the drop down menu
before clicking OK

e Select the three Volumes representing this construction stage and assign the thermal

support Free from the & Treeview, ensuring that it is assigned to volumes and
selecting Thermal stage 3 from the loadcase drop down list before clicking OK

The model is now complete.

|File El Save the model file.

| Save
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Checking the Attributes and g 18 1& @ |2 18 |

- [ ‘23 Concrete_Damm.rmdl
Loadcase Treeviews

|+

Ela Structural analyses

916 & |@ |+ 18 |
=24 Concrete_dam,mdl
= a Aptributes (13)

& 2:Air temperature
&% 2Ground temperature
& 4:Initial concrete temperature
Achivate Elements [1]
& 1Activate
Deactivate Elements (1]

i 1:Deactivate

In defining and modelling the staged
construction of the dam the Attributes & and

the Loadcase “E! Treeviews now contain all the
information for the LUSAS Solver to carry out
an analysis.

For a successful analysis your model should
contain Treeviews similar to those shown..
Right-clicking on attribute and loadcase data
allows any defined values to be checked. If your
model has potential errors in your Attribute data
or in your Loadcase Treeviews, a file is
provided to enable you to re-create the model

E

== Structural
= a Material
wewe1:Cancrete Ungraded
[=E {B 1:5truckural Initislisation
EI- a Supports

El- 23 Mesh (3] - 1:Fixed
22 Line (2] a Lnadlng
& 1:Drivisions = 2 e b Gravity
& 2:Drivisions = 8 Deactivate
- B Volume 1] - 1iDeactivate
: &b 3Coupled Brick Elements ¥y Monlinear and Transisnt
E a b aterial (1] =- {B 3:5tructural Skage 1
E1-423 Isotropic [1) EI ‘a Loading
H & 1:Concrete Ungraded [M.m kg,z.C) P {} Gravity
E| 423 Supports [2) My Norlinear and Transient
b 1:Fined =4 4:5tructural Stage 2
& 2Fiee =
- Loading (3)
- B Themal (4)

a Activate
i e Lihckivate
"b Morlinear and Transient
B {a S:Structural Stage 3

EI a Activate
e Lihckivate
% Morlinear and Transient
-y Morlinear analysis options

=-423) Thermal analyses

=% Thermal
E1-23 Load Curves
EIN 9 Concrete Placement
= a Loadlng
- 3Initial concrete temperature
H 10:External Surface Stage 1
¢ B3 Loading
: e 11 temperature (x 1.0)
EI H 12:External Surface Stage 3
=S a Loading
: e 11 AN bemperature (x 1,00
EI Fb’ 13:Base & Abutments
=423 Loading
: 2:Ground kemperature (x 1.0)
[—]@ 2:Thermal Initialisation
Deactivate

% Morlineat and Transient
=[5 6:Thermal Stags 1

EI- {23 Supports

- ZiFree

"b Morlinear and Transient
B @ 7:Thermal Stage 2

EI a Supports

from scratch and run the analysis successfully. - Z:Fres
. El-a Activate
See the next page for details. - thctivate

Note. The structural and thermal loadcases are

always tabulated and solved in (5 Treeview
order from top to bottom. The thermal loadcases
can be solved before the structural ones by
stating the coupling type in the Coupled analysis
object.

4

% Morlineat and Transient
=] Q 3:Thermal Stage 3
- Supports
e 21FrEE
Activate
: - 1rhckivate
By Norlinear and Transient
% Monlinear analysis options

% Coupled analysis options
% Model properties

INone

-

| Ei
ﬂ Specify...l
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Running the Analysis
With the model loaded:

El Open the Solve Now dialog. Ensure that the Thermal and Structural analyses are
selected, and press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (2 Treeview.

In addition, 4 files will be created in the Associated Model Data directory where the
model file resides:

U concrete_dam_therm.out this output file contains details of model data,
assigned attributes and selected statistics of the thermal analysis.

U concrete_dam_struct.out this output file contains details of model data,
assigned attributes and selected statistics of the structural analysis.
U concrete_dam_therm.mys this is the LUSAS results file from the

thermal analysis which is loaded automatically into the .@ Treeview to allow
results to be viewed.

U concrete_dam_struct.mys this is the LUSAS results file from the

structural analysis which is loaded automatically into the () Treeview to allow
results to be viewed.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered is written
to a output files in addition to the text output window. Any errors listed in the text
output window should be corrected in LUSAS Modeller before saving the model and
re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported the following file is
provided to enable you to re-create the model from scratch and run an analysis
successfully:

U concrete_dam_modelling.vbs carries out the modelling of the example.
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Staged Construction of a Concrete Dam

[New...

|File

| Script

| Run Script...

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

Enter the file name as concrete_dam

Select units of N,m,kg,s,C

Ensure the Coupled user interface is selected and click the OK button

To recreate the model, select the file concrete_dam_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

;l Run the analysis to generate the results.

Viewing the Results

Analysis loadcase results for each time step are present in the () Treeview. The time
step result for the first thermal loadcase is set to be active by default.

Temperature contours throughout the dam are to be investigated for each stage of the
construction process. Animations of the change in temperature and of the stress in the
dam will be created.

Thermal Results

To illustrate the variation of temperature throughout the model with time, an animation
will be created showing contours at different time steps. Firstly, contours of temperature
for the current time step will be created.

e Turn off the display of the Mesh, Deformed Mesh and Attributes layers in the
Treeview.

e With no features selected click the right-hand mouse button in a blank part of the
Graphics window and select the Contour option to add the contour layer to the
Treeview. Select Potential from the entity drop down list and ensure PHI is
selected in the component drop down list. Click OK.

A plot showing initial contours at ambient temperature will be displayed.

When creating animations of contours it is preferable to have a static contour scale. By
setting a Time Step active for the end of the construction stage under consideration an
estimate of the maximum and minimum values required for the contour key can be
obtained.
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Animation Wizard...

Viewing the Results

e In the {2 Treeview right-click on the Thermal loadcase results for Time Step 25
and Set Active

° In the Treeview Loadoase: 26:Time Step 25 Time = 10.0000
double-click ~on the %M e
Contours layer. Entty: Peterial

Component: FHI {Units: )
e Select the Contour
Range tab and ensure .

that the contour Interval

20.0
250

0.0

contour is set to 5.0. Set :ZE
the  Maximum  and w0
Minimum values to 60.0 500

and 20.0 respectively. o
Click OK .

Animating Thermal Results

Note. The viewing parameters (e.g. the view angle and contour options) used in the
animation are those that are currently specified in the window when the animation is
loaded. It is therefore important to have an appropriate view visible in the Modeller
window when running the animation wizard.

To create and save an animation of the temperature variation on the external surfaces of
the dam throughout the whole analysis, complete the following procedure:

e Select the Load history radio button and click Next

e From the File drop-down menu on the Animation Load History dialog choose the
Thermal results file

Note. In some analyses fine time increments are required for solution convergence
but are not required for animation purposes. It is possible to reduce the size of (and the
time required to produce) an animation by using the filter area of the dialog box.

e For the purposes of this example animate every 2" Time Step by entering a Start
value of 1, a Step value of 2 and click Filter. Only every 2™ Time Step will appear
in the Available area of the dialog. Select all of these filtered thermal results time
steps (by clicking on the first time step, holding the Shift key, scrolling all the way
to the bottom of the list and clicking on the last time step). Include these time steps

by clicking on the LI button and then clicking Finish
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Save As AVI...

Staged Construction of a Concrete Dam

*4 Animation: LUSAS3

Loadcase: 35:Time Step 34 Time = 12.5391
Results file: Concrete_Dam~Thermal.mys
Response time: 12.5391

Entity: Potential

Component: PHI (Units: C)

20.0
25.0
30.0

35.0
- 40.0
45.0
50.0

55.0

5 a] x4 alp|[F B 10—

LUSAS will load-in the selected time step results and open a window showing an
animation of the variation of temperature with time. Animations may be saved in
compressed AVI format for playback in other applications.

e Save the animation to your projects folder and enter concrete_dam_thermal.avi
for the filename and press Save

e  Close the Animation window.

Animating Thermal Results on a Slice Section

With heat of hydration analysis the maximum temperatures reached will occur within
the concrete. To plot the change of temperature over time inside the dam slice sections
are used:

Note. When creating animations using slice sections the animation results are only
created for the elements that are sliced. This means that for this example one of the
Thermal loadcase Time Step results for Stage 3 must be set active so that the complete
mesh for the dam can be seen.
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Viewing the Results

Section Through
3D...

In the ‘& Treeview right-click on the Thermal Stage 3 loadcase results for Time
Step 60 and select Set Active

Loadease: 61:Time Step 60 Time = 23.5391
Results file: Concrete_Dam~Thermal .mys
Responze time: 23.5291

Enitity: Potential

Component: PHI {Units: C) "-—-—-_._,____________________._._._,___._.—-'I

.0

2.0
0.0
3.0
40.0
45.0
50.0

55.0

Click OK to accept a grid size of 1

Position the cursor above the dam in-line with the Z-axis and click and drag
vertically downwards to define a slice section right through the centre of the dam. A

group named Slice 1 will be created in the L=l Treeview.

In the = Treeview select double-click the Contour option, ensure the Display on
slice(s) option is selected and click OK

El Use the Dynamic rotate button to rotate the model around to the view shown.
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Animation Wizard...

| File

Save As AVI...

Staged Construction of a Concrete Dam

Loadcase: 61:Time Step 60 Time = 23 5391
Results file: Concrete_Dam-Thermal mys
Response time: 23.5391

Enttityy: Potential

Component: PHI (Units: C)

0.0
50
ann
360
400
46.0
a0.0

a5.0

e Select the Load history radio button
and click Next

e From the File drop-down menu on
the Animation Load History dialog
choose the thermal results file
Concrete_Dam_therm.mys

e For the purposes of this example
animate every 4™ Time Step by
entering a Start value of 1, a Step
value of 4 and click Filter. Only

every 4" Time Step will appear in the Available area of the dialog. Select all of
these filtered thermal results time steps (by clicking on the first time step, holding
the Shift key, scrolling all the way to the bottom of the list and clicking on the last

time step). Include these time steps by clicking on the il button and then

clicking Finish

e Close the Animation window.

To create and save an animation of the temperature variation on this slice section
through the dam, complete the following procedure:

Loadcase: 57:Time Step 56 Time = 21.5391 A
Results file: Concrete_Dam~=Thermal mys 4 \
Response time: 21,5391 7
Eniity: Potential
Companent: PHI (Units: C)

200
250
30.0

350
40.0
450

.Bun

lv u) ) xla) alwl[ g

Save the animation to your projects folder and enter concrete_dam_thermal_slice.avi
for the filename. Click OK
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Plotting contours on the whole model after slicing

o Inthe = Treeview select double-click the Contour option and deselect the Display
on slice(s) option and click OK.

The display will revert to show contours of Potential of entity PHI on the whole model.

e Remove any slices generated by picking the Slices group from the Treeview,
clicking right-hand mouse button and choosing the Delete menu item from the
context menu.

Structural Results

Viewing and animating structural results is done in a similar manner to that described
for thermal results, ensuring that only Structural loadcase results Time Steps are set
active or used in an animation.

o In the {2 Treeview right-click on the structural results for Time Step 60 and Set
Active

e Double-click the contours layer in the [5* Treeview. On the dialog, set the results
entity to Stress — Solids and component S1.

e Select the Contour Range tab and ensure that an Automatic contour range using 9
contours is being used. Deselect the Maximum and Minimum values and click
OK

Loadcase: 61:Time Step 60 Time = 23.5391
Results fle: Concrete_Dam~Structural. mys
Responss time: 23.5391

Enfty: Stess - Solids

Componant: 51 {Units: Nim?)

-12 066366
-9.04972E5
-6.0331568

- -301657E8
00

301657E6
6.03315E6
904972E6
12.0663E6

Maximum 1392616 at node 231
Mimimum -13. 22316 at node 92

This will show contours of the maximum principal stress (S1) at the current time step.
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Graphing of Results at a Selected Node

In analyses of this type it may also be useful to graph

thermal time steps are selected for plotting.
Continuing on from the last animation created:

e Delete the animation window and maximise the Mode

Mesh layer.

In the ) Treeview right-click on Time Step 60 in t
results and Set Active

all the mesh.

Select the stage 1 node for results graphing.

Stage 3 node selected for results graphing

Stage 2 node &
selegcted for results = l "4!1‘.'-;
graphing =] I'_,,.iﬁﬁ'-iﬁf
| LTl
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Stage 1 node selected for results graphing

the changing temperature at a
selected node (or nodes) as the construction progresses. This can be done by selecting a
node of interest and using the Graph Wizard - making sure that only thermal results and

| window

In the Treeview, turn off the Contour and Geometry layers and turn on the

he Thermal Stage 3 loadcase

Double-click the Mesh layer and select Hidden parts and deselect Dotted to view
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Viewing the Results

| utilities e Select Time history and click Next.

Graph wizard...

To define the graph X axis details:
e Select Named entity data and in the Entity data panel.

e In the Sample loadcases panel ensure Whole analysis is selected and choose the
Thermal analysis from the drop-down box. Click Next to continue.

e Select Response time for the data to be plotted and click Next.

To define the graph Y axis details:

° SeIeCt NOdaI entlty data and CliCk Thermal results for selected internal nodes

Next. 76
74 foe

66 |-
61
£6 [ 45
51
a6 b
arfl-
36L--
31 f---
%

e Ensure entity Potential and
results component PHI are
selected for the node shown on
the dialog and click Next.

Temperature (Degrees)

e Enter the title as Thermal results
for selected internal nodes

e Enter the X axis title as Response
time (DayS) Response time (Days)

e Enter the Y axis as Temperature (Degrees) and click Finish to create the graph.

e Without deleting the Graph Window return to the Model Window

Graphing Results for Other Nodes

When a node in the mid-section of the dam for the other two construction stages is
selected the following graph can be created, which clearly shows the initial rise and
subsequent reduction of temperature after each stage of concrete is constructed.

| utilities For each additional node identified, select it, and run the Graph Wizard. Repeat the
[Graphwizard...  ahove steps, instead selecting Previously defined for the X-Attribute Entity Data and

re-using the Response time dataset.

Make sure that results for these additional modes are plotted onto the initial graph
created by selecting the Add to existing graph option at the final stage of the wizard.
Graph properties (such as editing axis or curve titles etc) can be edited by right-clicking
on the Graph and choosing Edit Graph Properties
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Thermal results for selected internal nodes

Staged Construction of a Concrete Dam
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This completes the example.
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